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Safety Precaution:
Read the safety precaution carefully and make sure you understand it before using the programmable
terminal so that you can use it safely and correctly.

CAUTION

Do not use input functions such as PT touch switches for applications

where danger to human life or serious property damage is possible or

for emergency switch applications.

CAUTION

Carefully check the operation of all screen data and host programs

before using them. If incorrect, the system may operate unpredictably.

Otherwise the system may operate unpredictably.

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.

CAUTION

When transferring the data in units of screens, if there are changes in

memory tables and /or direct access, transfer such data along with the

screen data.

Otherwise the system may operate unpredictably.
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OMRON Product References
AllOMRONproducts are capitalized in thismanual. Theword “Unit” is also capitalizedwhen it refers toan
OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “Ch,” which appears in some displays and on some OMRON products, often means
“word” and is abbreviated “Wd” in documentation in this sense.

The abbreviation “PC” means Programmable Controller and is not used as an abbreviation for anything
else.

[Numeral settings]

Each Support Tool screen displays options for functions to be set. The example to the left shows
such an option, “Numeral settings.”

Example Screens

The example screens that appear in this manual are mainly those of NT31C-V1.

Note that the contents of the screens of other models may differ somewhat from the examples.

Visual Aids
The following headings appear in the left column of the manual to help you locate different types of in-
formation.

Note Indicates information of particular interest for efficient and convenient operation
of the product.

1, 2, 3... 1. Indicates lists of one sort or another, such as procedures, checklists, etc.

E OMRON, 2000
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any
form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written per-
mission of OMRON.

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because
OMRON is constantly striving to improve its high-quality products, the information contained in this manual is sub-
ject to change without notice. Every precaution has been taken in the preparation of this manual. Nevertheless,
OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for damages resulting
from the use of the information contained in this publication.

Trademarks
MicrosoftR, MS-DOSR, WindowsR and Windows NTR are either registered trademarks or Trademarks of Micro-
soft Corporation in the United States and/or other countries.
PLC names of MELSEC FX, A series and FX-2PIF of MELSEC F series are registered trademarks of Mitsubishi
Electric Corporation.
Hewlett-Packard, HP, PCL and Laser Jet are registered trademarks of Hewlett-Packard Company.
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Organization of the Manual, and How to Use It:

The related manuals are listed below.

* The final digit of the manual number is the revision code.

For operating the Support Tool

S NT-series Support Tool for Windows Operation Manual (V061-E1-2):
This manual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Details on the operating procedure, settings, etc., of the Support Tool can be
displayed on the screen in the form of online help information. Normal operation
can be carried out by following this help information.

When youare unsure of the operating procedurewhile using theSupport Tool, or
you need to check detailed settings, refer to this manual.

The explanations in this manual center on the Support Tool itself. It does not
include detailed explanations on the operation of the PT. Therefore, refer to the
following manuals also.

This manual also explains the operation of NT Transfer Utility which is
exclusively used for downloading and uploading the screen data.

TheNT-series Support Tool forWindows 95/98 can be usedwith the latest direct
access versions of the following PT models. Details are given in this manual.

NT11S, NT20S, NT21, NT30, NT30C, NT31, NT31C, NT600S, NT620S,
NT620C, NT625C, NT631, NT631C

For information on PT functions, operations, and restrictions

S NT11S Programmable Terminal Operation Manual (V029-E1-j)

S NT20S Programmable Terminal Operation Manual (V020-E1-j)

S NT600S Programmable Terminal Operation Manual (V022-E1-j)

S NT30/NT30C Programmable Terminal Operation Manual (V034-E1-j)

S NT620S/NT620C Programmable Terminal Operation Manual (V033-E1-j)

S NT21 Programmable Terminal Setup Manual (V068-E1-j)

S NT31/31C Programmable Terminal Setup Manual (V062-E1-j)

S NT631/631C Programmable Terminal Setup Manual (V063-E1-j)

S NT21/31/631 Programmable Terminal Reference Manual (V069-E1-j)

These manuals contain full descriptions of PT functions, operations, and
restrictions.

For information on the functions and operations of the PC

S Operation manual for each PC

When youneed information about the operations, functions, etc., of thePC, refer
to the operation manual for the PC, advanced function unit, or communication
unit being used.
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Description of NT31, NT31C, NT631 and NT631C

There are two types of NT31, NT31C, NT631 and NT631C, the models with the
suffix “-Vj” and the models without the suffix “-Vj.”
In this manual, they are written as “NT31, NT31C, NT631 and NT631C” collec-
tively when it is not necessary to classify them. However, they are written sepa-
rately like “NT31, NT31C, NT631 and NT631C with -V1” and “NT31, NT31C,
NT631 and NT631Cwithout -V1” when it is necessary to classify them. (System
program version will be indicated like “NT31, NT31C, NT631 and NT631C with
(System Ver.3.1), if required.)
The system programs of NT31, NT31C, NT631 and NT631Cwith “-V2” (System
Ver.3.1) are suppliedwithNT-seriesSupport Tool forWindows (Ver.4.1). It is pos-
sible to upgrade NT31, NT31C, NT631 and NT631C models without “-Vj” by
installing this new system.
In this case, however, the functions indicatedbelowcannot beusedeven though
other functions can be used in the same way as the models with “-V2.”

S 32-dot font

S Font type ISO 8859-1

For details of 32-dot font, refer toSettings for text display in 6-1-10 Setting Prop-
erties. Note that smoothing is not performed for 32-dot font.
For details of font types, refer to Font Type in 3-3Operation of Screen Data (Ap-
plication) File and Appendix K.



1

SECTION 1
Introduction to the Support Tool

This section is designed for users to utilize the efficient usage of Support Tool.
Discussed in this section are what you can do using the Support Tool and the specifications and functions of Support Tool.

1-1 What Is Support Tool? 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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1-3-3 Tables 14. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
1-3-4 Types of Screens 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

1-4 Basic Operation Flow 20. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
1-5 Menu Chart 21. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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1-1 What Is Support Tool?
The NT-series Support Tool for Windows (Ver. 4.6) (hereafter referred to as the
Support Tool) is the application software, which runs on Windows 95, Windows
98 andWindows NT, developed to create the screen data for the programmable
terminal (PT).

Since the Support Tool has been developed to use the graphical interface and
run under the operation environment of Windows, persons not familiar with the
Support Tool can create the screen data of the programmable terminal without
difficulties.

The Support Tool can create the screen data for the following models of PT.

Conventional models: NT11S, NT20S, NT30, NT30C, NT600S, NT620S,
NT620C/NT625C

New models: NT21, NT31, NT31C, NT631, NT631C

The screen data created using the Support Tool consists of the objects shown in
the following page.
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Screen DataData created
by the Support Tool

Screen 1 Screen Properties

Display
Object

Arc

Circle

Sector

Polyline

Polygon

Rectangle

Text

Tiling

Image Object

Library Object

Mark

Lamp

Numeral Display

String Display

Graph

Alarm List/Alarm History

Standard Lamp

Image Lamp

Bar Graph

Broken-line Graph

Trend Graph

Touch Switch

Input
Setting

Input
Object

Numeral Input

String Input

Thumbwheel Switch

Screen 2

Screen 3
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Main Differences of V4.1

Model number Specifications

NT--ZJCAT1--EV4 For IBM PC/AT or compatible media: CD--ROM

Following changes aremade for NT-series Support Tool forWindows to improve
operational efficiency and to support new functions added for NT31, NT31C,
NT631 and NT631C with “-V2 (System Ver. 3.1).”
Refer to Appendix G New Functions of Support Tool Ver. 4.1.

NT31, NT31C, NT631, NT631C new system program support

System program for NT31, NT31C, NT631, NT631C has been upgraded to
Ver.3.1, so the following functions are now supported. New system program is
supplied with Support Tool Ver.4.1.

S CS1 memory area support

S Recipes

S Interlocks

S Mathematical table

S NT30/620-compatible mode

S Multiple line labels

S ON/OFF state labels

S Numeral display/string display labels

S Device monitor screens

S Contrast & brightness adjustment screens

Addition of NT Translation Support Utility

The Translation Support Utility is software that helps in translating a language to
another supported language.

For details, refer to Appendix D NT Translation Support Utility.

I/O comments importing from TAB-delimited text file

For details, refer to 7-7-4 Importing I/OComments fromTab-delimited Text Files.

Centering the Labels of Lamp and Touch Switches

Only horizontal direction could be centered in previous versions. In this version,
the labels of lamp/touch switches can be centered in both vertical and horizontal
directions.

For details, refer to 6-1-9 Centering the Label of Lamp and Touch Switch.

The Data input string in a string input function touch switch (Only for NT31/631)

The labelwas used for the input data string in previous versions. In this version, a
different string from the label can be specified as the data input string.

For details, refer to 6-8-3 Character String Input Touch Switch.

Launch the system installer

It is possible to launch the system installer from [Connect]--[Launch System In-
staller] in the menu bar.

Addition of NT30/620 series system programs

The system programs for NT30/620 are included.
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Main Differences of V4.6
NT21 New System Program Support

Starting with NTST-EV4.6, the NTST supports creating screen data for the
NT21.
NT31-V2 (System Ver. 3.1) data and NT21 data can be converted for mutual
compatibility.
NT20 data can be converted to NT21 data.
NTST-EV4.6 can transfer screen data to the NT21 in high-speed mode.
Refer to NT21/31/631 Reference Manual for details.

Pick I/O Comments from a CX-Server Database
I/O name in CX-Server data can be used as PT I/O comment.
When a PLC address is defined in the dialog, an I/O comment can be picked up
from CX-Server PLC point data in a cdm file. The “Pick CX-Server point” button
is enabled only when CX-Server is installed.
When the I/O comment table is edited,multiple I/O comment data can be picked
up fromCX-Server PLCpoint data in the cdm file. The “Import” button is enabled
only when CX-Server is installed.
Each I/O name will be imported as a PT I/O comment within 16 characters.

Property Dialog for Grouped Objects
Grouped object attributes can be edited by double-clicking or right-clicking to
display the properties for grouped objects. The properties show the tree the ob-
jects included in the group. Choose each object in the tree to edit the structure.

Preview in Symbol Manager
Registered symbols can be previewed on the symbol manager. Previous sym-
bols can be previewed after they are copied onto the NTST-EV4.6 screen and
copied back to symbol manager to create preview images. Or, those symbols
can be reused without preview as they are.

Copying Image/Library/Mark with contents
When copying Image/Library/Mark objects, NTST-EV4.6 will copy them with
contents and registered them in each table. If the same code is already used in
the table, the NTST will display a dialog to show the next unused number as a
substitute.
The functionality does not recursively apply to references in the Image/Library/
Mark object. For example, when copying a library object that refers to library
entry, and the content of the entry contains text with a mark reference, then the
corresponding mark content will be ignored. It also does not apply to when
screens are copied in ApplicationManager for pasting into a second instance of
NTST.

1-2 Equipment Necessary for Using the Support Tool
The following indicates the equipment necessary for using the Support Tool.

Hardware

S Recommended CPU

Pentium 100 MHz or faster CPU

S Personal Computer

Use an IBM personal computer or 100% compatible.

S Recommended Memory

32 Mbytes minimum
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S Free area in hard disk

At least 47 Mbytes. (for installing Support Tool, System Program, System In-
staller)

To install other data such as Sample Collection for Support Tool on CD-ROM,
another 38 MB is required.

S CD-ROM drive

At least one drive is required if the Support Tool is provided on CD-ROM.

S Display

VGA compatible display

When creating screen data for a PT that has a color display, a color display is
required.

When the resolution setting of desktop area is low (lower than 640×480), part
of the window of Support Tool may stick out of the screen. In this case, change
the resolution setting of desktop area to the higher one with the control panel
property of Windows.

S Mouse

Serial mouse or bus mouse

Operating system

MicrosoftWindows95,Windows98andWindowsNT (WindowsNT is only avail-
able with NT-series Support Tool Ver.3.3 onward.)

Device necessary for Transmitting screen data

S RS-232C cable

For cable specifications, refer toAppendix JConnectingCable Specifications.

1-3 General Configuration of the Support Tool

1-3-1 Outline of Screen Data
The screen data of the Support Tool consists of multiple screens that are linked
with each other.

Screens aremanaged by screen numbers. The range of usable screennumbers
varies according to the type of the PT connected to the Support Tool.

The screendisplay is switchedby pressinga touch switch or giving an instruction
from the PC (PLC).

PT Model Range of Screen Numbers

NT11S 1 to 250

NT20S 1 to 250, 256 to 500

NT600S 1 to 1000

NT30/NT30C
NT620S/NT620C/NT625C 1 to 1899, 1900 to 1979 1980 to 1999, 2000

NT21 1 to 3999, 9000, 9001, 9002, 9020

NT31/NT31C/
NT631/NT631C

1 to 3999, 9000, 9001, 9002, 9020 to 9023,
9030
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On a screen, a variety of objects can be arranged as desired.

The following objects are used to create a screen.

Display objects

Display objects are drawn on a screen and do not have an input function.

Display objects are classified into two kinds:Objects that are always displayed in
the same status, and those that change according to the status of the PT or the
PC (PLC).

Input objects

Input objects are objects that allow input by operation at the PT. Touch switches
and input fields for numerals and strings are examples of input objects.

Objects having code numbers

These objects are created using an exclusive editor.

Theyare registeredwithacodenumber so that they canbeused in different posi-
tions and different screens.

S Library data

A drawing created as a fixed display is registered as library data so that it can
be used multiple positions and screens.

The library editor is used to create library data.

S Image data

Image data are objects used to display bit map data on the screen.

An imageeditor or bitmapeditor (runningonWindows) availableon themarket
is used to create image data.

S Marks

Marks are used to display special characters and symbols. These objects can
be handled as characters.

The mark editor is used to create marks.

Registering created objects (symbol manager)

The efficiency of use of created objects can be increased by reusing them in oth-
er screen data or by registering objects that will be used frequently.

The symbol manager is provided to register created objects.
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Objects that can be used

The table below shows that objects can be used with particular PT models.

NT11S NT20
NT600
S

NT30
NT30C
NT620
S

NT620
C

NT625
C

NT21 NT31
NT31C
NT631
NT631
C

Objects Display
Object

Arc – – F F F
Object Circle – F F F F

Sector – – F F F

Polyline – F F F F

Polygon – – F F F

Rectangle – – F F F

Text F F F F F

Tiling – F F F

Standard Lamp – F F F F

Image/Library
Lamp – – F F F

Numeral
Display F F F F F

String Display F F F F F

Bar Graph F F F F F

Broken-line
Graph – – F F F

Analogue Me-
ter – – – F n*1

Trend Graph – – F F F

Alarm List – – F F F

Alarm History – – F F F

Recipe – – – F n*3

F: Can be used.

n*1: Can be used only with models with “-V1” and above.

n*2: Only use is insertion into character strings.

n*3: Can be used only with models ”-V2 (System Ver.3.1) and above.
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NT11S NT20
NT600
S

NT30
NT30C
NT620
S

NT620
C

NT625
C

NT21 NT31
NT31C
NT631
NT631
C

Objects Input
Objects

Touch Switch – F F F F
Objects Numeral

Input F F F F F

String Input – – F F F

Thumbwheel
Switch – F F F F

Library
Type

Image Display – – F F F
Type
Object Library Display – – F F FObject

Mark n*2 n*2 F F F

F: Can be used.

n*1: Can be used only with models with “-V1” and above.

n*2: Only use is insertion into character strings.
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1-3-2 Correspondence to PC (PLC) Data
The following table shows objects that are capable of transmitting data with PC
(PLC) to execute processing such as updating the screen display.

Object Input Output

Standard Lamp PC (PLC) (bit address)
PT (Numeral table)*1

–
PT (Numeral table)*1
PT (String table)*1

Image/Library Lamp PC (PLC) (Bit address)

Touch Switch PC (PLC)
(bit address for lamp)

PC(PLC) (bit address for in-
terlock) *1

PT (Numeral table) *1
PT (String table) *1

Notify Bit (bit address)

Switch Screen

Input key-Window/Keyboard

Window Move
(Can be used only on Win-
dow Screen)

Copy Setting
(Numeral, String table)

Input key - Control

Input key - String

Cursor Move

Print Screen

Thumbwheel Switch PC (PLC) (bit address for in-
terlock) *1

PT (Numeral table)

Numeral Display PT (Numeral table) –

String Display PT (String table) –

Bar Graph

Analogue Meter

Broken-line Graph

Trend Graph

PT (Numeral table) –

Numeral Input PC (PLC) (bit address for in-
terlock) *1

PT (Numeral table)

String Input PC (PLC) (bit address for in-
terlock) *1

PT (String table)

Alarm History PT (Bit Memory table) PT (Alarm History)

Alarm List PT (Bit Memory table) String Display
Image/Library Display

Recipe Object PC (PLC) (Word address) PC (PLC) (Word address)

*1: Theseareavailable onlywith theNT21andwith theNT31/631-V2andabove.

Operation of changing display objects

S Lamp display

The lamp is turnedON (OFF)when the specified PC (PLC) bit goesON (OFF).

Screen PC (PLC)
Bit address

Lamp lights when
bit comes ON
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S Touch switch -- Notify Bit

The specified PC (PLC) bit goes ON (OFF) when the switch area is pressed.

Screen

Notification

PC (PLC)

Bit address

S Touch switch -- Switch Screen

The display screen is switched to another when the switch area is pressed.

Screen A Screen B

S Touch switch -- Input Key - Window/Keyboard

A window (Keyboard Screen) pops up in the screen when the switch area is
pressed.

Screen Screen

Window (Keyboard)

S Touch switch -- Window Move

The window is moved by touch panel operation when the switch area is
pressed.

Window Window in a moving status

Screen Screen Screen

S Touch switch -- Input key - Control

When theswitcharea ispressed, theprocessingassigned to thespecifiedcon-
trol code is executed.

Screen
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S Touch switch -- Input Key - String

When the switch area is pressed, the characters of the label set for the switch
are displayed in the string input field and stored in the string table.

ScreenScreen

String input field

S Touch switch -- Copy Setting

When theswitcharea is pressed, data is copied.The following typesof copying
can be designated.

Data in Numeral table Numeral table

Data in Numeral table Numeral Input field

Data in String table String table

Data in String table String Input field

Constant Numeral table

Constant Numeral Input field

Input box

Screen
Data Data

S Touch switch -- Cursor Move

The cursor moves fromNumeral Input to Numeral Input fields when the switch
area is pressed.

ScreenScreen

S Touch switch -- Print Screen

A hard copy of the screen will be printed when the switch area is pressed.

Screen
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S Numeral display

The data in a Numeral table will be displayed.

1234
Reference

Display

Screen

Numeral display

1 2 3 4

Numeral
table

S String display

The string display object displays the data in a string entry.

String
table

A B C ABC

String display

Screen

Display

Reference

S Graph display

The graph display object displays the data in a numeral table entry.

100
60

Numeral
tableScreen

Bar graph display

0 Display

Reference

S Data Input -- numeral input and string input

These input objects write data into a table.

Numeral Input field Numeral Table
String Input field String Table

Screen
Numeral
table

Numeral data input

Input field

Writing
50

50

S Data Input -- Thumbwheel switch

The Thumbwheel Switch object stores the numeric values to a numeral table
entry through transaction of Thumbwheel Switch.

Screen
Numeral
table

1234
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S Data Input -- Recipe

The recipe object reads/writes numeric values that were set using NTST from/
to the PC (PLC) when the write/read touch switch is pressed.

Screen PC (PLC)

Recipe

315

Write
Read

10
25

S Alarm

When a bit in a bit memory table is ON (OFF), the object displays the data in a
string table entry and stores it in the alarm history.

When the displayed data of the string table is touched, the object displays
image/library data, switches the screen to the specified screen.

Alarm history display

Temp. Alarm

Temp .Alarm

Library
data

Image/Library table

Temp. Alarm 96/11/06 16:02
Pres Alarm 97/01/06 18:25

Touch display

String tableAlarm list display
Bit memory table

Reference: If an “Indirect Reference” is used with image/library data, data to be displayed
can be changed according to the change in the contents of numeral table. (The
NT21 andNT31,NT31C,NT631, NT631Cwith SystemVer. 2.1 and above only.)

1-3-3 Tables
Tables are areas secured in the PT to store data such as numeral data and char-
acter string data. They are used to share data for the functions assigned to ob-
jects and communicate with a PC (PLC).

If a word address of a PC (PLC) is set in a table, data communication processing
between the PT and PC (PLC) is executed automatically in predetermined
cycles.

The following types of tables are provided.

S Numeral table

S String table

S Bit memory table

S Extended I/O Input table

S Extended I/O Output table

S I/O Comment table

S F-key Input Notify table

S Mathematical table

S Recipe Table
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The number of memory table entries varies according to the model of PT con-
nected.

NT11S NT20S NT600S NT30
NT30C

NT620S
NT620C
NT625C

NT21

NT31
NT31C
NT631
NT631C

Numeral
table 128 128 512

512
or
1000

512
or
1000

512,
1000,
or
2000

512,
1000,
or
2000

String
table 128 128 256

256
or
1000

256
or
1000

256,
1000
or
2000

256,
1000
or
2000

Bit
Memory
table

– – – 256 256
256
or
1000

256
or
1000

Extended
I/O Input
table

– – – 64 – – –

Extended
I/O Output
table

– – – 64 – – –

F-key In-
put Notify
table

4 – – – – – –

Mathe-
matical
table

-- – – – – 256 256*1

Recipe
table -- – – – – 200 200*2

*1: This option is available only for V2 and above.
*2: This option is available only for V2 (System Ver.3.1) and above.

Numeral table

The Numeral table stores numeral data.

This table is set when using Numeral Display objects, Graph objects, and Nu-
meral Data Input.

For details of table setting, refer to 7-2 Numeral Memory Table.

String table

The String table stores text data.

This table is set when String Display object and String Input object are used.

For details of table setting, refer to 7-3 Character String Memory Table (String
Table).

Bit Memory table

The Bit Memory table stores status of a PC (PLC) memory bit.

This table is set when using the alarm list/history function.

It is also used when switching the screen by the operation at the PC (PLC).

For details of table setting, refer to 7-4 Bit Memory Table.

Extended I/O Input table

The Extended I/O Input table sets the usage of input terminals of an extended
I/O unit (e.g., B7A Unit).
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For the individual input terminals, a function is set or a PC (PLC) bit to be refer-
enced is allocated.

For details of table setting, refer to 7-5 Extended I/O Input Table.

Extended I/O Output table

TheExtended I/OOutput table is used to allocate thePC (PLC) bits that control
the output terminals of an extended I/O unit.

The output terminals of the extended I/O unit are controlled according to the
statuses (ON/OFF) of PC (PLC) bits.

For details of table setting, refer to 7-5 Extended I/O Output Table.

I/O Comment Table

The I/O Comment Table is an area provided in a PT to manage the comment
data of all words and bits in the PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by the numeral
memory table, character string memory table (string table), bit memory table,
extended I/O input table, extended I/O output table, and elements, in list form.

The displayed comments can be edited. For details, refer to 7-7 I/O Comment
Table.

F-Key Input Notify table

The F-Key Input Notify table assigns to a function key in a PT device. Host bits
are allocated to the function keys. By switching the function key ON and OFF,
the corresponding bit is turnedONandOFF.For details of table setting, refer to
7-8 F-Key Input Notify Table.

Mathematical table

Mathematical functions canbe formed through this table andassociated toany
numeral table entry/PLC address location. For details refer to 7-9 Mathemati-
cal Table.

Recipe Table

The Recipe Table will set the parameters of designated memory areas of the
address. For details refer to 7-10 Recipe Table.
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1-3-4 Types of Screens
APTdisplays two types of screens—user screens that are created by arranging
objects as desired and system screens for which a specific function is preset.

The types of screens displayed on a PT, and screen numbers assigned to the
each screen are shown below.

Screen Types NT11S NT20S NT600S

NT30
NT30C
NT620S
NT620C
NT625C

NT21

NT31
NT31C
NT631
NT631C

User
Screens Standard

screens
1 to
250

1 to
250

1 to
1000

1 to
1899,
2000

1 to
3999

1 to
3999

Overlapping
screens – 1 to

250
1 to
1000

1 to
1899,
2000

1 to
3999

1 to
3999

Continuous
screens – 1 to

250
1 to
1000

1 to
1899 – –

Window/Key-
board screens – – –

1900
to

1979

1 to
3999

1 to
3999

Host connect
screens – – – 1999 – –

System initializ-
ing screens – – – – 9000 9000

Password
screens

1 to
250 – – – – –

Menu screens 1 to
250 – – – – –

Print format
screens 255 – – – – –

System
Screens

Screen display
OFF 0 0 0 0 0 0

Extended
screens – – –

1980
to

1996
– –

Occurrence his-
tory screens – – – 1997 9001 9001

Frequency his-
tory screens – – – 1998 9002 9002

Programming
Console
screens

– – – -- *1 9020 9020

Device monitor
screens – – – -- --

9021
to

9023 *2

Return to the
previous screen – – – – 9999 9999

*1: Available only from the system menu. A screen number is not assigned.
*2: Only with NT31/631-V2 and above

Standard screens

Standard screens are the fundamental screens of the PT. Specify a Standard
Screen to create a screen.
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Overlapping screens

Overlapping screens are grouped screens; a maximum of eight screens can
be overlapped to display information on one screen. The screen used as the
base for the overlapping screens is called the Parent Screen and the multiple
standard screens that configure the overlapping screen are called Child
Screens.

This is an
example of an
Overlapping
Screen.

This is an

Screen No. 10
(Child Screen)Screen No. 8

(Parent Screen)

example of an
Screen No. 7
(Child Screen)

Overlapping
Screen.

Screen No. 25
(Child Screen)

When screen No. 8 (parent screen) is specified, objects set on the individual
child screens (screens No. 10, No. 7, No. 25) are displayed in this order.

SincescreenNo.8 is set asanoverlappingscreen, it cannotbedisplayed inde-
pendently. Note that a child screen can be displayed independently.

Continuous screens

Continuous screens are grouped screen: a maximum of eight screens can be
displayed in series. Thebase screenwhere continuous screens are registered
is called the Parent Screen and the registered screens are called Child
Screens.

[ ↓ ] [ ↓ ] Screen No. 1Screen No. 15Screen No. 20Screen No. 10

Parent
screen

Continuous
screen 1

Continuous
screen 2

Continuous
screen 3

[ ↑ ] [ ↑ ]

WhenscreenNo. 10 is specified, screenNo. 20 -- which is the first of the contin-
uous screens -- is displayed. After that, screens are displayed in the order of
screen No. 20, screen No. 15, and screen No. 1 by the operation of touch
switch
[ # ].

Since screenNo. 10 is set for a continuous screen, it cannot be displayed inde-
pendently.

Continuous screens are switched by pressing touch switches [ # ] and [ ↑ ], to
which system keypad is assigned.

Continuous screens cannot be used for the NT21, NT31/NT31C, and
NT631/NT631C. For these models, Switch Screen function of touch switch is
recommended to obtain the identical function.

Window/Keyboard Screen

Window/Keyboard Screen is used as awindow screen. This is a partial screen
used to display a keyboard such as a keypad for inputting numeral/string or an
operational help etc. overlapping a display screen.

For NT30, NT30C, NT620S, NT620C, and NT625C, this screen can also be
used as a standard screen if it is not used as a keyboard screen. (For NT21,
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NT31, NT31C, NT631, and NT631C, a keyboard screen cannot be displayed
independently.)

With the NT21 and with the NT31, NT31C, NT631 and NT631Cwith “-V1” and
above, all objects other than thumbwheel SW can be registered. With other
models, only fixed display, and touch switch used to input numeral/string and
temporary input field can be registered. (This type of window is called a
Keyboard Screen.)

With the NT21 and with the NT31, NT31C, and NT631Cwith “-V1” and above,
up to 3window/keyboard screens can be opened at the same time. (With other
models, only 1 window/keyboard can be opened.) For details, refer to 5-4
Window/Keyboard Screens.

Host connect screen (System initializing screen)

This screen is displayedat the start ofPToperationuntil the connection to aPC
(PLC) is completed.

If a Host Connect screen is not registered, the default screen that shows the
host connection message is automatically displayed when the PT power is
switched on or when the PT mode transfers to the run mode.

Display OFF screen (no-display screen)

This screen is used when nothing is to be displayed on the screen. Since this
screen is reserved by the systemas aDisplayOFF screen, it cannot be edited.

Extended screen

Screens reserved for future extension of PT functions. Screens should not be
registered to the screen numbers of these reserve screens.

Occurrence history screen

An occurrence history screen displays the numbers of screens displayed by
Switch screen operations in the order of occurrence.

Frequency history screen

A frequency history screen displays the numbers of screens displayed by
Switch screen operations in the order of frequency.

Password screen

This screen exists for the secure protection of a designated screen so that us-
ers can switch the screen only when the accurate password is input.

Menu screen

Menu screen serves as a control screen to switch to a designated screen
through the operation of numeric key.

Print Format screen

If this screen is assigned, printing can be done by simple operation.

Programming Console Screen
This screen can be used to execute Programming Console functions with the
NT21, NT31, NT31C, NT631, and NT631C. User editing of this screen is not
possible. Refer to 5-12 Programming Console Screen for details.

Device Monitor Screen
This screen can be used to execute device monitoring functions with the NT31,
NT31C, NT631, and NT631C with “-V2.” User editing of this screen is not pos-
sible. Refer to 5-13 Device Monitor Screen for details.
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1-4 Basic Operation Flow
The procedure for creating a screen using the Support Tool is shown below.

CAUTION

Carefully check the operation of all screen data and host programs

before using them. If incorrect, the system may operate unpredictably.

Otherwise the system may operate unpredictably.
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1-5 Menu Chart
The pull downmenu commands provided by theSupport Tool and the function of
each menu item are shown below.

File New Creating new screen data. . . . . . . . . . . . . . . . . . .

Open Reading created screen data. . . . . . . . . . . . . . . . . .

Close Ending creation of screen data. . . . . . . . . . . . . . . . . .

Save Saving screen data being created to a file. . . . . . . . . . . . . . . . . .

Save As Registering screen data being created under a new file name. . . . . . . . . . . . . . . .

Import Reading the data created by DOS version Support Tool. . . . . . . . . . . . . . . . .

Print Printing screen data. . . . . . . . . . . . . . . . . . .

Print Preview Displaying print format of screen data. . . . . . . . . . .

Print Setup Setting the printer. . . . . . . . . . . . .

Recent File(s) Recently used files. . . . . . . . . . .

Exit Exiting the Support Tool. . . . . . . . . . . . . . . . . . . .

Import Component Importing data from different screen data file. . . . . . .

Edit Undo Canceling the last operation. . . . . . . . . . . . . . . . . .

Redo Returning the screen status to the status before Undo. . . . . . . . . . . . . . . . . .

Cut Cutting an object (to the clip board). . . . . . . . . . . . . . . . . . . .

Copy Copying an object (to the clip board). . . . . . . . . . . . . . . . . .

Paste Pasting an object (from the clip board). . . . . . . . . . . . . . . . . .

Delete Deleting an object. . . . . . . . . . . . . . . . .

Select All Specifying objects collectively. . . . . . . . . . . . . . .

Edit Object Specifying editing an object. . . . . . . . . . . . .

Select Object Selecting an object. . . . . . . . . . .

Align Align Top Aligning objects to the top. . . . . . . . . . . . . . . . . . . . . .

Align Bottom Aligning objects to the bottom. . . . . . . . . . . . . . . . . . .

Align Left Aligning objects to the left. . . . . . . . . . . . . . . . . . . . . .

Align Right Aligning objects to the right. . . . . . . . . . . . . . . . . . . .

Center in a Row Aligning objects to vertically center. . . . . . . . . . . . . . . .

Center in a Column Aligning objects to horizontally center. . . . . . . . . . . . .
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View Full Tiling Switching tiling display for object to be tiled. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show Tag

Refresh Redrawing the current screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Toolbars

Full Screen Changing over entire screen display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

PC (PLC) Address Changing over the display to one with word numbers. . . . . . . . . . . . . .

Table No. Changing over the display to one with table entry numbers. . . . . . . . . . . . . . . . . . . . . .

Image and Library Code Changing over the display to one with code numbers. . . . . . . . .

Standard Bar Displaying/not displaying standard tool bar. . . . . . . . . . . . . . . . . .

Draw Bar Displaying/not displaying drawing tool bar. . . . . . . . . . . . . . . . . . . . . .

Status Bar Displaying/not displaying status bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Zoom 100% Changing display enlargement scale (100%). . . . . . . . . . . . . . . . . . . . . . . . .

200% Changing display enlargement scale (200%). . . . . . . . . . . . . . . . . . . . . . . . .

400% Changing display enlargement scale (400%). . . . . . . . . . . . . . . . . . . . . . . . .

800% Changing display enlargement scale (800%). . . . . . . . . . . . . . . . . . . . . . . . .

Simulate ON/OFF Displaying lamp ON/OFF status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Show
Window/

Local 1 (keyboard) Displaying/not displaying local window 1 (keyboard screen). . . . . . . . . . . . . .

Local 2 Displaying/not displaying local window 2. . . . . . . . . . . . . . . . . . . . . . .Keyboard

Simulate Flash Displaying flash status of an object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Error Log Displaying the error log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Utility Bar Displaying/not displaying utility bar. . . . . . . . . . . . . . . . . . . . .

Alignment Bar Displaying/not displaying alignment bar. . . . . . . . . . . . . . . . . .

Draw Selector Selecting object. . . . . . . . . . . . . . . .

Group Grouping objects. . . . . . . . . . . . . . . . . .

Ungroup Ungrouping objects. . . . . . . . . . . . . . .

Bring to Front Bringing object to the front. . . . . . . . . . .

Send to Back Sending object to the back. . . . . . . . . . .

Associate with Associating touch switch with object. . . . . . . . . .

Disassociate Canceling association of touch switch with object. . . . . . . . . . . .

Set Order Specifying moving order among numeral/character-string input fields. . . . . . . . . . . . . .

Properties Setting attributes of selected object. . . . . . . . . . . . . .

Use as Default Registering the status of the selected object as the default. . . . . . . . . .
for the object

Centralize Label Centralizing label of lamp/touch switch. . . . . . . . .



1-5SectionMenu Chart

23

Objects Fixed
Display

Text Specifying text. . . . . . . . . . . . . . . . . . . . . . . . . .

Circle Specifying a circle. . . . . . . . . . . . . . . . . . . . . . . . .

Arc Specifying an arc. . . . . . . . . . . . . . . . . . . . . . . . . . .

Sector Specifying a sector. . . . . . . . . . . . . . . . . . . . . . . .

Polyline Specifying a polyline. . . . . . . . . . . . . . . . . . . . . . .

Polygon Specifying a polygon. . . . . . . . . . . . . . . . . . . . . . .

Rectangle Specifying a rectangle. . . . . . . . . . . . . . . . . . . . .

Tiling Specifying tiling. . . . . . . . . . . . . . . . . . . . . . . . .

Image Display Specifying image data display. . . . . . . . . . . . . . . . .

Library Display Specifying library data display. . . . . . . . . . . . . . . . .

Mark Specifying a mark. . . . . . . . . . . . . . . . . . . . . . . . . .

Touch Switch Specifying a touch switch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Lamp Standard Specifying a standard lamp. . . . . . . . . . . . . . . . . . . . . .

Image Specifying an image/library lamp. . . . . . . . . . . . . . . . . . . . . . . .

Data Input Numeral Specifying a numeral setting input field. . . . . . . . . . . . . . . . . . . . . . .

String Specifying a character-string input field. . . . . . . . . . . . . . . . . . . . . . . . .

Thumbwheel Switch Specifying a thumbwheel switch. . . . . . . . . . . .

Numeral Display Specifying a numeral display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

String Display Specifying a character-string display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Graph Bar Graph Specifying a bar graph. . . . . . . . . . . . . . . . . . . . .

Broken-line Graph Specifying a broken-line graph. . . . . . . . . . . . . .

Trend Graph Specifying a trend graph. . . . . . . . . . . . . . . . . . .

Alarm List Specifying alarm list. . . . . . . . . . . . . . . . . . . . . . . . . . .

History Specifying alarm history. . . . . . . . . . . . . . . . . . . . . . . .

Analogue Meter Specifying an analogue meter. . . . . . . . . . . . . . . .

Recipe Specifying a recipe screen element. . . . . . . . . . . . . . . . . . . . . . . .

Screen New Adding a new screen. . . . . . . . . . . . . . . . . . .

Delete Deleting a screen. . . . . . . . . . . . . . . . .

Modify Parent Setting continuous/overlapping screens. . . . . . . . . . .

Copy to Image Saving screen data in image (BMP format) file. . . . . . . . . .

Extended I/O Setting an extended I/O table (setting a table common to all screens). . . . . . . . . . .

Grid Setting grid. . . . . . . . . . . . . . . . . . .

Properties Setting screen attributes. . . . . . . . . . . . . .
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Tools Table Setting memory tables. . . . . . . . . . . . . . . . . .

Image Editor Editing image. . . . . . . . . . . .

Library Editor Editing library. . . . . . . . . . .

Mark Editor Editing marks. . . . . . . . . . . . .

Change Address Changing PC (PLC) addresses set for objects and memory tables collectively. . . . . . . .

Validate Checking errors. . . . . . . . . . . . . . . .

PT Configuration Setting PT type, system settings, PT Status Control Area/PT Status Notify Area settings,. . . . . . . .
changing PT type (data conversion)

Import I/O comments Importing I/O comments from ladder program. . . .

Mathematical Table Editing mathematical functions. . . . . .

Recipe Table Setting recipe data. . . . . . . . . . . .

Upload
(PT to Support Tool)

Download
(Support Tool to PT)

Application Sending (downloading) all screen data to the PT. . . . . . . . . . . . . . . . . . . .

Screen Sending (downloading) screen data to the PT. . . . . . . . . . . . . . . . . . . . . . . .
in units of screens

Direct Access Information Sending (downloading) direct connection setting data. . . . . . .
to the PT

System Memory Sending (downloading) system memory data to the PT. . . . . . . . . . . . . . . .

Table Sending (downloading) memory table data to the PT. . . . . . . . . . . . . . . . . . . . . . . . .

Connect Comms. Setting Setting methods for communicating with the PT. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Application Reading (uploading) all screen data from the PT. . . . . . . . . . . . . . . . . . . .

Screen Reading (uploading) screen data to the PT in units. . . . . . . . . . . . . . . . . . . . . . . .
from the screen

Direct Access Information Reading (uploading) direct connection setting data. . . . . . .
from the PT

System Memory Reading (uploading) system memory data to the PT. . . . . . . . . . . . . . . .

Table Reading (uploading) memory table data to the PT. . . . . . . . . . . . . . . . . . . . . . . . .

Get History Log Screen History Reading (uploading) screen history data from the PT. . . . . . . . . . . . . . . . .

Alarm History Reading (uploading) alarm history data from the PT. . . . . . . . . . . . . . . . . .

Date and Time Reading/setting (uploading/downloading) clock. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
data in the PT

Window New Window Opening another window on the same screen. . . . . . . . . . . . . . . . . .

Cascade Displaying cascaded windows. . . . . . . . . . . . . . . . . . . . . .

Tile Displaying tiled windows. . . . . . . . . . . . . . . . . . . . . . . . . . .

Arrange Icons Arranging icons. . . . . . . . . . . . . . . . . .

Symbol Manager Starting symbol manager. . . . . . . . . . . . . . .

(Opened Window) Selecting window. . . . . . . . . . . . . .
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Help Contents Displaying table of contents of online help. . . . . . . . . . . . . . . . . . . . . .

Search for Help on Displaying help by search operation. . . . . . . . . . . . .

What’s This? Displaying help by a click. . . . . . . . . . . . . . . . . . .

PLC Address Help Displaying PLC Address help of the specified PLC vendor. . . . . . . . . . . . . .

About NT-series Support Tool Product information. . . .

1-6 Usable Hardware Combinations
The combinations of hardware that can be used are shown below.

The table shows the basic combinations. Depending on the PT display method
and system configuration, they may not be usable.

1-6-1 Applicable PT
NT-series Support Tool forWindows (Ver. 4.6) can create screen data for the fol-
lowing PT models.

PT Model Model

NT11S NT11S-SF121j

NT20S*1 NT20S-ST121j-V1 NT20S-ST121j-EV3
NT20S-ST122j-V1 NT20S-ST161j-EV3

NT30 NT30-ST131j-E

NT30C NT30C-ST141j-E

NT600S*1 NT600S-ST121j-V1 NT600S-ST121j-EV3
NT600S-ST211j-V1 NT600S-ST211j-EV3

NT620S NT620S-ST211j-E NT620S-ST212j-E

NT620C NT620C-ST141j-E

NT625C NT625C-ST152j

NT21 NT21-ST121j-E

NT31 NT31-ST121j-E NT31-ST121j-EV1 NT31-ST121j-EV2

NT31C NT31C-ST141j-E NT31C-ST141j-EV1 NT31C-ST141j-EV
2

NT631 NT631-ST211j-E NT631-ST211j-EV1 NT631-ST211j-EV
2

NT631C NT631C-ST141j-E NT631C-ST141j-EV1 NT631C-ST141j-E
V2
NT631C-ST151j-E NT631C-ST151j-EV1 NT631C-ST151j-E
V2

*1: NT20S and NT600S have direct access Ver.4 and Ver.5.
NT-series Support Tool for Windows supports only Ver.5.
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1-6-2 Communication Method for Each PT Model
Usable communication method differs depending on the PT types.

Also, some PT can use communication method that is not supported in their ini-
tial state by installing the exclusive system programs. (For details, refer to Ap-
pendix B System Installer Operation.)

PT
Model Communication Method

PT
Model Host

Link
NT Link
(1:1,1:N)

C200H Memory
Link

Mitsu-
bishi A

Mitsu-
bishi FX

NT11S NT11S-
SF121j f f ¢ ¢ ¢ ¢

NT20S NT20S-ST
121j-V1 f f ¢ ¢ ¢ ¢

NT20S-ST
121j-EV3 f f ¢ ¢ ¢ ¢

NT20S-ST
122j-V1 ¢ ¢ f ¢ ¢ ¢

NT20S-ST
161j-EV3 f f ¢ ¢ ¢ ¢

NT30 NT30-ST13
1j-E f f ¢ ¢ ¢ ¢

NT30C NT30C-ST
141j-E f f ¢ ¢ ¢ ¢

NT600S NT600S-ST
121j-V1 f f Y ¢ ¢ ¢

NT600S-ST
121j-EV3 f f Y ¢ ¢ ¢

NT600S-ST
211j-V1 f f Y ¢ ¢ ¢

NT600S-ST
211j-EV3 f f Y ¢ ¢ ¢

NT620S NT620S-ST
211j-E f f ¢ ¢ ¢ ¢

NT620S-ST
212j-E f f ¢ ¢ ¢ ¢

NT620C NT620C-S
T141j-E f f ¢ ¢ ¢ ¢

NT625C NT625C-S
T152j

f f ¢ ¢ ¢ ¢
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Model Communication Method
PT
Model Host

Link
NT Link
(1:1, 1:N) C200H Memory

Link
Mitsu-
bishi A

Mitsu-
bishi
FX

AB GE Sie-
mens

NT21 NT21-ST121j-E f f ¢ f ¢ ¢ ¢ ¢ ¢

NT31 NT31-ST121j-E f f ¢ f n n n n n

NT31-ST121j-EV1 f f ¢ f n n n n n

NT31-ST121j-EV2 f f ¢ f n n n n n

NT31C NT31C-ST141j-E f f ¢ f n n n n n

NT31C-ST141j-E
V1 f f ¢ f n n n n n

NT31C-ST141j-E
V2 f f ¢ f n n n n n

NT631 NT631-ST211j-E f f ¢ f n n n n n

NT631-ST211j
-EV1 f f ¢ f n n n n n

NT631-ST211j
-EV2 f f ¢ f n n n n n

NT631C NT631C-ST141j-E f f ¢ f n n n n n

NT631C-ST141j-
EV1 f f ¢ f n n n n n

NT631C-ST141j-
EV2 f f ¢ f n n n n n

NT631C-ST151j-E f f ¢ f n n n n n

NT631C-ST151j-
EV1 f f ¢ f n n n n n

NT631C-ST151j-
EV2 f f ¢ f n n n n n

f: Usable in the default state.
n: Exclusive system program should be installed.
Y: Exclusive communication I/F unit is needed. (C200H I/F unit: NT-LB122)
¢: Not usable

Note Communicationmethods are indicated in the table above using the following ab-
breviations:

C200H :C200H I/F
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SECTION 2
Setting Up the Support Tool

When you are going to use the Support Tool for the first time, the Support Tool software must be installed at your personal
computer.

The Support Tool is an application software that runs on Windows 95, 98, or NT of Microsoft Corporation.

The procedure described in the following pages assumes that your personal computer already has Windows installed.

2-1 Before Installing the Software 30. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-2 Installing the Support Tool 30. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

2-2-1 Basic Installation Operation 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-2-2 Procedure 31. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
2-2-3 Uninstall 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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2-1 Before Installing the Software
The Support Tool comes with the following program data.

Type Specifications

NT--ZJCAT1--EV4 For IBM PC/AT compatibles, media: CD-ROM

S Support Tool

S Supplement Symbols (keyboard/keypad collection)

S Color Palette Symbol (Tilling collection for color-type PT)

S System installer (for replacing the PT system program)

S System programs for NT31/NT31C with “-V2” (Ver. 3.1)

S System programs for NT631/NT631C with “-V2” (Ver. 3.1)

S System programs for NT21

S System program for NT11S

S System programs for NT30/620 Series

The following software should be installed separately.

S NT Transfer Utility

This utility uploads/downloads screen data file from/to PT using MMI format.
For details, refer to Appendix C NT Transfer Utility.

S NT Translation Support Utility

This utility will help in translating the language to another supported language.

For details, refer to Appendix D Translation Support Utility

The following data is copied to the folder if it is selected when installation.

S Parts Collection

Lamps and touch switches combined with image/library data are registered in
the Parts Collection (This is a screen data file in MMI format). For details, refer
to 3-3-7 Using Method of Parts Collection.

S Sample Screen Data

This data is provided just as sample screen data. It is not created for the pur-
pose of actual operation on PT after downloading it to PT.

S Symbol manager -- ISO symbol data

For details, refer to 6-10RegisteringCreated Elements (SymbolManagerOp-
eration).

Reference: S The system installer is an application software that sends the systemprogram
from a personal computer to PT to update the system program. Updating the
system program allows communication using a new method or upgrades the
PT software. However, since the system program is specific to each PTmod-
el, the system program that matches the PT model must be downloaded.

2-2 Installing the Support Tool
To install the Support Tool, execute the install program provided in your software
package.

Reference: The following data is selectable for installation.

S NT-series Support Tool Ver. 4.6

S System Installer

S Sample Collection
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If you select a Sample Collection, data such as Parts Collection, Image/Library
Sample Collection, ISO symbol data, and Sample Screen Data are installed.

S NT Transfer Utility should be installed separately. Please refer to Appendix C
NT Transfer Utility.

S NT Translation Support Utility should be installed separately. Refer to Appen-
dix D Translation Support Utility.

S Data can be added afterward by executing the installation program again. In
this case, when an item that is already installed is specified, it will not be over-
written. Also, the data will not be uninstalled even if its check mark was set to
OFF when the data is already installed.

To delete data that has already been installed, delete all data by uninstalling it
and then perform installation again.

2-2-1 Basic Installation Operation
The buttons that are displayed during the course of installation are shownbelow.

Clickingon thisbuttonconfirms thesettings in thedisplayedwindowanddisplays
the next window.

Clicking on this button cancels the settings in the displayedwindow and displays
the previous window.

Clicking on this button causes the window to close. The status set in the window
is canceled.

This button stopsSupport Tool installation if it is clickedat theprogram installwin-
dow. In this case, a message is displayed requesting confirmation that installa-
tion is to be stopped.

Clicking on this button displays the actual folder configuration in tree form. You
can select the folder in this display to install the Support Tool.

2-2-2 Procedure
1. Start up Windows.

2. Set the Support Tool CD-ROM in the CD-ROMdrive. The setup program au-
tomatically starts. Follow step 6 onward. If the setup program does not start
automatically, execute the setup program according to the steps shown be-
low.

Reference: You can execute the setup program by double clicking Setup.exe in the Support
Tool system disk by displayingWindows Explorer. In this case, steps 3, 4, and 5
below can be skipped.

3. Click on the Start button of Windows and select “Run ...”
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4. Input “d:\FD_Version\ Disk1\ Setup.exe” in the input field in the displayed
window.

Note that drive designationmust agree with the name of the drive where you
set the CD-ROM. If you set the CD-ROM in drive E, input “e:\FD-Version\
Disk1\ Setup.exe.”

5. Click on .

The installation is started.

6. When the setup screen of the Support Tool is displayed, click the
Button.

The screen to prompt you to input User Information (Name andCompany) is
displayed.

7. Input your name and company. In the initial state, the name and company
that are registered for the computer are displayed.

After inputting, click the Button.

The screen for specifying the destinationof program installation is displayed.

8. Select the directory for installation.

In the initial state, the directory shown below is set as the destination directo-
ry.

C:\Program Files\Omron\NTST4.6E
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To change the directory, click the Button and input the drive and
directory. (If a directory that does not exist in the hard disk is specified, the
directory is automatically made.)

After specifying the destination, click the Button.

The program selection screen is displayed to allow you to select the
programs to be installed.

9. Click on the check box, displayed to the left of the program to be selected to
enter a check mark.

When the system installer is installed, the systemprograms for NT21, NT31,
NT31C,NT631,NT631Cwith “-V2” (Ver. 3.1),NT30/620 seriesandNT11S is
also installed.

You can select the vendor type of system programs installed in the select
sub-componentswindow.Todisplay the select sub-componentswindow, set
the cursor on System Installer and press the Change Button.

Click the Button
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The screen for specifying the destination for registering the start menu is
displayed.

10. In the start menu of Windows, specify the folder where the short-cut to the
Support Tool is created.

In the initial state, the following folder is selected.

Start\Program\Omron\NTST4.6E

If you want to change the folder, select the desired folder from the Existing
Folders or directly input the folder name. (If a folder that does not exist in the
hard disk is specified, the specified folder is automatically made.)

After specifying the folder, click the Button.

Installation of the specified programs is implemented; files are copied.

During program installation, the progress of the processing is indicated as a
percentage.

11. After step (10), a dialog to select restart/non-restart will come out for Win-
dows 95, 98, NT, and ME.
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Restarting your machine is recommended because important information is
registered after the restart. If you select to restart later, the registrationwill be
performed at this next restart and installation is completed.

Click the Button to finish or restart. Restart is not required for
Windows2000.

2-2-3 Uninstall
An uninstaller (uninstall software) is supplied with the Support Tool.

If you want to remove the Support Tool from your personal computer, run the
uninstaller to delete the Support Tool program files and installation information.
Note that the data created by the Support Tool is not deleted.

S Starting the uninstaller from the Windows start menu

Select “Uninstall NTST” in the same folder where the short-cut to the Support
Tool is stored.

Example: Assuming the short-cut to the Support Tool exists in the Start\Pro-
gram\Omron\NTST4.6E

Select the uninstaller by the following operation.

[Start]→ [Program]→ [Omron]→ [Ntst4.6E]→[Uninstall NTST]

After the start up of the uninstaller, follow the instructions displayed on the
screen.
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SECTION 3
Support Tool Starting-up and Exiting Procedure

and File Operation

This section describes how to start up and exit the Support Tool and the operating procedure for PT screen data files.

3-1 Starting-up and Exiting the Support Tool 38. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3-1-1 Start-up Procedure 38. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3-1-2 Exit Procedure 39. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3-2 User Interface 39. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3-2-1 Functions Provided in the Main Window 39. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3-2-2 Major Functions of Dialog Boxes 43. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
3-2-3 Functions of Message Boxes 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

3-3 Operation of Screen Data (Application) File 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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3-1 Starting-up and Exiting the Support Tool
Theprocedure for starting up theSupport Tool installed in your personal comput-
er and exiting it is shown below.

3-1-1 Start-up Procedure

To start up the Support Tool, select [Programs]→ [Omron]→ [Ntst4.6E]→ [NT-
Series Support Tool] beginning with the Windows start button.

After the start-up of the Support Tool, the main window, shown below, is dis-
played.

Reference: Up to two Support Tools can be started up at the same time.
You can copy and paste the screen data or table data between them by open-
ing the two different screen data files. To start up the second Support Tool, se-
lect [Import Component] from the [File] menu in the main window of the first
Support Tool (It is not possible to start up the second Support Tool from the
[Start] menu of Windows). For details, refer to 3-3-6 Importing Components
from Different Screen Data File (Starting Up the Second Support Tool).
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3-1-2 Exit Procedure
To exit the Support Tool, use any of the operations shown below.

S In the menu, select [File]→ [Exit].

S Click the Button at the upper right corner in the main window.

S Double click the Support Tool icon displayed at the upper left section in the
main window.

S Click the Support Tool icon displayed at the upper left section in the main win-
dow, then select the Button in the control menu box.

S Press F4 key while pressing down the Alt key.

If you are going to exit the Support Tool before saving the data of the opened
screen, a confirmation message is displayed.

After you exit the Support Tool, the screen returns to the Windows screen.

3-2 User Interface

3-2-1 Functions Provided in the Main Window
The configuration of the Support Tool operation screen, name of each parts, and
the available functions are described below.

Title bar
Control Menu box

Menu bar

Standard toolbar

Draw bar

Application manager screen

Data creation screen

Status bar

Application manager screen

Directories of screens and tables are displayed as a tree list, which allows open-
ing, copying, and other operations.

Data creation screen

On this screen, the screen to be displayed by the PT is created.

Control menu box

The control menu box displayed at the upper left corner of the operation screen
and windows allows you to select how a window is displayed.
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Title bar

The titles of windows are displayed here on each window respectively.

Status bar

The status bar displays a simple explanation about the selected function, se-
lected object, cursor position, object position, themodel type of the objective PT,
PLC Vendor, the maximum memory size, and the remaining application size.

Selected PT model
Selected PLC
Vendor

Application Memory (Remain-
ing memory/Total memory
In case user application ex-
ceeds the total memory, re-
maining memory will be shown
as negative value in red color.)

Status/Help message
or
information of object

Cursor Position

Top-left coordinate of
selected objects

Menu bar

The functions provided by the Support Tool are divided into several groups.

The menu bar shows the names of these function groups and the functions in
each group are displayed in pull-down menus.

S Standard Toolbar

Functions that are used frequently — such as file reading/writing, copy and
paste, undo/redo, and print—are assigned to the buttons in the standard tool-
bar.

These functions can be called easily without selecting the function item from
the menu bar.

New

Open

Save

Print

Print
preview

New
Screen

Cut

Copy

Paste

Undo

Redo

What’s This?

S Draw Bar

Functions to draw objects are assigned to buttons in the draw bar.
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These functions can be called easily without accessing the commands from
the menu bar.

Alarm
list

Selector

Polyline

Arc

Rectangle

Circle

Polygon

Sector

Text

Tiling

Image
object

Mark

Library object

Standard lamp

Image lamp

Touch
switch

Thumb-
wheel
switch

Numeral
input

Recipe

String
input

Numeral
display

String
display

Bar
graph

Analogue
Meter

Trend
graph

Broker
line
graph

Alarm
history

S Utility Bar

Buttons for centralizing label of touch switch or lamp (refer to 5-1-3 Changing
the Display Method on the Support Tool), simulation for flash attribute in fixed
display objects (refer to 5-1-3 Changing the Display Method on the Support
Tool), lampON facility (refer to5-1-3Changing theDisplayMethodon theSup-
port Tool), and a combo-box for selecting to display certain screen object type
(refer to 5-1-4 Filter Function) are provided.

Centralize
Label

Filter Screen
Element

Simulate
ON/OFF

Simulate
Flash

S Alignment Bar

This toolbar provides the object alignment to the top, bottom, left, right andalso
center in a row and center in a column. (Refer to 6-1-6 Aligning Elements.)

Align
Top

Align
Left

Center in
a Column

Center
in
a Row

Align
Right

Align
Bottom

Reference: Whether or not Status Bar, Standard Toolbar, Draw Bar, Utility Bar and Align-
ment Bar are displayed can be selected, respectively, by the following opera-
tion.
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Status Bar: [View] (menu bar)→ [Status Bar]

Standard Toolbar: [View] (menu bar)→ [Toolbars]→ [Standard Bar]

Draw Bar: [View] (menu bar)→ [Toolbars]→ [Draw Bar]

Utility Bar: [View] (menu bar)→ [Toolbars]→ [Utility Bar]

Alignment Bar: [View] (menu bar)→ [Toolbars]→ [Alignment Bar]

Each time you select the item, display/no-display selection changes alternately.
The check mark, if displayed, indicates that the selection of the corresponding
item is to be displayed.

If [Auto hide] invoked by selecting [Start] button (Windows)→ [Settings]→
[Taskbar]→ [Taskbar Options] is checked, status bar may not be displayed cor-
rectly when the window of the Support Tool is maximized. In this case, clear the
checkmark for [Always on top] at [Taskbar Options].

Floating palette

The standard toolbar, draw bar, utility bar and alignment bar can be moved as a
floating palette to a convenient place for your operation.

S Object information on the status bar

The information for the selected object that will be displayed on the status bar is
indicated in the following table. (No information will be displayed when multiple
objects are selected) Information to be displayed may be cut depending on the
resolution of the screen or the selected object.

Screen Element
(Selected item) Information to be displayed

Fixed Display Object Fixed Display {Object Name: Attribute}

Fixed Display-Mark Mark Object {Code*1}

Fixed Display-Image Image Object {Reference Type: Code*1: Comment: Size: Compression}

Fixed Display-Library Library Object {Reference Type: Code*1: Comment}

Image Lamp Image Lamp {PLC Address: ON code*1: OFF code*1: ON comment if check else OFF com-
ment}

Standard Lamp Standard Lamp {PLC Address: Label*2}

Touch Switch Touch Switch {Function: PLC Address: Label*2} (If function type is Notify Bit, display Notify
Address, else display Lamp Address)
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Screen Element
(Selected item) Information to be displayed

Thumbwheel Thumbwheel {PLC Address: Table Entry*3}

Numeral Input Numeral Input {PLC Address: Table Entry*3: Reference Type}

String Input String Input {PLC Address: Table Entry*3: Reference Type}

Recipe Recipe{Recipe Number; Recipe Name; Write Notify Bit; No. of Records: No. of Parameters}

Numeral Display Numeral Display {PLC Address: Table Entry*3: Reference Type}

String Display String Display {PLC Address: Table Entry*3: Reference Type}

Bar Graph Bar Graph {PLC Address: Table Entry*3: Direction}

Trend Graph Trend Graph {Type: Drawing Width: Direction}

Broken-line Graph Broken-line Graph {Direction}

Alarm History Alarm History {Display Image/Library or not}

Alarm List Alarm List {Table Entry*3: Display Image/Library or not}

Analogue Meter Analogue Meter {PLC Address: Table Entry*3}

(*1) M: Mark I: Image L: Library

(*2) For the NT21 and the NT31. NT31C, NT631, NT631C with ”--V2,” the in-
formation to be displayed depends on the Label Type as follows:
Static: Label
OnOff Static:When [View] -- [Simulate ON/OFF] setting is ON, displaysON
label, when OFF, displays OFF label.
Numeral Display: Same for Numeral Display information
String Display: Same for String Display information

(*3) N: Numeral Table S: String Table B: Bit Memory Table

3-2-2 Major Functions of Dialog Boxes
A dialog box is a window that is displayed in a fixed size. The purpose of a dialog
box is to set data that is required to execute the functions of the Support Tool.

The following types of dialog boxes are used and the procedure for setting the
data differs according to the type of dialog box.

S Option button

This represents a selection item, withf displayed to the left of the item name.

Only oneof the displayed items canbe chosen.The item is identified by ablack
circle.

S Check box

This represents a selection item, with j displayed to the left of item name.

Items can be selected by giving a check mark in this box.
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S Text box

This text box is an input field to set characters.

S List box

A list box displays a list of data: the data to be set is selected from the list.

S Combo box

A list of selection items appears in the dropdown list box format. The data to be
set is selected from the list.

3-2-3 Functions of Message Boxes
Messageboxesdisplay details of errors that occur duringSupport Tool operation
and messages that request your confirmation of attempted operations.

When a message box shows up, operation can be continued or cancelled by
pressing the corresponding button in the message box.

3-3 Operation of Screen Data (Application) File
The procedure for operating the screen data file, where the PT screen data is
stored, is describedbelow.ThePTConfiguration,whichdetermines thebasicPT
operation, is also discussed.
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3-3-1 Creating New Screen Data (Application) File
To create new screen data, select [New] in the [File] Menu of the main window.

PT configuration dialog box appears so that users can set information of the ap-
plication environment and type of PT device.

Click the Button after completing the setting at the PT configuration
dialog box. For details of the setting at the PT configuration dialog box, refer to
Dialog Box Settings in the PT Configuration below.

If the PT is set to the NT21, the clock address dialog box will appear next. Refer
to page 53.

The application manager and the data creation screen (1 Standard Screen) are
displayed.

PT screen data is created by arranging objects on this data creation screen.

Theapplicationmanager is the tool tomanage the screendata createdby auser.
For operation procedure, refer to Section 4 Application Manager.

Dialog Box Settings in the PT Configuration

Before creating screen data, it is necessary to set the PT configuration and the
Control and Notify Areas that are shared with the PC (PLC).

The operation steps shown below display the PT configuration dialog box.
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S Menu Bar→ [File]→ [New] (creating new application)

S Menu Bar→ [Tools]→ [PT Configuration] (for modifying)

The PT configuration dialog box has a variety of setting items provided in three
pages.

S PT Type page

S System page

S Control/Notify Area page

S PT Type page

The PT Type page is displayed when you click on the [PT Type] tab.

The PT Type page is used to set the hardware configuration of the PT to be
connected.

PT Model

Specify the type of PT to be connected. When you are using the NT31, NT31C,
NT631 or NT631C, refer to the table below to select the correct model according
to the system program being installed.

PT Model System Program

Ver.1.01 Ver.2.0 Ver.2.1 Ver.3.1

NT31 ”NT31” ”NT31-V1” ”NT31-V1(System Ver.2.1)” ”NT31-V2 (System Ver. 3.1)”

NT31C ”NT31C” ”NT31C-V1” ”NT31C-V1(System Ver.2.1)” ”NT31C-V2 (System Ver. 3.1)”

NT631 ”NT631” ”NT631-V1” ”NT631-V1(System Ver.2.1)” ”NT631-V2 (System Ver. 3.1)”

NT631C ”NT631C” ”NT631C-V1” ”NT631C-V1(System Ver.2.1)” ”NT631C-V2 (System Ver. 3.1)”

Reference: To check the system program version installed in a PT, display the following
screens:

S Version display at the upper right position of PT system menu

S PT system menu! Expansion mode! Version display

The following PT Models are also available:

S NT31-V2

S NT31C-V2

S NT631-V2
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S MT631C-V2

NT20/30/620 Compatible Mode

For NT21 and NT31/631-V2 Models, the NT20/30/620 Compatible Mode check
box will be enabled. By setting this option, the Control Area will take 4 memory
address, instead of 5 and Notify Area will take 3 memory address, instead of 2.
This allows straight conversion for NT30/620 PTmodels to NT31/631 or NT20S
models to NT21 without the need to modify the PLC program.

PLC Vendor

Specify the usable direct access type from either of the following.
MEMLINK, Mitsubishi_A and Mitsubishi_Fx can be set only with NT31, NT31C,
NT631and NT631C with “-V1” and above.
AB andGE can be set only with NT31, NT31C,NT631 andNT631C below “-V1.”
Siemenscanbeset onlywithNT31,NT31C,NT631andNT631Cwith “-V1.” (Re-
fer to page 26).

S OMRON

S Mitsubishi_A

S Mitsubishi_Fx

S MEMLINK

S AB

S GE

S Siemens

Font Type

If you are using NT31-V1, NT31C-V1, NT631-V1, NT631C-V1 and above hard-
ware or had NT31, NT31C, NT631and NT631C and been updated the system
program to the -V2 (System Ver.3.1) system program, which is attached to this
Support Tool, it is possible to select the Font Type ISO8859-1 or CP437.
If you are using the European Keyboards, please refer to Appendix K for more
details.

Comment

Set the comment that is appended to the screen data file.

An arbitrary character of up to 28 characters can be set.

Reference: The PT model of the screen data that is opened can be changed. If it is
changed, thedata is convertedautomatically.Note that changingofPTmodels
is allowed only for the restricted combinations shown inAppendix ADataCon-
version.
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S System page

The System page is displayed when users click on the [System] tab.
Fundamental operating functions can be set in this System page.

Initial Screen
Screen number, which appears when the wrong data is set for PT Control Area
whenPT is driven, is selected from thedrop-down list box or keyboard input.Nor-
mally, this setting is invalid since PT References PT Control Area for the initial
screen number when starting up.

The screen numbers of existing screen data are listed in the list box or only
screen number 1 is displayed if the screen data is newly created.

Backlight OFF
Specify whether or not the backlight OFF function is used.

This option canbe selected fromSystemofPTConfiguration in theSupport Tool.
The Backlight OFF function automatically turns OFF the screen if the Support
Tool is not operated for a certain time period to save the backlight of PT.

If the check box is clicked to utilize the option, the time intervalwill be displayed in
the drop-down list box to set it.
For details of the PT models that can use this function, refer to Appendix E Sys-
tem Setting (PT Configuration).

Resume Function

The resume function holds the data in the table when the PT is OFF or reset.

For details of the PT models that can use this function, refer to Appendix E Sys-
tem Setting (PT Configuration).

History Setting

This itemspecifies themethod for processingwhen the Logmemory of the alarm
history function and History screen function becomes full.

- Alarm (Use Ring Buffer):

Same meaning with FIFO (First In First Out)
Alarm FIFO system is applied for this function if the log memory area is full.
When new alarm occurs, the oldest record data will be deleted so that the new
data can be stored there.
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If the Alarm function is not chosen, newly coming data is not acceptable to re-
cord when the memory space is full.

- Screen (Use Ring Buffer):

Same meaning with FIFO (First In First Out).

When the new screen history occurred, the oldest record data will be deleted
so that newdata can be stored there. This is so called FIFO. If this check box is
not ON, newly coming data is not acceptable to record when the memory
space is full.

Either the Alarm and the Screen data is available for the following PT models.

NT30, NT30C, NT21, NT31, NT31C, NT620S, NT620C, NT625C, NT631,
NT631C.
(For NT21, NT31, NT31C, NT631, and NT631C, both Alarm and Screen set-
tings are available.)

Number of Table Entries

Specify the number of numeral memory table entries, character string memory
table entries (String Table), and bit memory table entries.

Setting of the Number of Table Entries is valid for the following PT models.

NT30, NT30C, NT21, NT31, NT31C, NT620S, NT620C, NT625C, NT631,
NT631C

Buzzer --Enable

Specify whether or not the buzzer function is used.

Touse thebuzzer function, click the checkbox to enter the checkmark. To set the
buzzer function to be unused, click the check box to clear the check mark.

To sound the buzzer only at the occurrence of an alarm, specify [On Error] at the
drop-down list box.

If [Always] is selected for the buzzer function, the buzzer sounds at following
events.

S Occurrence of an error at PT

S Reception of a command from the host

S Screen switching

Setting of the buzzer function is valid for the following PT models.

NT30, NT30C, NT620S, NT620C, NT625C

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, buzzer function settings
are made by system menu operation at the PT and setting from the Support
Tool is not allowed.

Buzzer -- Key Input

Click the checkbox of [Key Input] to enter the checkmark if youwant to sound the
buzzer in response to the input froma touchswitchor theextended I/Ounit.Clear
the check mark if the key input sound is not to be used.

Printer for PT

Aprinter canbeconnected toPTdevice for printingscreendata if required.You
have to specify the typeof printer beingusedby theapplication for the following
PT models:
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NT30, NT30C, NT620S, NT620C, NT625C

S Printer

Select one of the Supported printers from the printer drop-down list box.

Although this setting is possible for NT31, NT31C, NT631, NT631C, it is not
valid from Support Tool.

Please set from the Maintenance Mode of PT.

S Mode

Color:

Specify “Color” for color printing.

Designation of Color is valid for the following PT models.

NT30C, NT620C, NT625C

S Tone:

Specify “Tone” for monochrome printing.

If a color typePT is usedwithToneset for [Mode], color data is expressedusing
a gray scale, printed in monochrome.

These setting are available for the following PT models.

NT30, NT30C, NT620S (Printer only), NT620C, NT625C

For NT21, NT31, NT31C, NT631, and NT631C, this setting has to be selected
from PT.

Numeral Storage Type

BCDorBinary canbeselected for the storage typeof theNumeralmemory table.
This setting is available only when the time the Storage Type in the Numeral
memory table has [System] setting. When BCD or Binary is set for Numeral
memory table Storage Type, this setting in the PT Configuration will be ignored
and follows the storage type in the Numeral Table.

This setting is available for the following PT Model.

NT21, NT31, NT31C, NT631, NT631C

S Control/Notify Area page

TheControl/NotifyAreapage isdisplayedwhenyouclickon the [Control/Notify
Area] tab.

The Control/Notify Area page is prepared to set the PT Control area, control-
ling PT fromPC (PLC) and for PTNotify Area, notifying PT information to a PC
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(PLC and for window control area, controlling a window (NT21, NT31, NT31C,
NT631, NT631C with “-V1” and “-V2” only).

PT Control Area

PC (PLC) Address

Set the type of words at the PC (PLC) and the first address (word number) of
the area used as the PT Status Control Area.

ThePTStatusControl Area differs depending on thePTmodel and it occupies
the following number of words.

NT31, NT31C, NT631, NT631C:
For V1 models, and V2 models without
NT20/30/620 Compatible mode: 5 words
For V2 models with NT30/620 Compatible mode: 4 words

NT21:
Without NT20/30/620 Compatible mode: 5 words
With NT20/30/620 Compatible mode: 4 words

Other models: 4 words

Comments

Set a comment concerning this area.

As a comment, up to 16 character can be set.

PT Notify Area

PC (PLC) Address

Set the type of words at the PC (PLC) and the first address (word number) of
the area used as the PT Status Notify Area.

The PT Status Notify Area differs depending on the PT model and it occupies
the following number of words.
NT31, NT31C, NT631, NT631C:
For V1 models and V2 models without NT20/30/620 Compatible mode: 2
words
For V2 models with NT20/30/620 Compatible mode: 3 words

NT21:
Without NT20/30/620 Compatible mode: 2 words
With NT20/30/620 Compatible mode: 3 words
Other models: 3 words
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Comments

Set a comment concerning the area set as the PT Status Notify Area.

As a comment, a character string of up to 16 characters can be set.

Window Control Area

PC (PLC) Address

Set the type of words at the PC (PLC) and the first address (word number) of
the area used as the Window Control Area.

Window Control Area differs depending on the PT model and it occupies the
following number of words.

NT21 and NT31, NT31C, NT631, NT631C with “-V1” or “V2”: 9 words

Other models: can not be used

Comments

Set a comment concerning the area set as the Window Control Area.

As a comment, a character string of up to 16 characters can be set.

Note Setmemory addresses so that the PTControl Area, PTNotify Area andWindow
Control Area do not overlap.

S PC (PLC) Address dialog box

Clicking on the [Set] button in the [PT Control Area], [PT Notify Area] or [Win-
dow Control Area] displays the PC (PLC) Address dialog box.

In the PC (PLC) Address dialog box, the PC (PLC) address of the PT Status
Control Area, the PT Status Notify Area and the Window Control Area can be
set by specifying the area type and address individually. The setting made in
the PC (PLC) Address dialog box will be reflected on the setting made in the
[PC (PLC) Control Area], [PT Notify Area] or [Window Control Area].

Use thePC (PLC)Address dialogboxonlywhen thearea typeandaddressare
input individually. If the PC (PLC) address is directly input in the Control/Notify
Area page, it is not necessary to call this dialog box.
Example PLC Vendor : OMRON

Channel (Word)

Specify the type of PC (PLC) area that is used as a PT Status Control Area, a
PT Status Notify Area or aWindow Control Area by selecting an item from the
drop-down list box.

Address

Specify the first word address in the PC (PLC) area that is to be used as thePT
Status Control Area, PT Status Notify Area, and Window Control Area.
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I/O Comments

Set a comment concerning the area set as the PT Status Control Area, a PT
Status Notify Area, or a Window Control Area.

As a comment, a character string of up to 16 characters can be set.

Clock Address
When the PT is set to the NT21, the addresses must be set to read the clock
from the PLC host. This setting is not necessary for other models of PT.

If the PT is set to theNT21 on the tools page of thePT configuration dialog box,
the clock address dialog box shown below appears. Always set an address
when using the clock function (data displays, screen display history, or alarm
history).

PLC Address

Set the area and the address of the first word fromwhich to read the clock data.
AClockDataAreawill be defined consisting of 4words starting at the specified
address.

I/O Comments

Set a comment for the address used to define the Clock Data Area. Up to 16
character can be input.

S PLC Address Dialog Box

This dialogbox is set in the samewayas theone for thePTconfigurationdialog
box.

3-3-2 Reading the Existing Screen Data (Application) File
To read the screendata that is saved in a file, select [File]→ [Open] from themain
window menu.
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The dialog box for the applicable folder, file name, and files of type exist appears
to specify them.

NTST Application (*.onw)

After specifying the folder, file name, and file type click on the [Open] button.

The application manager of the read out screen data is displayed.

WithNT-seriesSupport Tool forWindows, following screendata files canbehan-
dled.

onw

mmi

For details, refer to File Types in page 55

Reference:S Recent used files will be shown at the bottom of [File] menu. Recent four files
can be opened from this command.

S NT-series Support Tool forWindows (Ver. 4.6) can read the screen data that is
created using an earlier version of NT-series Support Tool.

S It is not possible to readscreendata createdbyNT-seriesSupport Tool forWin-
dows (Ver. 4.6) with an earlier version of NT-series Support Tool.

S With MMI files, the screen data created by the Support Tool Ver.4 can be read
usingSupport Tool Ver.3.j as long as thePTmodel is supportedwithVer.3.j.
(With MMI format, user group and grid information will be lost.)

e.g.

NT30C MMI file created with Ver.4

! Can be read with Ver.3

NT31C-V2 MMI file created with Ver.4

! Cannot be read with Ver.3

3-3-3 Saving the Screen Data (Application) File
After creating the screen data, save it to a file.

The procedure for saving the screen data to a file is: [File] (main window menu)
→ [Save], or [File] (main window menu)→ [Save As].

Save:

The existing screen data of the opened file is overwritten by the new screen
data.
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If the file was opened using [New], the operation to be followed is the same as
for saving a file by selecting [Save As].

Save As:

The created or edited screen data is saved by specifying the folder and the file
name.

S File name setting dialog

If you select [Save] when creating new screen data or [Save As], the file name
setting window (Save As) opens.

NTST Application (*.onw)

After inputting the folder and file name, click the Button the screen
data is saved to the specified file.

If the file name of an existing file is specified, a message requesting confirma-
tion that the file is to be overwritten is displayed.

S File types

When saving files in file name setting dialog, either of following two file types
can be selected.

S NTST screen data (*.onw) format (onw format)
This is a standard file format for Support Tool.
Use this format to save screen data normally.

S Memory map image file (*.mmi) format (mmi format)
This is a file format to which screen data is compressed after deleting informa-
tion used only for Support Tool. (Data to be lost are grid setting and grouping
information.)
Use this format for purposes such as transferring screen data using FD.
It is advisable to save the same data with onw format also, since part of in-
formation are lost with this format as mentioned above.

Once you saved data, specified file types will not be changed until you exit the
Support Tool or perform saving/reading the onw file. (Data will be saved in the
format same as before when you select “Save” to save it.) If you want to change
the file type, select “Save As.”

Reference: S It is not possible to save data in DOS format.

S Once you read the data that was created using DOS version Support Tool by
NT-series Support Tool for Windows, do not upload the data with DOS tool
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even if it has been download to PT.Downloadingwill be possible; however, the
data may not be used with DOS version Support Tool correctly.

ST

Windows version Support Tool

DOS version Support Tool

Upper
compatibility

NT20S, NT30,
NT30C, NT620S,
NT620C/NT625C

PT

S Withmmi file format, error check is executedbeforesaving.By this error check,
data that cannot be downloaded to PT will not be stored.

S With the Support Tool on CD-ROM, the NT Transfer Utility, which transmits
mmi file to the PT, is supplied. For details, refer toAppendix CNTTransfer Util-
ity.

3-3-4 Closing the Screen Data (Application) File

It is not possible to open two or more screen data files with one Support Tool. So
when you want to edit different screen data file, you need to close the currently
opened file, or start up the second Support Tool using the [Import Component]
command from the [File] menu. For details of Import Component, refer to 3-3-6
Importing Components fromDifferent Screen Data File (Starting Up the Second
Support Tool).

To close application, select [Close] from [File] in the main window menu.

If the screen data (application) has not been saved, a message requesting con-
firmation of saving it is indicated/displayed.

If the file name is not set, the name setting dialog appears. If
the file name has been already determined, the data will be
overwritten.

The screen data file closes without saving the screen data.

The file close operation is canceled.

3-3-5 Importing (Reading) the DOS Version Screen Data (Application)
File

The Support Tool has a function for reading screen data files created using the
previous DOS version Support Tool. Note that although the DOS version screen
data files can be read, files cannot be saved in DOS format.
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The procedure for reading a DOS version screen data file is:
[File] (main window menu)→ [Import].

For “Files of type,” select any of the following items according to the model of
Support Tool used to create the screen data you are going to read.

S M1S: Screen data for NT11S

S M2S: Screen data for NT20S

S M6S: Screen data for NT600S

S G6S: Screen data for NT30, NT30C, NT620S, NT620C, and
NT625C

Click the Button after selecting the folder and specifying the file
name.

The application manager of the read screen data will be displayed.

Reference: For details of the PT models and types, the Support Tool can create screen
data for, refer to 1-6 Usable Hardware Combinations.

3-3-6 Importing Components from Different Screen Data File (Starting
Up the Second Support Tool)

Select [Import Component] from the [File] menu and you can start up the second
Support Tool and open a different screen data file. By reading out the different
screen data files with the two Support Tools, data copying/pasting can be per-
formed easily between the files.
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When you select [Import Component], a dialog box to specify the file to be read is
displayed. (For details of this dialog, refer to 3-3-2 Reading the Existing Screen
Data (Application) File.)

After specifying the folder, file name and file type, click the Button.
The second Support Tool starts up and the application manager of the read out
screen data is displayed.

Reference: S It is not possible to start up the second Support Tool from the [Start] button of
Windows (Error message will be displayed). Be sure to select [Import Compo-
nent] from the [File] menu in the main window of the first Support Tool.

S Copy/paste operation can not be performed between the two files if the PT
model of the two files is different. In this case, perform data conversion before-
hand so that the PT model setting of the copy source screen data matches to
the setting of the copy destination screen data. (Selected PT model can be
checked on the status bar.)

S It is not possible to edit the samescreendata file by twoSupport Tools. If you try
to read out the file that is already opened by the other Support Tool, error mes-
sage will be displayed.

S The secondSupport Tool can read out the screen data file regardless of the file
types (onw, mmi).

S When the second Support Tool is started, the windows of both Support Tools
are automatically resized into normalwindows that overlap each other to facili-
tate the copy operation between the files.

S It is not possible to open one more Support Tool when two Support Tools are
already started.

S [Import Component] will not be displayed in the [File] menu when no screen
data is opened with the Support Tool.

S Conversion of PLC address is executed when the PLC vendor (direct access)
is different between the copy source/destination screen data.

S Conversion of key code is executed when the key code (font type) is different
between the copy source/destination screen data.

S In case of the numeral/string table and bit memory table, if the table size of
copy destination is smaller than the size of copy source, excessive entries will
be discarded.

S To achieve higher performance, close the second Support Tool after you com-
pleted import operation.
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S It may take time to read out MMI file since data checking is performed before
opening the file.

Possible Operation between Two Support Tools

While screen data files of the same PT model are opened with the two Support
Tools, following operations are possible.

a. Copying, cutting, pasting and drag&drop of a screen between application
managers (multiple screens can be also handled). (Refer to 4-2-4 Copying a
Screen.)

b. Copying, cutting, pasting and drag&drop of a table data between application
managers (All the data in a table is handled, it is possible to handle a table
entry individually or to handle multiple table entries collectively.) (Refer to
4-2-9 Copying the Whole Table.)

c. Copying, cutting, pasting of a number/code between the following table
entries (Drag&drop is not possible).
Between image table entries (Refer to 8-1-1 Operating the Image Table.)
Between library table entries (Refer to 8-2-1 Operating the Library Table.)
Between bit memory table entries (Refer to 7-1-4 Edit Operation.)
Between numeral table entries (Refer to 7-1-4 Edit Operation.)
Between string table entries (Refer to 7-1-4 Edit Operation.)
Between extended I/O output table entries (Refer to 7-1-4 Edit Operation.)
Between extended I/O input table entries (Refer to 7-1-4 Edit Operation.)

d. Copying, cutting, pasting and drag&drop of objects between editing screens
or library editors. (Drag&drop can not be performed if the copy destination
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window is hidden under other windows.) (Refer to 6-1-5 Copying, Cutting,
Pasting, and Deleting Elements.)

e. Copying, cutting, pastingof the specified areabetween imageeditors ormark
editors (Drag&drop is not possible). (Refer to 8-1-2 Creating Image Data Us-
ing Image Editor, 8-3-2 Creating Marks Using the Mark Editor.)

These operating procedures are same as normal operations of copy, cut, paste
and drag&drop on one Support Tool.

Copying/Pasting an Object That Contains Image/Library Data

Even if a screen or an object that contains image/library data is pasted onto a
different screen data file, image/library data itself is not copied if NT-series Sup-
port Tool version number is lower than 4.6.
If you want to copy/paste an object that contains image/library data between
screen data files, you need to copy the image/library data referenced by the ob-
ject beforehand.

Ex: Copying/pasting a fixed-display image that references image code 0001
while the contents of the code are different between the screen data files

As shown above, image data to be displayed will vary even if both objects are
referencing the same code, when the contents of the referenced image code are
different between the screen data files. (When no data is registered to the refer-
enced code, is displayed. )

3-3-7 Using Method of Parts Collection
With the Support Tool on CD-ROM, Parts Collection is supplied.
In this section, using method of Parts Collection is described.
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Parts Collection

Lamps and touch switches will be graphical and expressive parts when they are
combined with image/library data or image lamps. These graphical lamps and
touch switches are registered to the Parts Collection (Parts Collection for each
PT model is provided).
Using [Import Component] command, desired data can be copied/pasted from
Parts Collection to the editing screen easily.

Reference: S Parts Collection is supplied only for the Support Tool on CD-ROM. It can be
installed by specifying “Sample Collection” when installing the Support Tool.

S Parts Collection for NT11S, NT20S and NT600S is not supplied.

S Parts Collection is created in MMI format. It may take time to read out/save
MMI file.

S If you install the Parts Collection, the Parts Collection List, which shows how to
use the Parts Collection, the list of screen images, will be automatically
installed as well. This list is stored in the Parts Collection List folder inside the
Sample collection folder.

Operation Procedure

To use the Parts Collection, follow the procedure below.
Here, operations such as copying, pasting, drag&drop are not described in de-
tails. Please refer to 8-1 ImageEditor, 8-2 Library Editor and 6-1-5Copying, Cut-
ting, Pasting, and Deleting Elements.

(1) Open the screen data file to which you want to paste data from Parts Collec-
tion.

(2) Select [Import Component] from the [File] menu.

(3) Dialog box to specify the file to be opened is displayed. Open the Sample
Collection folder in the folder that Support Tool has been installed into. Then,
open the folder of the required PT model (see below). Select “Memory Map
Image File (*.mmi)” as a file type.
Parts Collection for each PTmodel is displayed. Specify the Parts Collection
of the PT model same as the currently opened screen data file and click the

Button.

Second Support Tool starts up and the selected Parts Collection opens.

(4) In the screen data file of Parts Collection, decide the object that you want to
import.

(5) If the object contains image/library data, the image/library data should be co-
piedbetween image/library tableentriesbeforehandbycopy/pasteoperation
if NT-series Support Tool version number is lower than 4.6. Follow the proce-
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dure below.
Code number to be copied can be checked in the property of an object. (Ref-
erenced image/library code is also displayed on the status bar for some ob-
ject when they are selected.)
If image/library copying is not performed beforehand, display will not be as
intended since the image/library allocated to the code is not copiedeven if the
object itself is copied.

Procedure

a. Open the property of an image lamp or image/library data to be imported and
check the referenced image/library code.

b. Select [ImageEditor] or [LibraryEditor] from the [Tools]menuand copy ([Edit]
-- [Copy]) the code to be imported on the image/library table.

c. Open the image/library table of the screen data file of copy destination and
paste the image/library data that has been copied.
This time, if the copy destination code number is different from the copy
source code number, display will not be correct when the object is pasted.
Register the samecodenumberas copysourceby clicking the But-

ton.

(6) Drag&drop theobject that youwant to import from the screendata file ofParts
Collection to the screen data file of copy destination ([Copy], [Paste] in the
[Edit] menu can be used also).
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SECTION 4
Application Manager

This section shows how the application manager is used when checking the created data, copying screen data, setting a
memory table, operating a window.
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4-2 Operating the Application Manager 65. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

4-2-1 Opening a Data Creation Screen 65. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
4-2-2 Closing a Creation Screen 65. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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4-1 What Is the Application Manager?
A screen data (application) file holds a variety of data. The application manager
is a data management tool used for managing the various types of screen data.

Since the application manager displays the data in tree style, you can check the
created data or read the necessary data easily.

(The number and type of screens and tables displayed in the applicationmanag-
er vary according to the settingmade for [PTModel] of [PTType] in thePTconfig-
uration. Bit map shown above is in case of NT31, NT31C, NT631 and NT631C.)

The application manager provides following operations:

S Opening a data creation screen

S Creation of new application

S Copying a screen

S Deleting a screen

S Displaying and setting PT configuration

S Displaying and setting screen properties

S Editing tables

S Saving the created data to a file

S Sending (downloading) the created data to a PT

Icons used by the application manager

App 1: Name of application folder

When a file name has been specified, the file name specified by App 1 is used.

Double clicking of this icon opens a set of sub-data box by screen type.

screen: Screen data box

Double clicking of this icon displays the screen data boxes classified by group.

table: Table data box

Double clicking of this icon shows memory tables classified by icon.

1-1899.2000 (Standard): Screen data boxes classified by screen type

1-1899.2000: Indicates a screen number.

Standard: Indicates screen type.

Double-clicking of this icon displays the screen icons in a group.

The screen number and screen type displayed here differ from PT models.
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: Screen icon

1: Indicates a screen number.

Double clicking of this icon opens a data creation screen.

numeral memory table: Table data icon

Numeral memory table: Indicates a table type.

Double clicking of this icon opens a memory table dialog box setting.

The type of table to be displayed differs depending on the PT model.

When you click on [+], displayed to the left of a icon, icons existing under the
clicked icon are displayed. Clicking on [−] hides these icons.

4-2 Operating the Application Manager
The procedure for operating and setting the data using the application manager
is shown below.

Two types of operations - mouse operation and menu operation - are possible.
For themenu driven operation, short-cut keys (keys used to call menu functions)
may be used instead of displaying the menu.

4-2-1 Opening a Data Creation Screen
The procedure for opening a creation screen of existing data is shown below.

Operation using the mouse (1)

(1) Double click the screen icon.

Operation using the mouse (2)

(1) Click the right mouse button at the screen icon.

(2) Select [Open].

4-2-2 Closing a Creation Screen
The procedure for closing a creation screen is shown below.

Operation using the mouse

(1) Click the Button at the upper right corner in the data creation screen.

4-2-3 Creating a New Screen
The procedure for opening a new screen is shown below.

Operation using the mouse

(1) Click the screen data box icon, or right click the mouse on the screen data
box (classified by group).

(2) Select [New], choose the screen type, then click the Button.

(3) Input a screen number and a comment, then click the Button.

Operation using the menu

(1) Select [New] from [Screen] in the menu bar.

(2) Select the screen type, then click the Button.
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(3) Input a screen number and a comment, then click the Button.

4-2-4 Copying a Screen
Theprocedure for copyinganexistingscreen toanother screennumber is shown
below.

Reference: The operations shown below can be performed between different screen data
files of the samePTmodel by startingup twoSupport Tools. For details, refer to
3-3-6 Importing Components from Different Screen Data File (Starting Up the
Second Support Tool).

Operation using the mouse (1)

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected screen icon, then select
[Copy].

(3) Click right buttonof themouseononeof the screen icon, then select [Paste].

(4) Input a screen number, then click the Button.

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the
available screen numbers is displayed.

If you input an existing screen number, a confirmationmessage is displayed
to overwrite it.

Operation using the mouse (2)

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Drag the selected screen icon in the screen icon display area.

(3) Input a screen number, then click the Button.

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the
available screen numbers is displayed.

If you input an existing screen number, a confirmationmessage is displayed
to overwrite it.

Operation using the menu

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Select [Copy] from [Edit] in the menu bar.

(3) Then select [Paste] from [Edit] in the menu bar.

(4) Input a screen number, then click the Button.

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the
available screen numbers is displayed.

If you input an existing screen number, a confirmationmessage is displayed
to overwrite it.
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4-2-5 Deleting a Screen
The procedure for deleting a created screen is shown below.

Operation using the mouse

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected screen icon, then choose
[Delete].

The message requesting your confirmation is displayed.

Operation using the menu

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Select [Delete] from [Edit] in the menu bar.

A message requesting your confirmation is displayed.

4-2-6 Displaying and Setting the PT configuration
The procedure for displaying the PT configuration dialog box is shown below.

For details, refer to Dialog Box Setting in the PT Configuration on page 45.

Operation using the mouse

(1) Click right buttonof themouseon the screendata (application) file icon, then
select [Setup].

Operation using the menu

(1) Select [PT Configuration] from [Tools] in the menu bar.

4-2-7 Displaying and Setting Screen Properties
The procedure for displaying the property setting dialog box is shown below.

For details, refer to 5-1 Types of Screens, CommonDialog Box Settings andOp-
erations.

Operation using the mouse

(1) Click right button of the mouse on the screen data file icon, then select
[Properties].

Operation using the menu

(1) Select the screen icon.

(2) Select [Properties] from [Screen] in the menu bar.

Reference: The following operations can also display the screen property setting dialog
box.

S Click right button of themouse on the editing screenwhere no objects are reg-
istered, then select [Properties].

S Double click on the editing screen where no objects are registered.

4-2-8 Editing a Table
The procedure for displaying the table setting dialog box is shown below.
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For details, refer toSection 7Memory Table Setting orSection 8 EditingGraphic
Data.

Operation using the mouse (1)

Double click the icon of the table data to be edited.

Operation using the mouse (2)

Make a right click on the icon of the table data to be edited, then select [Modify].

Operation using the menu

(1) Select [Tools] in the menu bar, then choose [Table], [Image Editor], [Library
Editor] or [Mark Editor].

(2) If [Table] is chosen, select the tab of the table to be edited.

4-2-9 Copying an Entire Table
Anentire table can be copied between the screen data files of the samePTmod-
el by starting up two Support Tools.

Caution: Copying of tables, screens, and objects between two screen data files involves
addition or overwriting of PLC address. Please check the movement sufficiently
before shifting to actual operation.

Reference: S To start up second Support Tool, select [Import Component] from [File] menu,
For details, refer to 3-3-6 Importing Components from Different Screen Data
File (Starting Up the Second Support Tool).

S If the whole table is copied, all the contents in the specified table are copied
collectively. Formethod to copy the individual data in a table, refer toSection 7
Memory Table Setting or Section 8 Editing Graphic Data.

S A check box for “Overwrite PLC Address” appears when copying the whole
table indicatedbelow. If this checkbox is checked,PLCaddresssetting isover-
written. If not checked, settings such as initial value will be overwritten but the
PLCaddress setting remains the same.Note that I/Ocommentsarenot copied
even if the PLC address is overwritten. If you need the same I/O comment,
copy the I/O comment.
Bit memory table, Extended I/O output table, Numeral table, String table, F-
Key input notify table

Operation using the mouse (1)

(1) Specify the table data icon.
Multiple tables canbeselectedbydragging themousecursorwhilepressing
the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected table data icon, then select
[Copy].

(3) Click right button of themouse on the desired table in the table data icon dis-
play area of another Support Tool, then select [Paste].

(4) In the confirmation dialog box, click the Button. If a check box for
“Overwrite PLC Address” appeared in the dialog box, make the setting as
required.

Operation using the mouse (2)

(1) Specify the table data icon.
Multiple tables canbeselectedbydragging themousecursorwhilepressing
the Shift key or Ctrl key.
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(2) Drag the selected table data icon to the table data icon display area of anoth-
er Support Tool.

(3) In the confirmation dialog box, click the Button. If a check box for
“Overwrite PLC Address” appeared in the dialog box, make the setting as
required.

Operation using the menu

(1) Specify the table data icon.
Multiple tables canbeselectedbydragging themousecursorwhilepressing
the Shift key or Ctrl key.

(2) Select [Copy] from [Edit] in the menu bar.

(3) Then select [Paste] from [Edit] in the menu bar of another Support Tool.

(4) In the confirmation dialog box, click the Button. If a check box for
“Overwrite PLC Address” appeared in the dialog box, make the setting as
required.

4-2-10 Saving the Screen Data (Application) to a File
The procedure for saving the screen data to a file is shown below.

For details, refer to 3-3-3 Saving the Screen Data (Application ) File.

Please save frequently. Support Tool will not save automatically.

Operation using the mouse

(1) Click right button of the mouse on the screen data file icon, then select
[Save] or [Save As].

If you select [Save] for a file other than a new file, the saving operation starts
immediately without prompting dialog box.

(2) Specify the folder and file nameof thedestinationandclick the But-
ton.

If you specify an existing file, amessage requesting your confirmation is dis-
played if it is overwritten.

Operation using the menu

(1) Select [File] in the menu bar, then choose [Save] or [Save As].

If you select [Save] for a file other than a new file, the saving operation starts
immediately without prompting dialog box.

(2) Specify the folder and file nameof thedestinationandclick the But-
ton.

If you specify an existing file, amessage requesting your confirmation is dis-
played if overwriting should be done.

4-2-11 Error Check (Validation)
The Support Tool has a function to check the data such as limitations of screen
elements and PC (PLC) address assignments in order to prevent illegal data
from being downloaded. This is called Validation.

The following three validation functions are provided:

S Validation performed on real time
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The Support Tool provides real time validation while users are creating data.
This function mainly checks the elements one by one. Moreover, maximum
number of elements and memory size will be also watched.

S Validation performed from the [Tools] menu→ [Validate]

It is also possible to perform the Validation using [Tools]→ [Validate] from the
menu bar.

By the check, Support Tool will detect the contradiction in the screen (applica-
tion) data including association between touch switches and the elements and
so on.

This check will be also performed at the beginning of the download process to
prohibit the wrong data to be downloaded.

S Validation during the data conversion and importing DOS data file

Validationwill bealsoperformedwhenconverting thescreendata (application)
from a current model to another model and when importing the DOS data file.
Data conversion will be also performed when the registered symbol data from
the Symbol Manager that was created by a certain PT model, has been
dragged and dropped to the another PT model screen. So at this time valida-
tion will be also performed.

Reference: Validation will be also performed when saving the screen data in mmi format.

Executing the Validation

S Validating the current focused screen

Make sure the screen you want to validate is open, and select [Validate] from
the [Tools] menu.

S Validating the whole screen data (application) file

(1) Right after performing the screen validationmentioned above, choose [Vali-
date] from the [Tools] menu again. Confirmation dialog box arrives.

(2) Click the Button. Then the validation will start.

During the validation, it is not possible to perform other operation.

After the validation has been completed the result message arrives.

Reference: S Please execute the validation after the creation of screen data (application).

S Validationmight need a sufficient time period in case the screen data (applica-
tion) itself has large size and validation for the whole data has been executed.
So when “Validating for the whole data” has been performed, the confirmation
dialog box appears asking whether you want to perform the validation or not.
Click the Button to start the validation.

Displaying the error log and its location

If the error check functiondetects anerror, a brief errormessage is displayedand
you are requested to confirm the “error log.”

Reference: S The messages contents of the error log are cleared when an element or a
screen is operated. Therefore, if an error is detected, display the error log win-
dow immediately to determine the details of the error. Since errors occurring
during data conversion, in particular, may not reoccur if you try to check them
later, they must be checked at their occurrence.
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S The results of the error check can be printed or saved in a file. For details, refer
to Section 12 Making Reports.

The procedure for displaying the error log window is shown below.

(1) Select [View] in the menu bar, then choose [Error Log].

The error log window opens.

With some types of errors, double-clicking on the error message will display the
screen(s) where the error has occurred.

For the meaning of error message and the solution to be taken to correct the er-
ror, refer to Appendix A Data Conversion and Appendix H Error Messages.

4-2-12 Sending (Downloading) the Data to a PT
The data created using the Support Tool can be sent (downloaded) to a PT. It is
possible to send the screen data collectively or only the data of the specified
screens or memory tables. Here, only the procedure is described. For details,
refer to 11-3 Sending (Downloading) the Data.

Before sending the data, set the communication conditions (communication port
and communication speed [Baud Rate]) by selecting [Connect] (menu bar) and
[Comms. Setting].

Operation using the mouse

S Sending (Downloading) the whole data file

(1) Right click the mouse on the screen data file icon, then select [Download].

If the screen data is free of errors, sending of the data starts immediately.
A message is displayed if the data has an error.

S Sending (Downloading) specified screen

(1) Specify the screen icon.

Multiple files can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Make a right click on the selected screen icon, then choose [Download].

(3) Specify if child screens of continuous/overlapping screens are also to be
sent, then click the Button.

If the screendata is freeof errors, transmittingof thedata starts immediately.
A message will be displayed if the data has an error.
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S Sending (Downloading) specified Table

(1) Right click the mouse on the table data box icon, then select [Download].

The dialog box used for specifying the table to be sent (downloaded) is dis-
played for PTs that allow table data to be sent in table individually. With PTs
that do not allow table data to be sent table by table, sending of the data
starts immediately.

(2) Specify the table to be sent (downloaded), then click the Button.

Reference: It is not possible to send (download) the direct access information or system
memory individually. Please use the menu operation.

Operation using the menu

S Sending (Downloading) the whole data file

(1) Select [Connect] in the menu bar, then choose [Download (NT-series Sup-
port Tool→ PT)]→ [Application].

If the screen data is free of errors, sending of the data starts immediately.
A message is displayed if the data has an error.

S Sending (Downloading) specified screen

(1) Specify the screen icon.

Multiple files can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool→ PT)]→ [Screen].

(3) Specify if child screens of continuous/overlapping screens are also to be
sent, then click the Button.

If the screen data is free of errors, sending of the data starts immediately.
A message is displayed if the data has an error.

S Sending (Downloading) specified Tables

(1) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool→ PT)]→ [Table].

The dialog box used for specifying the table to be sent is displayed for PTs
that allow table data to be sent in table units.With PTs that do not allow table
data to be sent table by table, sending of the data starts immediately.

(2) Specify the table to be sent, then click the Button.

Reference: Downloading in table units may not be possible with some PT types.

S Sending the Direct Access Information and system memory

(1) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool→ PT)]→ [Direct Access Information] or [System Memory].

If the setting is free of errors, sending of the data starts immediately. Ames-
sage is displayed if the data has an error.

4-2-13Window Menu
The following Support Tool operations are possible using the [Window] menu.

S Opening a new window for the data creation screen that is active
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S Arranging windows

S Switching windows

Reference: TheSupport Tool can operate windows in the samemanner as otherWindows
applications. Here, only the functions that can be selected from the Support
Tool menus are explained.

Opening a new window

To open a new window for the data creation screen that is active, follow the pro-
cedure described below.

Reference 1. Windows with the same screen number display the same contents.

2. When the same screen is displayed in twowindows, elements can be copied
between the windows by dragging themwhile pressing the Ctrl key. Usually,
copying an element to a desired position in the same screen is not possible.
However, if two samewindows are opened, it is possible to copy an element
to a desired position although they are on the same screen.
(Similarly, if different screen data files of the same PT model are opened by
two Support Tools, it is possible to copy screen data between the files.)

3. Whenmultiple windows that have the same screen number exist, the follow-
ing information is displayed in the window title area (for standard screens).

x Standard Screen: y

(x: Screen number, y: Serial number)

Serial numbers will be assigned in the order the windows are opened. If any
window presently opened is closed, the serial numbers are renumbered au-
tomatically.

4. The Support Tool can open up to ten windows at the same time in addition to
the application manager window.

S Operation

(1) Specify the screen.

Click on the screen or double-click on the screen icon to open multi-
windows.

(2) Select [New Window] from [Window] in the menu bar.

An additional window opens for the screen specified in step (1).

Arranging windows

Windows can be arranged in any of the following three ways.

Cascade:

All windows are cascaded in such a way that window titles are visible. All
windows are displayed at the same size.

The order of cascading differs depending on the display position of the win-
dows before the cascading operation is attempted.

Tile:

Allwindowsarearrangedover theentiremainwindowareaat thesamesize.
However, the sizesmaydiffer slightly, dependingon thenumber ofwindows.

The order of tiling differs depending on the display position of windows be-
fore tiling operation is attempted.
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Arrange Icons:

The application manager and creation screens shown in icon form are ar-
ranged in the lower left part of the main window.

The order in which the icons are displayed differs depending on the display
position of the icons before the arrange icons operation was attempted.

S Operation

(1) Select [Window] in themenu bar, then choose [Cascade], [Tile], or [Arrange
Icons].

The windows are arranged according to the selected item.

Switching windows

Under the [Window] menu, up to nine windows that are open are displayed in a
list.

If the number of windows is ten or more, the [More windows...] item is displayed.
The window selection dialog box opens when this item is selected.

Users can activate the particular screen to edit from [Window] in the main menu
or selecting from window selection dialog box of [More windows...].

This feature brings simple operation to edit data of veiled screen.

4-2-14 Help Menu
The [Help] menu includes the following items.

S Contents

S Search for Help on

S What’s This?

S PLC Address Help

S About NT-series Support Tool

Displaying help information using the table of contents

The help information of the Support Tool is constructed so that the functions can
be tracked according to the menu configuration. To display help on a specific
function, display the table of contents of the help information and find help on the
relevant function.

S Operation

(1) Select [Help] in the menu bar, then select [Contents].

The table of contents of help is displayed.

(2) Select an item to display the corresponding help contents.

In the information displayed in the help screen, items that have a link to de-
tailed help information are underlined; click on such an item to access the
detailed information.

The necessary information will be reached by tracking the items in this way.

Reference: The button or F1 key is also used to display the table of contents for
help information.

Displaying help information by searching for a keyword

Help information ona specific topic canbedisplayedby inputting the related key-
word.
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S Operation

(1) Select [Help] in the menu bar, then select [Search for Help on].

The topic search dialog box is displayed.

(2) Input a keyword.

When the keyword is input, the corresponding help item is highlighted.

(3) If you find the specified help item, click the Button.

The help information relating to the specified item is displayed.

Displaying help information by clicking on a screen

The Support Tool provides the [What’s This?] item that allows you to get help
when an item for which you need help is displayed.

Using this feature, you can display the help information in a simple operation
without tracking the table of contents or inputting a keyword.

S Operation

(1) Select [Help] in the menu bar, then select [What’s This?].

A question mark (?) is appended to the mouse cursor.

Clicking the Button in the standard tool bar, alsodisplaysaquestionmark

at the mouse cursor.

(2) Click on the item (place) for which you need help.

The corresponding help information is displayed.

Checking the input method of PLC address

PLC address dialog box is displayed when an address is allocated to an object.
If [PLC Address Help] is selected in the [Help] menu, the help about the PLC ad-
dress dialog box that shows the input method of PLC address is displayed.

Checking the Support Tool version

If [About NT-series Support Tool] is selected in the [Help] menu, the dialog box
that shows the version of the Support Tool is displayed.

If you have questions on the Support Tool, please check the version of your Sup-
port Tool before contacting.
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SECTION 5
Screen Types

This section deals with the types of screens that can be created by the Support Tool.

5-1 Types of Screens, Common Dialog Box Settings and Operations 78. . . . . . . . . . . . . . . . . . .
5-1-1 Setting the Screen Attributes 78. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-2 Grid Setting 80. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-3 Changing the Display Method on the Support Tool 81. . . . . . . . . . . . . . . . . . . . . . .
5-1-4 Filter Function 85. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-1-5 Switching Screens by Extended I/O Input at Each Screen 87. . . . . . . . . . . . . . . . . .
5-1-6 Saving the Screen Image 88. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5-2 Standard Screen 88. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-3 Continuous/Overlapping Screens 89. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5-3-1 Continuous Screens 90. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-3-2 Overlapping Screens 91. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-3-3 Editing a Parent Screen (Modification) 92. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

5-4 Window/Keyboard Screens 92. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-4-1 Window/Keyboard Screens 92. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-4-2 Improved Input Key-window/Keyboard Function 95. . . . . . . . . . . . . . . . . . . . . . . .

5-5 Extended Screen 97. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-6 Occurrence History Screen 98. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-7 Frequency History Screen 99. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-8 Host Connect Screen (System Initializing Screen) 99. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-9 Password Screen 100. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-10 Menu Screen 101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-11 Print Format Screen 101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-12 Programming Console Screen 101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-13 Device Monitor Screen 102. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
5-14 Contrast and Brightness Adjustment 102. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .



5-1SectionTypes of Screens, Common Dialog Box Settings and Operations

78

5-1 Types of Screens, Common Dialog Box Settings and
Operations

The Support Tool provides various types of screen.

The screens that can be created using the Support Tool are shown below. The
screens that can be used differ depending on the PT model.

S Standard screens

S Continuous/overlapping screens

S Window/Keyboard screens

S Extended screens

S Occurrence history screens

S Frequency history screens

S Host connect screens (system initializing screens)

The screen attributes and grid can be set for each screen, individually.

S Password screens

S Menu screens

S Print format screens

S Device monitor screens

S Contrast tuning screens

5-1-1 Setting the Screen Attributes
All screens have screen attributes used for setting the screen display specifica-
tions.

The information tobeset asattributes, specific to the individual screens, includes
screen number, screen comment, recording in display history, backlight, and
buzzer control.

To display the attributes, follow any of the operations indicated below.

S [Screen] (menu bar)→ [Properties]

S Right click on a screen data icon in the application manager→ [Properties]

S Right click at an arbitrary position on the screen→ [Properties]

S Double click at an arbitrary position on the screen
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Screen No.

Specify a screen number. The screen number of an existing screen may be
changed.

History (other than NT20S)

Specify whether or not the event of screen display is to be recorded in the display
history record (Screen history Log). The display history function records the
date/time and frequency of screen display for screens for which the [History] at-
tribute check box is ticked. The recorded display history can be checked on the
occurrence history screen and the frequency history screen.

The event of screen display is recorded in the display history if the check box of
the history attribute is ticked; if it is not ticked, the event is not recorded.

Title (other than NT20S)

Specify the title of screens that are displayed in the display history.

Setting of the title is possible only when the history attribute is selected.

Comment

Set the comment for a screen. For the comment, characters of up to 24 charac-
ters can be set.

Backlight - Type

Set if the backlight is to light continuously or flash when the screen is turnedON.

Light: When the screen is turned ON, the backlight lights.

Flash: When the screen is turned ON, the backlight flashes.

This attributes cannot be set for NT600S, NT620S, NT620C, NT625C.

Backlight - Color (only for NT30)

Specify the backlight color, white or red.

Buzzer (other than NT11S)

Specify whether or not the buzzer should sound when a screen is displayed and
also the type of buzzer sound.

If this attribute is selected, the buzzer sounds when a screen is displayed.

The buzzer type can be selected from the following.

Continuous: The buzzer sounds continuously.

Short: The buzzer sounds in cycles of 0.5-second beep and 0.5-se-
cond stop. (Setting is not possible for NT20S and NT600S.)

Long: The buzzer sounds in cycles of 1-second beep and 1-second
stop. (Setting is not possible for NT20S and NT600S.)

Beep: The buzzer sounds in cycles of 0.5-second beep and 0.5-se-
cond stop. (Only for NT20S and NT600S)

Buzzer type setting is possible only when the buzzer attribute is selected.

Load Local 1 (Keyboard) (other than NT11S, NT20S and NT600S)

Select whether or not a local window 1 (Keyboard) pops up on the screen when
standard screen is opened.

If the attribute is checked, a window (keyboard) pops up when the screen is dis-
played.Window (keyboard) does not pop up if the attribute is not selected. If the
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attribute is not setwhen the standard screen is created, it can be selected later to
display.

Specify the screennumber ofwindow/keyboard screen to bedisplayedas apop-
up window/keyboard.

Window (Keyboard)will be displayedat the position specifiedwhenwindow/key-
board screen was created.

With NT30, NT30C, NT620S, NT620C, NT625C, and NT31, NT31C, NT631,
NT631C below “-V1,” window is called a keyboard window since it is used to
place keypad (touch switch) for inputting numeral/string.
With the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and
above, it is simply called a window since all kinds of objects other than thumb-
wheel canbe registered on it. For details ofwindow/keyboard screen, refer to5-4
Window/Keyboard Screens.

Load Local 2 (NT21 and NT31, NT31C, NT631, NT631C with “-V1” and above)

Select whether or not a local window 2 pops up on the screen when standard
screen is opened.

If the attribute is checked, window pops up when the screen is displayed. Win-
dow does not pop up if the attribute is not selected. If the attribute is not set when
the standard screen is created, it can be selected later to display.

Specify the screen number of window screen to be displayed as a pop-up win-
dow.

Window is displayed at the position specified when window/keyboard screen
was created.
For details of window/keyboard screen refer to 5-4 Window/Keyboard Screens.

System Keypad (other than NT11S, NT21, NT31, NT31C, NT631 and NT631C)

Specify whether or not the keypad that is automatically created by the system is
used for setting numerals or strings.

If the attribute is selected, the system keypad is used and it is not used if the at-
tribute is not selected.

Color - Background (NT30, NT30C, NT31C, NT620C, NT625C, NT631C)

Set the background color.

5-1-2 Grid Setting

Specify the grid used for drawing.

The grid is used as the guide when drawing an element. When the grid is se-
lected, dots are set in the specified spacing.

The grid can be set so that the specified points of an element being drawn are
positioned at grid points.

To display the attributes, follow any of the operations indicated below.

S [Attributes] of screen property→
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S [Screen] (menu bar)→

Grid Size - Custom

Set the grid spacing in the horizontal and vertical directions to create the grid of
the desired spacing, respectively.

Horizontal Spacing: Specify the grid spacing in the horizontal direction as
a number of dots.

Vertical Spacing: Specify the grid spacing in the vertical direction as a
number of dots.

Grid Size - Touch Switch Grid

If this attribute is selected, grid spacing equivalent to the size of a touch switch is
set. The actual size differs depending on the PT model.

Display Grid

Specify whether or not the grid is displayed.

To display the grid, tick the check box of this attribute. If you want not to display
the grid, cancel the tick in the check box.

Snap to Grid

Specify if the specified position of an element being drawn is automatically ad-
justed so that it coincides with a grid position.

To adjust the element position, tick the check box of this attribute. If adjustment is
not necessary, cancel the tick in the check box.

Reference: S When saving screen data using mmi format, grid setting information and
grouping information will not be stored.
(Refer to 3-3-3 Saving the Screen Data (Application) File.)

S It is possible to select whether to print screen grid or not when printing screen
image. (Refer to 12-2-2 Output to a Printer.)
If grid is to be printed, the grid setting of each screen will be included in the
screen image.

5-1-3 Changing the Display Method on the Support Tool
The procedures for changing the screen display method and displaying the in-
formation on elements are indicated below.

Reference: In addition to the displaymethods indicated below, Support Tool has a filter func-
tion that displays only the elements of the selected type. (Refer to 5-1-4 Filter
Function.)

Confirming full tiling status

When [Full Tiling] is selected in the [View] menu with a tick mark entered on the
left side of themenu item, the element is displayed on the Support Tool screen in
the tiled status.
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Reference: S There may be differences in element display order and details in display be-
tween the Support Tool and a PT. Therefore, results of tilingmay be different in
the display obtained at a PT and that confirmed by the Support Tool.

S When a filter function is used for a fixed display, Full Tiling will be automatically
cancelled (confirmation message will be displayed) since the tiled status may
not be displayed correctly if the object used as a border is hidden by a filter
function.

Displaying element information (Show Tag)

The Support Tool can display the following element information on the screen at
the same time.

Information Displayed
on the Screen Description

PC (PLC) address PC (PLC) bit addresses of lamp settings (light
function) for lamps, PC (PLC) addresses of lamp
settings for touch switches, or PC (PLC) address-
es of notification (notify) bits are displayed.
For a touch switch with the notification bit function,
both PC (PLC) address of the notification (notify)
bit and lamp setting are displayed (upper: notify
bit, lower: lamp bit), and for touch switches with
other functions, the PC (PLC) addresses of lamp
settings (light function) are displayed.
The first character represents the type of element
as shown below. (In case of touch switch, the first
character for lamp bit is also represented by a T.)

L: Lamp
T: Touch switch

The second character represents the area type of
PC (PLC) addresses.
Example (PLC Vendor: OMRON)

Blank: CIO area
H: HR area
A: SR area
L: LR area
D: DM (Data Memory) area
E: EM Current Bank

For characters that indicates area type of Mitsu-
bishi, refer to page 129.
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Information Displayed
on the Screen Description

Table No. The table entry number of the Numeral or Charac-
ter String Memory Table (String Table) that is ref-
erenced for a numeral display, (character-)string
display, bar graph, numeral setting input, (charac-
ter-)string input, or thumbwheel switch is dis-
played.
The first character represents the type of table as
shown below.

N: Numeral memory table
S: Character String Memory Table

(String Table)

Image and library code The code of image and library data of a fixed dis-
play is displayed as a hexadecimal number.

Multiple sets of the element information described above can be displayed at the
same time. If they are set for a single element, the information is displayed ac-
cording to the priority shown below.

PC (PLC) address> Table entry number> Image and library data code

Setting for the display of element information is possible for all the editing
screens.

The display method for element information is set in the manner shown below.

(1) Select [View] in the menu bar, then choose [Show Tag].

The menu shows the items that can be set.

The items for which display is presently set are identified by a tick.

(2) Select any of [PLC Address], [Table No.], and [Image and Library Code] to
change whether element information should be displayed or not.

Each time a menu item is selected, the tick mark is set, or canceled, alter-
nately. When a tick mark is displayed, the specified element information is
displayed.

Inverting and flashing the objects

Some of the objects have Inverse, Flash, and Inverse Flash attributes.
Inverse status is always reflected on the screen.
Flash display can be checked by specifying the Simulate Flash command. (It is
possible to view Inverse Flash state also.)
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”Simulate Flash” is applied to each screen individually.
To activate this setting, follow the procedure below.

(1) Select “Simulate Flash” from the [View] menu. (or click on the / but-

ton.)
In the [View] menu, the check mark is set to ON and OFF each time it is se-
lected.
When the check mark is displayed, the objects that have Flash or Inverse
Flash attribute show their flashing status.
Each time the “Simulate Flash” button is clicked, it changes as follows:

: Flash status being shown

: Flash status not shown

Lighting and flashing the lamps/touch switches

For lamps and touch switches, it is possible to specify PLC address for lamp set-
ting. Lampsand touch switches light (flash) according to the status of the host bit.
When the PLC address for lamp setting goes to 1 (ON), they light or flash.
(Whether they light or flash is determined by the lamp attribute set to the object.)
With theSupport Tool,ONstatusof lampsand touchswitches canbecheckedon
the screen.
The Simulate ON/OFF setting is applied to all the screens being displayed.

Reference: S In caseof image lamp,ONstate imageanddotted line indicating the position of
OFF state image is shown when the state is ON, and OFF state image and
dotted line indicating the position of ON state image is shownwhen the state is
OFF.

S With the NT21 and NT31/631-V2 and above, the contents of a label can be
specified for each ON and OFF state. The display of the label is changed ac-
cording to the status of the lamp or the touch switch.

S Display of lamp ON/OFF status may differs between the Support Tool and PT
for the following cases.

S ON color when lamps/touch switches are overlapped.
S ON color of lamp/touch switch label when using NT30C, NT620C/NT625C.

SON status of lamp/touch switch when overlapping with other object (other than
fixed display)

To activate this setting, follow the procedure below.

(1) Select [SimulateON/OFF] from [View]menu. (or click on the / button)

In the [View] menu, the check mark is set to ON and OFF each time it is se-
lected.
When the checkmark is displayed, the lamps and touch switches show their
ON statuses.
Each time the Simulate ON/OFF button is clicked, it changes as follows:

: Lamp ON status being shown

: Lamp ON status not shown

Redrawing the editing Screen (Refresh)

In case the screen has disrupted during the edition of the screen, Refresh func-
tion will help you redrawing the screen.

Redrawing can be performed as follows:

(1) Select [Refresh] from the [View] menu. The screen will be updated.
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Displaying Full Screen (Full Screen)

This is available in case if you want to view the screen in wide range. (But is im-
possible to edit while displaying in full screen.)

Full Screen can be performed as follows:

(1) Select [Full Screen] from [View]menu.The current editing screenwill be dis-
played in wide range.

To recover from this condition, click at any place on the screen.

Zoom

Zooms thescreen to100%view (Normal), 200%,400%or 800%. If thegrid is set,
it will also be zoomed to the respective size.

It will help you to operate small elements. Zoom can be performed as follows:

(1) Select [Zoom] from [View]menu. On thismenu, current zoom percentage is
displayed using check mark.

Displaying window/keyboard (Show Window/Keyboard)

Local window (Keyboard) set for attribute of currently displayed screen can be
displayedoverlappingon thescreen to check theactual status tobedisplayedon
PT.
Local window 2 is available only with the NT21 and with the NT31, NT31C,
NT631 and NT631C with “-V1” and above.

Show Window/Keyboard command can be performed as follows:

(1) Open a property sheet of the screen and set a check mark for the window
type to be displayed and specify the screen number.

(2) Select [ShowWindow/Keyboard] from the [View]menu and specify thewin-
dow/keyboard type to be displayed (Local 1 (Keyboard) or Local 2).
Check mark will be set on menu next to the name of the displayed window
type.
Each time you select window, the check mark switches to the objective one
and according to it, window/keyboard display will be changed.

5-1-4 Filter Function

Support Tool has a filter function that can show only the specified object on the
screen.
It is possible to edit/select objectswhile this function is executed.So itwill beuse-
ful when you correct or edit complicated screen. In addition, it is possible to dis-
play the list of each object by types if this function is usedwithSelectObject func-
tion. (For details, refer to the Reference.)
Filter function is applied to individual screen.
To activate this setting, follow the procedure below.
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(1) Select the object to be displayed from the combo box on the utility bar.
To display all the objects (cancel filter function), select “All.”

Reference: S While a filter function is used, you can edit only the objects being displayed.

S If the Select Object dialog box (refer to page 107) is displayed by right-clicking
the object while a filter function is used, only the type of object being displayed
is shown in the list. In this case, the typenameof theobjectwill not bedisplayed
in the Select Object dialog box and detailed information of objects is shown.

S If a filter function is used for a Fixed Display, Full Tiling ([View] menu) will be
cancelled automatically since the tiled status may not be displayed correctly if
the element used as a border is hidden by a filter function. (Confirmationmes-
sage is displayed.)

S With a filter function, only one type of object can be specified. It is not possible
to select two or more objects, such as a Touch Switch and Bar Graph.

Reference: When the operations indicated below are performed while a filter function is be-
ing used, the filter function will be reset and returned to “All.”

Operation Remark

File→Print When the user performs this opera-
tion the screen will refresh and thenFile→Print Preview tion, the screen will refresh and then
the operation will be performed.

Edit→Paste
the operation will be performed.

Edit→Align

Draw→Associate With

Draw→Disassociate

Draw→Set Order

Draw→Group

Draw→Ungroup

All menu items under “Object” This includes all creation of screen
elements using the menus and tool-
bar except the object specified on
the filter.

Connect→Download When the user performs this opera-
tion the screen will refresh and then

Connect→Upload
tion, the screen will refresh and then
the operation will be performed.

All the references from the table When the user chooses the refer-
ence from the table, the filter will be
reset to ALL.



5-1SectionTypes of Screens, Common Dialog Box Settings and Operations

87

5-1-5 Switching Screens by Extended I/O Input at Each Screen
It is possible tomake a setting so that the specified screen is displayed when the
input of the extended I/O that is connected to the PT is turned ON. The following
two setting methods are provided to switch the screen by extended I/O input.

Note that this setting is possible only for NT30 and NT30C.

Common setting for all screens:

Regardless of the screen presently displayed, the specified screen is always
displayed when the extended I/O input is turned ON.

Select [Table] from [Tools] in the menu bar. Then click the tab of Extended I/O
Input to set the Switch screen.

Setting for the individual screens:

It is possible to set the screen to be displayed in response to turning ON of the
extended I/O input for each screen.

For this setting, select [Extended I/O] from [Screen] in the menu bar.

For example, this settingallows thedisplay screen to changesequentially from
screenNo. 1 to screenNo. 2, then to screenNo. 3 in response to turningONof
the extended I/O input. If the extended I/O input 0 goes ONwhile screen No. 1
displayed, the screen switches to screenNo. 2, then if the extended I/O input 0
goesONwhile screenNo. 2 displayed, the screen switches to screenNo. 3. To
allow screens to be changed in this way, set [Switch Screen No. 2] for [Ex-
tended I/O] at screen No. 1, and [Switch Screen No. 3] for [Extended I/O] at
screen No. 2.

Here, only the setting for screen switching at the individual screens is described.
Operations of theExtended I/O Input table and the commonsetting to all screens
are described in 7-5 Extended I/O Input Table.

The procedure for setting the screen to be displayed on turning ON of the ex-
tended I/O input at each screen is shown below.

(1) Select the screen for which [Extended I/O] is to be set to place the screen in
edit enabled state.

(2) Select [Screen] in the menu bar, then select [Extended I/O].

An extended I/O input table dialog box is displayed.

(3) Select the extended I/O input row where setting is to be done, and click on
.
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An extended I/O input setting dialog box is displayed.

(4) Set [SwitchScreen] for [Function] and the screennumber of the screen to be
displayed for [Screen No.].

5-1-6 Saving the Screen Image
The Support Tool provides a function to save the displayed screen image in a bit
map file as it is.

The grid display status and Show Tag can be also saved.

The following describes the procedure for saving the screen image.

(1) Select the screen that is going to be saved in a file so that it can be edited.

(2) Select [Screen] in the menu bar, then select [Copy to Image].

A dialog box is displayed to set a file name.

(3) Set the folder and file name, then click on .

The screen image is saved to the specified file.

5-2 Standard Screen
A standard screen is the base screen for the display at a PT.

Screen numbers of standard screens differ depending on the PT model. The
table below shows the screen numbers that can be used for a standard screen.
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PT Model Screen Nos.

NT11S 1 to 250

NT20S 1 to 250, 256 to 500

NT600S 1 to 1000

NT30, NT30C, NT620S, NT620C, NT625C 1 to 1899, 2000

NT21, NT31, NT31C, NT631, NT631C 1 to 3999

Screen No.

In a standard screen, all elements can be used.

However, the usable elements depend on the PT models.

Standardscreensarealsoused for creatingchild screensof continuous/overlap-
ping screens.

5-3 Continuous/Overlapping Screens
Continuous/overlapping screens aremultiple screens that are switched consec-
utively or overlapped for display.

Screens that are switched consecutively are called continuous screens and
screens that overlap multiple screens are called overlapping screens.

Screen numbers that can be used for continuous/overlapping screens are same
as those for standard screens.Note that continuousscreenscannotbeusedwith
theNT21,NT31,NT31C,NT631, andNT631C.Toobtain the sameeffect as con-
tinuous screenswith these PTmodels, use touch switches that are assigned the
switch screen function.

Reference: The application manager displays a parent screen as a folder as shown below
and child screens are displayed when the folder is opened.

For NT11S, parent screen setting is not possible.
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5-3-1 Continuous Screens
Two to eight screens can be registered for one continuous screen. The base
screenwheremultiple screensare registered is calleda parent screenandmulti-
ple screens registered to the parent screen are called child screens.

[ ↓ ] [ ↓ ] Screen No. 1Screen No. 15Screen No. 20Screen No. 10

Parent
screen

Continuous
screen 1

Continuous
screen 2

Continuous
screen 3

[ ↑ ] [ ↑ ]

When screen No. 10 is specified, the first continuous screen, screen No. 20, is
displayed. Pressing touch switch [ ↓ ] changes the screen to screen No. 15.
Pressing the touch switch again changes the screen to screen No. 1.

Since the screen of screen No. 10 is set as the parent screen of continuous
screens, it cannot be displayed independently.

Screens set as continuous screens are switched by the pressing of the touch
switches [ ↓ ] and [ ↑ ], for which system key functions are allocated.

In the parent screen setting dialog, showpage number can be set or reset to indi-
cate currently activated child screen number out of total pages on the upper right
corner of the parent screen.

Child screens should be created on standard screens in advance.

Continuous screens are set in the procedure described below.

(1) Create child screens using standard screens.

(2) Specify [Parent Screen] from [New] command in the [Screen] menu.

(3) In the parent screen setting dialog box, set a parent screen number, child
screen numbers, and whether or not a page number is displayed.

a. Set the number of the parent screen for [Screen No.] in [Parent].

If the number of screen data has been already created, it cannot be regis-
tered as a parent screen.

b. Select [Continuous].

c. If necessary, tick [Show Page Number].

d. Specify child screens.

Select screens that are specifiedas child screensbyselecting them from the
[Standard] field, then click on .

The selected screenmoves to the [Child] field. If a wrong number is moved,
click on : the screen returns from the [Child] field to the [Standard]
field.



5-3SectionContinuous/Overlapping Screens

91

Two to eight screens can be registered as child screens.

e. Modify the screen switching order.

Child screens are displayed in the order they are set in the [Child] field.

The setting order of the child screens can be modified using and
.

f. Click on after the completion of child screen setting.

When creating continuous screens with NT20S and NT600S, it is recom-
mended to create Switch Screen touch switch.

5-3-2 Overlapping Screens
Overlapping screens allow two to eight screens to be displayed as one screen.
(For theNT21, NT31, NT31C,NT631, andNT631C, one to eight screens can be
set.) The base screen of an overlapping screen is called the parent screen and
multiple screens that are the constituents of the overlapping screens are called
child screens.

This is an
example of an
overlapping
screen.

This is an

Screen No. 10
(child screen)Screen No. 8

(parent screen)

example of an
Screen No. 7
(child screen)

overlapping
screen.

Screen No. 25
(child screen)

When screenNo. 8 (parent screen) is specified, the elements set on the screens
No. 10, No. 7, and No. 25 are overlapped for display on the parent screen.

Since the screen of screen No. 8 is set for a parent screen for overlapping
screens, it cannot be displayed independently.

In the setting for a parent screen, screen numbers of a parent and child screens
are set.

Child screens should be created on standard screens in advance.

Overlapping screens are set in the procedure indicated below.

(1) Create the child screens on standard screens.

(2) Specify [Parent Screen] from [New] command in [Screen].

(3) In theparent screensettingdialogbox, set aparent screennumber andchild
screen numbers.
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a. Set the screen number of a parent screen for [Screen No.] in [Parent].

If the screen number has already existed, it cannot be registered as a parent
screen.

b. Select [Overlapping].

c. Specify child screens.

Select a screen that is specified as a child screen by selecting it from the
[Standard] field, then click on .

The selected screenmoves to the [Child] field. If a wrong number is moved,
click on : the screen returns from the [Child] field to the [Standard]
field.

Two to eight screens can be registered as child screens.

For the NT21, NT31, NT31C, NT631, and NT631C, one to eight screen can
be registered as child screen.

d. Modify the screen switching order.

Child screens are overlapped in the order they are set in the [Child] field.

The setting order of the child screens can be modified using and
.

e. Click on after the completion of child screen setting.

5-3-3 Editing a Parent Screen (Modification)
The type (continuous/overlapping) and configuration of a created parent screen
can be modified.

The procedure for modifying a parent screen is indicated below.

(1) Specify the parent screen that youwant tomodify from the applicationman-
ager, or display the pop-up menu by right clicking the mouse on the parent
screen.

(2) Select [Screen] in the menu bar, then choose [Modify Parent], or select
[Modify] in the pop-up menu.

The parent screen modify dialog box is displayed.

Theprocedure formodifying thesetting is the sameas setting for newparent
screen information. Refer to 5-3-1 Continuous Screens or 5-3-2 Overlap-
ping Screens.

Reference: If a parent screen is copied on the application manager, child screens are also
copied. (When two Support Tools are started up, the same operation is possible
between the Support Tools.)
For details of screen copying, refer to 4-2-4 Copying a Screen.

5-4 Window/Keyboard Screens

5-4-1 Window/Keyboard Screens
A window/keyboard screen is used as a window screen for the pop-up window/
keyboard function. It means a partially display window that contains a keypad or
other elements to overlap on the base screen.

Note that window/keyboard screen cannot be used with NT11S, NT20S, and
NT600S.
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With NT30, NT30C, NT620S, NT625C and NT31, NT31C, NT631, NT631C be-
low “-V1,” only onewindowcanbeopenedat a timeandobjects that canbe regis-
teredare limitedmainly to thoseused for inputtingnumeral/stringas follows (with
these PTs, this window is called a keyboard screen):

Fixed displays
Touch switches (Notify bit, cursor move and print screen functions are not per-
mitted.)
Numeral/string setting input filed (Only one input field can be set.)

Other elements are not displayed when the window/keyboard screen is opened
as a window although they can be registered for the window/keyboard screen.

With the NT21, and with the NT31, NT31C, NT631, and NT631C “-V1” and
above, up to threewindows can be opened at the same time and all objects other
than thumbwheels and recipes can be registered. (However, only one input field
of numeral/string input can be registered.)

Pop-up display frame

The pop-up display frame specifies the display range and display position of a
pop-up window/keyboard, the size and position of the frame can be specified as
follows:

NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit

NT21, NT31, NT31C, NT631, NT631C: Specify by 20 dot

The pop-up function displays only the area enclosed by the pop-up display
frame.

Reference: S Since the same memory area is shared by a pop-up window/keyboard and
print screen function, it is not possible to open the window during the printing
process. Moreover, it is also not possible to print from PT during the window is
opened.

S With PT models other than the NT21 and the NT31, NT31C, NT631, and
NT631C “-V1” and above, communication with a PC (PLC) is not possible for
elements that are displayed in a keyboard/window. Therefore, the lamp bit of a
touch switch in a window cannot be controlled.

S While a window is open, display processing may be slowed a little.

Touch Switch functions that can be set on Window/Keyboard screen;

NT30, NT30C, NT620S, NT620C, NT625C:

S Notify Bit

S Switch Screen
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S Input Key-Control

S Input Key-Window/Keyboard

S Input Key-String

S Copy setting

S Cursor Move

S Print Screen

With NT30, NT30C, NT620S, NT620C, and NT625C, keyboard screen can be
used as a standard screen. If it is used as a keyboard screen (called from other
screen), Notify Bit, Cursor Move and Print Screen functions are not available.

NT31, NT31C, NT631, NT631C below “-V1”:

S Switch Screen

S Input Key-Control

S Input Key-Window/Keyboard

S Input Key-String

S Copy setting

NT21 and NT31, NT31C, NT631, NT631C “-V1” and above:

S Notify Bit

S Switch Screen

S Input Key-Control

S Input Key-Window/Keyboard

S Input Key-String

S Copy setting

S Window Move

S Print Screen

Changing the size and the position of pop-up display frame

Theprocedure for changing the size and the position of a pop-updisplay frame is
shown below.

(1) Click the mouse on a dotted line of the pop-up display frame.

Green J (handles) appear around the pop-up display frame.
(Arrows in the handle indicates the direction to be resized.)

(2) The frame size can be changed by dragging a handle.

When the mouse cursor is positioned on a handle, the shape of the mouse
cursor changes as shown below according to the handle position.When the
mouse cursor is dragged in this state, the pop-up display frame size chan-
ges in the direction the arrow symbol of the mouse cursor indicates.

Up-down handleRight-left handle Apex handle
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(3) To move the pop-up frame, drag any position in the dotted lines other than
handles.

When the mouse cursor is positioned on dotted lines other than at handles,
the shape of mouse cursor changes as shown below. The pop-up display
frame moves when the mouse cursor is dragged in this state.

(4) After the size and the position of the pop-up display frame are determined,
click on an arbitrary point in the screen other than the pop-up display frame.

The size and the position of the pop-up display frame are set and the han-
dles are cleared.

To change the size and the position of the pop-up display frame, repeat the
procedure shown above from step (1).

Reference: The size and position of the pop-up display frame can be specified as follows:

S NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit

S NT21, NT31, NT31C, NT631, NT631C: Specify by 20 dot

5-4-2 Improved Input Key-window/Keyboard Function
This section describes input key-window/keyboard function that was improved
for the NT21 and the NT31, NT31C, NT631 and NT631C “-V1” and above.

Types of windows

Following two types of windows are available.

Global window

This window can be kept displaying all the time regardless of the screen dis-
playedonPT.Globalwindowstays at the sameposition evenwhen thedisplayed
screen is switched. (Global windowwill be closed automatically when the screen
other than user screen was displayed, and will be re-displayed when the screen
was switched back to user screen.)

Only one global window can be displayed at a time.

It can be opened, closed ormoved only by the operation ofWindowControl Area
from the host. For details of Window Control Area, please refer to the operation
manual of PT.

Local window

This window will be closed when the screen displayed on PT is switched.

By setting local window for attribute of each screen, specified window can be
opened at the same time the screen is opened.

Up to two local windows can be opened at the same time. (Local window1, Local
window 2)

Local window can be opened, closed or moved by following operations.

Setting screen attribute (Opens when the screen is displayed.)
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Touch switch operation (By Input key-window/keyboard touch switch and win-
dow move touch switch)

Operation of Window Control Area from the host

Types of windows can be specified when opening the window.

It is possible to open same window as a Global window or as a Local window.

(However, multiple display of the same window is not possible.)

Opening/Closing and moving a window

Window can be controlled by the following operations.

Opening windows by setting screen attribute

When creating screen using Support Tool, up to two windows can be selected to
be displayed when opening the screen.

By thismethod, window is displayed at the position that was specified whenwin-
dow screen was created. This type of windowwill be local window. For details of
the setting, refer to 5-1-1 Setting the Screen Attributes.

Screen 5 Screen 23

Window

Opening/Closing and moving a window by touch switch operation

To create input key-window/keyboard touch switch on a screen or a window en-
ables to open/close specified window.

By thismethod, window is displayed at the position set for touch switch property.

This type of window will be local window.

Screen Screen
Local
Window

Also, by creating window move touch switch on window, it is possible to move
window by touch panel operation at PT.

Screen Screen

Window Window in a moving status

Screen

For details of touch switch settings, refer to 6-8 Touch Switches.

It is not possible to control global window by touch panel operation.

Opening/ Closing and moving a window by the operation of Window Control Area

Window Control Area is added for the NT21 and the NT31, NT31C, NT631 and
NT631C “-V1” and above as a direct access area.
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While runningPT, bywritingwindowscreennumber or x, y co-ordinate ofwindow
position (bottom left) at Window Control Area from the host, opening/closing,
moving a window are possible.

Window Control Area can control global window and local window. For details,
refer to the operation manual of PT.

Screen

Window

The selected
window opens

PLC

Window
screen number

Window

Window

The window shifts

PLC
The co-ordinates
of the window

Size and display position of window (the NT21 and the NT31, NT31C, NT631, NT631C “-V1” and above)

With theNT21and theNT31,NT31C,NT631, andNT631C “-V1”andabove, size
of window can be specified freely by 20 dot unit. (Minimumwindow size: 20 × 20)

It is possible to display awindowat a different position fromwhere it was created,
or to move a window.

However, the distance between the position where window was created and
where it is displayed have to be always multiple of 20 dot.

Display

Co-ordinates at the bottom
left corner (20,179)

Window

Display

Co-ordinates at the bottom
left corner (180,219)

Window

Reference: Specify the bottom left co-ordinate of window when specifying the window posi-
tion at Window Control Area.

Checking the display status of a window

Whether window is opened or closed will be written to the PT Status of the PT
Notify Area.

Windowscreennumber andwindowposition (bottom left co-ordinate) of current-
ly displayed screen will be written to Window Control Area.

Checking these areas from the host enables to know the display status of win-
dow. For details, refer to the operation manual of PT.

5-5 Extended Screen
An extended screen is used by the expansion function of a PT.

Although an extended screen can be used in the same manner as a standard
screen, it should not be used unless absolutely necessary since it is used by the
expansion function.



5-6SectionOccurrence History Screen

98

If data is registered as a standard screen, the registered data is given priority.

The screen numbers used for an extended screen are indicated below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1980 to 1996

NT21, NT31, NT31C, NT631, NT631C None

5-6 Occurrence History Screen
An occurrence history screen displays the screen numbers recorded by the dis-
play history (Screen History) function in the order of displayed date and time.
This function records the date/timeof display and the number of times the screen
was displayed for the screens for which the [History] attribute is ticked in the
screen property.

The occurrence history screen, providedwith NT30, NT30C, NT620S, NT620C,
and NT625C, has a blank area at the right side in the screen so that scroll and
screen switching touch switches can be created. Other area of the screen must
not be changed.

The screen number of the occurrence history screen is indicated below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1997

NT21, NT31, NT31C, NT631, NT631C 9001*

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

Example: For NT30, NT30C

[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)

Indicates a screen number.

[Date] (NT30/NT30C), [Time] (NT30/NT30C)
[(YY/MM/DD HH:MM)] (NT620S/NT620C/NT625C)

Indicates the date and time the screen was displayed.

[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)

Indicates the number of times the screen has been displayed.

[Message]

Indicates the [Title] of the screen attribute.
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5-7 Frequency History Screen
A frequency history screen displays the screen numbers recorded by the display
history (ScreenHistory) function in the order of frequency of screen display. This
function records the date/time of display and the number of times the screen has
been displayed for screens for which the [History] attribute is ticked in the screen
property.

The frequency history screen, provided with NT30, NT30C, NT620S, NT620C,
and NT625C, has a blank area at the right side in the screen so that scroll and
screen switching touch switches can be created. Other area of the screen must
not be changed.

The screen number of the frequency history screen is shown below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1998

NT21, NT31, NT31C, NT631, NT631C 9002*

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

Example: For NT30, NT30C

[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)

Indicates a screen number.

[Date] (NT30/NT30C), [Time] (NT30/NT30C)
[(YY/MM/DD HH:MM)] (NT620S/NT620C/NT625C)

Indicates the date and time the screen was displayed.

[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)

Indicates the number of times the screen has been displayed.

[Message]

Indicates the [Title] of the screen attribute.

5-8 Host Connect Screen (System Initializing Screen)
The host connect screen is displayed for the start of PT operation until commu-
nication with the PC (PLC) is established.

This screen can be created freely using only fixed display.

In case host connect screen is not registered, a default screen indicating that PT
is trying to connect to the host will be automatically displayed at the timePTpow-
er is switched on or when the mode is changed to the RUN mode.
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The screen number of the host connect screen is shown below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1999

NT21, NT31, NT31C, NT631, NT631C 9000

Reference: For the NT21, NT31, NT31C, TN631, and NT631C, it is called a System Initializ-
ing Screen.

5-9 Password Screen
A Password screen is treated as one of the 250 Standard screen in NT11S.

It is used to protect another screen by password. When a password screen is
displayed on the NT11S PT, it forces the user to enter the correct password be-
fore bringing up the designated screen.

The figure above shows a new password screen created. It has a text element
with “password” as labeled.Next to the text element is thepasswordelement that
indicates the current password for this password screen. In the password prop-
erty page, you can set the password and the designated screen number to be
displayed next.
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5-10 Menu Screen
AMenuScreen is treatedas oneof the250Standard screens inNT11S. It serves
as a control screen that maps a numeric key inputs onto a designated screen. A
maximum of 4 designated screens for each of the numeric keys 1 to 4 can be
specified in the menu screen property page.

5-11 Print Format Screen
The Print Format Screen has the screen number 255 in NT11S. It creates a for-
mat for PTprinting functionmainly for the daily printing. You canonly useNumer-
al and String display to create the format.

5-12 Programming Console Screen
TheProgrammingConsoleScreen is used to access theProgrammingConsole
functions built into the PT. Displaying the Programming Console Screen during
PT operation enables using the Programming Console functions without dis-
playing the System Menu. PT operation, however, will stop while the Program-
ming Console Screen is displayed.

Refer to the User’s Manual or Reference Manual for your PT for details on the
Programming Console functions.

The Programming Console Screen can not be edited on the Support Tool.
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PT Screen No.

NT11S, NT20S, NT600S, NT30, NT30C,
NT620S, NT620C, NT625C

None

NT21, NT31, NT31C, NT631, NT631C 9020

Reference: The Programming Console Screen is supported only by the NT21, NT31,
NT31C, NT631, and NT631C.

5-13 Device Monitor Screen
These are system-defined screens and cannot be created or viewed in NTST.
Application manager will not list out these screens. Screens available are:

Screen No. DAC Function Name NT31/631/31C/631C-V
2 Function Name

9021 I/O Monitor Registration Monitor

9022 DM Monitor Continuous Monitor

9023 Error Monitor Error Log

Reference: These screen numbers can be referred by the following functions:

(1) Touch switch Switch screen

(2) Bit memory table Switch screen function

(3) Bit memory table Alarm function

These screens can only be view onPT if the communicationmethod is NT link. If
communication method is host link, it would not be possible to switch to these
screens.

5-14 Contrast and Brightness Adjustment
This is a system-defined screen and cannot be created or viewed on NTST. The
applicationmanagerwill not list this screen.Contrast andBrightnessAdjustment
is used for tuning the contrast and brightness of the PT screen without the need
to disconnect from the PLC.

The screen number designated is 9030.

PT models that support this requirement are as follows:
NT31-V2 (System Ver3.1),
NT31C-V2 (System Ver3.1),
NT631C-V2 (System Ver3.1). ( NT631C-ST141j only)

This screen can be accessed using the following functions:

(1) Touch switch -- Switch screen

(2) Bit memory table -- Switch screen function

(3) Bit memory table -- Alarm function
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SECTION 6
Element Operating Procedures

Screen data for a PT is created by arranging elements on a screen.
Elements are classified into two groups, elements for display and those used for inputting data at a PT.

6-1 Common Operation 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-1 Creating an Element 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-2 Pop-up Edit Menu 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-3 Selecting an Element 106. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-4 Modifying an Element 110. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-5 Copying, Cutting, Pasting, and Deleting Elements 111. . . . . . . . . . . . . . . . . . . . . . .
6-1-6 Aligning Elements 114. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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6-1-8 Associating Elements with the Touch Switch 117. . . . . . . . . . . . . . . . . . . . . . . . . . .
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6-1-10 Setting Properties 118. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-1-11 Relationships between Elements and Memory Tables 134. . . . . . . . . . . . . . . . . . . . .
6-1-12 Interlock 134. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

6-2 Fixed Display 136. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
6-2-1 Polyline 136. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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6-1 Common Operation

Operations common to all element creation steps are shown below.

6-1-1 Creating an Element

To create an element, specify the element to be created and click the mouse at
the position where the element is to be placed.

(1) Specify an element.

Menu bar: [Objects]→ Select the objects to be created.

Drawing toolbar: Click on the icon of the object to be created.

(2) Click the mouse after placing the mouse cursor at the position where you
want to create the specified element.

The elements shown below can be dragged to change the size of the ele-
ments instead of clicking the mouse when the element is positioned.

Circle, Arc, Sector, Polyline, Polygon, Rectangle, Touch switch, Standard
lamp, Bar graph, Analogue meter, Broken-line graph, Trend graph

After placing the element by clicking or dragging, the dialog box for setting
the property of the element is automatically displayed. (The procedure to
open the property setting dialog box is omitted.)

(3) In the displayed dialog box, set the property of the element.
Change the size and the shape as required.

The selection of an element, the object to be created, is canceled on completion
of the drawing of a graphic.

To draw graphics with the same element continuously, you canmaintain the ele-
ment’s selected status by pressing the Shift key when releasing the left mouse
button after the clicking or dragging.

Reference: Thedialogwill be displayedeach time theelement is created evenwhen theShift
key is being pressed to draw the same element continuously. In case of Polyline
however, the dialog will be displayed only for the last element that was created
immediately after the Shift key is released.

6-1-2 Pop-up Edit Menu

The Support Tool provides pop-up menus where functions used for editing are
collected.

The pop-up edit menu is displayed by clicking the right button of the mouse.

Items displayed in the pop-up edit menu are common to most of all elements.

(1) Select an element.
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(2) Right click the mouse.

6-1-3 Selecting an Element
To edit or move an element, select the created element.

When an element is selected,J marks (handles) are displayed to enclose the
selected element.

Selection mark (handle)

Reference: Arrows in thehandle indicate the direction towhich the sizeof theelement canbe
changed.When themouse cursor is set on the handle, the shape of the cursor is
changed to an arrow of the same direction.

S Selecting an element using a mouse

Click the element you want to select.

S Selecting an element using a Tab key

Each time theTab key is pressed, elements are selected one by one according
to the display order. (If no elements are selected, the element of the highest
display order will be in selected status when the Tab key is pressed.)
When the Shift + Tab keys are pressed together, the selection order will be re-
versed.

Selecting an element from among overlapped elements

When elements are overlapped complicatedly, use the element selection func-
tion below.

Reference: When you click on the overlapped elements, the element with the smallest area
enclosing the point of selectionwill be selected.However, if youwant to select an
element A that is enclosed by other element, like in the figure below, it is not pos-
sible to select element A if the element enclosing it is already selected. In this
case, click any position on the screen where no element is registered to cancel
the selected status and then select element A.
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For a complicated screen, element select operation will be easier if a filter func-
tion (refer to 5-1-4 Filter Function) is used to limit the display objects.

(1) Select the element at the foremost position.

(2) Select [Edit] (menu bar), then select [Select Object].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse and choose [Select Object] in the
menu.

The list of elements behind the element selected first is displayed.
(Detailed information of the objects are displayed in the list. However, part of
the informationmay not be displayed for some objects such as lamps/touch
switches with long label.)

(3) Select the desired element from the list.

(4) Click on .

(1) (2) (3) (4)

Reference: S The element selected in the Select Object dialog box is also selected on the
screen so that you can confirm which element is being selected before you
click the button.

S In the Select Object dialog box, object information same as the one displayed
on the status bar is shown.
For details, refer to page 42.

Batch selection of multiple elements

It is possible to select multiple elements collectively.

S Using the Shift key

Click an element while holding down the Shift key, and it is added to the pre-
viously selected elements. If you click a selected element while holding down
the Shift key, the element is deselected.

+ Shift

S Specifying a range
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Drag themousecursor so that all elementswill beenclosedby the rangespeci-
fying frame.

Range specifying frame

S Selecting all elements in a screen

To select all the elements arranged in a screen, use the select all function.

Select [Select All] from the [Edit] menu.

Specifying an element consisting of multiple elements

To edit an element that consists of multiple elements as shown below, use the
edit element function.

S Position of a label in a touch switch

S Position of a label in a standard lamp

S Position of a “Display %” in a bar graph

S Position of a “Display %” in an analogue meter

S Position of a “Display %” in a trend graph and touch switches for controlling
function

S Display position of image/library data and position of touch switches in an
alarm list/alarm history

(1) Select the element to be edited.

Select only one element, if multiple elements are selected, edit object func-
tion can not be used.

(2) Select [Edit] (menu bar), then select [Edit Object].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse on the elements and select [Edit
Object] in the menu.

It is also possible to enter Edit Object mode by simply pressing the [Insert]
button on a keyboard.
(To cancel Edit Object mode, press [Insert] button again.)

The green J marks (handles) change into red.

(3) Select an element.
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Example: Changing the position of the label in a touch switch

(1)

Green Red

(2) (3)

Reference: The following operation is also possible.

(1) Confirm that no element (or element other than objective one) is selected.

(2) While holding down the Shift key and Ctrl key, click on the objective part of
the element that consists of multiple elements.

(3) The element automatically enters into Edit Object mode so that the element
selected at (2) can be edited.

Multiple Edit Mode for Recipe Touch Switch

Activating Edit Modes

To edit the component of a recipe element (frame and touch switches),

(1) Select the Recipe element.

(2) Select “Edit Object” from the Edit menu, or right click the mouse button and
select “Edit Object” from the pop-up menu.

This is the first level edit mode.

The recipe touch switches now behave like normal touch switches. The touch
switches can be resized and moved. When an internal touch switch is being se-
lected, EditModewill be available again for you tomanipulate the components of
the internal touch switch by means of activating second level edit mode. That is,
the Edit Object menu item (both in pop-up menu and main menu) will not be
checked, and by selecting it the touch switch can be switched to edit mode. You
may also switch to edit mode using the Ins key.

In short, using the Edit Object menu item or the Ins key will allow you to toggle
between edit mode and selection mode or second edit level and first edit level.
If any of the editable components is selected, the screen element will go to se-
cond edit level. In that level, the editable component will be selected.

Only when the recipe screen element is in edit level one, can the internal touch
switches be resized.

Appearance of Resize Handles

When the second edit mode is active, the red handles surrounding the recipe
screen element are switched from solid red handles to red-outlined handles,
while the handles of the internal touch switch change fromgreen to red solid and
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the selected component of the internal touch switch will be decorated with green
handles.

6-1-4 Modifying an Element
The size, shape, and/or position of a created element can be modified.

Modifying the size and shape of an element

Tomodify the size or the shape of an element, drag one of greenJmarks (han-
dles) that enclose the objective element.

Position the mouse cursor on a green handle, and the shape of mouse cursor
changes as shown below. (Same direction as arrows in the handles)

Drag themouse cursor in the indicated direction tomodify the size and the shape
of the element.

Note If a greenmark is shown as when an element is selected, the size of this ele-

ment cannot be changed.

Moving an element

Moving an element by dragging operation

To move an element, position the mouse cursor on the selected element and
confirm that themouse cursor changes as shown below. Then, drag the element
as desired.
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Ifmultiple data creation screens are displayed, an element can bemoved over to
another data creation screen by dragging it.

Moving an element by keyboard operation

The screen element can be moved by pressing cursor key (↑, ↓,←,→) on key-
board after selection.

The size of movement depends on the setting of the Snap to Grid as follows:

When Snap to Grid is OFF

Cursor key: move by 1 dot

Shift key + Cursor key: move by 16 dots

When Snap to Grid is ON

Cursor key: move by 1 dot

Shift key + Cursor key: move by set grid size

However, if the selected elements include touch switch, elements always move
by the size of the touch switch grid regardless of whether Shift key is pressed or
not.

Tomove a part of an element such as the%Display for a bar graph or Label for a
lamp/touch switch, click on the objective part while holding down the Shift key
and Ctrl key (or after selecting “Edit Object”), then perform move operation.

In case of NT11S, there is a special requirement i.e. The selected objects will
move by one system grid size (8,16) in all cases. The snap to grid option value is
not considered.

Reference: The Snap to Grid setting can be made by the procedures below.

[Screen] menu - [Property] - [Grid] button

[Screen] menu - [Grid]

Double clicking on a screen -- [Grid]

Right-clicking on a screen -- [Property] -- [Grid] button

6-1-5 Copying, Cutting, Pasting, and Deleting Elements
The operations for copying, cutting, and pasting elements using the clip board,
and also the operation for delete an element, are described below.

Copying and pasting elements

The procedure for copying an arranged element to the clip board then pasting it
at another position in the screen is shown below.

The attributes set for the copy source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element copied to the clip board can be used for pasting as many times as
desireduntil another element is copiedor cut. Pastinga copiedelement to anoth-
er screen is also possible.
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(1) Select an element.

(2) Select [Edit] (menu bar), then select [Copy].

This operation is also possible using the pop-up edit menu; display the pop-
up editmenu by right clicking themouse on the element and select [Copy] in
the menu.

(3) Select [Edit] (menu bar), then select [Paste].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse and select [Paste] in the menu.

Copied element is pasted at the
upper left section of the screen.

Reference: S If multiple data creation screens are displayed, an element can bemoved over
to another data creation screen by dragging it.
If Ctrl key is being pressedwhile dragging, an elementwill be copied instead of
being moved.

S If twoSupport Tools are startedup, copy, cut, paste anddrag&dropoperations
can be performed between Support Tools.
For details, refer to 3-3-6 Importing Components from Different Screen Data
File (Starting Up the Second Support Tool).

Cutting and pasting elements

The procedure for cutting an arranged element to the clip board then pasting it at
another position in the screen is shown below.

The attributes set to the cut source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element cut to the clip board can be used for pasting as many times as de-
sired until another element is copied or cut. Pasting a cut element to another
screen is also possible.

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Edit] (menu bar), then select [Cut].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse on the element and select [Cut] in
the menu.

(3) Select [Edit] (menu bar), then select [Paste].
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This operation is also possible using the pop-up edit menu; display the pop-
upeditmenuby right clicking themouseon the element and select [Paste] in
the menu.

Cut element is pasted at the
upper left section of the screen.

Reference: S If multiple data creation screens are displayed, an element can bemoved over
to another data creation screen by dragging it.
If Ctrl key is being pressedwhile dragging, an elementwill be copied instead of
being moved.

S If twoSupport Tools are started up, copy, cut, paste are drag& drop operations
can be performed between Support Tools.
For details, refer to 3-3-6 Importing Components from Different Screen Data
File (Starting Up the Second Support Tool).

Deleting an element

The procedure for deleting an arranged element is described below.

Since the delete operation does not store the element in the clip board, the de-
leted element cannot be restored by the paste function.

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Edit] (menu bar), then select [Delete].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse on the element and select [Delete]
in the menu.

Moving an overlapped element to the front or back

If multiple elements are overlapped, it is possible to move a selected element to
the front or back of other elements. This command is valid between same kinds
of elements only.

Therefore, it is not possible to change the laying order of touch switch and lamp,
for example.
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(However, it is effective between different shapes of fixed display since they are
treated as one kind.)

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Draw] (menu bar), then select [Bring to Front] or [Send to Back].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse on the object and select [Bring to
Front] or [Send to Back] in the menu.

Choose [Bring to Front] tomove the selected element to the foreground and
[Send to Back] to move it to the background.

Undoing the operation

The Undo function will undo or cancel the last (most recent) action that was per-
formed. Ten times of Undo can be performed.

It is invoked by:

Menu bar: [Edit]→ [Undo]

Draw bar: Click on

Redoing the operation

The Redo function will repeat the last (most recent) action that was performed.
Ten times of Redo can be performed.

It is invoked by:

Menu bar: [Edit]→ [Redo]

Draw bar: Click on

6-1-6 Aligning Elements
Two or more elements can be aligned collectively.
There are following six functions for alignment. The buttons below are provided
on the alignment bar.

S Align Top: (Short cut key: Ctrl + Up Arrow)

S Align Bottom: (Short cut key: Ctrl + Down Arrow)

S Align Left: (Short cut key: Ctrl + Left Arrow)

S Align Right: (Short cut key: Ctrl + Right Arrow)

S Center in a Column: (Short cut key: Ctrl + F9)
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S Center in a Row: (Short cut key: Ctrl + Shift + F9)

These functions canalign theelements to theextremely edge in the selectedele-
ments’ range or to the vertical/horizontal center of all the selected objects.

Align Top, Align Bottom, Align Left, Align Right

Align
Top

Align
Bottom

Align Left

Align Right

Center in a Column, Center in a Row

Center
in a
Row
Center in a Column

However, if a touch switch (including elements, such as thumbwheels, alarm
lists/histories, that contain touch switches within themselves) is included in the
selected elements, the touch switch will take precedence for alignment and the
other elements will be aligned to the touch switch as follows:

Example: Align Bottom, Align Right

Align
Bottom

Align
Right

Base line for
“Align Bottom”

Base line for
“Align Right”

Reference: S Alignment function can be used also in the Edit Object mode. By using this
function in this mode, position of the lamp/touch switch label or image/library
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for image/library lampON/OFFstatus canbealignedeasilywithin theelement.
If alignment function was used in Edit Object mode, only the selected element
will bemoved (Alignment is performed towards thewhole area of the element).

S Touch switches may not be aligned to the center properly when “Center in a
Column”or “Center in aRow” is performedbecauseof thedefined touchswitch
grid size. (They will be aligned to the nearest center.)

S If alignment function is performed when the filter function is activated, the filter
function will be cancelled.

(1) Select multiple elements to be aligned
Or: select oneelement that consists ofmultiple elements andspecify theob-
jective part after entering the Edit Object mode.

(2) Specify any of the aligning method after selecting [Align] from the [Edit]
menu.
Or: right-click the mouse and specify the aligning method after selecting
[Align] from thepop-upmenu. (Short cut key canalsobeused.Refer to page
114.)

6-1-7 Grouping Elements
It is possible to group multiple elements into one element.

When creating a graphic by combining several elements, future editing such as
copying, pasting, and moving will be facilitated if they are grouped.

Grouped elements can be returned to individual elements by ungrouping them.

In thegroupedstate, it is not permissible to change theelement sizeandproperty
settings. To change the size or set properties, ungroup the elements.

Reference: When saving screen data using mmi format, grid setting information and group-
ing information will not be stored.
(Refer to 3-3-3 Saving the Screen Data (Application) File. )

Grouping

(1) Specify the elements to be grouped.

(2) Select [Draw] (menu bar), then select [Group].

This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse and select [Group].

Ungrouping

(1) Select an element in the grouped elements. (Select only one grouped ele-
ment).

(2) Select [Draw] (menu bar), then select [Ungroup].
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This operation is also possible using the pop-up edit menu; display the pop-
up edit menu by right clicking the mouse and select [Ungroup].

6-1-8 Associating Elements with the Touch Switch
If the cursormove touch switch has been created independently later than a cer-
tain element, this touch switch has to be associated with this element in order to
specify the data input field when the touch switch has been pressed on PT.
For NT30, NT30C, NT620S, NT620C, NT625C, it is possible to associate the
control code input touch switches (page and line scroll touch switches) with the
alarm list and history.
It is also possible to disassociate the touch switch with the elements.

Reference: S If the Auto Arrange check box is ticked in the Setting property of cursor move
touch switch, the cursormove touch switchwill always bemoved together with
the attacheddata input object. So, it is not possible tomoveor resize the cursor
move touch switch itself independently. To move or resize it, first of all cancel
the Auto Arrange check box, then move or resize it.

S For the NT21, NT31, NT31C, NT631, and NT631C, the touch switch of trend
graph and alarm list/history is built into each element. It is only possible to
change the location of the touch switch. (Size cannot be changed.)

Association

(1) Select the touch switch that you want to associate. (Select only one ele-
ment.)

The touch switches that can be associated to an element should be page or
line scroll touch switch.

(2) Select [Associate With...] from the [Draw] menu.

Dialog box that prompts the user to select the elements to be associatedwill
be displayed.

(3) Choose the data input or Alarm that you want to associate. Then click

.

Disassociation

(1) Select the touch switch youwant to disassociate. (Select only one element.)

(2) Select [Disassociate] from the [Draw] menu.

Touch switch disassociation will be performed.

6-1-9 Centralizing the Label of Lamp and Touch Switch
With the Support Tool, the label of lamp/touch switch can be centralized within
the element (both vertical and horizontal directions). This function is useful, for



6-1SectionCommon Operation

118

example, when the label is edited after the creation of lamp/touch switch. Touch
switch has two kinds of areas, one is the displayed figure and the other is the
touch sensing area. “Centralize Label” is performed toward the touch sensing
area.

(1) Select the lamp/touch switch you want to centralize.
Multiple selection is also possible. However, “Centralize Label” cannot be
performed if no lamps or touch switches are included in the selected ele-
ments.
“Centralize Label” can be performed alsowhen elements other than lampor
touch switch are included in the selected elements. (Nothing is performed
for elements other than lamp or touch switch)

(2) Select [Centralize Label] from the [Draw]menu, or click on the button. (or

press Ctrl key + L)

Reference: S Centralization of lamp/touch switch label can be also performed by alignment
function (Center in a Column) in Edit Object mode. However, the result may
differ since the alignment function is performed towards the whole lamp/touch
switch area.

S If “Center in a Row” is performed for a label in Edit Object mode, the label is
centralized vertically.

S If “Center in a Column” is performed for a label in Edit Object mode, the label is
centralized horizontally.

S By selectingmultiple lamps/touch switches, you can center labels collectively.

6-1-10 Setting Properties
For each element, properties are set to characterize the individual elements. Ba-
sically, following two types of properties are set.

S General

General settings such as display color and character size.

S Settings (only for elements that have a specific function)

Settings related to data conversion, such as PC (PLC) address and memory
table address.

In addition to the properties shown above, some elements have the following
properties.

S Light Function (only for lamps and touch switches)
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Setting of bits (lamp bits) for control that are used when changing display.

S Label (only for lamps and touch switches)
Setting of label that is displayed on lamps or touch switches.

S Interlock (only for touch switches, numeral input, string input, thumbwheel and
recipe in the NT21 and NT31/631-V2 and above)
Setting of interlock bit that is used for controlling whether the corresponding
object is enabled/disabled.

S Logging (Data Logging property) (only for trend graph)

Setting of the data logging function that records data.

The following explains only the basic settings. For details of the properties of
each element, refer to 6-2 Fixed Display and later sections.

Displaying the Property Setting Dialog Box

The property setting dialog box is displayed in any of the following operations.

S Using the mouse (1)

(1) Double click an element.

S Using the mouse (2)

(1) Right click the mouse on an element, then select [Properties...].

S Using the menu

(1) Specify the element for which you want to display properties (specify only
one element).

(2) Select [Draw] (menu bar), then select [Properties].

S Using the keyboard

(1) Specify the element for which you want to display properties (specify only
one element).

(2) Press the Enter key while holding down the Alt key.

Setting the line type

You can select the type of line for polylines, broken-line graphs, and trend
graphs.

Dot-dot-dashSolid Dash Dot-dash

The line type is set in a property of individual elements.

Setting the display color

Set the display color of elements.

Color setting is possible with NT30C, NT31C, NT620C, NT625C, and NT631C.

The colors that can be used are shown below.

White, black, blue, red, magenta, green, cyan, yellow

For some elements, [Transparent] may be specified to display a transparent
background. Note that [Transparent] can be specified only for the elements
shown below.

S Background of fixed display text (Either foreground or background has to
be other color.)
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S Background of label of lamps and touch switches

S OFF state color of lamps and touch switches

S Background of element tiling patterns

S Setting the color for text and numerals

For text and numerals, color setting is possible both for characters and back-
ground.

Foreground: Specify the color of text and numerals.

Background: Specify the color for the background of text and numerals.
If [Transparent] is specified, elements arranged behind text is
visible.

Background color

Foreground color

S Setting the color for graphics

For a graphic, the foreground color can be set.

Foreground: Specify the color of lines in a graphic and the color of the graphic
itself when the attribute is set to Inverse.

Foreground color

Reference: Color setting is possible only for color-type PT.
However, with NT30, the NT21, and NT31, setting of white and black (and trans-
parent) is possible.

S Setting the tiling color

When tiling a graphic, color designation is possible for the foreground, back-
ground, and border.

Foreground: Specify the tiling color.

Background: Specify the background color of tiling (color visible throughblank
areas in the selected pattern). If [Transparent] is specified, the
background becomes transparent, and elements arranged be-
hind text and numerals are visible.

Border: Specify the border color of tiling area.

Background

Foreground

Border

Available tiling patterns are shown below.

When tiling a graphic, the color of border should be set to the same color as set
for graphics that surround the tiling element. If a different color is specified, or
there is a gap in the border, the tiling fills out the specified area.
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Reference: The Color Palette Symbol for which tiling patterns and color combinations are
registered is suppliedwithSupport Tool as symbol data. Using color palette sym-
bol enables you to register required tiling objects on screen while checking their
display status. Color palette symbol does not have transparent background pat-
terns.Border colorsare set to ‘White’.Change thesettingas requiredwhenusing
it. For details, refer to 6-10-5 Operating Procedure of Color Palette Symbol.

S Setting the color for lamps and touch switches

Whenspecifying thecolor for lampsand touchswitches, it is possible to specify
the color for the frame, color when ON, and color when OFF.

Frame: Specify the frame color if an element is displayed with a frame.

ON: Specify the color that represents the lamp/touch switch ON status.

OFF: Specify the color that represents the lamp/touch switch OFF status.

If a lamp or a touch switch is set to flash, the ON color and OFF color are dis-
played alternately.

Lamp/touch
switch ON

ON color

Frame

Lamp/touch
switch OFF

OFF color

Lamp/touch
switch flashing

ON color

Frame

OFF color

S Setting graph colors

When setting the color for bar graphs, analogue meters, broken-line graphs,
and trendgraphs, specification is possible for the frameof thegraph,+ range, --
range, line (foreground), and scale.

Frame: Specify the color of the graph frame.

+ Range: Specify the background color of the graph, to be applied when the
numeric value is positive.

For abar graph, thebar is displayed in thespecified color in thepos-
itive range.

-- Range: Specify the background color of the graph, to be applied when the
numeric value is negative.

For a bar graph, the bar is displayed in the specified color in the
negative range.

Line-Color (Foreground color): Specify the line color of broken-line graphs
and trendgraphs,and foregroundcolor for
present value of analogue meters.



6-1SectionCommon Operation

122

Scale Color: Specify the scale color of analogue meters.

Foreground color

Scale color+range

--100%

--100%

--100%

--100%--100%

100%

100%

100%

100%100%

0%0%

0%

0%0%

--range

--range--range

+range+range

Frame
color

Frame color

<Trend graph><Broken-line graph>

<Analogue meter><Bar graph>

Frame color
Frame color

+range--range

Settings for text display

Set the size and display attributes for displaying fixed display of text and charac-
ter strings in a character string memory table (string table) in the manner shown
below.

The following shows only the common settings for text of fixed display.

As an example, the properties for a text display (fixed display) are shown below.

Font Type

Specify the font type for displaying alphanumerics and symbols.

Standard: A character is displayed in standard font (16×8 dots).

Half Height: A character is displayed in half-height font (8×8 dots).

Half height Standard
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Scale

Specify the character size. (Only 1×1 (Equal) and 2×1 (Wide) can be set for
NT11S.)

1×1 (Equal): A character is displayed in the original size both in height and
width.

1×2 (High): A character is displayed with doubled height and the original
width.

2×1 (Wide): A character is displayed with the original height and doubled
width.

2×2: A character is displayed with doubled height and width.

3×3: A character is displayed with threefold height and width.

4×4: A character is displayed with fourfold height and width.

8×8: A character is displayed with eightfold height and width (not
possible for NT20S).

1×1 1×2 2×1 2×2 3×3 4×4 8×8

Reference: With the NT21 and with the NT31, NT31C, NT631, NT631C “-V1” and above,
characters of 2×2or larger scale are automatically displayed in 32 dot high-defi-
nition font. (Marks inserted into a string are always displayed in 16×16 dot font.)
32 dot font and font type ISO 8859-1 are not available on PT when system pro-
gramsof “-V1” typeandabove,were installed forNT31,NT31C,NT631,NT631C
below “-V1,” even though other functions will be same as “-V1” and above type.
Therefore, in this case, characters of 2 x 2 or larger scale are displayed in 16 dot
font for PT, while they are displayed in 32 dot font for Support Tool. Also,
ISO8859-1 font type can not be used for PT, CP437 font type is applied.

Smoothing

Smoothingprocessingallows jags tobe smoothedwhenacharacter is displayed
in an enlarged scale.

Selection of this item is possible for characters of 2×2 or larger and for marks
(16×16 dots). (With the NT21, NT31, NT31C, NT631, and NT631C, smoothing
is not performed for marks.)

Smoothing cannot be selected for NT20S andNT600S since smoothing proces-
sing is always executed for characters larger than 2×2 with these models.

Without smoothing With smoothing

Attribute

This is an attribute to determine how text is displayed. Attributes to be displayed
here vary somewhat according to the PT model.
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Standard: Text is displayed in the specified color and specified back-
ground color.

Inverse: Text and background are displayed in colors that are the re-
verse of the specified colors.

Flash: Text flashes when displayed. If this attribute is selected, stan-
dard display and no display (background color only) are alter-
nately displayed.

Inverse Flash: Text is displayed by alternating standard display and inverse
display.

Reference: To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate
Flash] from the [View] menu. (For details, refer to 5-1-3 Changing the Display
Method on the Support Tool.)

Settings for numeral display

Set the size and display attributes for displaying numeric values of numeral table
data and percentage values in a graph in the manner shown below.

The following shows only the common settings for numeral display.

As an example, the properties of a numeral display are described below.

Font Type

Specify the font type.

Standard: A numeric value is displayed in the standard font (16×8 dots).

Half Height: A numeric value is displayed in the half-height font (8×8dots).

Double Width: A numeric value is displayed in the double-width font (16×16
dots).

StandardHalf height

Scale

Specify the character size. (Only 1×1 (Equal) and 2×1 (Wide) can be set for
NT11S.)

1×1 (Equal): A numeric value is displayed at the original size both in height
and width.
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1×2 (High): A numeric value is displayed with doubled height and original
width.

2×1 (Wide): A number is displayed at the original height and doubledwidth.

2×2: A numeric value is displayed with doubled height and width.

3×3: A numeric value is displayed with threefold height and width.

4×4: A numeric value is displayed with fourfold height and width.

8×8: A numeric value is displayed with eightfold height and width
(not possible for NT20S).

1×1 1×2 2×1 2×2 3×3 4×4 8×8

Reference: With theNT21andwith theNT31,NT31C,NT631,andNT631C“-V1” andabove,
numbers of 2×2 or larger scale are automatically displayed in 32 dot font.

Smoothing

Smoothing processing allows jags to be smoothed when a number is displayed
in an enlarged scale.

Selection of this item is possible, for numbers of 2×2 or larger.

Smoothing cannot be selected for NT20S andNT600S since smoothing proces-
sing is always executed for numbers larger than 2×2 with these models.

Without smoothing With smoothing

Attribute

This is an attribute to determine how a numeric value is displayed. Attributes to
be displayed here vary somewhat according to the PT model.

Standard: The numeric value is displayed in the specified color and spe-
cified background color.

Inverse: Thenumeric valueandbackgroundaredisplayed in colors that
are the reverse of the specified colors.

Flash: The numeric value flashes when displayed. If this attribute is
selected, standard display and no display (background color
only) are alternated.

Inverse Flash: Thenumeric value is displayed by alternating standard display
and inverse display.



6-1SectionCommon Operation

126

Reference: To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate
Flash] from the [View] menu. (For details, refer to 5-1-3 Changing the Display
Method on the Support Tool.)

Display Type

Specify the notation in which numeric values are displayed.

Decimal: Numeric value is displayed in decimal.

Hexadecimal: Numeric value is displayed in hexadecimal.

Thedisplaywill differ according to the specified notationeven if the samecontent
is displayed.

Decimal Hexadecimal

Format

Specify the number of digits in the integer part and decimal fraction part.

Integer: Specify the number of digits entered in the integer part.

Decimal: Specify the number of digits entered in the decimal fraction
part.

Integer part Decimal part

Zero Suppression

Specify whether leading zeros should be suppressed.

Ticked: Leading zeros are suppressed.

Not ticked: Leading zeros are not suppressed.

Without zero suppression With zero suppression

Display Sign

Specify if a sign (–) is displayed.
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When a negative numeric value is displayed with this item selected, a negative
sign “–” is displayed preceding a numeral. Since this sign is included in the num-
ber of digits in the integer part, themaximumdigit number is reduced by 1.When
this item is not selected, a negative numeric value is displayed as an absolute
value.

Ticked: Numeric values are displayed without a sign.

Not ticked: Numeric values are displayed with a sign.

Without a sign With a sign

Reference: Howanumeric value is displayedaccording to the setting for [Integer], [Decimal],
[Zero Suppression], and [Display Sign] is shown below.

Integer Decimal Zero
Suppression Display Sign

Data Stored
in Numeral

Table

Display on
the Screen

3 0 Not ticked Check mark not set 12 012

3 0 Not ticked Check mark not set –12 012

3 0 Ticked Check mark not set 12 12

3 0 Ticked Check mark not set –12 12

3 0 Ticked Check mark set 12 12

3 0 Ticked Check mark set –12 –12

3 1 Not ticked Check mark not set 1 000.1

3 1 Not ticked Check mark not set –12 001.2

2 1 Not ticked Check mark set 1 00.1

2 1 Not ticked Check mark set –12 –01.2

2 1 Ticked Check mark set 1 0.1

2 1 Ticked Check mark set –12 –1.2

*: With conventional PTmodels, negative numeric value data is prefixed by F.
For example, –12 is set as F0000012.
With the NT21, NT31, NT31C, NT631, and NT631C, numeric values are
stored as signed binary data.

Word setting for an element

Specify the PC (PLC) address used for reading and writing by an element such
as memory table entry, lamp, or touch switch.

For a numeral or character string memory table entry (string table), specify the
lower address or the least significant address of the word to be referred to.

For a lamp, a touch switch, or a bit memory table entry, specify the allocated bit
number.

When specifying a bit, specify the address of the word and the bit position in the
word that is referred to

Note that, timer (TIM) and counter (CNT) cannot be set for bits or character string
words.

S Using PLC address setting dialog box

Normally, a button for displaying thePLC address setting dialog is provided for
PLC address input field.
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In the dialog, PLC address can be set easily by selecting from the available
areas.

Example: Numeral table
(PLC Vendor : OMRON)

Example: Touch switch
(PLC Vendor : OMRON)

Channel (Word)

Select the type of word to be referred to from the list box.

Address

Input the address of word to be referred to.

Bit

Input the bit position in the word to be referred to.

Direct input of PLC address

It is possible to input PC (PLC) address, for example D00001, directly into the
address input field. You can input addresses easily when you knowwhich area is
available.

When inputting PLCaddresses, input aword address and a bit numberwithout a
blank following a character that indicates area type.However, in case of numeral
table or string table, specification of bit number is not needed.

When you do not specify PLC address, input “- -” into the input field.

Input methods varies according to the PLC Vendor setting as listed below. Only
input method is described here. For details on specification method of PLC ad-
dress for PLC other than OMRON, refer to PC Connection Operation Manual
(V042-E1-j).

PLC Vendor: OMRON

Possible areas and characters that indicate area type are as follows:

Character Area Type Word Bit

None Common I/O Area f f

H HR Area f f

A AR Area f f

L LR Area f f

T Timers f ×
C Counters f ×
D Data Memory Area f f

E EM Current Bank f f

E1 EM Bank 1 f1 f1

E2 EM Bank 2 f1 f1

E3 EM Bank 3 f1 f1

E4 EM Bank 4 f1 f1

E5 EM Bank 5 f1 f1
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Character BitWordArea Type

E6 EM Bank 6 f1 f1

E7 EM Bank 7 f1 f1

E8 EM Bank 8 f1 f1

E9 EM Bank 9 f1 f1

EA EM Bank A f1 f1

EB EM Bank B f1 f1

EC EM Bank C f1 f1

ED* EM Bank D × ×
EE* EM Bank E × ×
EF* EM Bank F × ×
CU Count Up Flag × f1

TU Time Up Flag × f1

W Work Area f1 f1

TK Task Flag × f1

* EMBank D, EMBank E, EMBank F are not available since these are reserved
words.

1 Only available for the NT21 and the NT31/631-V2 and above models.

f: Specification possible ×: Specification not possible

With NT11S, NT20S, NT30, NT30C, NT600S, NT620S, NT620C and NT625C:
Input aword address as a 4-digit number (leading zeros canbe suppressed) and
a bit number as a 2-digit number.

With NT21, NT31, NT31C, NT631 and NT631C:
Input aword address as a 5-digit number (leading zeros canbe suppressed) and
a bit number as a 2-digit number.

PLC Vendor: MEMLINK

Possible areas and characters that indicate area types are as follows:

Character Area Type Word Bit

None Memory Link Area f f

f: Specification possible ×: Specification not possible

Input aword address as a 4-digit number (leading zeros canbe suppressed) and
a bit number as a 2-digit number.

PLC Vendor: Mitsubishi_A

Possible areas and characters that indicate area types are as follows:

Character Area Type Word Bit

X Input Relay f f

Y Output Relay f f

M Internal Relay f f

L Latch Relay f f

B Link Relay f f
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Character BitWordArea Type

C Counter f ×
T Timer f ×
D Data Register f f

R File Register f f

W Link Register f f

f: Specification possible ×: Specification not possible

Input aword address as a 4-digit number (leading zeros canbe suppressed) and
a bit number as a 2-digit number.

PLC Vendor: Mitsubishi_Fx
Possible areas and characters that indicate area types are as follows:

Character Area Type Word Bit

X Input Relay f f

Y Output Relay f f

M Auxiliary Relay f f

S State f f

C Counter f ×
T Timer f ×
D Data Register f f

f: Specification possible ×: Specification not possible

Input aword address as a 4-digit number (leading zeros canbe suppressed) and
a bit number as a 2-digit number.

PLC Vendor: AB

Possible file types and characters are as follows (available only for NT31/631
models):

Character File Type File/Slot
Number

Element/
Word
Number

Sub-Ele-
ment

Number

Bit/Termi-
nal Num-

ber

B Bit f f × f

C Counter × × f f

N Integer f f × f

R Control f f f f

S Status f f × f

T Timer f f f f

Character File Type Slot Number Word
Address

Bit/Terminal
Number

I Input f f f

O Output f f f

f: Specification possible ×: Specification not possible

Input a file number as a 3-digit number (leading zeros can be suppressed), ele-
ment number or word address as 3-digit number, sub-element number as 1 digit
and bit number as a 2-digit number.
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PLC Vendor: GE

Possible memory types and characters are as follows (available only for
NT31/631 models):

Character Memory Type Data Offset

R Register f

AL Analog Input f

AQ Analog Output f

I Discrete Input f

Q Discrete Output f

T Discrete Temporary f

M Discrete Internal f

S System Status f

SA System Status A f

SB System Status B f

SC System Status C f

G Genius Global Data f

f: Specification possible ×: Specification not possible

Input a Data Offset as a 4-digit number (leading zeros can be suppressed).

PLC Vendor: Siemens

Possible memory types and characters are as follows (available only for
NT31/631-V1 models):

Character Memory Type Address Bit

C Counter f ×
DB Data Block f f

I Input f f

IW Input f ×
M Bit Memory f f

MW Word Memory f ×
Q Output f f

QW Output f ×
T Timer f ×

f: Specification possible ×: Specification not possible

Input a address number as a 4-digit (5 digit in case of DB) number (leading zeros
can be suppressed) and a bit number as a 1-digit number.

Batch address change operation

The set PC (PLC) addresses can be changed into the required addresses in a
batch. Since the change source can be specified as a range, processing such as
changing the address range DM 1000 to DM 01499 to the address range
DM 1800 to DM2299 is possible at one time. Shifting in bit units is also possible.

Reference: Batchaddresschangeoperation ispossibleusingeither thedialogboxdisplayed
by [Tools]→ [Table...] or the function called by [Tools]→ [Change Address]. De-
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pending on how the address change operation is called, the objective addresses
differ -- in the operation using the edit dialog box of thememory table, addresses
in the table being edited are objective while all addresses in the entire screen
data are objective of the operation if the operation is performed using the [Tools]
menu.

The explanation below is given for the batch address change operation where
the entire screen data is the objective of the operation. For the procedure to per-
form the operation using the edit dialog box of the memory table, refer to 7-1-3
Batch Address Change Operation.

S Description of batch address change dialog box

Find -- Channel (Word)

Specify the channel type of the batch change source.

Find -- Start Range

Specify the start address of the source range for the batch address change.

Find -- End Range

Specify the end address of the source range for batch address change.

The address to be set for [End Range] must always be larger than or equal to
the address set for [Start Range].

Change to -- Channel (Word)

Specify the word type, and start address, after the change.

Addressesare changedwithin thenumber of specified points from the start ad-
dress (number of points from “Start Range” to “End Range”).

Change Comment

Specify whether or not the same I/O comment appended to an address before
the change is appended to the address after the change.

To append the same I/O comment, click on the check box to display a check
mark in it.

Batch address change processing starts when you click on this button.

S How addresses are changed

In the operation for changing addresses in bit units, processing is executed as-
suming that bit 15 of a word is immediately followed by bit 0 of the next word.

Addressesarechangedasshownbelowaccording to theset search rangeand
the address after the change.
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Example: Bit memory table entry

15 10 0

[Change To] -- [Address]
(start address after the change)

Address and Bit set
for [Start Range]

CIO area Word 0CIO area Word 1

Bit 15 0

Address and Bit set
for [End Range]

15 0Bit 15 0

HR area Word 10HR area Word 11

Before change After change

0000010 H0001000

0000012 H0001002

0000100 H0001006

0000110 H0001100

0000115 H0001105

S Operation procedure

(1) [Tools] (menu bar)→ [Change Address]

(2) Select the type of word before the change in the [Channel] box.

(3) Specify the range of the change by setting addresses at the [Start Range]
and [End Range] boxes.

(4) Specify the word and the address after the change in the corresponding
boxes in the [Change To] area.

(5) Set a check mark in the Change Comment check box as desired.

If a check mark is set in this check box, I/O comments appended to the ad-
dresses before the change are also appended to the addresses after the
change.

(6) Click on .

Setting the current object status as the existing value

Register the status of the selected object as theexisting valueof the samekindof
object. This feature allows the status of the object, when it is registered to the
screen, to be changed, eliminating the operation steps to modify the property of
the object.

Note that the PC (PLC) address and reference memory table entry cannot be
registered as the existing value.

(1) Specify the object to be registered as the existing value (select only one ob-
ject).

(2) [Draw] (menu bar)→ [Use as Default] (Or select [Use as Default] from pop-
up edit menu)
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The current set status of the specified object is registered as the existing val-
ue of the same kind of object.

6-1-11 Relationships between Elements and Memory Tables
The relationships between elements and memory tables are shown below.

When creating an element, attend carefully to thememory table address, capac-
ity, etc.

F: Reading from a memory table
f: Writing to a memory table

Numeral Memory
Table

Character String
Memory Table
(String Table)

Bit Memory Table

Numeral display F – –

Bar graph F – –

Analogue Meter F – –

Broken-line graph F – –

Trend graph F – –

Numeral setting
+ Touch switch (for inputting control code)*1 f – –

Numeral setting
+ Touch switch (for copy setting)*1 f – –

Numeral setting
+ Touch switch (for numeral input)*1 f – –

Thumbwheel switch f

Alarm list – F F

Alarm history – F F

Character string display – F –

Character string setting
+ Touch switch (for character string input)*1 – f –

Character string setting
+ Touch switch (for inputting control code)*1 – f –

Character string setting
+ Touch switch (for copy setting)*1 – f –

Standard lamp*4 – – –

Image lamp*2 – – –

Touch switch (for notifying input)*4 – – –

*1: Numeral setting and character string setting are used in combination with a
touch switch.

*2: A standard lamp and an image lamp reads the specified PC (PLC) bit direct-
ly without using a memory table.

*3: A touch switch (for notifying input) directly drives the specified PC (PLC) bit
ON/OFF without using a memory table.

*4: When a Numeral Display or a String Display is specified as the label type,
the specified memory table will be read. (Only for NT21 and NT31/631-V2
and above)

6-1-12 Interlock
By setting the Interlock flag, the interlock facilitywill be activated for touch switch/
thumbwheel/numeral input/string input and recipe.When interlock is set, the cor-
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responding object will be enabled/disabled according to the interlock bit: when
the PLC Address set on the Interlock address is ‘ON’ the touch switch/thumb-
wheel/numeral input/string input will work; if the address is ‘OFF’, the touch
switch/thumbwheel/numeral input/string input will not respond to the touches.

The interlock functionality is supported for the PT models NT21 and
NT31/631-V2 and above. The temporary input object does not support interlock
function.

Operation procedure

Select the Interlock tab on the property sheet of the screen object that supports
Interlock.

Property setting

This property pagewill be the same for all other supported objects. Only the cap-
tion will be changed according to the object.

Interlock Check Box

To ON/OFF interlock. By default it is OFF.

PLC Bit Address

To specify the bit address associated with Interlock. Interlock is ON, if this bit is
set, OFF otherwise.

IO Comment

I/O Comment for the address specified.

Conversion

For conversions due to cut/copy/paste, drag/drop of screen elements with inter-
lock settings (e.g. Touch Switch, Thumbwheel, Numeral Input, and String Input)
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from the NT21 and NT31/631-V2 and above to previous PT models, interlock
settings will be discarded as they are not being supported.

In the case of copy/paste of screen elements, drag/drop of screen elements as
well as application conversion:

Target PT model sup-
ports Interlock

Original screen ele-
ments support Interlock

Remarks

Yes No Interlock Flag will as-
sume FALSE.

No Yes Interlock Flag will be
set to FALSE and ig-

nored.

No No No conversion required.

Yes Yes No conversion required.

Reference

This feature is used by Touch Switch, Thumbwheel Switch, String Input and Nu-
meral Input.

6-2 Fixed Display
Fixed display means graphic data that does not have the data communication
function with a PC and a memory table.

Set only general properties.

Reference: Rotation and other processing are not possible for the fixed display. For image
data, rotation and inverse are possible during creation of the image data.

6-2-1 Polyline

A straight line is drawn.

Polylines cannot be used with NT11S.

(1) A continuous line is drawn and changed into a required shape.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Polyline]

Selection using the drawing toolbar:

Reference: To draw a continuous polyline, press the Shift key when the drag operation is fin-
ished. Dragging this end point creates a continuous polyline.
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Terminology

Vertex

Vertex

Property setting

General

Line Style: Specify the type of line
Solid line, dotted line, alternate short and long lines, alternate
two short and long lines

Attribute

Standard, Flash (Flash can be set only for the NT21, NT31, NT31C, NT631,
and NT631C)

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S For line type, the following four choices are provided.

Dot-dot-dashSolid Dash Dot-dash

The line type is specified using the line style property.

S When creating a polyline, draw a continuous line first, then add vertices in the
edit operation to change thedrawncontinuous line into thedesired broken line.

Vertices can be set at up to 254 positions.

S To add a vertex, follow the steps shown below.

(1) Draw a continuous line.

(2) After locating the cursor at a position where a vertex is to be added, right
click the mouse and select [Add Node] in the pop-up menu.
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(3) Drag the vertex to the desired position.

Cursor position

[Remove Node]
executed

S To remove a vertex, locate the cursor on the vertex to be removed and select
[Remove Node] in the pop-up menu.

6-2-2 Arc
An arc is drawn.

Arcs cannot be used with NT11S, NT20S and NT600S.

(1) An arc is drawn. The radius of an arc can be changed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Arc]

Selection using the drawing toolbar:

Terminology

Center point

End point

Start point

Property setting

General

Position

Center point: Indicates the position of the center of an arc.

Start point: Indicates the position of the start point of an arc.
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End point: Indicates the position of the end point of an arc.
An arc is drawn anti-clockwise from the start point to the end
point.

Size: Indicates the radius of an arc.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S An arc is defined by the center point, the start point, and the end point

The line type is specified using line style attribute.

Center point: Indicates the position of the center of an arc.

End point: Indicates the position of the end point of an arc.
The end point can be dragged to the desired position.

Start point: Indicates the position of the start point of an arc.
When the start point is dragged, the start point position and
arc
radius are changed.

6-2-3 Rectangle

A rectangle is drawn.

Rectangles cannot be used with NT11S, NT20S and NT600S.

(1) A rectangle is drawn. The length of a vertical and horizontal sides can be
changed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→
[Rectangle]

Selection using the drawing toolbar:
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Terminology

Position

Property setting

General

Position: Indicates the display position of a rectangle.

Size: Indicates the size of a rectangle.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S A rectangle element can be modified in the manner shown below.

A rectangle can be modified by dragging a green J mark (handle).

Modified in the
upper left direction

Modified in the
left direction

Modified in the
lower left direction

Modified in the
lower direction

Modified in the
upper direction

Modified in the
upper right direction

Modified in the
upper left direction

Modified in the
right direction

Modified in the
lower right direction

S To tile a rectangle, paste a tiling element into it.

Rectangle

Tiling element

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-4 Circle
A circle is drawn.
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Circles can be used with all models except for NT11S.

(1) A circle is drawn. The radius of a circle can be changed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Circle]

Selection using the drawing toolbar:

Terminology

Center point

Property setting

General

Position

Center point: Indicates the position of the center of a circle.

Size: Indicates the radius of a circle.

Attribute: Specify the display attribute. (Setting is not possible with NT20S
and NT600S) Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S A circle element can be modified in the manner shown below.

A circle can be modified by dragging a green J mark (handle).



6-2SectionFixed Display

142

Note that a circle cannot be deformed to an oval.

For modification in the
lower right direction

For modification in the
upper left direction

For modification in the
lower left direction

For modification in the
upper right direction

S To tile a circle, paste a tiling element into it.

Tiling element

Circle

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-5 Polygon
A polygon is drawn.

Polygons cannot be used with NT11S, NT20S and NT600S.

(1) After a polygon is drawn, it is modified to give the desired shape.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Polygon]

Selection using the drawing toolbar:

Terminology

Vertex (Node)
Vertex

Attribute point

Vertex
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Property setting

General

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Position: Indicates the position of Attribute Point (reference point).

Guidance

S Apolygon is createdon thebasis of a triangle.After a triangle is drawn, vertices
are added in the edit operation to create a polygon.

Vertices can be set at up to 255 positions.

S To add a vertex, follow the steps shown below.

(1) Draw a polygon.

(2) After locating the cursor at a position where a vertex is to be added, right
click the mouse and select [Add Node] in the pop-up menu.

(3) Drag the vertex to the desired position.

S To remove a vertex, locate the cursor on the vertex to be removed and select
[Remove Node] in the pop-up menu.

Cursor position

[Remove Node] executed
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S To tile a rectangle, paste a tiling element into it.

Polygon

Tiling element

For details of tiling elements, refer to 6-2-8 Tiling.

6-2-6 Sector
A sector is drawn.

Sectors cannot be used with NT11S, NT20S and NT600S.

(1) A sector is drawn. The size of a sector can be changed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Sector]

Selection using the drawing toolbar:

Terminology

Center point

End point

Start point

Property setting

General

Position

Center point: Indicates the position of the center of a sector.

Start point: Indicates the position of the start point of a sector.

End point: Indicates the position of the end point of a sector.
A sector is drawnanti-clockwise from the start point to the end
point.

Size: Indicates the radius of a sector.
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Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S A sector is defined by the center point, the start point, and the end point

The line type is specified using line style attribute.

Center point: Indicates the position of the center of a sector.

End point: Indicates the position of the end point of a sector.
The end point can be dragged to a desired position to change
the position of the end point.

Start point: Indicates the position of the start point of a sector.
When the start point is dragged, the start point position and
sector radius are changed.

S When tiling a sector, paste a tiling element in it.

Tiling element

Sector

For details of tiling element, refer to 6-2-8 Tiling.

6-2-7 Text
Text is drawn.

Text can be used with all models.

(1) Text is drawn. Font, size, color, etc. can be changed.

Note Mark data can be inserted into a character string. With the NT30, NT30C,
NT620S, NT620C, NT625C, NT21 and NT31/631-V2 and above with
NT20/30/620-compatible mode set, image data can also be inserted.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Text]

Selection using the drawing toolbar:
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Terminology

Foreground color

Background color

Property setting

General

Description: Set the text to be displayed.

Position: Indicates the position where the text is displayed.

Font type: Specify the font. (Only Standard can be set for NT11S.)
Standard, Half Height

Scale: Specify the character size.
(Only 1×1 (Equal) and 2×1 (Wide) can be set for NT11S.)
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8
(Not for NT20S)

Smoothing: Specify whether smoothing processing is executed for characters
larger than 2×2 scale. (Setting is not possible for NT11S, NT20S
and NT600S. For NT20S, NT600S, smoothing is always ON.)

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the text color.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow (Transparent is available for the NT21, NT31, NT31C,
NT631, NT631C)

Background: Specify the color of the background in the text display area.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

: Select the mark data to be pasted into a character string.

: Select the image data to be pasted into a character string.
(Only for NT30, NT30C, NT620S, NT620C, NT625C, and
NT21 and NT31/631-V2 and above with NT20/30/620 com-
patible mode set.)

Guidance

S The maximum number of characters that can be input (displayed) is:

NT11S: 20 characters

NT20S, NT21: 32 characters
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NT30, NT30C, NT31, NT31C: 40 characters

NT600S, NT620S, NT620C/NT625C, NT631, NT631C: 80 characters

S To display “\”, input two characters without a blank, like “\\”.

S It is possible to insert mark data, image data into a character string.
(For NT20S, NT600S, mark data can be used only in strings.)

Note that insertion of image data is possible only for the NT30, NT30C,
NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible mode),
NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2
(NT20/30/620-compatible mode). Although the NT21, NT31, NT31C, NT631,
and NT631C support image data, it cannot be inserted into a character string.

The procedure for inserting mark data, image data into a character string is
shown below.

(1) In the character string input field,move the cursor ( | ) to themark/imagedata
insertion position.

(2) Select or in the dialog box.

The mark selection dialog box or image selection dialog box is displayed.
Select the mark data, image data to be inserted and click on .

Mark data: FF20 to FFFFH (FF20 to EF5FH for NT11S, NT20S
and NT600S)

Image data: Only for the NT30, NT30C, NT620S, NT620C, NT625C, NT21, and
NT31/631-V2 and above with NT20/30/620-compatible mode
FE20 to FEFFH

Example: Mark data

(3) The code of the specified data is displayed at the data insertion position in
the character string input field.

(4) Click on to close the character string attribute. The setmark data,

image data, or library data is displayed in the character string displayed on
the screen.

6-2-8 Tiling
The closed area of the graphic (inside the border) will be filled with some pattern
and color.
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Tiling cannot be used for NT11S, NT20S and NT600S.

(1) The area inside the border is tiled according to the specified color and pat-
tern.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Tiling]

Selection using the drawing toolbar:

Terminology

Background colorForeground color

Border

Property setting

General

Position: Indicates the position of the tiling element.

Pattern: Specify the tiling pattern.

Color

Foreground: Specify the foreground color of the tiling area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the tiling area.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

Border: Specify the color of the border of tiling area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

S AJ mark (handle) is displayed when a tiling element is selected.

Property setting and tiling element can beedited by selecting theJmark (han-
dle).
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S Tiling is possible for the elements shown below.
Rectangle, circle, polygon, sector

In addition to the elements indicated above, tiling is possible for an area en-
closed by a solid line of the same color (border color). If an element such as a
lamp that changes status is specified for the border, however, tilingmay not be
executed correctly due to changes in color and display.

S To check the tiling status, select [View] (menu bar) then select [Full Tiling]. The
result of tiling will be displayed (in this state, a checkmark is set for [Full Tiling]
in the display menu.).

When [Full Tiling] is selected again, then return to the previousJmark (han-
dle).

Selection of
[Full Tiling]

Selection of
[Full Tiling]

S Toexecute tiling, specify the samecolor for theborder of area and the border of
a tiling element.

Tiling is executed in the enclosed area for which the samecolor as the color set
for the border is set. If an enclosed areawith the same color does not exist, the
tiling extends outside the enclosed area.

S If the tiling area is not an enclosed area, the tiling spills out the specified area.

S The patterns are displayed in the actual status of tiling according to the setting
for the foreground and background color.

The available tiling patterns are shown below.

Reference: S Transparent backgroundcanbeset for tilingobjects.However, it will not bedis-
played as transparent on the Support Tool. When the screen is downloaded to
a PT, it will be displayed as transparent.

(1) Double-click the screen to display the screen property.

(2) Set Red for screen background color.

(3) Register a tiling object on the screen and set Transparent for the back-

ground and for Pattern.

(4) Check ON the [View] -- [Full Tiling] command.

(5) Tilingwill beexecutedand thescreenbackgroundcolor (red)will be invisible
(figure (a) below).

(6) When this screen data is downloaded to aPT, background color for tiling ob-
ject will be transparent (figure (b) below).

It will not be transparent.

(a) Support Tool screen

It will be transparent (red).

(b) PT screen
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S If “Full Tiling” is performed, performance of Support Tool may be slower. In this
case, clear the check mark for [Full Tiling] from the [View] menu.

S [Full Tiling] is automatically cancelled when a filter function is performed for a
Fixed Display.

S TheColor Palette Symbol, for which tiling patterns and color combinations are
registered, is supplied with Support Tool as symbol data. Using color palette
symbol enables you to register required tiling objects on screenwhile checking
their display status. Color palette symbol does not have transparent back-
ground patterns. Border colors are set to ‘White’. Change the setting as re-
quired when using it. For details, refer to 6-10-5 Operating Procedure of Color
Palette Symbol.

6-2-9 Image Object Data
Image data is displayed.

There are two types of image data. One type of image data references the fixed
code directly, the other type uses indirect reference. Indirect reference is a func-
tion that can change the image data to be displayed by writing the image code to
the numeral table just like the indirect reference of numeral/string display. This
enables the animation display by switching the display contents using a simple
program. For details of the PT models that can use indirect reference, refer to
Appendix D Table of Functions of Each PT Model.

Image data cannot be used for NT11S, NT20S and NT600S.

(1) Image data created in the bit map (BMP) format is displayed.

Note Bitmapdatacreatedbygeneral application software runningonWindowscanbe
displayed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→
[Image Display]

Selection using the drawing toolbar:

Terminology

Foreground color

Background color

Property setting
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General

Position: Indicates the display position of image data.
(The reference point is at the upper left corner in the image ele-
ment.)

Size: Indicates the size of image data.

Reference Type

Direct: Set the image code directly.

Code: Indicates the code number of the image data to be displayed.

Mode: Indicates the colormodeof the imagedata (2 colors, 8 colors).

Comment: Displays the comment that is set for the image data.
Indirect: Set this item when the value for the specified numeral table

entry is treated as image code and referenced indirectly.

Table No.: Specify the numeral table entry to be referenced.
Whenusing the indirect reference, set the storage typeof allo-
cated numeral table entry to Binary. Also, when specifying the
imagecode fromaprogrametc., usehexadecimal valuesince
the image table code is in hexadecimal.

Color

Foreground: Set the display color of image data.
(Setting is possible only when 2 colors is set for the color
mode.)

Background: Set the color of background in the image data display area.
(Setting is possible only when 2 colors is set for the color
mode.)

: Displays the list for selecting the image data when Direct is

specified. Displays the list for referencing the numeral table
entry when Indirect is specified.

Guidance

S When the image data is firstly specified, the data of character code FE20H (for
the NT30, NT30C, NT620S, NT620C, NT625C and NT21 and NT31/631-V2
and above with NT20/30/620-compatible mode), or the data that corresponds
to image/library code 0001H (for the NT21, NT31, NT31C, NT631, NT631C
without NT20/30/620-compatible mode) is arranged as default.

S Themark shownbelowwill be displayed if image data has not been created for
the specified code.

S To change the image data to be displayed, click on in the property and se-

lect the desired image data or numeral table entry from the list.
If you are using the NT31, NT31C, NT631 or NT631C “-V1” and above, and its
system program version is 2.1 and above, “Indirect reference” can be set.

The procedure for specifying the desired image data is shown below.

Direct
Specify the code of the image data to be displayed directly.
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(1) Click on at the right side of theCode field after checking the [Direct] but-

ton in the property setting dialog box to display the image data selection dia-
log box.

(2) If the code of the desired image data is not found in the list, scroll the list us-
ing the scroll bar at the right side of the screen, or click on to
open the code input dialog box.

Input the code of the desired image data and click on .

By pressing cursor keys (↑, ↓) on keyboard, the contents of the code can be
checked in the preview window one by one.

(3) Select the code of the desired image data to be displayed.

The selected line will be highlighted.

(4) Click on to close the dialog box.

Indirect
Specify the numeral table entry to be referenced.
With indirect reference, the contents for the specified numeral table entry are
treated as an image code and the corresponding image data is displayed. This is
useful when you want to change the image data to be displayed according to the
statuses. Set the storage type of numeral table entry to be referenced by indirect
reference to Binary and specify the value (image code) to be stored in hexadeci-
mal since the image code is in hexadecimal.

Set the numeral table entry number to be referenced in the table entry number
field.
It is possible to display a numeral table entry so that you can select the desired
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table entry number from it.
To display a numeral table entry, follow the procedure below.

(1) Click on at the right side of the table entry number after checking the [In-

direct] button in the property setting dialog box to display the numeral table
selection dialog box.

(2) If the number of the desired numeral table entry is not found in the list, scroll
the list using the scroll bar at the right side of the screen, or click on

to open the entry input dialog box.

Input the number of the desired numeral table entry and click on .

(3) Select the desired numeral table entry to be referenced.
The selected line will be highlighted.

(4) Click on to close the dialog box.

How to create the image data is described in 8-1 Image Editor.

6-2-10Mark
Mark data is displayed.

Mark data can be used for all models. (With NT11S, NT20S, and NT600S, mark
data canbe insertedonly in string.)Since theSupport Tool doesnot supportmark
data of 32× 32 dots and 64× 64 dots, it is necessary to group 16× 16 dot
marks if image data created by the DOS version Support Tool is imported.
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(1) The mark data, fixed at 16× 16 dot size, is displayed.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→ [Mark]

Selection using the drawing toolbar:

Terminology

Foreground color

Background color

Property setting

General

Position: Indicates the display position of mark data.
(The attribute point is at the upper left corner in the mark data.)

Code: Indicates the character code of the mark data to be displayed.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash
(With the NT21, NT31, NT31C, NT631 and NT631C, the Inverse
attribute is not supported.)

Scale: Specify the character size.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8

Smoothing: Specify whether smoothing processing is executed for mark
data.*1

(Setting is not possible for the NT21, NT31, NT31C, NT631 and
NT631C)

Color

Foreground: Set display color of mark data.

Background: Set the color of background in the mark data display area.

: Displays the list for selecting the mark data.

*1: For the NT21, NT31, NT31C, NT631, and NT631C, even under condition
that the string has smoothing ON and the mark has inserted, it will not
work.

Guidance

S By specifying mark data, special characters and symbols can be created on
the screen.

S To display a mark, specify its code.

S If no mark data has been created for the specified code, a blank is displayed.

S To change the mark data to be displayed, click on in the property set-
ting dialog box and select the desired mark data in the list.
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The procedure for selecting the desired mark data is shown below.

(1) Click on in the attribute setting dialog box to display the mark data
selection dialog box.

(2) Specify the mark data to be displayed. The specified field is displayed en-
larged. Or, input the character code that corresponds to themark data to be
displayed into the [Code] input field.

(3) Click on to close the dialog box.

S For the procedure for creating mark data, refer to 8-3 Mark Editor.

6-2-11 Library Object (Data)
Library data is displayed.

There are two types of library data. One type of library data references the fixed
code directly, the other type uses indirect reference. Indirect reference is a func-
tion that can change the library data to be displayed by writing the library code to
the numeral table entry just like the indirect reference of numeral/string display.
This enables theanimationdisplayby switching thedisplay contents usingasim-
ple program. For details of thePTmodels that can use indirect reference, refer to
Appendix E Table of Functions of Each PT Model.

Library data cannot be used for NT11S, NT20S and NT600S.

(1) Library data consisting of fixed display elements is displayed.

Note By registering a graphic created using multiple fixed display elements as the li-
brary data, the same graphic can be arranged in different positions.

Operation procedure

Selection using the menu bar: [Objects]→ [Fixed Display]→
[Library Display]
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Selection using the drawing toolbar:

Property setting

General

Position: Indicates the display position of library data.
(The attribute point is at the upper left corner in the library data.)

Size: Indicates the size of library data. (frame size of the library
data)

Reference Type

Direct: Set the library code directly.

Code: Indicates the code of the library data to be displayed.

Comment: Displays the comment that is set for the library data.

Indirect: Set this item when the value for the specified numeral table
entry is treated as library code and referenced indirectly.

Table No.: Specify the numeral table entry to be referenced.
Whenusing the indirect reference, set the storage typeof allo-
cated numeral table entry to Binary. Also, when specifying the
library code fromaprogrametc., usehexadecimal valuesince
the library table code is in hexadecimal.

: Displays the list for selecting the library data when Direct is

specified. Displays the list for referencing the numeral table
entry when Indirect” is specified.

Guidance

S When the library data is specified, the data of character code FA20H (for the
NT30, NT30C, NT620S, NT620C, NT625C, NT21, and NT31/631-V2 and
above with NT20/30/620-compatible mode), or the data that corresponds to
image/library code 1000H (for theNT21,NT31,NT31C,NT631, NT631Cwith-
out NT20/30/620-compatible mode) is arranged.

S Themark shownbelowwill be displayed if library data has not been created for
the specified code.

S To change the library data to be displayed, click on in the property and se-

lect the desired library data or numeral table entry from the list.
If you are using the NT31, NT31C, NT631 or NT631C “-V1” and above, and its
system program version is 2.1 and above, “Indirect reference” can be set.

The procedure for specifying the desired library data is shown below.

Direct
Specify the code of the library data to be displayed directly.



6-2SectionFixed Display

157

(1) Click on at the right side of the code after checking the [Direct] button in

the property setting dialog box to display the library data selection dialog
box.

(2) If the code of the desired library data is not found in the list, scroll the list us-
ing the scroll bar at the right side of the screen, or click on to
open the code input dialog box.

Input the code of the desired library data and click on .

By pressing cursor keys (↑, ↓) on keyboard, the contents of the code can be
checked in the preview window one by one.

(3) Select the code of the library data to be displayed.

The selected line will be highlighted.

(4) Click on to close the dialog box.

Indirect
Specify the numeral table entry to be referenced.
With indirect reference, the contents for the specified numeral table entry are
treated as a library code and the corresponding library data is displayed. This is
useful when youwant to change the library data to be displayed according to the
statuses. Set the storage type of numeral table entry to be referenced by indirect
reference to Binary and specify the value (library code) to be stored in hexadeci-
mal since the library code is in hexadecimal.

Set the numeral table entry number to be referenced in the table entry number
field.
It is possible to display a numeral table entry so that you can select the desired
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table entry number from it.
To display a numeral table entry, follow the procedure below.

(1) Click on at the right side of the table entry number after checking the [In-

direct] button in the property setting dialog box to display the numeral table
selection dialog box.

(2) If the number of the desired numeral table entry is not found in the list, scroll
the list using the scroll bar at the right side of the screen, or click on

to open the entry input dialog box.

Input the number of the desired numeral table entry and click on .

(3) Select the desired numeral table entry to be referenced.
The selected line will be highlighted.

(4) Click on to close the dialog box.

S For the procedure for creating library data, refer to 8-2 Library Editor.
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6-3 Alarm
Alarms are elements that check the status of a bit memory table entry and
change the contents of the display according to the detected status. Alarm ele-
ments consist of alarm lists and alarm histories.

Alarm list:

When a bitmemory table entry in the specified range goesON, the alarm list
displays the corresponding message or image/library data.

Since the bit memory table entries to be checked are set for the individual
alarm lists, it is possible to check different ranges of bitmemory table entries
with different alarm table entries.

Bit memory table entries in the specified range are checked only while an
alarm list is displayed, and the message and image/library data are dis-
played in accordance with the bit memory table entry that is ON.

Alarm history:

When a bit memory table entry for which a check mark is set for the history
property goesON, the date/time and the number of goingON events are re-
corded and displayed by the alarm history. All bit memory table entries for
which a checkmark is set for the history property are objects of alarmhistory
recording. Therefore, it is not possible to check different bit memory table
entries with different alarm histories.

The status of the bit memory table entries for which a check mark is set is
always checkedwhile aPT is running, regardless ofwhether or not an alarm
history element is displayed.

Note that an alarm history element displays only the record of past events. It
displays only the contents of the record at the point when it was displayed
and the displayed record remains the same even if the status of the bit
memory table entry changes after that.

Alarm list and alarm history elements cannot be used with NT11S, NT20S
and NT600S.

6-3-1 Alarm List
If a bit memory table entry in the check objective range goes ON, the alarm list
element displays the contents (alarm message) of the character string memory
table entry (string table) that is allocated to the bit memory table entry. It is also
possible to display the corresponding image/library data.

Note It is possible to switch the screen by operating the alarm list element by setting
the screen number to which the screen should be switched for the bit memory
table entry.

No.1

No.2

Screen

Alarm
list

Press
message

Bit memory table
Character string memory
table (String table)

Image/library data

WARNING HIGH TEMP.

WARNING HIGH TEMP.
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(1) When thebitmemory tableentry number in thespecified rangegoesON, the
alarm list element reads out the alarm message from the character string
memory table entry (string table) and displays themessage at the alarm list
area in the screen.

(2) If an operator touches the displayed alarmmessage, the specified image/li-
brary data will arrive.

Note The alarmmessage and the image/library data to be displayed are specified ac-
cording to the setting at the bit memory table entry.

Operation procedure

Selection using the menu bar: [Objects]→ [Alarm]→ [List]

Selection using the drawing toolbar:

Related elements and settings

Bit memory table entry: [Tools]→ [Table]→ Bit Memory
(Refer to 7-4 Bit Memory Table.)

Terminology

Frame

Display line

Length

Message Background

Page scroll touch switch

Line scroll touch switch

Image/
library data

Foreground

Background

Property setting

General

Position: Indicates the display position of the alarm list.
(The attribute point is at the upper left corner of the alarm list.)

Size: Indicates the size of the alarm list.

Message

Length: Specify the number of characters of the message to be
displayed.

Max. 32 characters: NT21

Max. 39 characters: NT30, NT30C, NT31, and NT31C

Max. 40 characters: NT631 and NT631C to which a system program ver-
sion lower than Ver.2.1 is installed.

With thesemodels above, thenumber of characters to bedisplayedwill be less
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than these values according to the display method and if the history informa-
tion is displayed.

Max. 40 characters: NT620S, NT620C, NT625C, NT631(System Ver.2.1),
and NT631C(System Ver.2.1)

With these models above, up to 40 characters can be displayed regardless of
the display method etc.

Display Line Qty: Specify the number of messages to be displayed.

Max. 7 lines: NT21

Max. 12 lines: NT30, NT30C, NT31, NT31C

Max. 16 lines: NT620S

Max. 24 lines: NT620C, NT625C, NT631, NT631C

Scale: Specify the character size of the message to be displayed.
1× 1 (Equal), 1× 2 (High), 2× 1 (Wide), 2× 2, 3× 3, 4× 4,
8× 8

Smoothing: Specify if smoothingprocessing is executed for themessage tobe
displayed.

Line Scroll Touch Switch: Set if a touch switch is set for scrolling messages
line by line. Only for NT21, NT31, NT31C, NT631,
and NT631C

Page Scroll Touch Switch: Set if a touch switch is set for scrolling messages
page by page. Only for NT21, NT31, NT31C,
NT631, and NT631C

Color

Frame: Specify the color used for the frame of an alarm list.

Background

ON: Specify the background color of the selected message display
field.

OFF: Specify the background color of themessage display fields that
are not selected.

Image & Library

Display of Image Lib: Specify if the image/library data is displayed.

Color

Specification of color is valid only when 2-color mode image data is dis-
played by a color type PT.

Foreground: Specify the display color of image data.

Background: Specify the background color of the image data display
area.

Reference: WithNT30,NT30C,NT620S,NT620C, andNT625C, adialog box is displayed to
set if the line scroll touch switch and page scroll touch switch are used.
With NT21, NT31, NT31C, NT631, and NT631C, whether or not the line scroll
touch switch and page scroll touch switch are used is determined in the alarm
list/history properties.

Settings

List Setting
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Start Bit Table Entry: Specify the start number of bit memory table entries
that are checked by the alarm list element.

No. of Bits Referenced: Specify the number of bit memory table entries that
are checked by the alarm list element.

Guidance

S Using a line scroll touch switch and a page scroll touch switch, you can scroll
messages in units of a line or a page within the alarm list display area.

S With NT31, NT31C, NT631, and NT631C, to display a line scroll touch switch
and/or a page scroll touch switch, set a check mark in the line scroll touch
switch and/or a page scroll touch switch check box in the Property setting dia-
log box.

S With the NT21, NT31, NT31C, NT631, and NT631C, a line scroll touch switch
and a page scroll touch switch are a part of an alarm list element. Therefore,
they cannot be modified as a touch switch. They can be moved only when the
alarm list is modified. For the NT21, NT31, NT31C, NT631, and NT631C, the
line and page scroll touch switch can be moved by clicking the desired touch
switch while holding down the Shift key and Ctrl key. ([Edit Object] from the
[Edit] menu (or pop-upmenu) and Ins key can also be used for this operation.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll
touch switch and a page scroll touch switch are independent elements and
their position, size, and label can be changed as required. However, the touch
switch function and the lamp setting should not be changed, otherwise the
switch and the lamp will fail to function correctly on PT.

S To display the image/library data, set a checkmark in the check box of [Display
Image Lib] in the Property setting dialog box.

S The procedure for editing the image/library data display area is shown below.

(1) Specify only the image/library data display area (dotted line frame) while
holding down the Shift key and Ctrl key. (automatically enters to Edit Object
mode)

GreenJmarks (handles) are displayed surrounding the image/library data
display area.

There are other methods to enter Edit Object mode. For details, refer to
Specifying an element consisting of multiple elements on page108.

(2) Specify the display size of the image/library data display area andmove it as
desired.

S If the size of the image/library data is smaller than the display area, the image/
library data is displayed taking the lower left corner of the display area as the
reference.

Image/library data

Image/library data display area

Reference: With NT31, NT31C, NT631, NT631C, if image/library data is larger than the
image/library data display area, the area exceeding the display area will not be
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displayedonPTwhile thewhole data is displayedon theSupport Tool. Be sure to
set image/library data display area so that image/library data fits inside it.

S For an alarm list element, the property settings, bit memory table, and charac-
ter stringmemory table (string table) are related to each other as shownbelow.

:10

:FE20
:0001000

10

11

12

13

ABC

DEF

GHI

JKL

FE20

ABC

Table Entry No.: Set for Start Bit
Table Entry

Alarm list Displayed
at ON

Bit memory table

Character string memory
table entry (String table)

Image/library data
PC (PLC) address

Character string
memory table
(String table)

Image data

Specified PC
(PLC) bit

Number of bits; Set for No. of Bits
Referenced

S Analarm list element is used in combinationwithbitmemory table entries.How
they function is shown below:

Setting at bit memory table

S Setting at Set dialog box

PLC Address

S Setting at Function dialog box

History
Screen No.

Switch Screen
Screen No.

String Table Entry
Image/Library Code

Use of image/library data
Image/library code

Color

Property settings for alarm list element

Start Bit Table Entry
No. of Bits Referenced

S The setting for the [SwitchScreen] bitmemory table settingdiffers between the
NT30,NT30C,NT620S,NT620C, andNT625C, and theNT21,NT31,NT31C,
NT631, and NT631C as shown below.

NT30, NT30C, NT620S, NT620C, and NT625C:

Specifies whether or not the screen is switched at the same time the PC
(PLC) bit allocated to bit memory table entry goes ON.
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NT21, NT31, NT31C, NT631, and NT631C:

Specifies whether or not the screen is switched when the message dis-
played at the alarm list is pressed.

The following table shows the appropriate setting of the bit memory table for the
required alarm processing, for your reference.

NT30, NT30C, NT620S, NT620C, and NT625C:

Usage of Alarm
Setting for Bit Memory Table

Usage of Alarm
Function Setting Switch Screen Screen No.

To display alarm only Alarm/Switch
Screen OFF 0

To display alarm and
switch to a specified
screen in response to
the pressing of alarm
message

Alarm/Switch
Screen OFF As desired

To switch to a speci-
fied screen at the
same time the bit
goes ON.

Alarm/Switch
Screen ON As desired

To switch to the pre-
vious screen at the
same time the bit
goes ON. (Switch to
the previous screen
based on the record
of screen history.)

Alarm/Switch
Screen ON 0

NT21, NT31, NT31C, NT631, and NT631C:

Usage of Alarm
Setting for Bit Memory Table

Usage of Alarm
Function Setting [Switch Screen] [Screen No.]

No function (For reg-
istering only allocated
bits and securing
them)

None – –

To display alarm only Alarm OFF –

To display alarm and
switch to a specified
screen in response to
the pressing of alarm
message

Alarm ON As desired

To switch to a speci-
fied screen at the
same time the bit
goes ON.

Switch screen – As desired

When converting the bit memory table from the NT30,
NT30C, NT620S, NT620C, NT625C to the NT21, NT31,
NT31C, NT631, NT631C, the function setting is not the
same with before converting. To adjust the setting of this
bit memory table, please refer to Data Conversion (Bit
memory conversion) in Appendix A.

WARNING
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S The [Settings] of an alarm list element are used to specify the range of bit
memory table entries that are subject to the check.

The check objective range is determined by setting the start bit memory table
entry numberand thenumberof bitmemory tableentries.Themaximumallow-
able number of bit memory table entries varies according to the PTmodel and
the setting of the number of bit memory table entries. The range of bit memory
table entry numbers is displayed in parentheses in the dialog box: Set the start
memory table entry number and the number of memory table entries so that
the displayed range is not exceeded.

While an alarm list element is displayed, the status of the bit memory table
entries in the specified range is always checked and the element displays the
message or image/library data that is set for the bit memory table entry when a
bit memory table entry is turned ON.

No.0
1
2
3

128
129

Allocation of a PC (PLC) bit to a bit memory table entry is specified at
the bit memory table. (Specified character string memory table entry
(string table) and image/library data code are also specified at the bit
memory table.)

Bit memory table PC (PLC)

Alarm
range

The alarm range, i.e., the start address (No.) in the bit memory
table entry and the size, is specified by the alarm list element.

6-3-2 Alarm History
If a bit memory table entry for which a check mark is set for the history property
goes ON, the date/time and the number of going ON events are recorded in an
alarmhistory.Analarmhistory elementdisplays the recordedbit tableentrynum-
bers in the order of occurrence or frequency when the element is displayed.

An alarm history element can also display the contents (alarm message) of the
character stringmemory table entry (string table) and the image/library data that
are allocated to the bit memory table entry.

Screen

Alarm
history

Bit memory table

Image/library data

WARNING HIGH TEMP.

WARNING HIGH PRESS. 98/05/12 18:25

WARNING HIGH TEMP. 98/04/10 16:02

WARNING HIGH TEMP. 98/04/10 16:02

No.1

No.2

Character string memory
table (string table)

Alarm history record data

(1) When a bit memory table entry for which a check mark is set for the history
property goes ON, the alarm history element reads out the alarm message
from the character string memory table entry (string table) and records the
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message with the date/time of the occurrence. The recorded information is
displayed when the alarm history element is displayed.

(2) If the operator touches the displayedalarmmessage, the specified image/li-
brary data is displayed.

Note The bit memory table entries to be checked are determined according to the set-
tings made at the individual bit memory table entries.

Operation procedure

Selection using the menu bar: [Objects]→ [Alarm]→ [History]

Selection using the drawing toolbar:

Related elements and settings

Bit memory table: [Tools]→ [Table]→ Bit Memory
(Refer to 7-4 Bit Memory Table.)

Terminology

Frame

Display line

Length
Background

Page scroll touch switch

Line scroll touch switch

Background

Image/
library data

Foreground

Message

Property setting

General

Position: Indicates the display position of the alarm history.
(The attribute point is at the upper left corner of the alarm history)

Size: Indicates the size of the alarm history.

Message

Length: Specify the number of characters of a message to be displayed.

Max. 32 characters: NT21

Max. 39 characters: NT30, NT30C, NT31, and NT31C

Max. 40 characters: NT631 and NT631C to which a system program ver-
sion lower than Ver.2.1 is installed

With thesemodels above, thenumber of characters to bedisplayedwill be less
than these values according to the display method and if the history informa-
tion is displayed.

Max. 40 characters: NT620S, NT620C, NT625C, NT631(System Ver.2.1),
and NT631C(System Ver.2.1)



6-3SectionAlarm

167

With these models above, up to 40 characters can be displayed regardless of
the display method etc.

Display Line Qty: Specify the number of messages to be displayed.

Max. 7 lines: NT21

Max. 12 lines: NT30, NT30C, NT31, NT31C

Max. 16 lines: NT620S

Max. 24 lines: NT620C, NT625C, NT631, NT631C

Scale: Specify the character size of the message to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8

Smoothing: Specify if smoothing processing is executed for the message to
be displayed.

Line Scroll Touch Switch: Set if a touch switch is set for scrolling messages
line by line. Only for NT31, NT31C, NT631, and
NT631C

Page Scroll Touch Switch: Set if a touch switch is set for scrolling messages
page by page. Only for NT31, NT31C, NT631, and
NT631C

Color

Frame: Specify the color used for the frame of an alarm list.

Background

ON: Specify the background color of the selected message dis-
play field.

OFF: Specify the background color of themessage display fields
that are not selected.

Image & Library

Display of Image Lib: Specify if the image/library data is displayed.

Color

Specification of color is valid only when the image data of 2-color mode is dis-
played by a color type PT.

Foreground: Specify the display color of image data.

Background: Specify the background color of the image data display
area.

Reference: WithNT30,NT30C,NT620S,NT620C, andNT625C, adialog box is displayed to
set if line scroll touch switch and page scroll touch switch are used.
With NT31, NT31C, NT631, and NT631C, whether or not the line scroll touch
switch and page scroll touch switch are used is determined by the setting for the
use of control touch switches in the alarm list/history properties.

Settings

History Info:

Specify whether or not an alarmmessage is displayedwith date/time of occur-
rence or frequency of occurrence. If a check mark is set for this item, the date/
time of alarm occurrence is displayed with an alarm message for display in
order of occurrence, or the frequency of occurrence is displayedwith an alarm
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message for display in the frequency of occurrence. The display format of the
date/time of occurrence is set for [Info Type]. If the date/time or frequency of
occurrence is displayed, the number of alarm message display characters is
reduced accordingly.

Order Type

Order of Frequency: Alarmmessagesaredisplayed in theorder of occur-
rence frequency.

Order of Occurrence: Alarmmessagesaredisplayed in theorder of occur-
rence (from the oldest record or from the newest re-
cord). The order in which the alarm messages are
displayed depends on the system memory setting.

Info Type:

If the setting is so made to display the date/time of alarm occurrence, the dis-
play format of the date/time is specified for this item. The setting for this item is
invalid if the date/time is not displayed with an alarm message.

Y/M/D h:m (14 digits)
M/D h:m (11 digits)
h:m (5 digits)

Guidance

S Using a line scroll touch switch and a page scroll touch switch, you can scroll
messages in units of a line or a page within the alarm list display area.

S With the NT21, NT31, NT31C, NT631, and NT631C, to display a line scroll
touch switch and/or a page scroll touch switch, set a check mark in the check
box for the line scroll touch switchand/or a page scroll touch switch in theProp-
erty setting dialog box.

S With the NT21, NT31, NT31C, NT631, and NT631C, a line scroll touch switch
and a page scroll touch switch are a part of an alarm list element. Therefore,
they cannot be modified as a touch switch. They can be moved only when the
alarm list is modified. To move a line scroll touch switch or a page scroll touch
switch, click the desired touch switch while holding down the Shift key andCtrl
key. ([Edit Object] from the [Edit] menu (or pop-up menu) and Ins key can also
be used for this operation.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll
touch switch and a page scroll touch switch are independent elements and
their position, size, and label can be changed as required. However, the touch
switch function and the lamp setting should not be changed, otherwise the
switch and the lamp will fail to function correctly.

S To display the image/library data, set a checkmark in the check box of [Display
Image Lib] in the Property setting dialog box.

S The procedure for editing the image/library data display area is shown below.

(1) Specify only the image/library data display area (dotted line frame) while
holding down the Shift key and Ctrl key. (automatically enters to Edit Object
mode)

GreenJmarks (handles) are displayed surrounding the image/library data
display area.

(2) Specify the display size of the image/library data display area andmove it as
desired.
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S If the size of the image/library data is smaller than the display area, the image/
library data is displayed taking the lower left corner of the display area as the
reference.

Image/library data display area

Image/library data

Reference: With the NT21, NT31, NT31C, NT631, andNT631C, if image/library data is larg-
er than the image/library data display area, the area exceeding the display area
will not be displayed onPTwhile thewhole data is displayed on theSupport Tool.
Besure to set image/library datadisplayareaso that image/librarydata fits inside
it.

S For analarmhistory element, theproperty settings, bitmemory table entry, and
character string memory table entry (string table) are related to each other as
shown below.

Character string memory
table entry (String table):10

:FE20

:H0001512

10

11

12

13

ABC

DEF

GHI

JKL

FE20

ABC 02/12

H0001512 97/02/12 10:51

History data

Alarm list

Displayed
at ON

Bit memory table

Image/library data

PC (PLC) address

Character string
memory table
(String table)

Image data

Specified PC
(PLC) bit

Number of bits; Set for No. of Bits
Referenced

table entry No.: Set for Start Bit
Table Entry

S An alarm history element is used in combination with the bit memory table
entry. How they function is shown below:

Setting at bit memory table entry

S Setting at Set dialog box

PLC Address

S Setting at Function dialog box

History
Screen No.

Switch Screen
Screen No.



6-3SectionAlarm

170

String Table Entry
Image/Library Code

Use of image/library data
Image/library code

Color

Property settings for alarm history element

History Info
Order Type

S Order of Frequency

S Order of Occurrence

S All bit memory table entries for which a check mark is set for the alarm history
property are subject to alarm history recording.
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6-4 Data Input
For inputting numerals and character strings in a PT, the following three data in-
put elements are provided.

Numeral input:

A numeric value is input into a numeral setting input field using touch switches
towhich numerals are allocated and the input froman extended I/O connected
to a PT.

Character string input:

A character string is input to a character string input field using touch switches
to which characters are allocated and a bar code reader connected to a PT.

Thumbwheel switch:

Touch switches that increase or decrease a numeral are provided at each digit
of an input field; a numeric value can be input by simply pressing the + and –
touch switches.

String input is not possible for NT11S, NT20S and NT600S.

6-4-1 Numeral Input

You can write numeric data to a numeral memory table entry using touch
switches and extended inputs.

Touch switches must be allocated numerals or the copy function beforehand.

For extended inputs, numerals must be allocated beforehand.

Input using touch switches (control code input function)

PT

No.1
No.2
No.3
No.4
No.5

50

50

Screen

Numeric keys
System keypad

Input field key

Numeral
memory table

Writing

(1) Create numeric keys using the touch switch control code input function, or
create a system keypad using the screen property.
(With the NT21, NT31, NT31C, NT631, and NT631C, system keypad is not
available.)

(2) Set a numeric value in the numeral setting input field using the numeric keys
on the screen.

(3) Press the touch switch towhich the key code is allocated towrite the data
set at the input field to the specified numeral memory table entry.
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Input using touch switches (copy function + control code input function)

PT

No.1
No.2
No.3
No.4
No.5

50

50 50

Screen

Set

keyInput field

Numeral
memory table

Copying the
set data

Set

(1) Copy the preset data (numeral memory table entry or constant) to the input
field using the copy function allocated to a touch switch.

(2) Press the touch switch to which the key code is allocated (by the control
code input function) towrite the data thatwas copied (set) to the input field to
the specified numeral memory table entry.

Reference: To copy (in the numeral table) and display a numeral by a single key operation,
without using the key code, use a touch switch (copy function) and a numeral
display element.

PT

No.1
No.2
No.3
No.4
No.5

50

50 50

Screen

Display field

Part type A

Numeral
memory table

Input using extended input (control code input function)

PT

No.1
No.2
No.3
No.4
No.5

50
50key

Screen

Input field

Extended
input

Numeral
memory table

External
numeric keys

(1) By turning ON an external switch that is connected to an external input, the
numeral or the control code set for the extended input function can be input
to the numeral setting input field.

(2) Press the touch switch towhich the key code is allocated towrite the data
set at the input field to the specified numeral memory table entry.
(For the setting of an extended input, refer to 7-5 Extended I/O Input Table.)

Operation procedure

Selection using the menu bar: [Objects]→ [Data Input]→ [Numeral]

Selection using the drawing toolbar:

Related elements and settings

Touch switch (control code input): [Objects]→ [Touch Switch]→
Control code input function
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Touch switch (copy setting): [Objects]→ [Touch Switch]→
Copy setting

Extended I/O input table (control code input):
[Tools]→ [Table]→Control code function

Terminology

Cursor (focus) moving touch switch Foreground

Background

Focus (cursor) frame

Sign digit

Integer Decimal

Input digits of maximum limit

Property setting

General

Position: Indicates the display position of the numeral setting input field.
(The attribute point is at the upper left corner of the input field.)

Font type: Specify the font for the numerals to be input.
Standard, Half Height, Double Width
(Only Standard can be set for NT11S.)

Size: Specify the size of numerals to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4,
8×8 (Not supported for NT20S) (Only 1×1 (Equal) and
2×1 (Wide) can be set for NT11S.)

Smoothing: Specify whether or not smoothing processing is executed for
numerals.
(Setting is not possible for NT11S, NT20S and NT600S.)

Attribute: Specify the display attributes (attributes to be displayed depend
on PT models.)
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the numeral color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the numeral display
area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Table Entry: Specify the table entry number of the numeral memory table
where input data is stored.

Display Type (Only Decimal can be set for NT11S.)*1
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Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in hexade-
cimal.

Format*2

Integer: Specify the number of digits of the integer part of the input
data.

Decimal: Specify the number of digits of the decimal fraction part of the
input data.

Limit (Setting is not possible for NT11S.)*1

Maximum: Specify the upper limit of the input data.*3

Minimum: Specify the lower limit of the input data.*3

Zero Suppression:*1 Specify whether or not leading zeros are suppressed to
display the input data.

Display Sign:*1 Specify if a sign is displayed for a negative value.

Focus Frame: Specify whether or not the frame that indicates the data in-
put objective is displayed. (Setting is not possible for
NT11S, NT20S and NT600S.)

Focus Attribute: Specify how the input data is displayed before it is con-
firmed. Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a numeral input is used as a temporary input
field for the NT21, NT31, NT31C, NT631, and NT631C.

*2: When a numeral input is used as a temporary input field for the NT21, NT31,
NT31C, NT631, and NT631C, only No. of digits (sign digit + integer digit +
decimal point + decimal digit) can be specified, since the digits such as deci-
mal digits are determined by the numeral input field on a base screen.

*3: An inputmethod for a negative value in decimal differs between the following
types of PT.

S With NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C:
Input F to indicate a negative value in the most significant digit.
(e.g., F0000008)

S With NT21, NT31, NT31C, NT631, and NT631C:
Input -- (negative sign) in the most significant digit.
(e.g., --8)

Interlock

Refer to 6-1-12 Interlock.

Guidance

S When a numeral input element is specified, a dialog box is displayed to set
whether the cursor moving touch switch is automatically created or not.
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Note It is possible to create a touch switch to which a cursor moving key is allocated
later.

Create Cursor Move Touch Switch

Specify whether or not a cursor moving touch switch is automatically created.
Settings may not be possible for some PT models.

Each time a numeral input or thumbwheel object is newly created, a numeral
table entry number (where input data is stored) is automatically set as 0→1→2...
incrementally (table entry number after the last set one will be the next default
number). A numeral table entry number can be changed by displaying the prop-
erty setting dialog box. (It is also possible to change it later.)

S Anumeral input element itself creates a numeral setting input field. It is always
used with a control code inputting touch switch (control code input function) or
a system keypad. Data is input to a numeral setting input field using the control
code input touch switches and the system keypad that are displayed with the
numeral setting input field.

After creating touch switches (control code
input) or a system keypad on the same
screen (includes a keyboard window),
pressing the key allocated the control
code [1] enters [1] in the numeral setting
input field. If key [2] is then pressed, the
input field shows 12.
Press the key to store the data input
into the input field in the numeral memory
table.

0 0 0 0 0 . 0 0

1 2

1 1

2 12

This data input field is created by a numeral
input element.

The input field and the control code input touch
switch are automatically correlated. Carry over
is processed automatically.

Control code inputting
touch switch

Numeral setting
input field

Touch

Touch

Touch → This is stored
in the memory
table.

12

S The procedure for creating a control code input touch switch is shown below.

(1) Set the control code input function for a touch switch.

(2) Select the code from the control code list.
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The control code input function allows an arbitrary name for a label of a touch
switch. Click the Button in the Tab to display the label input
dialog box. Input a label.

Confirmation

S A system keypad is created in the manner shown below.

With the NT21, NT31, NT31C, NT631, and NT631C, a system keypad cannot
be created.

(1) Select [Screen] (menu bar), then select [Properties].

This operation is also possible by selecting [Properties] after displaying the
pop-up edit menu, which is displayed by right clicking the mouse or by
double clicking the mouse with the mouse cursor placed at a position other
than an element.

(2) Set a check mark for the system keypad in the screen properties.

Numeral input element

System keypad
Note: A system keypad is automatically

displayed when a numeral setting
element or a character string setting
element is created in the same
screen.

S The allowablemaximumnumber of input digits is determined by the setting for
the [Format] and [Display Sign] properties.

S Even if multiple input fields are arranged in a screen, input is possible only for
one numeral setting input field. Therefore, it is necessary to create a touch
switch (cursor moving touch switch, or arrow symbol touch switches) that can
be used to select the desired numeral setting input field. If the Create Cursor
Move TouchSwitch check box isONwhen creating the input element, a cursor
moving touch switch is automatically created overlapping a numeral setting in-
put field. By simply pressing this input field, the cursor is moved.

No.1

No.2

No.3

Data input field

Cursor moving
touch switch

Numeric keys
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If a touch switch on input field No. 2 is pressed, the No. 2 input field becomes
the objective field for data input. The data input using the numeric keys is
stored in input field No. 2.

S A cursor moving touch switch is created using the dialog box that is displayed
when creating a numeral input element. The properties for the cursor moving
touch switch can be set in the same manner as for a standard touch switch.

How the properties for a touch switch are set is shown below.

For details of [Settings], refer to 6-8 Touch Switches.

S If a checkmark is set for [UseWindow/Keyboard Screen] in the cursormoving
touch switch setting properties, it is possible to display the specified window/
keyboard at the same time the cursor is moved.

This feature allows appropriate numeric keys for the input field to bedisplayed.

It is possible to create a temporary input field in addition to numeric keys.
(With the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and
above, all objects other than thumbwheel switch and recipe objects can be
created on window.)

Window/Keyboard

Displayed when the
input field is touched.
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S It is possible to create a temporary input field at the same time as numeric keys
are arranged in the window/keyboard.

A temporary input field is created using a numeral input element.

When a numeral input element is arranged in the window/keyboard, the ele-
ment is automatically set as a temporary input field.

Only one numeral input element (temporary input field) can be created for one
window/keyboard.

S Setting processing differs as shown belowdepending onwhether or not a tem-
porary input field is used.

When a temporary input field is used

Numeral memory table
Storing by pressing

key

Temporary input field

(1)

(2)

(1) The data that is input using numeric keys is displayed in the temporary input
field.

(2) Input the key, and the data in the temporary input field is set in the numer-
al setting input field and stored in the numeral memory table at the same
time.

When a temporary input field is not used

Numeral memory table
Storing by pressing

key

(2)

(1)

(1) The data input using numeric keys is directly set in the numeral setting input
field.

(2) Press the key, and the set data is stored in the numeral memory table.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, the settings, such as the
DisplaySign cannot be set at setting property of temporary input field (These set-
tings are determined by the numeral input field on a base screen). When a nu-
meral input field is used as a temporary input field for the NT21, NT31, NT31C,
NT631, andNT631C, specify the requiredNo. of digits (sign digit + integer digit +
decimal point + decimal digit).

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.
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Note 1. The data set in the input field is not stored in the numeral memory table until
the key (button where the Return key code is set) or the ENT key is
pressed.
At the end of data input, always press the key or the ENT key.

2. To correct the data set in the input field, use the CLR key, the BS key, and the
DEL key.

3. When a numeral setting input field is moved, the touch switch is also moved
automatically. To modify or move a numeral setting input field and a touch
switch independently, cancel the check mark set for [Auto Arrange] in the
[Settings] page of the touch switch properties.

4. The cursor can also bemoved using an arrow symbol key touch switch. The
cursor moves in the order the numeral input elements were created; this or-
der can be changed after creating the elements.

5. With theNT21, NT31, NT31C, NT631, andNT631C,when hexadecimal val-
ue is input, it is regarded as signed binary data and upper/lower limit check is
performed. Therefore, if the top bit is 1, it is regarded as negative value and
input will be prohibited when theminimum limit was set as 0. In this case, set
those value such as $80000000 (--2147483648) for minimum limit setting to
prevent it from being checked.

Reference: At the numeral setting input field, the written numeric value in the numeral
memory table is displayedwhen the key is pressed.Since this is different from
the one read from the numeralmemory table entry, it is necessary to use another
numeral input element to readout the data from the sameaddress of thenumeral
memory table entry.

No.1

No.2

Screen

Numeral input element

Set numeral

Pop-up window/keyboard

Numeric keys

Numeral setting input field

Numeral memory table

Set numeral

6-4-2 Character String Input
You can write character string data to a character string memory table entry
(string table) using touch switches and a bar code reader.

Touch switches must be allocated character strings or a key code (control code
input and character string input function), or the copy function beforehand.
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Input using touch switches (character string input function + control code input function)

PT

No.1
No.2
No.3
No.4
No.5

ABCABC

ABC DEF GHI

Screen

Touch switches

Input field

Writing

key

Character string memory
table (String table)

(1) Set the character strings to be input using the character string input function
to touch switches.

(2) Press a touch switch to set the label that is set for the touch switch into the
character string input field.

(3) Press the touch switch for which the key code is allocated (by the control
code input function) to write the character string set at the input field to the
specified character string memory table entry (string table).

Input using touch switches (copy function + control code input function)

No.1
No.2
No.3
No.4
No.5

ABC

ABCABC

ABC

PT

Screen
Input field

Character string memory
table (String table)

SET

key

Copying the
set data

(1) Copy the preset data (character string memory table entry (string table)) to
the input field using the copy function allocated to a touch switch.

(2) Press the touch switch for which the key code is allocated (by the control
code input function) to write the data that was copied (set) into the input field
to the specified character string memory table entry (string table).

Reference: To copy (in the character string memory table entry (string table)) and display a
character string by a single key operation, without using the key code, use a
touch switch (copy function) and a character string display element.

Part type A

Part type A

No.1
No.2
No.3
No.4
No.5

PT

Screen
Character string
memory table
(String table)

Display field

Part type A

Part type A
Copy
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Input using a bar code reader

Character string
memory table
(String table)

PT

No.2
No.3
No.4
No.5

ABC
ABC

No.1

Screen

Input field

Bar code reader

(1) By reading out a bar code using a bar code reader, the bar code data can be
input to the character string setting input field. If “automatic confirm” is set for
bar code reading operation by thememory switch of aPT, the read-out char-
acter string is automatically written to a character string memory table entry
(string table).

(2) If the setting for bar code reading operation is “manual confirm,” the data set
in the input field is written to the specified character string memory table
entry (string table) when the touch switch allocated the key code is
pressed.

(For details of memory switch setting, refer to the operation manual for PT.)

Operation procedure

Selection using the menu bar: [Objects]→ [Data Input]→ [String]

Selection using the drawing toolbar:

Related elements and settings

Touch switch (character string input): [Objects]→ [Touch Switch]→
character string input function

Touch switch (control code input): [Objects]→ [Touch Switch]→
Control code input function

Touch switch (copy setting): [Objects]→ [Touch Switch]→
Copy setting

Terminology

Cursor (focus) moving touch switch

Focus (cursor) frame

Background

Foreground

Property setting

General

Position: Indicates the display position of the numeral setting input field.
(The attribute point is at the upper left corner of the input field.)

Font type: Specify the font of the character string to be input.
Standard, Half Height
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Size: Specify the size of character string to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8

Smoothing: Specifywhetheror not smoothingprocessing isexecuted for char-
acter strings.

Attribute: Specify the display attribute (attributes displayed depend on the
PT model.)
Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the character string color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the character string
display area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Table Entry:*1 Specify the table entry number of the character string memory
table entry (string table) where input data is to be stored.

Length: Specify the number of characters to be input.

Focus Frame: Specifywhether or not the framewhich indicates thedata input
objective is displayed.

Focus Attribute: Specify how the input data is displayed before it is confirmed.
Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a string input is used as a temporary input field
for the NT21, NT31, NT31C, NT631, and NT631C.

Interlock

Refer to 6-1-12 Interlock.

Guidance

S When a character string input element is specified, the dialog box is displayed
to set whether the cursor moving touch switch is automatically created or not.

Note It is possible to create a touch switch to which a cursor moving key is allocated
later.

Create Cursor Move Touch Switch

Specify whether or not a cursor moving touch switch is automatically created.

S Each time a string input object is newly created, a string table entry number
(where input data is stored) is automatically set as 0→1→2... incrementally
(table entry number after the last set one will be the next default number). A
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string table entry number can be changed by displaying the property setting
dialog box. (It is also possible to change it later.)

S A character string input element itself creates a character string setting input
field. It is always used with a control code inputting touch switch (control code
input function) or a system keypad. Data is input to a character string setting
input field using the control code input touch switches and the system keypad,
which are displayed with the character string setting input field.

A A

B AB

Touch

Touch

Touch → This is stored
in the charac-
ter string
memory table
(string table).

After creating touch switches (character
string input and control code input) or a
system keypad on the same screen (in-
cludes a pop-up window), pressing the key
allocated label [A] enters [A] in the charac-
ter string setting input field. If the touch key
allocated [B] is then pressed, the input field
shows AB.
Press the key to store the data input to
the input field in the character string
memory table (string table).

A B

This data input field is created by a character
string input element.

The input field and the control code input touch
switch are automatically correlated. Insertion of a
character string is automatically processed.

Control code
inputting touch
switch

Character string
setting input field

AB

S The procedure for creating a character string input touch switch is shown be-
low.

NT30, NT30C, NT620S, NT620C and NT625C

(1) Set the character string input function for the touch switch function.

(2) Set a check mark for the [Label] property in the Label tab.

(3) Click the Button and input the character string as a label.

A label may be either a character or a character string consisting of multiple
characters. When a touch switch is pressed, the character string set as the
label is set to the character string input field.

When a lamp bit with an I/O comment is set, pressing the Copy I/O Com-
ments button copies the I/O comment as a label.

Property setting for input key-string touch switch
Example

NT31C

Dialog box for
inputting a label

NT21, NT31, NT31C, NT631 and NT631C



6-4SectionData Input

184

(1) Set the character string input function for the touch switch function.

(2) Specify a string to be input for the Input Key String in the Settings tab.

The string can be either a character or a character string consisting ofmulti-
ple characters. When a touch switch is pressed, the character string set as
the Input Key String is set to the character string input field.

When a label is set, pressing the Copy From Label button copies the label as an
Input Key String.When the label type is “OnOff Static,” theOff label will be used.
Whenmultiple lines of label have been set, only the first line will be used. If more
than 40 characters are set for a label, only the first 40 characters will be set.

S The number of characters that can be set for a character string input touch
switch and the number of characters that are actually written to a character
string input field differ depending on the PT model, as shown below.

PT Model Number of Characters
(Label)

Number of Characters
(Written to Input Field)

NT30, NT30C Max. 40 characters Max. 40 characters

NT620S, NT620C, NT625C Max. 80 characters Max. 40 characters

With theNT21,NT31,NT31C,NT631andNT631C, amaximumof 40 characters
can be used for string input function regardless of the PT model.

S The procedure for creating a control code input touch switch is shown below.

(1) Set the control code input function for a touch switch.

(2) Select the code from the control code list.

(3) Thecontrol code input functionallowsanarbitrary name fora label of a touch
switch. Click the Button in the Tab to display the label input
dialog box. Input a label.

Confirmation

S The number of characters that can be input depends on the setting for the
[Length] property.

S Even if multiple input fields are arranged in a screen, input is possible only for
one character string input field. Therefore, it is necessary to create a touch
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switch (cursor moving touch switch, or arrow symbol touch switches) that is
used to select the desired character string input field. If the [Focus Frame]
property is selected, a cursor moving touch switch is automatically created
overlapping a character string input field. The cursor moves when the input
field is pressed.

No.1

No.2

No.3

ABCABC

Data input field
Cursor moving
touch switch

If the touch switch on input field No. 2 is pressed, theNo. 2 input field becomes
the objective field for data input. The input character string is stored in input
field No. 2.

S A cursor moving touch switch is created using the dialog box that is displayed
when creating a character string input element. The properties for the cursor
moving touch switch can be set in the same manner as for a standard touch
switch.

How the properties for a touch switch are set is shown below.

For details of [Settings], refer to 6-8 Touch Switches.

S If a checkmark is set for [UseWindow/Keyboard Screen] in the cursormoving
touch switch setting properties, it is possible to display the specified window/
keyboard at the same time as the cursor is moved.
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This feature allows appropriate numeric keys for the input field to bedisplayed.

It is possible to create a temporary input field in addition to numeric keys.

(With the NT21 and with the NT31, NT31C, NT631, and NT631C “-V1” and
above, all objects other than thumbwheel switch and recipe objects can be
created on a window.)

Window/Keyboard

Displayed when the
input field is touched.

S It is possible to create a temporary input field at the same time as numeric keys
are arranged in the window/keyboard.

A temporary input field is created using a character string input element.

Whenacharacter string input element is arranged in thewindow/keyboard, the
element is automatically set as a temporary input field.

Only one string input element (temporary input field) can be created for one
window/keyboard

S Setting processing differs as shown belowdepending onwhether or not a tem-
porary input field is used.

When a temporary input field is used

CBA

ABCDEF

ABCDEF

ABCDEF

FED

HG

Character string memory
table (String table)

Temporary input field

Storing by pressing
key

(1)

(2)

(1) The input character string is displayed in the temporary input field.

(2) Press the key, and the character string in the temporary input field is set in
the character string input field and stored in the character string memory
table (string table) at the same time.

When a temporary input field is not used

CBA

ABCDEF

ABCDEF

FED

HG

Storing by pressing
key Character string memory

table (String table)

(1)

(2)
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(1) The input character string is directly set in the character string input field.

(2) Press the key, and the set data is stored in the character string memory
table (string table).

Reference: When there are no string to show, string input will be invisible.
Therefore, with Support Tool, dotted-line frame is displayed in character fore-
ground color enclosing string input.
(This frame will not be displayed on PT)
This frame can not be set to off. However, the dotted-line frame can be set to ON
and OFF when printing screen image (refer to page 425).

Note 1. The data set in the input field is not stored in the character string memory
table (string table) until the key (button where the Return key code is set)
or the ENT key is input if “manual confirm” is set for the bar code read opera-
tion (set using the PT memory switches).
If “manual confirm” is set, always input the key or theENTkey at the endof
data input.

2. To correct the data set in the input field, use the CLR key, the BS key, and the
DEL key.

3. When a character string input field is moved, the touch switch is also moved
automatically. To modify or move a character string input field and a touch
switch independently, cancel the check mark set for [Auto Arrange] in the
[Settings] page of a touch switch property.

4. The cursor can also bemoved using an arrow symbol key touch switch. The
cursor moves in the order the character string input elements were created;
this order can be changed after creating the elements.

6-4-3 Thumbwheel Switch
Thumbwheel switches are provided as means to input numeric data. “+” and “–”
keys are provided at each input digit to allow you to input numeric data at individ-
ual digits. (Thumbwheel switch cannot be used with NT11S.)

1234

Numeral
memory table

(1) Touch the + or – key at each digit of thumbwheel switches to set numeric
data.

(2) The numeric data set using the thumbwheel switch is written to a numeral
memory table entry.
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Note If thumbwheel switches are used to input numeric data, the input data is directly
written to a numeral memory table entry without being set in a data input field.

Operation procedure

Selection using the menu bar: [Objects]→ [Data Input]→
[Thumbwheel Switch]

Selection using the drawing toolbar:

Terminology

Frame: Foreground

Frame: Background

Character Color: Foreground

Character Color: Background

End plate

Sign digit Integer Decimal

Input digits of maximum limit

Property setting

General

Position: Indicates the display position of the thumbwheel switch.
(The attribute point is at the upper left corner of the thumbwheel
switch.)

Size: Specify the size of the thumbwheel switch.
Small, Medium, Large

Attribute: Specify the display attribute (attributes displayed depend on the
PT model.) Standard, Inverse, Flash, Inverse Flash

End Plate: Specify whether or not end plates are displayed at the ends of the
thumbwheel switch.

Thumbwheel Color

Frame: Specify the color of thumbwheel switch frame.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Foreground: Specify the foreground color of the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Character Color

Foreground: Specify the foregroundcolor of thenumeric valuedisplayed in
the thumbwheel switch.
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(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the numeric value displayed
in the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Table Entry: Specify the table entry number of the numeralmemory table entry
where input data is stored.

Display Type

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in hexade-
cimal.

Format

Integer: Specify the number of digits of the integer part of the input
data.

Decimal: Specify the number of digits of the decimal fraction part of the
input data.

Limit

Maximum: Specify the upper limit of the input data.*1

Minimum: Specify the lower limit of the input data.*1

Display Sign: Specify if a sign is displayed for a negative value.

*1: An inputmethod for a negative value in decimal differs between the following
types of PT.

S With NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C:
Input F to indicate a negative value in the most significant digit.
(e.g., F0000008)

S With NT21, NT31, NT31C, NT631, and NT631C:
Input “--” (negative sign) in the most significant digit.
(e.g., --8)

Interlock

Refer to 6-1-12 Interlock.

Guidance

Each time a numeral input or thumbwheel object is newly created, a numeral
table entry number (where input data is stored) is automatically set as 0→1→2...
incrementally (table entry number after the last set one will be the next default
number). A numeral table entry number can be changed by displaying the prop-
erty setting dialog box. (It is also possible to change it later.)
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S The size of a thumbwheel switch can be selected from the following three
sizes.

Large

Small

Medium

S End plates can be displayed at both ends of a thumbwheel switch.

Without end plateWith end plates

S With a thumbwheel switch, the data input method can be selected as decimal
or hexadecimal.

Decimal selection: Numbers in the range of 0 to 9 can be set at each
digit.

Hexadecimal selection: Numbers in the range of 0 to 9 and A to F can be set
at each digit.

S For [Decimal] property, specify the position of a decimal point in the numeral to
be displayed. Numeric data is written to a numeral memory table entry without
a decimal point and input data is stored as an integer.

Numeral 2341 is written to a
numeral memory table
entry.

S In the sign digit, “ ” or “–” is displayed. To set a positive value, specify a blank
(“ ”). For a negative value, specify “–.”

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.

Note 1. If you use a thumbwheel switch to input numeric data, the set data is written
to a numeral memory table entry at each pressing of the + or – key.
Thismeans that the values during data setting are alsowritten to thememory
table.

2. With a thumbwheel type numeric setting input field, if n...n< m...m [upper
limit: 1n...n, lower limit: 0m...m (n and m are arbitrary values at each digit)],
carry over and shift to the lower digit are not possible at the highest digit posi-
tion.
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Example:

When 1200 is set for the Maximum and 201 is set for the Minimum, if the initial
value is a 3-digit value, the setting value can be changed only in the range of 201
to 999, and if the initial value is a 4-digit value, the setting value can be changed
only in the range of 1000 to 1200.
This is because the limit check function detects an error if the most significant
digit value is changed from 0 to 1 or from 1 to 0.
Toavoid this problem, set themaximumandminimum limits so that n...n≧m...m
or provide a touch switch separately to write a value at carry over or shift to the
lower digit.

3. With theNT21, NT31, NT31C, NT631, andNT631C,when hexadecimal val-
ue is input, it is regarded as signed binary data and upper/lower limit check is
performed. Therefore, if the top bit is 1, it is regarded as negative value and
input will be prohibited when theminimum limit was set as 0. In this case, set
those value such as $80000000 (--2147483648) for minimum limit setting to
prevent it from being checked.
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6-5 Lamps
The status of a lamp changes according to the status of a PC (PLC) bit.

Two types of lamp element are provided – standard lamps that change their dis-
play status (ON/flash/inverse flash) and image/library lamps that show different
image/library data in the lamp ON and OFF states.

Image/library lamps cannot be used with NT11S, NT20S and NT600S.

6-5-1 Standard Lamps
A lamp (OFF/ON/flash) is displayed in accordance with the status of a PC (PLC)
bit.

PC (PLC)
Bit status

(1) The status of a lamp is changed according to the allocated PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects]→ [Lamp]→ [Standard]

Selection using the drawing toolbar:

Terminology

Label

Frame

ON color/
OFF color

Property setting

General

Position: Indicates the display position of a standard lamp.
(The reference point is at the upper left corner of the standard
lamp)

Size: Indicates the size of a standard lamp.

Frame: Specify whether or not a frame is displayed for a standard lamp.

Shape: Displays shapes of a standard lamp.
(Selectable shapes vary according to the PT model)
Rectangle, Circle, Polygon, Sector
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Color

Frame: Specify the color of a lamp frame if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a standard lamp when the PC (PLC) bit is ON.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC (PLC) bit is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

Light Functions

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives a standard lamp ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit that drives a standard lampON/OFF.

Lamp Attribute

ON Type: Specify the status of a standard lamp that is ON.
Light, Flash

: Displays the dialog box used to specify the bit number.

: Displays an I/O comment table entry.

Label

Label: Specify whether or not a label is appended to a standard lamp.

Label Type: Specify the type of the Label when [Label] is selected. Following
selectionswill be available for theNT21andNT31/631-V2mod-
els: Static, Static On Off, Numeral Display and String Display.
For the other PT models, this option is disabled and is set to
Static (default).

: Displays the dialog box used to edit a label. This button is en-

abled only when [Label] is selected.

:Copies the I/O comment set to the lamp bit as a label.

To display a label, set a check mark in the check box of the Label attribute in [la-
bel] page and select an option of the available options from the Label Type com-
bo box.

For the non-NT21 and NT31/631 V2 models this combo box will have only one
choice (‘Static’) and this will remain disabled.

Static: For this option the On label and the Off label will be same.

On Off Static: For this option On/Off labels may be different.
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Numeral Display: Displays the numeral value by referencing the specified table
entry. Indirect reference is also possible.

String Display: Displays the character string by referencing the specified table
entry. Indirect reference is also possible.

To display the settings for a label click the Button. The dialog box for
setting a label is displayed.

Use the button in the property dialog to copy the I/O comment

set to the PLC address of the lamp bit as a label.

The property setting dialog for both Static and On Off Static labels is shown be-
low.

For Static, the label can be set by changing description ofOff Label group box of
[Standard Lamp <Label>] dialog box. On Label group box will be disabled.

ForOnOff Static, theOff Label and theOnLabel can be set by changing descrip-
tion of corresponding text boxes.

Off Description: Specify the text of the label that will be displayed when lamp
bit is OFF.

On Description: Specify the text of the label that will be displayed when lamp
bit is ON.

Line Spacing: Determines the space between two lines in both the Off De-
scription and the On Description.

Insert New Line: Inserts a new line character in the description to bring the fol-
lowing characters to the next line. On the Label Description
edit box, the new line character will be shown as ‘<\n>’.
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Set Lines: Displays the On/Off Description Settings dialog box. This
dialog is for enteringOff Description andOnDescriptionwith
multiple lines.

In all NT21 and NT31/631 V2 models, Labels can be entered in multiple lines.
The following table shows the specification for each PT model.

Maximum
number of
characters

Maximum
number of
characters
per line

Number of
lines per-
mitted

Remarks

NT21 128 32 1 to 8 Maximum number of
characters per line in-
clude the “\n” charac-
ter.

NT31/C-V2 128 40 1 to 15 Maximum number of
characters per line in-
clude the “\n” charac-
ter.

NT631/C-V2 256 80 1 to 30 Maximum number of
characters per line in-
clude the “\n” charac-
ter.

TheSet Lines buttonwill displayOn/Off DescriptionSettings dialog box, inwhich
the On/Off description can be entered in multiple lines by pressing Enter Key.

WhenNumeralDisplay or StringDisplay is selected asLabel Type (For theNT21
and NT31/631-V2 Models only)

Indirect Reference:

If a numeral in the specified memory table entry is treated as the reference table
entry number for indirect reference, specify this item.

Table Entry:

Specify the address of the numeral or stringmemory table entry to be referred to.
If [indirect Reference] is not selected, the contents of this numeral or string
memory tableentryaredisplayed, and if [indirectReference] is selected, thecon-
tents of this numeral memory table entry are treated as the reference table entry
number and the contents of the reference memory table entry are displayed.

Edit:

Displays theNumeralDisplay orStringDisplayproperty page.For descriptionon
property settings refer to 6-6 Numeral Display and 6-7 Character String Display.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
the [View] menu.
Additionally, to view flashing display of lamp attribute, select [Simulate Flash]
from the [View]menu. For details, refer to 5-1-3Changing theDisplayMethodon
the Support Tool.

Guidance

S The following kinds of standard lamps are provided.

SectorRectangle Circle Polygon
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S The shape of a lamp can be modified when you select polygon or sector.

Use the element edit function to modify the lamp shape. (For details, refer to
page 110.)

(1) Click on a line of a polygon or a sector while pressing the Shift key and Ctrl
key.

(2) Drag a green J mark to modify the graphic.

(3) To add a greenJmark (addition of a vertex), position the mouse cursor on
the line in a graphic and execute the vertex addition operation (right click the
mouse→ [Add Node]).

To delete a greenJmark (deletion of a node), position themouse cursor on
the greenJ mark to be deleted and execute the vertex deletion operation
(right click the mouse→ [Remove Node]).

(4) Drag the added green J mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

S A standard lamp element can display a label (lamp name).

To display a label, set a checkmark in the check box of the [Label] attribute and
click on . The dialog box for setting a label is displayed. Set the prop-
erty for the label to be displayed.

For the procedure for setting the properties, refer to 6-2-7 Text. For the NT21,
NT31, NT31C, NT631, and NT631C, it is possible to set different colors for lamp
ON and lamp OFF by setting [Color – OFF] and [Color – ON] instead of setting
label color. However, background color is fixed to transparent for the NT21,
NT31, NT31C, NT631 and NT631C.

Use the button in the property dialog to copy the I/O comment

set to the lamp bit as a label.

S Toedit theposition of a label, use theelement edit function. (For details, refer to
page 110.)

(1) Click on the label while pressing the Shift key and Ctrl key.
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(2) Drag the label to change the display position.

(1) (2)

S When displaying a string as a label, mark data and image data can be inserted

into a string by clicking the Button or the

Button. On the NT21 and NT31/631 without NT20/30/620-compatible mode,
image data cannot be used in a string.

Reference: S With a standard lamp, only the lamp color and the label color change. To
change the contents of a label, create image/library lampsanddisplaydifferent
image/library data according to the status of the lamp.

Example:

ON OFF

Image/library lamp

S With theNT21andNT31/631-V2andabove, youcanalso change thecontents
of a label by specifying ON OFF Static as label type.

S With the NT21 and NT31/631 without NT20/30/620-compatible mode image
data cannot be inserted into a label.

6-5-2 Image/library Lamps
Different image/library data are displayed according to the status of a PC (PLC)
bit.

PC (PLC)

Bit status

Display when
the bit is OFF

Display when
the bit is ON

(1) The image data or the library data is switched to be displayed according to
the status of the allocated PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects]→ [Lamp]→ [Image]
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Selection using the drawing toolbar:

Terminology

Image/library data

Property setting

General

OFF State

Code: Specify whether or not image/library data is displayed in the
lampOFF state and the code of the image/library data to be
displayed.

ON State

Code: Specifywhether or not image/library data is displayed in the
lamp ON state and the code of the image/library data to be
displayed.

: Specify the image data to be displayedwhen the lamp isON/
OFF.

: Specify the library data to be displayedwhen the lamp isON/
OFF.

Color (Only for NT31C and NT631C. Setting is not possible for other color types
of PT.)

Foreground: Set the display color of an image element.
(Specification of color is valid only when the color mode is 2
colors. Setting is not possible for a monochrome type PT.)

Background: Set the display color of the background in the image element
display area.
(Specification of color is valid only when the color mode is 2
colors. Setting is not possible for a monochrome type PT.)

Light Functions

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives an image/library lamp ON/OFF.

I/O Comment: Specify the comment of thePC (PLC) bit that drives an image/library lampON/
OFF.

: Displays the dialog box used to specify the bit number.

Displays an I/O comment table entry.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
the [View] menu. For details, refer to 5-1-3 Changing the Display Method on the
Support Tool.
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Guidance

S For image/library lamp element, the image/library data that is displayed when
thePC (PLC)bit isONand the image/library data that is displayedwhen thePC
(PLC) bit is OFF are specified independently.

To display the image data or the library data only when the PC (PLC) bit is ON or
OFF, cancel the checkmark in the check box of the bit status forwhich the image/
library data is not to be displayed.

S To select the image/library data to be displayed, click on /
and select the desired image/library data from the list.

Click on the line of the desired data to display the line in reverse video and click
the Button.

Clicking the Button enables the direct display of the specified code.

S If the data is not registered to the specified code, themark shown below is dis-
played on the screen.

S For the procedure for creating the image data, refer to 8-1 Image Editor.

S For the procedure for creating the library data, refer to 8-2 Library Editor.
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6-6 Numeral Display
The contents of a numeral memory table entry are displayed.

Numeral displays can be used with all models.

PT

No.1
No.2
No.3
No.4
No.5

50

50

Screen

Display field

Read

Numeral
memory table

(1) The contents of the specified numeral memory table entry are displayed.

Operation procedure

Selection using the menu bar: [Objects]→ [Numeral Display]

Selection using the drawing toolbar:

Terminology

Display digits of maximum limit

Foreground

Background

Sign digit Integer Decimal

Property setting

General

Position: Indicates the display position of the numeral display field.
(The reference point is at the upper left corner of the display field.)

Font Type: Specify the font of the numeric value to be displayed.
Standard, Half Height, Double Width
(Only Standard can be set for NT11S.)

Scale: Specify the scale of the numeric value to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8
(Only 1×1 (Equal) and 2×1 (Wide) can be set for NT11S.)

Smoothing: Specify whether or not smoothing processing is executed for
numeric values to be displayed.
(Setting is not possible for NT11S, NT20S and NT600S.)

Attribute: Specify the display attribute (attributes displayed depend on the
PT model.) Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the numeral color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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When this property page is called from Label of Standard Lamp or Touch Switch
when Label Type is Numeral Display, Foreground ON/OFF color can be speci-
fied.

ON: Specify the display color of a standard lamp when the PC
(PLC) bit is ON.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC
(PLC) bit is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

Background: Specify the color of the background in the numeral display
area. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Reference:

Indirect Reference:

If a numeral in the specified memory table entry is treated as the reference
table entry number for indirect reference, specify this item. (Setting is not
possible for NT11S.)

Table Entry:

Specify the address of the numeral memory table entry to be referred to. If
[Indirect Reference] is not selected, the contents of this numeral memory
table entry are displayed, and if [IndirectReference] is selected, the contents
of this numeral memory table entry are treated as the reference table entry
number and the contents of the referencememory table entry are displayed.

Display Type (Only Decimal can be set for NT11S.)

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in hexade-
cimal.

Format

Integer: Specify the number of digits of the integer part of the input
data.

Decimal: Specify the number of digits of the decimal fraction part of the
input data.

Zero Suppression: Specifywhether or not leading zeros are suppressed to dis-
play the input data.

Display Sign: Specify if a sign is displayed for a negative value.

: Displays the list of numeral memory table entries.

Guidance

S With a numeral display element, thememory table designationmethod can be
selected as direct designation or indirect designation.
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Example: Specifying numeral memory table address 2.

5 5
1

2

3

4

5

5 123
1

2

3

4

5 123

Direct designation

Numeral
memory table

Display

The contents of the specified
memory table entry are displayed.

Indirect designation

Numeral
memory table

Display

The contents of the specified
memory table entry are treated as
the table address reference value
and the contents of the referenced
memory table entry are displayed.

Indirect designation is possible only in the following cases. Do not apply for other
cases.

S When C200H I/F unit is used.

S When the NT21, NT30, NT30C, NT31, NT31C, NT620S, NT620C,
NT625C, NT631, or NT631C is used.

S WhenanNT20SorNT600S that uses the direct connection ver. 5. is used.

With conventional models, up to 50 indirect designation settings can be made
per screen, including both numeral display and character string display.

S For numeral display elements, it is possible to select whether numeric values
are displayed in decimal (signed/unsigned) or hexadecimal.

23456
23456

5BA0

Numeral
memory table Display in decimal

Display in hexadecimal

Reference: S With the NT21, NT31, NT31C, NT631, and NT631C, numerals are always
storedassignedbinary data.Whenallocatingnumeralmemory table entries to
PC (PLC) words, it is possible to select whether the data is recognized in BCD
or recognized in hexadecimal using the [Storage Type] property.

According to the combination of the storage type and display method, nu-
meric values are stored and displayed in the manner shown below.

00005BA0
2 3 4 5 6

5 B A 0

0 0 0 2

3 4 5 6

5 B A 0

0 0 0 0

PC (PLC) words
(2-word allocation)

Recognition in BCD
Numeral
memory table

Display

Recognition in hexadecimal

Display in decimal

Display in hexadecimal

S With NT30, NT30C, NT620S, NT620C, and NT625C, the only difference in
decimal/hexadecimal display of a numeric value iswhether or not F at themost
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significant digit is treated as a sign or a numeral.With theNT21,NT31,NT31C,
NT631, and NT631C, however, the stored numeric value is converted for dis-
play according to the decimal/hexadecimal designation.

S For [Decimal], the number of digits entered in decimal fraction part is specified.
Since integers are stored in the numeralmemory table entry, a decimal point is
appended according to this setting when a numeral is displayed.

1234 12.34

If setting for [Decimal] is 2.

Numeral
memory table

S If [DisplaySign] is selected, a blank (“ ”) is displayed for a positive value and “–”
is displayed for a negative value.

If a negative value is displayedwith [DisplaySign] deselected, it is displayedas
an absolute value.

S For [Format] (number of numeral digits; integer part + decimal fraction part),
set a sufficient value according to the contents of the numeral memory table
entry.

The allowable display range for numeric values is shown below.

Display Method Conventional Models New Models

Hexadecimal 00000000 to FFFFFFFFH 00000000 to 7FFFFFFFH

Decimal (signed) –9999999 to 9999999 –2147483648 to
2147483647

Decimal (unsigned) 0 to 99999999 0 to 2147483647*1

Conventional models: NT11S, NT20S, NT600S, NT30, NT30C, NT620S, NT620C, NT625C

New models: NT21, NT31, NT31C, NT631, NT631C

*1: Since a negative value is also displayed as a positive value when [Display
Sign] is deselected, --2147483648 is displayed as 2147483648, even though
the maximum value that can be stored in the numeral memory table is
2147483647.
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6-7 Character String Display
The contents of a character string memory table entry are displayed.

Character string displays can be used with all models.

PT

Display field

Character string memory
table (String table)Screen

No.1
No.2
No.3
No.4
No.5

TOOL

TOOL

Read

(1) The character string stored in the specified character string
memory table entry (string table) is displayed.

Operation procedure Selection using the menu bar: [Objects]→ [the String Display]

Selection using the drawing toolbar:

Terminology

Background

Foreground

Property setting

General

Position: Indicates the display position of the (character) string display field.
(The reference point is at the upper left corner of the display field.)

Font Type: Specify the font of characters to be displayed.
Standard, Half Height
(Only Standard can be set for NT11S.)

Scale: Specify the scale of characters to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8
(Not possible for NT20S)

Smoothing: Specify whether or not smoothing processing is executed for char-
acters to be displayed. (Setting is not possible for NT11S, NT20S
and NT600S.)

Attribute: Specify thedisplayattribute (attributesdisplayeddependon thePT
model.) Standard, Inverse, Flash, Inverse Flash

Color

Foreground: Specify the character color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

When this property page is called from Label of Standard Lamp or Touch Switch
Foreground ON/OFF color can be specified for Label of type String Display.
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ON: Specify the display color of a standard lamp when the PC (PLC) bit is ON.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC
(PLC) bit is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow

Background: Specify the color of thebackground in the (character) stringdis-
playarea. (Canonly beset forPTswith color display.) Transpar-
ent, white, black, blue, red, magenta, green, cyan, yellow

Settings

Reference

Indirect Reference: If the numeric value in the specified memory table
entry is treated as the reference table entry number
andused for indirect table reference, specify this item.
(Setting is not possible for NT11S.)

Table Entry: Specify the number of the character string memory
table entry (string table) to be referred to. If [Indirect
Reference] is not selected, the contents of this char-
acter string memory table entry (string table) are dis-
played. If [Indirect Reference] is selected, the con-
tents of this numeral memory table entry are treated
as the reference table entry number and the contents
of the referenced character string memory table entry
(string table) are displayed.

Length: Specify the number of characters to be displayed.

: Displays the list of numeral memory table entries or character string
memory table entries (String Table). In indirect designation, the list of
numeral memory table entries is displayed and in direct designation,
the list of character string memory table entries (String Table) is dis-
played.

Guidance

S With a (character) string display element, thememory table designationmeth-
od can be selected as direct designation or indirect designation.



6-7SectionCharacter String Display

206

Example

Specifying memory table address 2

TOOL

Character string
memory table
(String table)

Indirect designationDirect designation

Display

TOOL
1

2

3

4

5

Character string
memory table
(String table)

Display

TOOL
1

2

3

4

5 TOOL

The contents of the specified
memory table entry are displayed.

The contents of the specified numeral
memory table entry are treated as the
table entry address reference value and
the contents of the referenced memory
table are displayed.

Numeral
memory table

1

2

3

4

5

5

Indirect designation is possible only in the following cases. Do not apply for other
cases.

S When C200H I/F unit is used.

S When the NT21, NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C,
NT631, or NT631C is used.

S When an NT20S or NT600S that uses direct connection ver. 5 is used.

With conventional models, up to 50 indirect designation settings can be made
per screen, including both numeral display and (character) string display.

S If the value set for [Length] (thenumber of digits to bedisplayed) is smaller than
the number of characters in the specified character string memory table entry
(string table), the specified number of characters is displayed from the first
character of the (character) string. The remaining characters are not dis-
played.

S To display mark data or image data, specify the address of the mark data or
image data as shown below.

Note that image data cannot be inserted into a (character) string when using
the NT11S, NT20S, NT21 (20/30/620 mode off), NT31, NT31C, NT600S,
NT631, NT631C, NT31/C-V2 (20/30/620 mode off), and NT631/C-V2
(20/30/620 mode off).

ABC

DisplaySetting

ABC<!FFFE>

Mark data at code FFFE

Reference: When there are no string to show, string input will be invisible.
Therefore, with Support Tool, dotted-line frame is displayed in character fore-
ground color enclosing string input.
(This frame will not be displayed on PT.)
This frame can not be set to off. However, the dotted-line frame can be set to ON
and OFF when printing screen image (refer to page 425).
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6-8 Touch Switches
When a touch switch is pressed, any of the nine functions shown below is
executed. In addition to thegeneral functions suchas the input notification (notify
bit) and the screen switching (standalone) function, a variety of functions can be
realized including control codes used in combination with a data input element.
(Touch switches cannot be used for NT11S.)

CAUTION

Do not use input functions such as PT touch switches for applications where

danger to human life or serious property damage is possible or for emergen-

cy switch applications.

Notify bit touch switch

PT

ON/OFF
notification

Switch PC (PLC)

Specified
bit goes
ON/OFF

(1) When a touch switch is pressed, the specified bit in the PC
(PLC) goes ON/OFF.
Set switches, reset switches, alternate switches, and momen-
tary switches can be used.

Screen switching touch switch

Screen 1

Switch

Screen 2

Switching
to screen 2

(1) When a touch switch is pressed, the screen is switched to the
screen with the specified screen number.

Character string input function touch switch

A B C D E F G H I

ABC

(Character) string data input field
(by (character) string input element)

(1) When a touch switch is pressed, the label of the touch switch
is stored in the (character) string input field.

Note This type of touch switch is always used in combination with
a (character) string input element.

Pop-up window/keyboard function touch switch

OPEN CLOSE

Standard screen (base screen)
Window/Keyboard screen

(1) When a touch switch (OPEN) is pressed, the specified win-
dow (keyboard screen) is displayed on the screen presently
displayed.

(2) When a touch switch (CLOSE) is pressed, the window (key-
board screen) presently displayed closes.
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Control code input touch switch (Input key – Control)

Standard screen

Input field

1 2 3 4

(1) When a touch switch is pressed, the input processing of the
control code is executed as shown below.

S 0 to 9 numeral keys:
Data setting at the numeral setting input field

S CLR key:
Clearing the numeral setting input field

S key:
Confirmation

S Arrow symbol key:
Switching among continuous/overlapping screens
Moving the cursor in the numeral setting input field

Numeric keys can be created using the touch switches assigned
these control codes.
Note These touch switches are always used with a numeral/(char-

acter) string input element. (The element to be used differs
according to the allocated control codes.)

Copy setting touch switch

Memory
table

50
COPY

50
Copy DestinationCopy Source

Numeral memory table
Character string
memory table (String
table)
Input field specified by
cursor

Numeral memory table
Character string
memory table (String
table)
Constant

(1) When a touch switch is pressed, the data in the memory table
entry or a constant is copied to another memory table entry or
input field.

Window move touch switch

Window moves

MOVE

(1) When a touch switch (window move touch switch) is pressed,
the window can be moved by touch panel operation at PT.
When you press the destination (center of the window will
come here), window will be moved to that position.

Note Windowmove touch switch can be created only on window/
keyboard screen.

Cursor moving touch switch

Data input field 1

Data input field 2

Data input field 3

Input cursor
moves

Input cursor
moves

(1) When a touch switch (cursor moving touch switch) in an input
field is pressed, the cursor moves to that input field.

Note The cursor moving touch switch should be specified when
creating a numeral or (character) string input element. (The
cursor moving touch switch can be added later.)
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Print screen function touch switch

PRINT

Printing screen
hard copy

(1) When a touch switch is pressed, a hard copy of the screen is
output to a printer.

Operation procedure Selection using the menu bar: [Objects]→ [Touch Switch]

Selection using the drawing toolbar:

Terminology

Frame

Label

Color – ON, OFF

Property setting

General

Position: Indicates the display position of a touch switch frame (the area that
senses pressing of the switch.)
(The reference point is at the upper left corner of the touch switch
frame)

Size: Indicates the size of a touch switch frame.

Frame: Specify whether or not a frame is displayed for a touch switch.

Shape: Specify the shape of a touch switch.
Standard,Shadow,3-Dimension,Rectangle,Circle,Polygon,Sec-
tor

Show ON State: Specify the status when touch switch is pressed. When this
check box is ticked, touch switch will be lighten. (Not valid for
3-Dimension)

Color

Frame: Specify the color of a touch switch if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a touch switch which is ON.
(Can only be set for PTs with color display.)
(Setting is valid only when [Show ON state] is selected.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a touch switch that is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan,
yellow
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Settings

Function: Specify the touch switch function. Select from the following nine
functions.

Notify bit

Switch screen

Input key – Control

Input key – Window/Keyboard

Input key – String

Copy setting

Cursor move

Window move (Only available on Window/Keyboard Screen)

Print screen

The setting contents differ depending on the selected touch switch function.

For details of setting, refer to Guidance.

Light Function

Touch switch also has the light function like a lamp.

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) that drives a touch
switch ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit that
drives a touch switch ON/OFF.

Lamp Attributes

ON Type: Specify the status of a touch switch that is ON.
Light, Flash

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
the [View] menu.
Additionally, to view flashing display of lamp attribute, select [Simulate Flash]
from the [View]menu. For details, refer to 5-1-3Changing theDisplayMethodon
the Support Tool.

Label

Label: Specify whether or not a label is appended to a touch switch.

Label Type: Specify the type of the Label when [Label] is selected. Fol-
lowing selections will be available for the NT21 and
NT31/631-V2models:Static, StaticOnOff, NumeralDisplay
and String Display. For the other PT models, this option is
disabled and set to Static (default). Refer to Guidance sec-
tion for details of individual label type description.

To display a label, set a checkmark in the check box of the Label attribute in [La-
bel] page and select an option of the available options from the Label Type com-
bo box.
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For non-NT21 and NT31/631-V2 models this combo box will have only one
choice (‘Static’) and this will remain disabled.

Static : For this option the On label and the Off label will be same.

On Off Static: For this option On/Off labels may be different.

Numeral Display: Displays the numeral value by referencing the specified table
entry. Indirect reference is also possible.

String Display: Displays the character string by referencing the specified table
entry. Indirect reference is also possible.

To display the settings for a label, click the Button. The dialog box for
setting a label is displayed.

Use the button in the property dialog to copy the I/O comment

set to the PLC address as a label.

In case of Notify Bit function: I/O comment of notify bit

In case of other function: I/O comment of lamp bit

The property setting dialog for both Static and On Off Static labels is shown be-
low.

For Static, the label can be set by changing description ofOff Label group box of
[Standard Lamp< Label >] dialog box. On Label group box will be disabled.

ForOnOff Static, theOff Label and theOnLabel can be set by changing descrip-
tion of corresponding text boxes.

Off Description: Specify the text of the label that will be displayed when lamp
bit is OFF.
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On Description: Specify the text of the label that will be displayed when lamp
bit is ON.

Line Spacing Determines the space between two lines in both the Off De-
scription and the On Description.

Insert New Line Inserts a new line character in the description to bring the fol-
lowing characters to the next line. On the Label Description
edit box, the new line character will be shown as ‘<∖n>’.

Set Lines Displays the On/Off Description Settings dialog box.
This dialog is for entering Off Description andOn Description with multiple lines.

In all NT31/631V2models, Labels canbe entered inmultiple lines. The following
table shows the specification for each PT model.

Maximum
number of
charac-
ters

Maximum
number of
charac-
ters per
line

Number
of lines
permitted

Remarks

NT21 128 32 1 to 8 Maximum number of
characters per line
include the “\n” char-
acter.

NT31/31C 128 40 1 to 15 Maximum number of
characters per line
include the “\n” char-
acter.

NT631/631C 256 80 1 to 30 Maximum number of
characters per line
include the “\n” char-
acter.

Set Lines button will display On/Off Description Settings dialog box, in which the
On/Off description can be entered in multiple lines by pressing Enter Key.

When Numeral Display or String Display is selected as Label Type
(For NT31/631-V2 Models only)

Indirect Reference:

If a numeral in the specified memory table entry is treated as the reference table
entry number for indirect reference, specify this item.

Table Entry:

Specify the address of the numeral or stringmemory table entry to be referred to.
If [Indirect Reference] is not selected, the contents of this numeral or string
memory table entry are displayed, and if [Indirect Reference] is selected, the
contents of this numeral memory table entry are treated as the reference table
entry number and the contents of the reference memory table entry are dis-
played.

Edit:

Displays theNumeralDisplay orStringDisplayproperty page.For descriptionon
property settings refer to Section 6-6 Numeral Display and 6-7 String Display.
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Guidance

Common description

S The following shapes can be used for touch switch elements.
(Selectable shapes vary according to the PT model.)

Rectangle

SectorCircle Polygon

3-DimensionStandard Shadow

Although [Standard]and [Rectangle] have thesameshape, how the touchswitch
frame is defined differs between them. With [Standard], the touch switch frame
itself provides the display graphic.With [Rectangle], however, a rectangle shape
can be specified independently of the touch switch frame and the touch switch
frame can be separated from the rectangle shape.

S If rectangle, circle, polygon, or sector is selected, only the shape of a graphic
can bemodified in the procedure shown below. The touch switch frame (touch
sensing area) remains unchanged even if the shape is modified.

Use the element edit function to modify the touch switch shape. (For details,
refer to page 110.)

(1) Click on a line of a graphic while pressing the Shift key and Ctrl key.

(2) Drag a green J mark to modify the graphic.

(3) To add a greenJmark (addition of a node) in a polygon, position themouse
cursor on the line in a graphic and execute a vertex addition operation (right
click the mouse→ [Add Node]).

To delete a greenJmark (deletion of a node), position themouse cursor on
the green J mark to be deleted and execute a vertex deletion operation
(right click the mouse→ [Remove Node]).

(4) Drag the added green J mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

(1) (2) (3) (4)

S A touch switch element can display a label (touch switch name).
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Todisplay a label, set a checkmark in the check box of the [Label] property and
click on . The dialog box for setting a label is displayed. Set the prop-
erty for the label to be displayed.

For the procedure for setting the properties, refer to 6-2-7 Text. When using the
NT21,NT31,NT31C,NT631, andNT631C, it is possible to set different colors for
the lampONand lampOFF states.With thesemodels, however, it is not permis-
sible to insert image data.

button in theproperty dialog can copy the I/O comment set to the

PLC address as a label.

In case of Notify Bit function: I/O comment of notify bit

In case of other function: I/O comment of lamp bit

S Toedit theposition of a label, use theelement edit function. (For details, refer to
page 110.)

(1) Click on the label while pressing the Shift key and Ctrl key.

(2) Drag the label to change the display position.

(1) (2)

6-8-1 Input Notify Touch Switch
Function: Notify bit

Settings

Address

PC (PLC) Bit Address: Specify the PC (PLC) bit that is drivenON/OFFac-
cording to the operation of a touch switch.

I/O comment: Specify the comment of the PC (PLC) bit that is
driven ON/OFF according to the operation of a
touch switch.



6-8SectionTouch Switches

215

Action Type

Set, Reset, Alternative, Momentary

: Displays the dialog box used to specify the bit number.

: Displays the I/O comment table.

Guidance

S The input notify touch switch drives the specified PC (PLC) bit ON/OFF in re-
sponse to the pressing of the touch switch.

S The status of the PC (PLC) bit when the touch switch is pressed is processed
as shown below according to the setting for [Action Type].

Set: Drives thePC (PLC) bitONwhen the touch switch is pressed. ThePC (PLC)bit
stays ON even after the touch switch is released.

Reset: Drives the PC (PLC) bit OFF when the touch switch is pressed. The PC (PLC)
bit stays OFF even after the touch switch is released.

Alternative: Drives the PC (PLC) bit from OFF to ON or from ON to OFF when the touch
switch is pressed. The PC (PLC) bit is turned ON when the touch switch is
pressedwhile it isOFFand if the touch switch is pressedwhen thePC (PLC)bit
is ON, the PC (PLC) bit goes OFF.

Momentary: Drives the PC (PLC) bit ONwhen the touch switch is pressed; thePC (PLC) bit
remains ON only while the touch switch is being pressed. The PC (PLC) bit
goes OFF when the touch switch is released.

6-8-2 Switch Screen Touch Switch
Function: Switch screen

Settings

Screen No.:Specify the screen number of the screen to which the display is to
change when the touch switch is pressed.

Guidance

The switch screen touch switch changes the displayed screen at aPT to the spe-
cified screen.

6-8-3 (Character) String Input Touch Switch
Function: Input key – String

Settings

Input Key String: Indicates the (character) string that is input into the (charac-
ter) string input field when the touch switch is pressed. This
control is enabled for the PT models NT21 and NT31/631
only.

Insert Mark: Select the mark data to be pasted into a string.

Copy from Label Copies the contents of Touch Switch’s label to the Input Key
String label. This will be enabled only if the label type of a
Touch Switch is Static or On Off Static.

Related elements and setting

(Character) string input element:
[Objects]→ [Data Input]→ [String] (Refer to 6-4-2 (Character) String Input.)
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Guidance

S The (character) string input touch switch is used for inputting a (character)
string to a (character) string input field.

S The (character) string to be input is set for a label in the General attributes. It
may be a single character or multiple (character) strings.

S Numeric keys can be created on the screen by combining (character) string
input touch switches and control code input touch switches.

S For details of (character) string input elements, refer to 6-4-2 (Character)
String Input.

Note (Character) string input touch switches are always used in combination with
(character) string input elements.

6-8-4 Pop-up Window/Keyboard Function Touch Switch
Function: Input key-Window/Keyboard

Settings

Screen No.: Specify the window (keyboard screen) type (Local 1 or Local
2) and screen number of thewindow (keyboard screen) that is
displayed when the touch switch is pressed.

Window Position: Specify the bottom left co-ordinate of window to be dis-
played.

Action Type: Specify how the window/keyboard is displayed when the
touch switch is pressed.
Open, Close, Toggle

Replace Local Window:

Specify thebehavior ofwindowswhenanotherwindowof the
same type (Local 1, Local 2) is alreadydisplayedwhenopen-
ing a window.

Guidance

The input key-window/keyboard touch switch is used for displaying the window
(keyboard screen) overlapping the presently displayed screen (base screen).

This touch switch function can not be used with NT20S and NT600S.
Settings shown below can be made only with the NT21 and with the NT31,
NT31C, NT631, NT631C “-V1” and above.

Local 2
Window Position
Replace Local Window

Display methods of window/keyboard varies depending on PT models.

NT30,NT30C,NT620S,NT620C,NT625C, andNT31,NT31C,NT631,NT631C
below “-V1”

How the window/keyboard is displayed is determined by the
setting for [Action Type].

Action Type

Open: Displays the specifiedwindow/keyboard. If another window/ keyboard
is already displayed, it is closed and then the specified window/key-
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board is opened. If the specified window/keyboard is already dis-
played, no operation is executed.

Close: Closes the presently displayed window/keyboard. No operation is
executed if no window/keyboard is displayed.

Toggle: Closes thepresently displayedwindow/keyboardandopens thespeci-
fied window/keyboard. If the specified window/keyboard is already
opened, the window/keyboard closes.

NT21 and NT31, NT31C, NT631, NT631C “-V1” and above

How the window is displayed is determined by the settings for [Action
Type] and [Replace Local Window].

Action Type

Open: Displays the specifiedwindow. If anotherwindowof the same type (Lo-
cal 1, Local 2) is already displayed, follows the setting for [Replace Lo-
cal Window]. If the specified window is already displayed in specified
type, no operation is executed.

Close: Closes the presently displayed window with specified type (Local 1,
Local 2) and number. No operation is executed if specified window is
not displayed in specified type.

Toggle: Closes the windowwith specified type (Local 1, Local 2) and number if
it is presently displayed and opens the specified window if it is not
opened. If another window of the same type is already displayed, fol-
lows the setting for [Replace Local Window].

Replace Local Window

Check mark: If another window of the same type (Local 1, Local 2) is already
displayed, no operation is executed.

No check mark: If another window of the same type(Local1, Local 2) is already
displayed, closes the window and then opens the specified win-
dow.

6-8-5 Control Code Input Touch Switches

Function: Input key-Control

Settings

Control Key: Specify the key code that is input when the touch switch is
pressed. (Select from 39 kinds of codes.)

Some codes cannot be specified depending on the PT model.

Related elements and setting

Numeral input element:
[Object]→ [Data Input]→ [Numeral] (Refer to 6-4-1 Numeral Input.)

(Character) string input element:
[Object]→ [Data Input]→ [String] (Refer to 6-4-2 (Character) String Input.)
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Guidance

S Control code input touch switches control data input processing, cursormove-
ments, etc.

S The contents of control are selected from the codes shown below.

Control code input touch switches are used in combination with numeral input
elements, (character) string input elements, continuousscreens,alarm list ele-
ments, and alarm history elements.

(1) Combination with numeral input elements, (character) string input ele-
ments, and continuous screens

If control code input touch switches are arranged with a numeral input ele-
ment or a (character) string input element on the same screen (including the
window (keyboard) and the base screen), these touch switches canbeused
to input data into the input field.

Numeric keys and other data input devices can be created by combining
these items.

: Inputs numeral 0 in a data input field.

: Inputs numeral 1 in a data input field.

: Inputs numeral 2 in a data input field.

: Inputs numeral 3 in a data input field.

: Inputs numeral 4 in a data input field.

: Inputs numeral 5 in a data input field.

: Inputs numeral 6 in a data input field.

: Inputs numeral 7 in a data input field.

: Inputs numeral 8 in a data input field.

: Inputs numeral 9 in a data input field.

: Inputs hexadecimal A in a data input field.

: Inputs hexadecimal B in a data input field.

: Inputs hexadecimal C in a data input field.

: Inputs hexadecimal D in a data input field.

: Inputs hexadecimal E in a data input field.

: Inputs hexadecimal F in a data input field.

: Moves cursor in a data input field one character left.

: Moves cursor in a data input field one character right.

: Deletes numeric value/(character) string in a data input field.

: Cancels inputs in a data input field.

: Backspaces a cursor to delete a character in a data input field.

: Deletes the character at the cursor location in a data input field.
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: Confirms inputs in a data input field (cursor remains in this field.).

: Confirms inputs in a data input field (cursor moves to the next input
field.).

: Toggles plus (+) and minus (–) sign in a data input field.

: Inputs a decimal point in a data input field.

: Moves the input cursor to the data input field at the upper left area.

: Moves the cursor to the data input field immediately above the present
data input field.

: Moves the cursor to the data input field immediately below the present
data input field.

: Move the cursor to the left data input field.

: Move the cursor to the right data input field.

: Moves the cursor to the previous data input field in the order.
Changes continuous screens to the previous screen.

: Moves the cursor to the next data input field in the order.
Changes continuous screens to the next screen.

Reference: With and keys, the cursor moves between the data input fields in the order
the data input fields weremade. However, the order of moving the cursor can be
changed with [Set Order] of the [Draw] menu.

(2) Combination with alarm list elements and alarm history elements

This control code can be selected only with NT30, NT30C, NT620S,
NT620C,andNT625C.With theNT21,NT31,NT31C,NT631, andNT631C,
these touch switches are a part of alarm list/history elements.

These touch switches can be created automatically when creating an alarm
list/history.

: Scrolls up alarm list/history display page (page scroll).

: Scrolls down alarm list/history display page (page scroll).

: Scrolls up alarm list/history display page (line scroll).

: Scrolls down alarm list/history display page (line scroll).

(3) PT control

: Stops buzzer.

: Displays system menu.

Reference: Any required (character) string can be used as the label of a control code input
touch switch. For example, “SET” can be used as the label of a control code
touch switch.

Click the Button in the Tab attributes to display the label setting
dialog box. Input a label in the displayed dialog box.
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6-8-6 Copy Setting Touch Switch
Function: Copy setting

Settings

Copy From

Numeral Table: Specifies a numeral table entry for the copy source.

String Table: Specifies a character string memory table entry (string
table) for the copy source.

Code: Specifies copying a constant (numeric data).

Data setting field: Specify the memory table entry number when a numeral
table entry or a character string memory table entry
(string table) is specified.When code is specified, specify
a constant here.

Copy To

Numeral Table: Specifies a numeral table entry for the copy destination.

String Table: Specifies a character string memory table entry (string
table) for the copy destination.

Cursor Position: If this is specified, the numeral input field or the character
string input field, which is the active input objective, is se-
lected for the copy destination.

Data setting field: Specify the memory table entry number when a numeral
table entry or a character string memory table entry
(string table) is specified. If Cursor Position is selected,
this field is invalid.

: Displays the list of numeral/character string memory
table entries (string table).

Guidance

S A copy setting touch switch is used in the cases shown below.

Copying the data in a memory table entry to another memory table entry

part3
part2
part1

Character string memory
table (String table)

SET 2

SET 3

part1
SET 1

By setting the data in several memory table entries beforehand, the necessary
data can be copied to the work area as needed.

Note Data copying from amemory table entry to amemory table entry is possible only
between memory table entries of the same type; from numeral memory table
entry to numeral memory table entry, and from character string memory table
entry (string table) to character string memory table entry (string table).
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Copying a constant to a numeral memory table entry (setting)

Numeral
memory table

1234
1234SET 1

2345SET 2

3456SET 3

By setting a constant in the data setting field of a copy function touch switch be-
forehand, the necessary data can be copied to a numeral memory table entry as
desired.

Note Copying a constant to a string table entry is not possible.

Copying data or a constant in a memory table entry to an input field

Numeral
memory table

1234

CONSTANT

1

Character string memory
table (String table)

PT

1234

PT

Numeral input
field

(Character) string
input field

By setting the setting data to amemory table entry or a touch switch beforehand,
the data is copied to the input field at the cursor location as desired.

Since the data is copied to the input field, it can be modified after copying.

6-8-7 Cursor Moving Touch Switch
Function: Moving cursor

Settings

Use Window/Keyboard Screen:
Specify whether or not the window (keyboard screen)
is displayed when the cursor is moved.

Screen No. : Specify the screen type (Local 1/Local 2) and the
screen number of thewindow (keyboard screen) to be
displayed when moving a cursor.

Window position: Specify the bottom left co-ordinate of window to be dis-
played.

Replace Local Window: Specify thebehavior ofwindowswhenanotherwindow
of the same type (Local 1/Local 2) is already displayed
when opening a window.

Auto Arrange: Specify if a touch switch is to move with, or indepen-
dently of, an input field when the input fields shifts.

Related elements and setting

Numeral input element:
[Object]→ [Data Input]→ [Numeral] (Refer to 6-4-1 Numeral Input.)

(Character) string input element:
[Object]→ [Data Input]→ [String] (Refer to 6-4-2 (Character) String Input.)
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Guidance

S When a cursor moving touch switch is pressed, input is enabled at the speci-
fied (or associated) input field.

S Settings shown below can be made only with the NT21 and with the NT31,
NT31C, NT631, and NT631C “-V1” and above.

Local 2
Window Position
Replace Local Window

S If a cursormoving touch switch is created automatically at the creation of a nu-
meral/(character) string input element, the touch switch is created overlapping
the input field.

S It is possible to specify a window (keyboard) for a cursor moving touch switch.
This specification enables display of the specified window (keyboard) by sim-
ply pressing the cursor moving touch switch.

Numeral/(character) string input field

When the touch switch
at the top is pressed

Numeral/(character) string input field

Specified window opens.

Touch switches
assigned with
cursor movement
and window open
functions

1 2 3 4 5 6

–41.8

ABCDE

1 2 3 4 5 6

–41.8

1 2 3
654

Reference: S A cursor moving touch switch can be created automatically when creating a
numeral input element or a (character) string input element.

S If [Auto Arrange] is selected, it is not possible to move a touch switch indepen-
dently. To move a touch switch independently, deselect this attribute.

S If a cursormoving touch switch is created later independently, the touch switch
can be associated with a specific input field. Specify the touch switch and se-
lect [Draw] (menu bar)→ [Associate With]. To disassociate the touch switch
from an input field, select [Draw] (menu bar)→ [Disassociate].

S Cursor movement among data input fields is also possible using control code
input touch switches for which arrow-symbol key codes are set.
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6-8-8 Window Moving Touch Switch

Function: Moving window

Settings

Function setting only.

Guidance

When a window move touch switch on a window is pressed, window can be
moved by touch panel operation at PT.

This touch switch function is available only with the NT21 and with the NT31,
NT31C, NT631, and NT631C “-V1” and above.

Procedure for moving a window is as follows:

1)Press a window move touch switch on a window to be moved.

2)Press the touch panel at a destination position of a window (center position of
window comes) and a window moves to that position.

Screen Screen

(3)(2)(1)

Window Window in a moving status

Screen

6-8-9 Print Screen Touch Switch

Function: Print screen

Settings

Printing of Display Screen

Start: Specify when starting printing of screen hard copy.

Abort: Specify when aborting printing.

Guidance

S A print screen touch switch is used to print the image (hard copy) of the pres-
ently displayed screen.

S Printing of a hard copy can be aborted by pressing the abort touch switch if it is
selected in Settings.

S The print screen function cannot be usedwith theNT20S,NT21, andNT600S.

S With conventional models where the samememory area is shared by the print
screen function and the input key-window/keyboard function, it is not possible
to print a hard copy while a window (keyboard) is displayed.
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6-9 Graphs

Graphscanbeused todisplay thecontents of anumeralmemory tableentry.The
Support Tool provides four types of graph as indicated below.

Bar Graph:
Apresent value in a numeralmemory table entry is displayed in the formof a
bar graph.

Analogue Meter:
A present value in a numeral memory table entry is displayed in the form of
quarter, semi-circle, and circle graph.

Broken-line Graph:
Present values of several consecutive numeral memory table entries are
displayed in the form of a broken-line graph.

Trend Graph:
Numeralmemory tableentry contents that changewith timearedisplayed in
the form of a trend graph. The graph moves as time passes.
The data logging function, which logs the past data, and the background
function, which continues logging the data while a trend graph is not
displayed, are available.

6-9-1 Bar Graph

A present value in a numeral memory table entry is displayed in the form of a bar
graph.

Numeral memory table

76%

100%

0%

7600

(1) A value in a numeral memory table entry is converted into a percentage val-
ue, in the range from0 to 100%or from–100% to100%, anddisplayed in the
form of a bar graph.

Operation procedure

Selection using the menu bar: [Objects]→ [Graph]→ [Bar Graph]

Selection using the drawing toolbar:
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Terminology

Display % Frame

Foreground

Background

+ Range–Range

Property setting

General

Position: Indicates the display position of a bar graph.
(The reference point is at the upper left corner of the bar graph)

Size: Indicates the size of a bar graph.

Frame: Specify whether or not a frame is displayed for a bar graph.

Display Sign: Specify whether or not a display area for negative values is
displayed. (Setting is not possible for NT11S.)

Direction: Specify the display direction of a bar graph.
Right (→ ), Left (← ), Up ( ↑ ), Down ( ↓ )
(Only Right (→) can be set for NT11S.)

Color

Frame: Specify the color of a bar graph frame if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of bar graph displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of bar graph displayed for a negative value.
(Can only be set for PTs with color display.) Valid only when [Display
Sign] is selected. White, black, blue, red, magenta, green, cyan, yel-
low

Settings (Only 100% can be set for NT11S.)

Value

Table Entry: Specify the table entry number of a numeralmemory table entry to
be displayed.

Display %: Specify whether or not a percentage value is displayed on the
screen.

100%

Table Entry: Specify this item if a 100%value is set by a numeralmemory table
entry; set the table entry number of the numeral memory table.

Value: Specify this item if a 100%value is set by a constant; set the value
to be taken for a 100% value.
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0%

Table Entry: Specify this item if a 0% value is set by a numeral memory table
entry; set the table entry number of the numeral memory table.

Value: Specify this item if a 0% value is set by a constant; set the value to
be taken for a 0% value.

–100%

Table Entry: Specify this item if a –100% value is set by a numeral memory
table entry; set the table entry number of the numeral memory
table.

Value: Specify this item if a –100% value is set by a constant; set the val-
ue to be taken for a –100% value.

Note that specification for –100% is valid only when [Display Sign] is selected.

Setting of 0% and --100% is not possible with NT20S and NT600S.

Guidance

S The following types of bar graph element are provided.

0% to 100% display

Direction: Right

Direction: Left Direction: Up Direction: Down

–100% to 100% display

Direction: Right

Direction: Left Direction: Up Direction: Down

S Which of [0 to 100%] and [–100 to 100%] bar graphs is displayed should be
selected with the setting for [Display Sign] in the general attributes.

Check mark set: –100 to 100% display
Check mark not set: 0 to 100% display

S In the default setting, a percentage value is displayed.
Whether or not a percentage value is displayed can be set with the [Display%]
property.

Check mark set: A percentage value is displayed.
Check mark not set: A percentage value is not displayed.

S If the setting is for a percentage value to be displayed, the size and display
position of the value can be modified using the element edit function in the
manner shown below. (For detail of the element edit function, refer to page
110.)
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(1) Click on a percentage value while pressing the Shift key and Ctrl key.

(2) Drag a percentage value to change the display position.

Example: Modifying the percentage value display position

(1) (2)

(3) To change the size of a displayed percentage value, double click on the val-
ue.

The properties of a percentage value display are displayed.

Position: Indicates the display position of the percentage value.
(The reference point is at the upper left corner of the percentage
value.)

Font Type: Specify the font of the value to be displayed.
Standard, Half Height, Double Width (Only Standard can be set
for NT11S.)

Scale: Specify the scale of the value to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8
(Only 1×1 (Equal) can be set for NT11S.)

Smoothing: Specify whether or not smoothing processing is executed for the
value to be displayed.
(Setting is not possible for NT11S, NT20S and NT600S.)

Attribute: The display attribute cannot be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display
area. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

S When displaying a specific value (reference value) in a bar graph, the percent-
age value is calculated based on the values for 100%, 0%, and –100%.
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If the 100% value, 0% value, and –100% value are set as indicated below, ref-
erence values are displayed in the bar graph as shown below.

Bar graph

Value referred to: 3000 100%

Value referred to: 1500 50%

Value referred to: 0 0%

Value referred to: –1000 – 50%

Value referred to: –2000 – 100%

If the 100% value, 0% value, and –100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Numeral
memory table

0

1

2

3

4

5
–2000

0
3000

Bar graph

6-9-2 Analogue Meter
Apresent value in a numeralmemory table entry is displayed in the form of quar-
ter, semi-circle, circle graph.

Analogue meter can be used only with the NT21 and with the NT31, NT31C,
NT631, and NT631C “-V1” and above.

Numeral Memory Table

65%

0650
--100% 100%

0%

A value in a numeral memory table entry is
converted into a percentage value, in the
range from 0 to 100% or from --100% to
100%, and displayed in the form of
quarter, semicircle, circle graph.
Also, scale display is available.



6-9SectionGraphs

229

Operation Procedure

Selection using the menu bar: [Objects]→ [Graph]→ [Analogue Meter]

Selection using the drawing toolbar:

Terminology

Display %

Foreground Color

+ Range-- Range

Scale

Frame

Property setting

General

Position: Indicates the display position of an analogue meter.
(The referencepoint is at theupper left corner of the analogueme-
ter. It changes depending on the other settings.)

Size:

Center Point: Indicates the center point of an arc or a circle of the analogueme-
ter.
(It is not affected by other settings.)

Radius: Indicates the meter radius of an analogue meter.
(It is not affected by other settings.)

Frame: Specify whether or not a frame is displayed for a meter of an
analoguemeter.When the framedisplay isON, select the frame
color. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Display Sign: Specify whether or not a display area for negative value is dis-
played.

Direction: Specify the positive direction of an analogue meter.
Clockwise, Anti-Clockwise

Meter Shape

Shape: Specify the shape of an analogue meter.
Quarter, Semi-Circle, Circle

Direction: Specify the display direction of an analogue meter.
Right (→), Left (←), Up (↑), Down (↓)

Type: Specify the display type of an analogue meter.
Needle, Fill

Width Rate: Specify the meter width of an analogue meter in % format re-
garding the radius as 100%.
10 to 100 (by 1%)
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Scale Display

Scale: Specify whether or not a scale is displayed for an analogue me-
ter.

Distance: Specify the scale position in % format regarding the radius as
100%.
0 to 150 (by 1%)

Scale Length: Specify the scale length in % format regarding the radius as
100%.
10 to 110 (by 1%)

No. of Division: Specify the number of the division that the scale should be di-
vided in the range from 0 to 100%.
1 to 20

Scale Color: Specify the scale color of an analogue meter.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Color

Foreground: Specify the color for displaying the present value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the circumscribed rectangle of an
analogue meter. (Can only be set for PTs with color display.)
Transparent, white, black, blue, red,magenta, green, cyan, yellow

+Range: Specify the color of analoguemeter displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green cyan, yellow

--Range: Specify thecolor of analoguemeter displayed for anegative value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Settings

Value

Table Entry: Specify the table entry number of a numeral memory table entry to
be displayed.

Display %: Specify whether or not a percent value is displayed on the screen.

100%

Table Entry: Specify this item if a 100% value is set by a numeral memory table
entry; set the table entry number of the numeral table.

Value: Specify this item if a 100% value is set by a constant; set the value
to be taken for a 100% value.

0%

Table Entry: Specify this item is a 0% value is set by a numeral memory table
entry; set the table entry number of the numeral table.

Value: Specify this item if a 0% value is set by a constant; set the value to
be taken for a 0% value.

--100%

Table Entry: Specify this item if a --100%value is set by anumeralmemory table
entry; set the table entry number of the numeral table.
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Value: Specify this item if a --100%value is set by a constant; set the value
to be taken for a --100% value.

Note that specification for --100% is valid only when [Display Sign] is selected.

Guidance:

S Analogue meters are displayed as follows depending on the settings of
[Shape], [Direction] and [Display sign].

Assumptions
Direction: Clockwise, Display: 30%

Shape Display
sign

Direction:
Up (↑)

Direction:
Down (↓)

Direction:
Left (←)

Direction:
Right (→)

Quarter

ON

Quarter

OFF

Semi-

ON

Semi
Circle

OFF

Circle

ON

Circle

OFF

S Which of [0 to 100%] and [-100 to 100%] analogue meters is displayed should
be selected with the setting for [Display Sign] in the general attributes.

Check mark set: --100% to 100% display

Check mark not set: 0 to 100% display

S A present value is displayed as follows according to the types.

Needle Fill
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S Meter shape is displayed as follows according to the width rate.

Width Rate: 10% Width Rate: 50% Width Rate: 100%

S Scale position and its shape are displayed as follows depending on the set-
tings of [Distance], [Scale Length].

Scale
Length Distance: 0% Distance: 100% Distance: 150%

10%

50%

100%

Scale is always displayed at the front of meter. Therefore, when type is set to a
Needle, the needle may be invisible if meter and scale are overlapped.

S When the Display Sign is set to ON, specified No. of division is applied also for
a negative range. Therefore, actual numbers of division differs as follows de-
pending on the presence/absence of display sign even if the specified number
of divisions is same.

Example: In case No. of division is 5

Display Sign: ON Display Sign: OFF

S In the default setting, a percentage value is displayed.

Whether or not a percentage value is displayed can be set in the [Display La-
bel] property.

Check mark set: A percentage value is displayed.

Check mark not set: A percentage value is not displayed.

S If the setting for a percentage value is displayed, the size and display position
of the value can be modified using the element edit function in the manner
shown below. (For detail of the element edit function, refer to page 110.)

(1) Click on a percentage value while pressing the Shift key and Ctrl key.

(2) Drag a percentage value to change the display position.
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E.g. Modifying the percentage value display position.

(1) (2)

(3) To change the size of a displayed percentage value, double click on the val-
ue.

The properties of a percentage value display are displayed.

Position: Indicates the display position of the percentage value.
(The reference point is at the upper left corner of the percentage
value.)

Font Type: Specify the font of the value to be displayed.
Standard, Half Height, Double Width

Scale: Specify the scale of the value to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8

Smoothing: Specify whether or not smoothing processing is executed for the
value to be displayed.

Attribute: The display attribute can not be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display
area. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

When displaying a specific value (reference value) in an analogue meter, the
percentage value are calculated based on the values for 100%, 0%, --100%
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When the following values are specified 100%, 0%, --100% inananaloguemeter
with semi-circle shape:

Analogue
Meter

Value referred to: 3000

Value referred to: 1500

Value referred to: 0

Value referred to: --1000

Value referred to: --2000

If the 100% value, 0% value, and --100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Analogue
Meter

Numeral
Memory
Table

3000
0

--2000

0
1
2
3
4
5
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6-9-3 Broken-line Graph
The present values of several consecutive numeral memory table entries are
displayed in the form of a broken-line graph.

0%

Numeral memory
table

30
80
32
72
33
83

Broken-line graph
100%

(1) The values of consecutivememory table entries are converted into percent-
age values, in the range from 0 to 100% or from –100% to 100%, and dis-
played in the form of a broken-line graph.

Operation procedure

Selection using the menu bar: [Objects]→ [Graph]
→ [Broken-line Graph]

Selection using the drawing toolbar:

Terminology

Frame

+Range

–Range

Line

Property setting

General

Position: Indicates the display position of a broken-line graph.
(The reference point is at the upper left corner of the broken-line
graph)

Size: Indicates the size of a broken-line graph.

Frame: Specify whether or not a frame is displayed for a broken-line
graph.

Display Sign: Specify whether or not a display area for negative values is
displayed.

Direction: Specify the display direction (display direction of numeral
memory table entries in ascending order) of a broken-line graph.
Right (→ ), Left (← ), Up ( ↑ ), Down ( ↓ )
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Color

Frame: Specify the color of a broken-line graph frame if [Frame] is
selected. (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of broken-line graph displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of broken-line graph displayed for a negative value.
(Can only be set for PTs with color display.)
Valid only when [Display Sign] is selected.
White, black, blue, red, magenta, green, cyan, yellow

Settings

: Specify this when displaying multiple broken lines. The line
properties [Line] are displayed.

: Specify this when deleting broken lines.

: Specify this when modifying broken lines. The line properties
[Line] are displayed.

Line

Start Table Entry: Specify the start table entry number of the numeral memory
table entries that are displayed in a broken-line graph.

No. of Points: Specify the number of vertices in the broken-line graph.

Interval Type

Even: Specify this when displaying numeral memory table entries at even
intervals.

Uneven: Specify this when displaying numeral memory table entries at
user-selected intervals.

: Set the broken-line intervals if [Uneven] is selected.

Line

Color: Specify the broken-line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Style: Specify the broken-line style.
Solid, Dash, Dot-dash, Dot-dot-dash

100%

Table Entry: Specify this item if a 100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 100% value is set with a constant: set the
value to be taken as the 100% value.

0%

Table Entry: Specify this item if a 0% value is set with a numeral memory table
entry: set the table entry number of the numeral memory table.

Value: Specify this item if a 0% value is set with a constant:
set the value to be taken as the 0% value.
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–100%

Table Entry: Specify this item if a –100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a –100% value is set with a constant:
set the value to be taken as the –100% value.

Note that specification for –100% is valid only when [Display Sign] is selected.

Guidance

S The following types of broken-line graph element are provided.

0% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→ Higher digit word

↑Higher digit word

← Higher digit word

↓Higher digit word

–100% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→ Higher digit word

↑Higher digit word

← Higher digit word

↓Higher digit word

S Which of [0 to 100%] and [–100 to 100%] broken-line graphs is displayed
should be selected with the setting for [Display Sign] in the general properties.

Check mark set: –100 to 100% display

Check mark not set: 0 to 100% display

S If you specify a broken-line graph element, only one broken line is displayed.
Tomodify the settings for the broken line, select the broken line to bemodified
and click on . The line properties are displayed.
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To add a broken line, click on . A broken line is added and the line
properties are displayed for the added broken line. A maximum of 256 broken
lines can be created.
To delete a broken line, select the broken line to be deleted with the “Settings”
and click on . The specified broken line is deleted.

S The following four types of line are provided for displaying broken-line graphs.

Dot-dot-dashSolid Dash Dot-dash

Set the line type with the [Style] property.

S The relationships between the points (vertices) in a broken-line graph and
numeral memory table contents are shown below.

Numeral memory table

30
70

88
28

When display direction is right

Start table entry number

Number of points

50

67

S The intervals between numeral memory table entries in a broken-line graph
can be set as even or uneven, as desired, with the [Interval Type] line property.

If you select even, the numeral memory table entries are displayed in equal
intervals.

Even intervals

If you select uneven, the intervals between numeralmemory table entries canbe
set as desired.

Click on , and the interval setting dialog box is displayed.

Set number of dots
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Intervals can be set in the manner shown below.

Note that intervals are set as numbers of dots.

(1) Specify the point for which the interval is to be set. The field of the specified
point is displayed in reverse video.

(2) Change the width between points (the number of dots).

(3) Click on .

(4) After setting the interval for all point positions, click on .

S Whendisplaying abroken-line graph, the display points are determinedby cal-
culating the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, ref-
erence values are displayed in the broken-line graph as shown below.

Value referred to: 3000 100%

Value referred to: 1500 50%

Value referred to: 0 0%

Value referred to: –1000 –50%

Value referred to: –2000 –100%
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If the 100% value, 0% value, and –100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Numeral memory
table

0

1

2

3

4

5
–2000

0
3000

6-9-4 Trend Graph
Changes in the contents of a numeralmemory table entrywith timearedisplayed
in the form of a trend graph.

0%

Numeral memory
table

80

Trend graph
100%

(1) The value in a numeralmemory table entry is converted into percentage val-
ues at the set intervals, in the range from0 to 100%or from–100% to 100%,
and displayed in the form of a trend graph.

Operation procedure

Selection using the menu bar: [Objects]→ [Graph]→ [Trend Graph]

Selection using the drawing toolbar:

Terminology

Frame

+Range

Display and control
touch switches

–Range

Line

Display %

(Only NT31, NT31C, NT631, NT631C)
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Property setting

General

Position: Indicates the display position of the trend graph.
(The reference point is at the upper left corner of the trend
graph)

Size: Indicates the size of the trend graph.

Display

Type: Specify the trend graph display type.
Standard, Pen Reco (pen recording)

Drawing Width: Specify the amount of graph shift when the display is updated.

Frame: Specify whether or not a frame is displayed for the trend graph.

Display Sign: Specify whether or not a display area for negative values is
displayed.

Direction: Specify the direction of trend graph movement.
Right (→ ), Left (← ), Up ( ↑ ), Down ( ↓ )

Sampling Cycle: Specify the graph updating time interval.

NT30, NT30C, NT620S, NT620C, NT625C: 0.1 second unit
NT21, NT31, NT31C, NT631, NT631C: 0.5 second unit

Color

Frame: Specify the color of the trend graph frame if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

+Range: Specify the color of trend graph displayed for a positive value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

–Range: Specify the color of trend graph displayed for a negative value.
(Can only be set for PTs with color display.)
Valid only when [Display Sign] is selected.
White, black, blue, red, magenta, green, cyan, yellow

Settings

: Specify this when displaying multiple graphs (lines). The line
properties [Line] are displayed.

: Specify this when deleting a graph (line).

: Specify this when modifying a graph (line). The line properties
[Line] are displayed.

Logging Property (only for NT21, NT31, NT31C, NT631, and NT631C)

Data logging: Specify whether or not the data logging function is used.

Background: Specify whether or not the background function is used.

Touch switches for logging
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Next Page:
(Forward)

Specify whether or not a touch switch used to
move the display range in the direction of newer
records is used.

Previous Page:
(Rewind)

Specify whether or not a touch switch used to
move the display range in the direction of older
records is used.

Log Clear:
(Clear log)

Specify whether or not a touch switch used to
clear all logged data is used.

Touch switches for display function

Restart :
(Continue)

Specify whether or not a touch switch used to restart
the halted data sampling is used.

Stop: Specify whether or not a touch switch used to halt
data sampling is used.

Display Clear:
(Clear display)

Specify whether or not a touch switch used to clear
the graph display is used. Note that the log data is
not cleared by this switch.

Line

Value

Table Entry: Specify the table entry number of the numeral memory table
entry whose contents are displayed in a trend graph.

Display %: Specify whether or not a percentage value is displayed on
the screen.

Line

Color: Specify the graph (line) color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Style: Specify the line type.
Solid, Dash, Dot-dash, Dot-dot-dash

100%

Table Entry: Specify this item if a 100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 100% value is set with a constant:
set the value to be taken as the 100% value.

0%

Table Entry: Specify this item if a 0% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a 0% value is set with a constant:
set the value to be taken as the 0% value.

–100%

Table Entry: Specify this item if a –100% value is set with a numeral memory
table entry: set the table entry number of the numeral memory
table.

Value: Specify this item if a –100% value is set with a constant: set the
value to be taken as the –100% value.
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Note that specification for –100% is valid only when [Display Sign] is selected.

Guidance

S Following types of trend graph element are provided.

0% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→Time

↑Time

←Time

↓Time

–100% to 100% display

Direction: Right

Direction: Left

Direction: Up

Direction: Down

→Time

↑Time

←Time

↓Time

S Which of [0 to 100%] and [–100 to 100%] trend graphs is displayed should be
selected with the setting for [Display Sign] in the general attributes.

Check mark set: –100 to 100% display

Check mark not set: 0 to 100% display

S The following two types of trend graph display are provided.

Standard: The latest drawing position moves in the direction set for [Direc-
tion].

Present
drawing
position

Next
drawing
position
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Pen Reco: The latest drawing position is fixed and the entire graph moves in
the direction set for [Direction].

Present
drawing
position

Present display status Present drawing position
Next
display
status

S If you specify a trend graph element, only one broken line is displayed.
To modify the settings for the line, select the line to be modified and click on

. The line properties are displayed.

To add a line, click on . A line is added and the line properties are
displayed for the added line. A maximum of 50 lines can be created.
To delete a line, select the line to be deleted with the “Settings” and click on

. The specified line is deleted.

S The following four types of line are provided for displaying trend graphs.

Dot-dot-dashSolid Dash Dot-dash

Set the line type with the [Style] property.

S The intervals between points of a trend graph in the time axis is specified by
[Drawing Width]. The width is set as a number of dots.

S The time intervals in which the drawing value of a trend graph is read is speci-
fied by [Sampling Cycle]. Set the interval in units of 0.1 seconds for NT30,
NT30C, NT620S, NT620C, NT625C and 0.5 seconds for the NT21, NT31,
NT31C, NT631, and NT631C.

S The latest drawing value of a trend graph can be displayed as a percentage
value.

In the default setting, a percentage value is displayed.
Whether or not a percentage value is displayed can be set with the [Display%]
line property.

Check mark set: A percentage value is displayed.

Check mark not set: A percentage value is not displayed.

S If the setting is for a percentage value to be displayed, the size and display
position of the value can be modified using the element edit function in the
manner shown below. (For detail of the element edit function, refer to page
110.)

(1) Click on a percentage value while pressing the Shift key and Ctrl key.

(2) Drag a percentage value to change the display position.

Example: Modifying the percentage value display position

(1) (2)



6-9SectionGraphs

245

(3) To change the size of a displayed percentage value, double click on the val-
ue.

The properties of the percentage value display are displayed.

Position: Indicates the display position of the percentage value.
(The reference point is at the upper left corner of the percentage
value.)

Font Type: Specify the font of a value to be displayed.
Standard, Half Height, Double Width

Scale: Specify the scale of a value to be displayed.
1×1 (Equal), 1×2 (High), 2×1 (Wide), 2×2, 3×3, 4×4, 8×8

Smoothing: Specify whether or not smoothing processing is executed for a
value to be displayed.

Attribute: The display attribute cannot be set (fixed as standard display).

Color

Foreground: Specify the color of the percentage value.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the percentage value display
area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Reference: S A percentage value and other elements cannot be overlapped on a trend
graph.

S With a trend graph, a percentage value can be displayed for each line. If there
are too many lines with percentage values and the correspondence between
the values and lines is not clear, use the procedure shown below to check the
line that corresponds to the percentage value.

(1) Select a trend graph.

(2) Select [Edit] (menu bar) – [Edit Object].
Or press Insert key (P122).

The trend graph element enters the edit enabled state and the J marks
surrounding the trend graph change to red.
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(3) Select [Edit] (menu bar) – [Select Object]. (Place where graph or % display
does not exist.)

The components of a trend graph (trend graph, percentage values) are dis-
played in a list. The line numbers that correspond to the individual percent-
age values are displayed.

If you click a line in the list, the corresponding percentage value display is
selected in the screen tomake the correspondencebetween the lineand the
percentage value clear.

Instead of the operation in step (3) above, right-clicking the mouse on the trend
graph→ [Edit Object]→ right-clicking the mouse on the trend graph near by the
% display where % display and frame does not exist→ [Select Object], the per-
centage values displayed near the click point are displayed in a list.

S When displaying a trend graph, the display points are determined by calculat-
ing the percentage value based on the values for 100%, 0%, and –100%.

If the 100% value, 0% value, and –100% value are set as indicated below, refer-
ence values are displayed in the trend graph as shown below.

Value referred to: 3000 100%

Value referred to: 1500 50%

Value referred to: 0 0%

Value referred to: –1000 –50%

Value referred to: –2000 –100%
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If the 100% value, 0% value, and –100% value are set using numeral memory
table entries as indicated below, the percentage value of the reference value is
calculated according to the value stored at the specified address.

Numeral memory
table

0

1

2

3

4

5
–2000

0
3000

S Thedata logging functionandbackground function canbeusedwith theNT21,
NT31, NT31C, NT631, and NT631C.

Data logging function

The data logging function records the values used for display at a PT.

Usually, the data collected in sampling for display in a trend graph are not re-
corded internally. If you use the data logging function, the data are logged and
can be displayed by tracing them back.

The data logging function can be executed for up to 8 kinds of data.

Background function

The background function continues data sampling evenwhen a trend graph is
not displayed.

With a trend graph, data sampling is executed only when a trend graph is dis-
played and stops when the screen is switched from the trend graph screen.
However, if the background function is used, data sampling can be continued
in the background mode (while the trend graph is not displayed). The data
sampled and logged when in background mode can be displayed by tracing
back to the past.

The background function is valid only when it is used with the data logging
function; when the background function is used, the objective data is continu-
ously recorded.Pleasenote that sincedata sampling is executed continuously
if the background function is used, the processing speed at a PTmay be a little
slow.

S How the data recording is changed depending on whether or not the data log-
ging function and the background function are used is shown below. Regard-
less of the use of these functions, the trend graph element always starts draw-
ing a graph from the initial state when the screen is changed to the trend graph
display screen.

<Without logging and background functions>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen
(starts drawing a graph newly)

Data not logged
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<With data logging function but without background function>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen
(starts drawing a
graph newly)

Data logged Data not logged during this period

Previous data are re-displayed by pressing (page return)

Data logged

The trend graph is drawn newly when the screen is switched back to the trend
graph display screen. However, it is possible to redisplay the past data drawn in
the trend graph previously by pressing a touch switch that has the function to dis-
play the past data. In this case, however, the data are not logged while a trend
graph is not displayed.

<With logging and background functions>

Trend graph screen

Switching
the screen

Other screen

Returning

Trend graph screen

Data is always logged

Past data are re-displayed continuously by pressing (page return)

Although the trend graph starts displaying new data when the screen is
switched back to the trend graph display screen, it is possible to display the
data of theperiodduringwhich the trendgraphwasnot displayedbypressinga
touch switch that has the function to display the past data.

S The trend graph element can control data sampling, display and other related
operations using the special touch switches shown below.

These touch switches execute their function only oncewhen they are pressed.

Stop touch switch

Stops data sampling. Updating of a trend graph display is also stopped at
the same time.
While sampling is halted, the touch switch is lit.

If data sampling is executed by the background function, data sampling
in the background mode is also halted.

When the background function is not used, if the screen is switched back
to the trend graph display screen after halting data sampling and calling
other screen, the trend graph is redisplayed and logging restarts auto-
matically.

Restart (Continue) touch switch

Restarts halted data sampling. At the same time, updating of the trend graph dis-
play restarts.



DSP
CLR

LOG
CLR

6-9SectionGraphs

249

During data sampling, the touch switch is lit.

Display Clear (Clear Display) touch switch

Clears the trend graph display. Even if the display is cleared, the logged data are
not cleared.

Log Clear (Clear Log) touch switch

Clears all logged data. At the same time, the trend graph being displayed is
cleared. This switch clears only the trend graph being displayed. The trend
graphs registered on other screens are not cleared. This switch is valid only
when the data logging function is used.

Previous Page (Rewind) touch switch

Displays the logged past data, older than the time range of the presently dis-
played graph. This switch is valid only when the data logging function is used.

Next Page (Forward) touch switch

Displays logged data that is newer than the time range of the presently displayed
graph. This switch is valid only when the data logging function is used.

If the latest data is displayedwhile the data is being logged, updating of the trend
graph display automatically restarts.

Concerning the previous page touch switch and the next page touch switch, the
one pressed later is lit.

Reference: When the data of trend graph made with NT30, NT30C, NT620S, NT620C, and
NT625C were converted to the use for NT31, NT31C, NT631, and NT631C, if
touch switches for controlling trend graph is added after that, the Label of the
touch switch may not be appeared or some other marks may be appeared.
This is because the method of using marks of “FFEF to FFF5 (hexadecimal)
code” differs between NT30, NT30C, NT620S, NT620C, NT625C and NT31,
NT631, NT631C.
(With NT31, NT31C, NT631, and NT631C, they are used for touch switches for
controlling trend graph.)
Resetting the eachmark of FFEF to FFF5 codewithmark editor enables the cor-
rect display. For details, refer toCorrecting theScreenDataConversion (Correc-
tion related to control touch switch of trend graph) in Appendix A.
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6-10 Registering Created Elements (Symbol Manager
Operation)

The created graphic data can be collectively registered as an element by using
theSymbolManager. Thegraphic data registered collectively in a group is called
symbol or symbol data.

By registering data that is often used by the Support Tool, it is possible to use the
same data among multiple screen data (Application).

Since the graphic data for creating a keyboard and keypads for each PT model
and color/pattern combinations of tiling objects are registered and provided with
the Support Tool, you can save time when creating graphics.

6-10-1 Screen Configuration of Symbol Manager
The symbol manager screen configuration is shown below.

Symbol name

Menu bar

Symbol icon

Folder

Folder name

A folder represents one symbol data file, and symbols displayed under the folder
represent the individual symbol data registered in that file.

The name of the selected folder, or the name of the file that stores the selected
symbol is displayed in the title column of the Symbol Manager window.

Starting with V4.6, there is a Preview pane to show an overview picture and a
Listing pane to show the object contents.

For newly installed symbol data with V4.6, the preview is immediately available.
Old data can be reused into this version but a preview is not applicable. Tomake
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apreviewof old data, copy the data to the screenonV4.6 and then copy it back to
the symbol manager to register the preview information.

File configuration

The symbol manager is controlled in a data file that is separate from the screen
data file.

The symbol data file configuration is shown below.

NTST4.6\Symbol SPPLMNT.SBL

SYMFILE1.SBL

SYMFILE2.SBL

SYMFILE3.SBL

File storing the keyboard and keypad data

Group of files storing newly registered symbols
A file is created for each symbol

Color PL. SBL File storing tiling objects

Reference: For the Support Tool, keyboard data for each PT model, color palette and ISO
elements are provided as symbol data.
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6-10-2 Basic Symbol Manager Operation
Starting up the symbol manager

(1) [Window] (menu bar)→ [Symbol Manager]

Reference: S Thesymbolmanagerwindow isalwaysdisplayedat the topof thewindowsdis-
played on the screen. If this disturbs your operation, minimize the window by
either clicking on the button at the upper right area in thewindow or select-
ing the [minimize] item from the control menu box displayed by the clicking on
the button at the upper left area in the window.

S The symbol manager memorizes the folder that was open when you quit the
symbol manager last time and opens the same folder automatically when you
next start the symbol manager. The symbol registration state in the folder is,
however, the state when the folder was saved last.

Basic operation

S Menu bar

File New: Creates a new file (folder).

Open: Displays a file (folder) that is not displayed in the screen.

Close: Closes the file (folder) presently displayed in the screen.
(The file is not deleted although it disappears from the
screen.)

Save: Saves the specified folder by overwriting the present file.

Save As: Saves the specified folder by changing the file name.
(Folder name remains unchanged.)

Save All: Saves all folders to the individual files.

Exit: Lets you exit the symbol manager.

Edit Cut: Moves the specified symbol data to the clip board.
(The data is deleted from the symbol manager.)

Copy: Copies the specified symbol data to the clip board.
(The data remains in the symbol manager.)

Paste: Pastes the symbol data, stored in the clip board by cut or
paste, to the active screen.

Delete: Deletes the specified symbol data from the symbolmanag-
er. (The data is not stored in the clip board.)

Choose Icon: Changes the icon design of the symbol data.

Change Label: Changes a folder or symbol name.

View Status Bar: Specifies whether or not the status bar, which
displays menu item functions, etc., is displayed un-
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der thewindow. In themenu, if there is a checkmark
to the left of [StatusBar], the status bar is displayed.

Help Contents: Displays the help information.

Search for Help on: Enables you to display help information
on the input word.

About Symbol Manager: Displays information such as the ver-
sion of the symbol manager.

S Screen Operation

Double click on the folder or symbol name,
and the folder opens to display the list of
registered symbol data.
Double clicking on the folder or symbol
name while the list of the registered symbol
data is displayed causes the folder to close
so that only the folder name is displayed.

“+” indicates that symbol data is registered for the folder. “–”
is displayed when the folder is open.
Clicking on this has the same effect as double clicking on the
folder name.

Reference: Folders are displayed in the alphabetical order of the folder names. In a folder,
the list of symbol data displays the symbol data in the alphabetical order of the
symbol names.

6-10-3Operating the Symbol Manager
Opening a folder (file)

Open a folder in which symbol data is registered.
By opening the symbol collections supplied with the Support Tool or the files
saved by the symbolmanager (P274), it is possible to display the opened data in
the symbol manager and to use the required one for screen creation.

Reference: S The following symbol data files are supplied with the Support Tool.

Color Palette Symbol (ColorPL.SBL)

Keyboard/Keypad Collection (Spplmnt.SBL)

ISO Symbol Collections (ISO7000 (XXXX-XXXX).SBL) (CD-ROM version
only)

S The opened folders (symbol data files) in the symbol manager remain dis-
played until they are closed. The symbol manager memorizes the folder con-
figuration when you quit the symbol manager last time and displays the same
state when you next start the symbol manager. (The symbol registration state
in the folder is the state when the folder was saved last.)

S While registering a symbol from a screen or pasting it to a screen, the folder to
be used (symbol data file) should be opened. However, if the symbol data file
has a Read-only property, the characters “Read Only” are displayed in the
symbol manager. In this case, it is not possible to perform symbol registration.
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(1) Select [File] in the menu bar, then select [Open].

The dialog to specify the file name is displayed. In the dialog, the folders that
contain the symbol data file to be read are displayed. (File type is fixed to a
Symbol File (*.SBL))

(2) Specify the desired folder and file name and click on .

Opened symbol data file is displayed in the symbol manager.

Ex: Opening ISO Symbol file (ISO7000 (0001-0099).SBL)

Closing a folder (file)

Close the unnecessary folder (symbol data file) to remove it from the symbol
manager.

(1) Select the folder that should be closed in the symbol manager. The folder
name is displayed in reverse video.

(2) Select [File] in the menu bar, then select [Close].

If the file has not been saved, the message asking you whether to save it or
not is displayed.

(3) If you click the Button, the window to specify the file name is dis-
played.

Specify the file name and save it. (If you click the Button in the file

name specifying window, the symbol folder closes without being saved. If
you click the Button, the symbol folder closeswithout beingsaved.
(Registered symbol will be discarded.) For details on saving, refer toSaving
a folder (file) on page 256.

Creating a new folder

Create a new folder to register the symbol data by the procedure shown below.

By collecting symbols relatedwith each other in the same folder, the screen data
creation operation can be facilitated since searching for symbol data is simple.

Select [File] in the menu bar, then select [New].
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A new folder is named as “No description.”

S Changing folder name

To change the folder name to one that is easy to understand, follow the opera-
tion shown below.

(1) Select the folder name that should be changed. The folder name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set the desired folder name and click the Button.

Registering the symbol data

A graphic consisting of several elements is registered as a single element
(symbol).

After registering the symbol data, be sure to perform the file save operation.

To register the symbol data, select the elements to be registered collectively and
drag them to the symbol manager folder where they are to be registered.

Drag the symbol to the desired folder, then release the mouse.

The element in the source screen remains as it is.

For a new symbol, symbol name “New Symbol x” (x is a serial number) is as-
signed.

Reference: The symbol data can be registered also by the following operation.

(1) Select the elements to be registered in the source screen and select [Copy]
or [Cut] from the [Edit] menu in the Support Tool.

(2) Select [Paste] from the [Edit] menu in the symbol manager.
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In this case, symbol name “Pasted Symbol x” (x is a serial number) is assigned
for a new symbol.

S Changing the symbol name

To change the symbol name to the one easy to understand, follow the opera-
tion shown below.

(1) Select the symbol name that should be changed. The symbol name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set your desired symbol name and click the Button.

S Changing the symbol icon

It is possible to change the icon of the symbol data to a desired one. To change
the icon, follow the procedure shown below.

The data that can be used for an icon is bit map data.

(1) Select the symbol for which the icon should be changed. The symbol name
is displayed in reverse video.

(2) Select [Edit] in the menu bar, then select [Choose Icon].

The data selection dialog box is displayed.

(3) Specify the bit map data that should be used as an icon and click on
.

Reference: For an icon, 16×16-dot, 8-color bitmap data can beused. Althoughbitmapdata
larger than 16×16 dots can be used, only the 16×16 dots at the upper left area
of such data is used.

Saving a folder (file)

After registering the symbol data, save the registered data to a file by the opera-
tion shown below.

Select [File] in the menu bar, then select [Save], [Save As], or [Save All].

If there is a folder that has not been saved, the file name specifying window is
displayed regardless of the savemethod you chose. If this windowopens, speci-
fy the file name to save the folder. Please note that the file name specifying win-
dow does not show the objective folder name, which means that the objective
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folder for saving cannot be distinguished if you select [Save All] when there are
several unsaved folders. It is advisable to save a folder that has not been saved
by assigning a file name beforehand.

Overwrites the file where the symbol data was originally
stored with the symbol data in the specified folder.

Saves the symbol data of the specified folder to the file of the
specified file name.

Overwrites the individual original files with the symbol data
that was open.

Reference: Before executing [Save] or [Save As], click the object folder.

Copying/deleting the registered symbol

Registered symbols can be moved or copied to another folder or deleted.

To move, copy, or delete a registered symbol, select [Edit] in the menu bar, then
select the required function ([Cut], [Copy], [Paste], [Delete]).

Moves the specified symbol to the clip board.
The specified symbol is deleted from the source folder.

Copies the specified symbol to the clip board.
The specified symbol remains in the source folder.

Pastes the symbol, stored in the clip board by the cut or copy
function, to the currently selected folder.

Deletes the specified symbol.
The symbol is not stored in the clip board.

Move or copy of a symbol is also possible by dragging the symbol using the
mouse.

S If a symbol is dragged to another folder, the symbol is moved.

S If a symbol is dragged to another folder while the Ctrl key is held, the symbol is
copied.

In these operations, the “+” mark is displayed at the mouse cursor.

6-10-4 Pasting a Symbol to Screen
To paste a registered symbol to the data creation screen of the Support Tool, se-
lect the symbol and drag it to the desired position on the data creation screen,
then release the mouse.

The symbol is copied to the data creation screen.

Drag the symbol to the data creation screen and release the mouse.

The symbol copied to a data creation screen can be used in the samemanner as
other elements.
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Reference: S Symbols created by different PT models can be pasted to a data creation
screen. In this pasting operation, the symbol data is automatically converted
and, if anerror occurred in data conversion, anerrormessage is displayed.For
details, refer to Appendix A Data Conversion.

S Concerning image/library data, only the code is registered at the symbol man-
ager. Therefore, if the image/library data is pasted to another screen data file,
the image/library data of that code in the file to which the data was pasted is
displayed.

S If the ISO symbols, supplied by the CD-ROM version Support Tool, are used
with NT20S, or NT600S, those symbols that consist of elements that are not
supported may not be displayed correctly.

S Image/library collection, supplied by the CD-ROM version Support Tool, can
be used only with models that can use image/library.

Pasting an ISO symbol

Topastean ISOsymbol to thedata creation screenof theSupport Tool, select the
symbol and drag it to the desired position on the data creation screen, then re-
lease the mouse. (Same operation as the other symbols.)

Drag the symbol to the data creation screen and release the mouse.

Reference: It is not possible to change the colors and size of ISO symbols, since the ele-
ments are registered in the grouped status.

6-10-5Operating Procedure of Color Palette Symbol
Color palette symbol

Color palette symbol is a symbol for which tiling objects are registered with their
tiling patterns, foreground and background colors respectively combined. You
can select required tiling objects while checking the tiling status on screen.

Color palette symbol is separated into tiling patterns and each pattern is set as
one symbol as shown below. Combinations of foreground and background col-
ors are registered for each symbol.
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Operation procedure

Follow the procedure below to use color palette symbol.

1. Open new screen to place color palette on it.

2. Drag required tiling pattern symbol from palette symbol and drop it on the
screen created in 1.

3. Select [Ungroup] from the [Draw] menu to cancel the grouped status (default
status) after confirming that the dragged symbol is in selected status.

4. Clear the check mark for [Full Tiling] from the [View] menu to select the tiling
object easily after you decided which one to use, then drag it to the objective
screen while depressing [Ctrl] key (or perform copy&paste). To check the til-
ing status, select [Full Tiling] from the [View] menu. However, in this status,
theposition of tiling objectwill not beclear.Cancel the [Full Tiling] statuswhen
required.

5. Border color of tiling objects in color palette symbol is set to White. Change
the border color of tiling object by displaying property sheet if required.
Note that the transparent background color is not registered for color palette
symbol. Change the property afterwardswhen youwant to apply transparent
background.

6-11 Recipe Screen Element

6-11-1 Recipe Screen Element
Recipe screen element provides you with an interface to apply a set of data val-
ues from the recipe table to the PLC.

It can only be placed on a standard screen and it can be displayed in the parent
screen. The screen element property dialog box has 4 pages -- general, touch
switch, setting and interlock.

Operation procedure

Selection using the menu bar: [Objects]! [Data Input]! [Recipe]

Selection using the drawing toolbar:

Terminology

Description of Recipe Screen Element Components

Name

Specifies the recipe name.
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Number, ... Color

Displays parameter names.

Object A ... Object C

Displays record names.

100, ... 4

Displays record numeral data.

Write

Transfer data to PLC.

Read

Transfer data from PLC.

Scroll 1 page up.

Scroll 1 page down.

Scroll 1 page left.

Scroll 1 page right.

Scroll 1 line up.

Scroll 1 line down.

Scroll 1 line left.

Scroll 1 line right.

No.

Display recipe number.
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Property setting

General

Note The text data display in the recipe frame will be such that any character that ex-
ceeds the specified column width will not be shown. This affects the following
fields: recipe name, record name and parameter name. For example, given a
recipe entry named “Long Recipe,” the recipe frame will show “Long” when the
Record Name Width is set as 4.

The parameter data values display will depend on the “Param Column Width”
setting. If it is set as 2 and the parameter data is 200, then # will be displayed for
each digit. The value will be displayed as 200 only when the column width is set
greater than 2.

Thewidth of each cell in the recipe framewill be set such that the width is amulti-
ple of the touch switch grid size, and just enough to accommodate the cell data
display. An example recipe framewill have the frame lines exactly over the touch
switchgrid. Thewidthof a2-character-wide cellwill beexactly 1 touch switchgrid
wide.

Position: Displays the position of the top-left corner of the
screen element.

Size: Displays the size of the screen element.

Show Parameter: Displays parameter when checked.

Show Serial No.: Displays serial number when checked.
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No. of Parameters: Sets the number of parameters to display on the
screen.

Display Line Qty: Sets the number of record rows to display on the
screen.

Param Column Width: Sets thewidth of each parameter column. All columns
have the same width. The actual width (in pixels) will
be in terms of touch switch grid size.

Record Name Width: Sets thewidth of the recordnamecolumn.All columns
have the same width. The actual width (in pixels) will
be in terms of touch switch grid size.

Scale: Defines the font size for alphanumeric characters.

Smoothing: Defines whether alphanumeric characters have
smoothing effect.

Frame Colour: Defines the frame color of the screen element.

Record Name Colour

Foreground: Defines the foreground color of the serial numbers, recipe name
and record names part of the screen element.

Background:Defines the background color of the serial numbers, recipe name
and record names part of the screen element.

Parameter Comment Colour

Foreground: Defines the foreground color of the recipe name and parameter
name part of the screen element.

Background:Defines the background color of the recipe name and parameter
name part of the screen element.

Parameter Data Colour

Foreground: Defines the foreground color of the parameter data part of the
screen element.

Background:Defines the background color of the parameter data part of the
screen element.
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Setting

Recipe Entry: Sets the recipe entry to refer to. The “...” button invokes the
recipe table when it is clicked.

Edit Param: Call up the Parameter Setting Table.

Write Notify Address

PLC Address: Inputs the write flag PLC address. If this is a
valid address, the write notify bit in the
memory map is set.

Set: Sets the write flag PLC address via an ad-
dress composition dialog.

I/O Comments: Inputs comments for the write flag PLC ad-
dress. The “...” button will invoke the I/O
comment table.

Show Window/Keyboard Screen: Allow the use of window/keyboard screen.

Screen No.

Local 1 or Local 2: Sets the keyboard screen to use with this recipe object.
Either Local 1 or Local 2 alone can be enabled.

Screen

Position X & Position Y: Sets the position for the keyboard screen.

Screen Attributes
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Replace Local Window: Determine whether to replace the local window.

Touch Switch

Read/Write Touch Switch

Read: Show Read touch switch.

Write: ShowWrite touch switch.

Page Scroll Touch Switch

Up: Show Page Scroll Up touch switch ( ).

Down: Show Page Scroll Down touch switch ( ).

Left: Show Page Scroll Left touch switch ( ).

Right: Show Page Scroll Right touch switch ( ).

Line Scroll Touch Switch

Up: Show Line Scroll Up touch switch ( ).

Down: Show Line Scroll Down touch switch ( ).

Left: Show Line Scroll Left touch switch ( ).

Right: Show Line Scroll Right touch switch ( ).

Interlock

Refer to 6-1-12 Interlock.
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SECTION 7
Memory Table Setting

Memory tables are areas in aPTfor storingnumericvaluedata andcharacter stringdata.Theseareas areused for communicat-
ing with PC (PLC).
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7-1 Common Operation
The operating procedures common to all memory tables are described below.

Copy setting button

Edit button

Batch address change button

Search buttonReference button

Specified number display button

Set button

Operation starts by specifying the number, that is, clicking on the objective line
(memory tableentry number). Theshapeof themousecursor changesasshown
below when it enters the No. field.

7-1-1 Reference Operation
The reference screen displays the screen numbers and the table entry numbers
in which the specified table entry is used, in the form of a list, and the screen or
element that corresponds to the specified table entry is displayed.

Reference: Reference operation is valid only when a memory table window is opened with
the [Tools]→ [Table] operation. If thememory tablewindow is called from theele-
ment property dialog box, reference operation is not possible.

Description of reference dialog box

Table Entry

Displays the selected table entry number.

Screen/Table

Displays the screen number or the table entry number where the specified table
entry is used.
Whether the displayed number is a screen number or a table entry number can
be determined from the displayed number as shown below.

For screen numbers, only a number is displayed.
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For table entry numbers, a number is preceded by a code that represents the
table type.

The codes representing table types are summarized below.

Code Table type

N Numeral memory table

S Character string memory table (String table)

B Bit memory table

I Extended I/O input table

O Extended I/O output table

M Mathematical table*1

*1 Reference operation is slightly different for mathematical table.When amath-
ematical table entry is created with numeral table entry as either operand or re-
sult, a reference is created to the corresponding entry in numeral table. When
operand/result is PLC address, a reference is created to the corresponding ad-
dress entry in I/O comment table.

Comments

Displays screen comments corresponding to a screen number.

No. of References

Displays the number of appearances of the screen or the table entry.

Operation

(1) Click on the table entry number of the reference memory table entry.

(2) Click on . List of referenced screen/table entry number is dis-
played.

(3) In the reference dialog box, specify the objective screen/table entry number
and click on .
As an alternative to the operation above, youmay double click on the objec-
tive element.

The specified screen automatically opens to display the specified element.

7-1-2 Search Operation
Youcan locate specific data set in a table by using the search operation, andalso
replace the found data with the desired data.

Search and replacement is possible for the following types of memory table.

Note that search and replacement is always executed toward the end of a table.
This means that search and replacement is possible within the range from the
present cursor position in the table to the last entry number in the table.

Table Type Objective of Search/Replacement

Numeral memory table PC (PLC) address, initial value

Character string memory table
(String table)

PC (PLC) address, contents of initial val-
ue

Bit memory table PC (PLC) address, image/library code
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Table Type Objective of Search/Replacement

I/O comment table I/O comment

Extended I/O input table –––

Extended I/O output table –––

Description of search dialog box

PC (PLC) address Initial value or contents of initial value

Image/library code I/O comment

Search By

Specify the objective data for the search or replacement operation.

PC (PLC) address: Data set for addresses of table entries.

Initial value (contents): Data set for the initial values of a numeralmemory table
entry or character string memory table entry (string
table).

Image/library code: Image/library codes set for a bit memory table entry.

I/O comment: I/O comment in I/O comment table.

Find What

Set the data to be searched for or replaced.

Replace With

Set the new data to replace the data set for [Find What].

Clicking this button starts search processing.

When the specified data is found, the cursor in the table automatically moves to
the found table entry number.

Search for the next appearance by clicking on this button again.

Clicking this button starts replace processing.

The data specified for [FindWhat] is searched for and replaced with the data set
for [Replace With].
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When the specified data is found, the cursor in the table automatically moves to
the found table entry number.

Search for the next appearance by clicking on this button again.

Clicking this button starts replace processing.

The data specified for [FindWhat] is searched for and replaced with the data set
for [Replace With].

All appearances are replaced with the specified data at one time.

Operation procedure (search)

(1) Specify the table address (the start position of the search range).

(2) Click on .

(3) Select the objective of the search in the [Search By] box.

(4) Specify the search objective data in the [Find What] box.

(5) Click on .

Operation procedure (replace)

(1) Specify the table address (the start position of the replace range).

(2) Click on .

(3) Select the objective of replace in the [Search By] box.

(4) Specify the data to be replaced in the [Find What] box.

(5) Specify the data to replace the old data in the [Replace With] box.
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(6) Click on or .

D00000

D00030

7-1-3 Batch Address Change Operation
The set PC (PLC) addresses can be changed into the required addresses in a
batch. Since the change source can be specified as a range, processing such as
changing theaddress rangeDM1000 toDM01499 to theaddress rangeDM1800
to DM2299 is possible at one time. Shifting in bit units is also possible.

Note that the batch address change operation is allowed only for displayed table
entries.

Independent with the location of the cursor, this address change will be per-
formed to the whole table.

Description of batch address change dialog box

Find -- Channel (Word)

Specify the word type of the batch change source.

Find -- Start Range

Specify the start address of the source range for the batch address change.

Find -- End Range

Specify the end address of the source range for batch address change.

The address to be set for [EndRange]must always be larger than or equal to the
address set for [Start Range].



7-1SectionCommon Operation

271

Change to -- Channel (Word)

Specify the word type and start address after the change.

Addresses are changed within the number of specified points from the start ad-
dress (number of points from “Start Range” to “End Range”).

Change Comment

Specify whether or not the same I/O comment appended to an address before
the change is appended to the address after the change.

Toappend the same I/Ocomment, click on the check box to display a checkmark
in it.

Batch address change processing starts when you click on this button.

How addresses are changed

In the operation for changing addresses in bit units, processing is executed as-
suming that bit 15 of a word is immediately followed by bit 0 of the next word.

Addresses are changed as shown below according to the set search range and
the address after the change.

Example: Bit memory table

15 10 0

[Change To] -- [Address]
(start address after the change)

Address and Bit set
for [Start Range]

CIO area Word 0CIO area Word 1

Bit 15 0

Address and Bit set
for [End Range]

15 0Bit 15 0

HR area Word 10HR area Word 11

Before change After change

0000010 H0001000

0000012 H0001002

0000100 H0001006

0000110 H0001100

0000115 H0001105

Operation procedure

(1) Click on .

(2) Select the type of word before the change in the [Channel] box.

(3) Specify the range of the change by setting addresses at the [Start Range]
and [End Range] boxes.

(4) Specify the word and the address after the change in the corresponding
boxes in the [Change To] area.
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(5) Set a check mark in the Change Comment check box as desired.

If a check mark is set in this check box, I/O comments appended to the ad-
dresses before the change are also appended to the addresses after the
change.

(6) Click on .

7-1-4 Edit Operation
Theprocedure for clearing, cutting, copying, pasting, and incremental copyingof
the data set in a memory table is described below.

In the “copy to next” operation, the specified incremental amount is automatically
added to the data in the memory table entry at the cursor location and copied to
the memory table entry with the next number.

The procedure for specifying the incremental amount to be used for “copy to
next” is explained in 7-1-5 Copy Increment Setting Operation.

Reference: S To start editing, click on or right click the mouse on a table entry
number to display themenu, then select the desired edit function in this menu.
It may not be possible to select an edit function if an input field is displayed. If
the selection of an edit function is not possible, left click the mouse on a table
entry number field to select the entire line and, after that, click on
or right click the mouse on a table entry number to display the menu.

S When the two screendata files of the samePTmodel are openedusing [Import
Component] command, it is possible to paste the table data that was cut/co-
piedbyoneSupport Tool to a tableof anotherSupport Tool. (For details, refer to
3-3-6 Importing Components from Different Screen Data File (Starting Up the
Second Support Tool).)

Clear

Clears the data in the selected memory table entry.

Cut

Cuts the data in the selected memory table entry and stores it in the clipboard.

The cut data can be pasted to another memory table entry.

Copy

Copies the data in the selected memory table entry to the clipboard.

The copied data can be pasted to another memory table entry.

Paste

Pastes the data stored in the clipboard by the cut or copy function to thememory
table entry at the cursor position.
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Copy to Next

Executes the “copy to next” operation.

How this function is executed differs according to the table type as shown below.

Table Type
Increment Item

Table Type
Initial Value PC (PLC) Address

Numeral memory table Addition processing Addition processing

Character string memory table
(String table) Cannot be specified. Addition processing

Bit memory table Cannot be specified. Addition processing

Extended I/O input table Cannot be specified.

Extended I/O output table Cannot be specified.

Operation procedure (Clear)

The clear function clears the data at the specified address of a table.

Since thedata is not stored in the clipboard, the data deleted by the clear function
cannot be restored by the paste function.

(1) Click on the table entry number of the data to be cleared.

(2) Click on or right click the table entry number.

(3) Select [Clear].

Operation procedure (Cut)

The cut function cuts the data at the specified address of a table and stores it in
the clip board.

The data deleted by the cut function can be used for pasting.

(1) Click on the table entry number of the data to be cut.

(2) Click on or right click the table entry number.

(3) Select [Cut].

Operation procedure (Copy)

The copy function copies the data at the specified address of a table to the clip
board.

The data copied by the copy function can be used for pasting.

(1) Click on the table entry number of the data to be copied.

(2) Click on or right click the table entry number.

(3) Select [Copy].

Operation procedure (Paste)

The paste function pastes the data stored in the clip board by the cut or copy op-
eration to the specified table entry.

(1) Click on the table entry number of the table where the data is to be pasted.

(2) Click on or right click the table entry number.

(3) Select [Paste].
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Operation procedure (Copy To Next)

The “copy to next” function copies the data at the specified address of amemory
table to the next address after adding the specified amount to the existing data.

The procedure for specifying the incremental amount is explained in 7-1-5 Copy
Increment Setting Operation.

(1) Click on the table entry number of the copy source table.

(2) Click on or right click the table entry number.

(3) Select [Copy To Next].

7-1-5 Copy Increment Setting Operation
To set the incremental amount used for the “copy to next” operation, follow the
steps described below.

Copy Increment Setting dialog box

Value -- Increment By

Specify the incremental amount for the initial value data in a numeral memory
table entry.

The amount set here is valid only for the numeral memory table.

Value -- Input Type

Specify whether the incremental amount is specified in decimal or hexadecimal.

The specified item is identified by the F indication of a radio button.

The setting is valid only for the numeral memory table.

Address -- Increment By

Specify the incremental amount for table addresses.

Address -- Format

Specify whether the incremental amount is specified in decimal or hexadecimal.

The specified item is identified by the F indication of a radio button.

Operation procedure

(1) Click on .

(2) Specify the incremental amount to be added to the initial value in the numer-
al memory table at [Value] -- [Increment By].

(3) Specifywhether thenotationof the incremental amount setabove isdecimal
or hexadecimal at [Value] -- [Input Type].

(4) Specify the table address incremental amount at [Address] -[Increment By]

(5) Specifywhether thenotationof the incremental amount setabove isdecimal
or hexadecimal at [Value] -- [Input Type].
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(6) Click on to close the dialog box.

(7) Click on the table entry number of the copy source table.

(8) Click on or right click the table entry number.

(9) Select [Copy to Next].

7-1-6 Table Display Operation by Specifying the Table Entry Number
S Description of [Go to] dialog box

Entry

Specify the table entry number of the table to be displayed.

The cursor moves to the specified table entry number.

Operation procedure

(1) Click on .

(2) Specify the table entry number of the table to be displayed.

(3) Click on .

7-2 Numeral Memory Table
Numeral Memory Table

The numeral memory table is an area provided in a PT to store numeric value
data.

A numeralmemory table entry is allocated to one or twowords in aPC (PLC) and
the numeral memory table entry used for display can be shared with the PC
(PLC).
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With elements such as numeral display, graph, and numeral input, reading/writ-
ing of a numeric value is executed by specifying the numeralmemory table entry
number.

PC (PLC)

Initial value
Initialization

Storage type
No. of words
PC (PLC)
address
I/O comment
Reference

Numeral memory
table

1234Numeral display
element

2345Numeral data
input element

Bar graph

0

1

2

3

4

5

Screen
PT

Read

Write

Read
Shared

Shared

Shared

7-2-1 Operation Procedure
A numeral memory table entry is displayed by the operation described below.

S At the property settings for individual elements, click on in the table entry
number field.

S Select [Tools] (menu bar)→ [Table], then click the [Numeral] tab.

Setting

For numeral memory table entries, the objective of an operation is specified by
clicking on a line. The necessary setting can bemade by input using a keyboard
or by selection using a drop-down list.

For the operation procedure for , , ,
, , and , refer to 7-1 Common Operation.

(Note that cannot be used if it is displayed by the operation using an
element property.)

Reference: For PT models other than NT20S and NT600S, numeral memory table entries
No. 247 to No. 255 are used by the clock function and, therefore, cannot be allo-
cated to a PC (PLC).

7-2-2 Related Elements
S When reading numeral data from a numeral memory table entry

Numeral display element
[Objects]→ [Numeral Display]

Bar graph element
[Objects]→ [Graph]→ [Bar Graph]

Analogue meter element
[Objects]→ [Graph]→ [Analogue Meter]

Broken-line graph element
[Objects]→ [Graph]→ [Broken-line Graph]

Trend graph element
[Objects]→ [Graph]→ [Trend Graph]



7-2SectionNumeral Memory Table

277

Image object (Indirect reference)
[Objects]→ [Fixed Display]→ [Image Display]

Library object (Indirect reference)
[Objects]→ [Fixed Display]→ [Library Display]

Standard lamp (Label type: Numeral display)
[Objects]→ [Lamp]→ [Standard]→ ([Edit] in the Label property of standard
lamp)

Touch switch (Label type: Numeral display)
[Objects]→ [Touch Switch]→ ([Edit] in the Label property of touch switch)

S When writing numeral data to a numeral memory table entry

Numeral input element
[Objects]→ [Data Input]→ [Numeral]

Thumbwheel switch element
[Objects]→ [Data Input]→ [Thumbwheel Switch]

S When copying numeral data between numeral table entries, or when setting a
constant for a numeral memory table entry

Touch switch (copy setting)
[Objects]→ [Touch Switch]→ [Settings-Copy Setting] in property sheet

7-2-3 Description of Numeral Memory Table Fields

The display format varies slightly depending on the PT model. The example
screen shown above is for the NT21, NT31, NT31C, NT631, and NT631C.

Value

Specify the initial value to be set when the power is switchedON, the PT is reset,
or the mode is changed from the System Menu to RUN.

The range of values that can be input in this field is shown below.

PT Model Input Type Input Range

Other than NT21, NT31,
NT31C NT631 and

BCD F9999999 to 99999999
NT31C, NT631, and
NT631 Hexadecimal 00000000 to FFFFFFFF*1

NT21, NT31, NT31C, Decimal --2147483648 to 2147483647NT21, NT31, NT31C,
NT631, and NT631 Hexadecimal $00000000 to $FFFFFFFF*2
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*1: F in the most significant digit position (8th digit) indicates a negative value.

*2: With the NT21, NT31, NT31C, NT631, and NT631C, a hexadecimal num-
ber can be input by entering $ at the beginning of a numeric value. The input
hexadecimal value is converted to decimal for display.

For PT models other than the NT21, NT31, NT31C, NT631, and NT631C, the
input 8-digit hexadecimal value is simply stored as it is; there are no distinctions
between BCD and hexadecimal for these models. If the input numeric value is
displayed in BCD format, F in the most significant digit position (8th digit) is
treated as a negative sign.

With the NT21, NT31, NT31C, NT631, and NT631C, the input numeric value is
stored after conversion to signed binary data (2 words).

Settingof an initial value is validwhen the resume function is not selectedand the
[Initial] item is selected for the numeral memory table entry, and in this case the
content of the numeralmemory table entry is returned to the initial value. If thePT
has the memory table initialization function, this function can also be used to re-
turn the content of a numeral memory table entry to the initial value.

Initial

Specifywhether or not the content of thenumeralmemory table entry iswritten to
the allocatedword in the host when the PT is switched on or reset, or themode is
changed from the System Menu to RUN.

The term “initialize”means the processing to initialize the content of aword in the
host with the content in a numeral memory table entry. The setting for [Initial] is
not valid if the numeral memory table entry is not allocated to a word in the host.

Tomake the [Initial] item valid, click on the check box to display a crossmark (¢)
in the box. If the box is clicked on while it is in the valid state, the [Initial] item is
made invalid.

Reference: The content of numeral memory table entries at the start of PT operation is as
shown below according to whether or not a numeral memory table entry is allo-
cated to the host, the [Initial] setting for the numeral memory table entry, and
whether or not the resume function is used.

Allocation to [Initial] Resume FunctionAllocation to
Host

[Initial]
setting Used Not Used

Allocated Initialized
(valid)

Existing numeral memory
table value retained
(also for the word in the
host)

Initial value of the numer-
al memory table
(also for the word in the
host)

Initial value of the numeral memory table entry if it is
initialized by System Menu operation
(also for the word in the host)

Not initialized
(invalid)

Content of word in the host

Not allocated (Invalid) Existing numeral memory
table value retained

Initial value of the numer-
al memory table entry

In case numeral table entry has been initialized in
the system menu operation, initial value of the nu-
meral memory table entry

Storage Type (only for the NT21, NT31, NT31C, NT631, and NT631C)

Specify if a numeral in the PC (PLC) is treated as BCDor binary data when read-
ing/writing the content of a PC (PLC) word to which a numeral memory table
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entry is allocated. This setting is valid only for the NT21, NT31, NT31C, NT631,
andNT631C.With other PTmodels, numeric values are always treated asBCD.

BCD: The content of an allocated word is regarded as BCD
(binary coded decimal).

When the content of an allocated word is read, it is stored as signed
binary data. If F is set at the most significant digit position in the allo-
cated word, the content is regarded as a negative value. If an error is
found in the content of an allocated word (A to E at themost significant
digit positionorA toF inother thanat themost significant digit position),
the read out content is not stored in a numeral table. (The previously
stored content remains in the numeral table.)

When data is written to an allocatedword, the signed binary data in the
numeral memory table entry is converted into BCD before writing. If a
negative value is written, F is entered at the most significant digit posi-
tion. (In this case, the number of storable digits is reduced by one.) If
the number of digits in the content of a numeral memory table entry is
greater than the number of digits of the allocatedword in thePC (PLC),
only the numeric value is written from the least significant digit value.

Binary: The content of an allocated word is regarded as binary data.

When reading the content of the allocated word, the read content is
stored in a numeral memory table entry without change.

When writing a numeric value to the allocated word, the content of the
numeral memory table entry is written as it is. If the number of digits in
thecontent of anumeralmemory tableentry is greater than thenumber
of digits of theallocatedword in thePC (PLC), only thenumeric value is
written from the least significant digit value.

System: Conforms to the setting for [Numeral Display Type] of [System] in the
PC (PLC) Configuration.

Words

Specify the number of words to be allocated to a numeral memory table entry.
The possible specifications are 1 and 2.

S If the setting is 1 word, the 4-digit BCD or binary data is shared by the PT and
PC (PLC).

S If the setting is 2 words, the 8-digit BCD or binary data is shared by the PT and
PC (PLC).

When the setting is 2, the 1st to 4th digit data is allocated to the lower digit word in
the PC (PLC) and the 5th to 8th digit data is allocated to the higher digit word.

S PT models other than the NT21, NT31, NT31C, NT631, and NT631C

If the setting has beenmade to display a sign, one digit (bit 4) in the most signifi-
cant digit position is regarded as representing a sign; if F (1111 in binary) is set,
thenumeric value is regardedasnegativeand if any other code is set, thenumer-
ic value is regarded as positive. Therefore, if the numeric value is displayed with
a sign, themaximumnumber of significant digits of a negative value is 3 if 1 word
is set and 7 if 2 words is set.

Example: When1word is set, the value–123 is treatedasF123 inhexadecimal
in a numeral memory table entry.
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Similarly, when 2 words are set, the value –1234567 is treated as
F1234567 in hexadecimal in a numeral memory table entry.

S PT models NT21, NT31, NT31C, NT631, and NT631C

Regardless of thenumber of allocatedwords, 2wordsarealways secured for a
numeral memory table entry and a numeric value is stored as signed binary
data. If the setting for [StorageType] is decimal, F appearing at themost signifi-
cant digit position is treated as anegative sign. In this case, therefore, thenum-
ber of significant digits of a negative value is one digit less than the number of
significant digits of a positive value, as with conventional PT models.

Example: If the settings are BCD and 1 word, the value --123 is treated as F123
in a PC (PLC) word and FFFFFF85 in a numeralmemory table entry.
However, the value F123 in a PC (PLC) word is 0000F123 (61731 in
decimal) in a numeral memory table entry if the [Storage Type] is
hexadecimal.
Similarly, if the settings are BCD and 2words, the value --1234567 is
treated as F1234567 in aPC (PLC)word and FFED2979 in a numer-
al memory table entry. However, the value F1234567 in a PC (PLC)
word is F1234567 (--249346713 in decimal) in a numeral memory
table entry if the [Storage Type] is hexadecimal.

Example

In PC (PLC)
Word Write To No. of Words Storage Type In Numeral Memory Table

F123 ↔ 1 word BCD FFFFFF85
(in decimal: --123)

↔ 1 word Binary FFFFF123
(in decimal: --3805)

F1234567 ↔ 2 words BCD FFED2979
(in decimal: --1234567)

↔ 2 words Binary F1234567
(in decimal: --249346713)

4567 → 1 word BCD 000011D7
(in decimal: --4567)

→ 1 word Binary 00004567
(in decimal: --17767)

F567 ← 1 word BCD FFED2979
(in decimal: --1234567)

2979 ← 1 word Binary FFED2979
(in decimal: --1234567)

Note If only one word is allocated although two words are necessary to express a nu-
meric value, only the lower 4 digits of a numeric value are read or written. A suffi-
cient number of words must be allocated for reading/writing a numeric value.

PLC Address
Specify thePC(PLC)address (start address) of theareawherenumeralmemory
table entries are allocated.

I/O Comment
Specify a comment for a PC (PLC) word.
A comment can comprise up to 16 characters.
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Ref
Indicates whether the table entry with the specified number is already used or
not.

Yes: Already used as an element.
No: Not used.

If the indication is Yes, you can checkwhere the table entry in question is usedby
clicking on .

(For details of , refer to 7-1-1 Reference Operation.)

7-3 Character String Memory Table (String Table)
The character string memory table (String table) is an area provided in a PT to
store character string data.

Acharacter stringmemory tableentry (string table) is allocated to1 to20words in
a PC (PLC) and a character stringmemory table entry (string table) used for dis-
play can be shared by the PT and the PC (PLC).

It is possible to insertmark data, imagedata or library data into a character string.
Note that, however, NT11S, NT20S and NT600S do not have image data and
library data. With the NT21, NT31, NT31C, NT631, and NT631C without
NT20/30/620-compatible mode, it is not permissible to insert image data and li-
brary data into a character string.

With elements such as character string display and character string input, read-
ing/writing of character string data is executed by specifying the character string
memory table entry (string table) number.

PC (PLC)

Initial value
Initialization
No. of words
PC (PLC)
address
I/O comment
Reference

Character string
memory table
(String table)

OMRON
Character string
display element

PTCharacter string
input element

0

1

2

3

4

5

Screen

PT

Read

Write

Shared

Shared

7-3-1 Operation Procedure
A character stringmemory table entry (string table) is displayed by the operation
described below.

S At the property settings for individual elements, click on in the table entry
number field.

S Select [Tools] (menu bar)→ [Table], then click [String] tab.

Setting

For character string memory table entries (string table), the objective of opera-
tion is specified by clicking on a line. The necessary setting can bemadeby input
using a keyboard or by selection using a drop-down list.
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: Inserts mark data.
: Inserts image data.
: Inserts library data.

For the operation procedure for , , ,

, , and , refer to 7-1 Common Operation.

(Note that cannot be used if it is displayed by the operation using an

element property.)

7-3-2 Related Elements
S When reading from a character string memory table entry (string table)

Character string display element [Object]→ [String]
Alarm list [Object]→ [Alarm]→ [List]
Alarm history [Object]→ [Alarm]→ [History]

S When writing to a character string memory table entry (string table)

Character string input element [Object]→ [Data Input]→ [String]

S When copying character strings between character string memory table entry
entries (string table)

Touch switch (copy setting) [Object] → [Touch Switch] → [Copy Set-
ting]

7-3-3 Description of Character String Memory Table (String Table) Fields

Value

Specify the initial value to be set when the power is switchedON, the PT is reset,
or the mode is changed from the System Menu to RUN.

For an initial value, acharacter stringcontainingamaximumof40characters can
be specified. (20 characters for NT11S, 32 characters for NT20S)

To display “\”, input two characters without a blank, like “\\”.

Settingof an initial value is validwhen the resume function is not selectedand the
[Initial] item is selected for the character string memory table entry (string table),
and in this case the content of the character string memory table entry (string
table) is returned to the initial value. If the PT has the memory table initialization
function, this function can also be used to return the content of a character string
memory table entry (string table) to the initial value.
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Byclicking the , , or Button, you can insert
mark data, image data, or library data into a character string. (With theNT21 and
NT31/631 without NT20/30/620-compatible mode, and

are not enabled.)

Initial

Specify whether or not the contents of the character string memory table entry
(string table) are written to the allocated words in the host when the PT is
switched on or reset, or the mode is changed from the System Menu to RUN.

The term “initialize” means the processing to initialize the content of words in the
host with the content in a character string memory table entry (string table). The
setting for [Initial] is not valid if a character stringmemory table entry (string table)
is not allocated to a host word.

To make [Initial] valid, click on the check box to display a cross mark (¢) in the
box. If the box is clicked on while it is in the valid state, [Initial] is made invalid.

Reference: The content of character string memory table entries (string table) at the start of
PT operation is as shown below according to whether or not a character string
memory table entry (string table) is allocated to thehost, the [Initial] setting for the
character stringmemory table entry (string table), andwhether or not the resume
function is used.

Allocation to [Initial] [Initial] settingAllocation to
Host

[Initial]
setting Used Not Used

Allocated Initialized
(valid)

Existing character string
memory table (string
table) content retained
(also for the word in the
host)

Initial value of the char-
acter string memory table
entry (string table)
(also for the word in the
host)

Content of the character string memory table entry
(string table) if it is initialized by System Menu opera-
tion
(also for the word in the host)

Not initialized
(invalid)

Content of a word in the host

Not allocated (Invalid) Existing character string
memory table (string
table) content retained

Initial value of the char-
acter string memory table
entry (string table)

Content of the character string memory table entry
(string table) if it is initialized by System Menu opera-
tion

Words
Specify the number of words in the PC (PLC) to be allocated to the character
string memory table entry (string table).

The number of allocated words varies depending on the PTmodel as shown be-
low.

PT Model No. of Allocated Words

NT11S 1 to 10 words (1 to 20 characters)

NT20S 1 to 16 words (1 to 32 characters)

NT30, NT30S, NT21, NT31, NT31C, NT600S,
NT620S, NT620C, NT625C, NT631, NT631C

1 to 20 words (1 to 40 characters)
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One word corresponds to 2 characters.

A character string is allocated to the PC (PLC) words in units of 2 characters, be-
ginning with the leftmost character, from lower digit words to higher digit words.
The data type is 1-byte or 2-byte.

Note If the number of characters in a character stringmemory table entry (string table)
is larger than the number of words used, the number of characters equal to the
number of specified words is sent to the PC (PLC) beginning with the start of the
character string.

ABCDEFG AB
If setting is 2 words.

Words allocated in PC (PLC)Character string memory table
(String table)

If setting is 4 words.
HIJKLMN

JK

HI

CD

LM

N

* EFG is not sent.

The character string is sent in units of 2
characters, beginning with the leftmost
character in the character string, and
allocated to words from lower word to
higher word.

00 (hexadecimal) is entered in blank
areas.

PLC Address

Specify the PC (PLC) address (start address) of the area where character string
memory table entries (string table) are allocated.

I/O Comment

Specify a comment for a PC (PLC) word.
A comment can comprise up to 16 characters.

Ref

Displayswhether the tableentrywith thespecified number is alreadyusedor not.

Yes: Already used as an element.
No: Not used.

If the indication is Yes, you can checkwhere the table entry in question is usedby
clicking on . Note that this operation is not possible when setting a

character stringmemory table entry (string table) from the property dialog box of
an element.
(For details of , refer to 7-1-1 Reference Operation.)

7-3-4 Inserting Mark Data into a Character String
To insert mark data into an initial value, follow the steps described below.

(1) After specifying the Value field, move the cursor to the position where the
mark data is to be inserted.

(2) Click on .

The Show Mark dialog box is displayed.

(3) Specify the mark data in the list of mark data.

(4) Click on .
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The code of the specified mark data is inserted to the Value field. The mark
itself is not displayed here.

[ Insert Mark ] button [ OK ] button

Screen Screen

↑
Mark data

7-3-5 Inserting Image Data into a Character String
To insert image data into an initial value, follow the steps described below.

Note that insertion of image data into a character string is possible only with the
NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible
mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2
(NT20/30/620-compatible mode).

(1) After specifying the Value field, move the cursor to the position where the
image data is to be inserted.

(2) Click the Button.

The Image Table dialog box is displayed.

(3) Specify the image data in the list of image data.

(4) Click the Button.

The code of the specified image data is inserted into the Value field. The
image data itself is not displayed here.

[ Insert Image ] button [ OK ] button

Screen

↑
Image data

Screen

Reference: By clicking the Button, an image codewith no data can be added to the
list. You can first insert this image to a string and then register the image data
afterward. (Use the image editor to create image data.)
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7-3-6 Inserting Library Data into a Character String
To insert library data into an initial value, follow the steps described below.

Note that insertion of library data into a character string is possible only with the
NT30, NT30C, NT620S, NT620C, NT625C, NT21 (NT20/30/620-compatible
mode), NT31/C-V2 (NT20/30/620-compatible mode) and NT631/C-V2
(NT20/30/620-compatible mode).

(1) After specifying the Value field, move the cursor to the position where the
library data is to be inserted.

(2) Click the Button.

The Library Table dialog box is displayed.

(3) Specify the library data in the list of library data.

(4) Click the Button.

Thecodeof thespecified library data is inserted to theValue field. The library
data itself is not displayed here.

[ Insert Library ] button [ OK ] button

↑
Library data

ScreenScreen

Reference: By clicking the Button, a library code with no data can be added to the
list. You can first insert this library code to a string and then register the library
data afterward. (Use the library editor to create library data.)

7-4 Bit Memory Table
A bit memory table is an area that operates like flags to execute preset functions
when the specified bits go ON.

A bit memory table entry provides a screen switching function that switches the
screen when the specified PC (PLC) bit goes ON and an alarm function that dis-
plays the alarm message or logs the event of alarm occurrence if the specified
PC (PLC) bit goes ON.

By allocating a bit memory table entry to a PC (PLC) bit, data can be shared be-
tween a PC (PLC) and a PT.
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Screen switching function

Screen switching

Screen No. : 2

PC (PLC)
address : 00010

Bit memory table

Specified PC (PLC) bitScreen 1

Screen 2

Allocated bit ON

PT

Alarm function

Character string
memory table
(String table) No.: 10

Image/library code: FE20

PC (PLC) address: 0001000

Bit memory table

10

11

12

13

Character string
memory table
(String table)

ABC

DEF

GHI

JKL

Image data

FE20

Specified PC (PLC) bit

ABC

Alarm list
Displayed in
response to
bit going ON

The range of bit memory table entries used for checking bit status is
set by the alarm list.

Displayed
in response
to touching
a message

Specifying item
to be called

Specifying item
to be called

ON

Stored in alarm history

ABC 96/04/10

7-4-1 Operation Procedure
The bit memory table setting dialog box is displayed by following either of the op-
erations described below.

S At the properties of the alarm list element, click on the table entry number field.

S Select [Tools] (menu bar)→ [Table], then click [Bit Memory] tab.

Setting

Forbitmemory table entries, theobjectiveof theoperation is specified by clicking
on a line. The necessary setting can be made by input using a keyboard or by
selection using a drop-down list.

For the operation procedure for , , ,

, and , refer to 7-1 Common Operation. (Note that
cannot be used if bit memory table entry is displayed by the operation

using an element property.)

7-4-2 Related Elements
Alarm list element [Object]→ [Alarm]→ [List]
Alarm history element [Object]→ [Alarm]→ [History]
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7-4-3 Description of Bit Memory Table Fields

As the reference of bit memory table setting, please refer to 6-3 Alarm.

WARNING

When converting the bit memory table from NT30, NT30C,
NT620S, NT620C, NT625C to NT31, NT31C, NT631, NT631C,
the function setting is not the same with before converting. To
adjust the setting of this bit memory table, please refer to Data
Conversion (Bit memory conversion) in Appendix A.

Items set to use the screen switching function

To use the screen switching function, follow the procedure below.

(1) Input PLC address directly on a PLC address field on a bit memory table
entry or click on and input PLC address on a PLC address dia-
log. (Refer toWordsetting for anelementonpage127). Input I/O comment if
required.

(2) Click on to display function dialog.

(3) Select “Switch Screen” from function combo box.
Setting items for screen switching function are displayed.

(4) Set screen number to be switched for “Screen No..”

S Settings to make at the Set dialog

PLC Address

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table
entry.

I/O Comment

Specify a comment for a PC (PLC) bit.

A comment can comprise up to 16 characters.

S Settings to make at the Function dialog

Function
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Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and
NT625C, and select [Switch Screen] for the NT21, NT31, NT31C, NT631, and
NT631C.

Switch Screen (only for NT30, NT30C, NT620S, NT620C, and NT625C)

To make the screen switching function valid, click on the check box to display a
checkmark in it. If you click on the check boxwhen it already has a checkmark in
it, the check mark is cleared and the screen switching function is made invalid.

For the NT21, NT31, NT31C, NT631, and NT631C, whether or not the screen
switching function is used is determined by the setting for [Function].

Screen No.

Specify the screen No. of the screen to which the screen switches when the bit
memory table entry goes ON.

Items set to use the alarm function

To use the alarm function, follow the procedure below.

(1) Input PLC address directly on a PLC address field on a bit memory table
entry or click on and input PLC address on a PLC address dia-
log. (Refer toWordsetting for anelementonpage127). Input I/O comment if
required.

(2) Click on to display function dialog.

(3) Select “Alarm” or “Alarm/Switch Screen” from function combo box.
Setting items for Alarm function are displayed.

(4) Make the settings for the alarm function. (See below)

S Settings to make at Set dialog

PLC Address

Specify the bit in a PC (PLC) whose status is reflected by the bit memory table
entry.

I/O Comment

S Specify a comment for a PC (PLC) bit.

A comment can comprise up to 16 characters.

S Settings to make at Function dialog

Function

Select [Alarm/Switch Screen] for NT30, NT30C, NT620S, NT620C, and
NT625C, and select [Alarm] for the NT21, NT31, NT31C, NT631, and NT631C.

Switch Screen

The meaning of the [Switch Screen] setting differs between the NT30, NT30C,
NT620S, NT620C, and NT625C and the NT21, NT31, NT31C, NT631, and
NT631C.

S NT30, NT30C, NT620S, NT620C, and NT625C

To use the alarm function, the check boxmust not have a checkmark set in it. If
it does, the screen switching function is selected.

S NT21, NT31, NT31C, NT631, and NT631C

To display the specified screen by the operation of an alarm list/history ele-
ment, set a checkmark in the checkbox.Clear the checkmark in the checkbox
in order not to display the specified screen.
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Screen No.

The message area displayed in the alarm list/history element is a touch switch
and pressing the touch switch that is in the selected state displays the specified
screen.

S NT30, NT30C, NT620S, NT620C, and NT625C

Specify the screen No. of the screen to which the screen should switch by the
operation of the alarm list/history. Specify 0 if you do not switch the screen.

S NT21, NT31, NT31C, NT631, and NT631C

Specify the screen No. of the screen to be displayed if a check mark is set for
[Switch Screen]. The setting for this item is not valid unless a checkmark is set
for [Switch Screen].

String Table Entry

Specify the character string memory table entry (string table) number where the
character string that is displayed as a message is stored when the bit memory
table entry goesONor the bit memory table entry registered for the alarmhistory
is displayed.

Image/Library Code

If you want to display image data or library data when amessage is selected, set
a checkmark in thecheckboxandspecify the image/library codeafter clickingon

or .

Color -- Foreground

Specify the color in which the message display field is displayed when a mes-
sage is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

S Code setting in the image/library code field

When setting a code in the image/library code field, the desired code can be
selected from the list as an alternative to direct input of a specified code using a
keyboard.

Setting the image data

To set an image code in the image/library code field by selecting image data
from the list, follow the procedure described below.

(1) Specify the image/library code field where the code is set.

(2) Click on .

(3) Specify the image data from the list.

(4) Click on .

Thecodeof thespecified imagedata isdisplayed in the image/library code
field.

[Insert Image]
button

[OK] button
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Setting the library data

Toset a library code in the image/library code fieldby selecting library data from
the list, follow the procedure described below.

(1) Specify the image/library code field where the code is set.

(2) Click on .

(3) Specify the library data from the list.

(4) Click on .

Thecodeof thespecified librarydata isdisplayed in the image/library code
field.

[Insert Library]
button

[OK] button

7-5 Extended I/O Input Table
The extended I/O input table is used to set functions at the input terminals of an
extended I/O unit or allocate PC (PLC) bits to be referred to.

Extended I/O units can be used only with NT30 and NT30C.

The following functions can be set at extended I/O unit input terminals.

Screen switching

Screen 1

Screen 2

PT

External input

Extended I/O input table

Screen switching
2Screen No.

When the input terminal goes ON, the screen is switched to the set screen.
If 0 is set, the display returns to the previous screen.

Notify bit

Notify bit
PC (PLC)
address:

0000002

PT

External input

PC (PLC)

Extended I/O input table
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The extended I/O input table notifies the PC (PLC) of the status (ON/OFF) of the
input terminals.

Control code input

Control code
input function
Control key�RET

PT

External input

Extended I/O input table

Data input field
1234

When the input terminal goesON, it has thesameeffect aspressingof thecontrol
key.

Canceling backlight OFF

Canceling backlight
OFF function

External input

Extended I/O input table

Backlight
ON

Backlight
OFF

PT

When the input terminal goes ON, the backlight, which has been turned OFF by
the Cancel Backlight Off function set by a memory switch, is turned ON to redis-
play the screen.AbacklightOFF function releasingattribute is automatically pro-
vided for the screen switching function and the control code input function.

Do not use the input function of a PT extended I/O input
for applications that could cause fatal injury and/or
serious damage, or as an emergency switch function.

7-5-1 Operation Procedure
An extended I/O input table entry is displayed by following the operation de-
scribed below.

S Select [Tools] (menu bar)→ [Table]→ [Extended I/O Input] tab→ Clicking on
table entry No.→

Setting

Settings for the extended I/O input table fields can be made by using the setting
dialog box that is displayed by clicking on .

For the operation procedure for , , and ,
refer to 7-1 Common Operation.

WARNING
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7-5-2 Description of Extended I/O Input Table Fields

No.: Extended I/O unit input terminal number.

Cncl: Presence/absence of the backlight OFF cancelling attribute.
Make this setting at Set dialog.

Function: Function set for the input terminal.
Notify bit, Switch Screen, Input Key-Control.
Make this setting at Set dialog.

Description: Contents set at “Function” are shown.
Make this setting at Set dialog.

Cancel Backlight Off

Specify whether or not the backlight OFF state is to be canceled.

To set the Cancel Backlight Off function, click on the check box to set a check
mark in it.

If you donotwant to set theCancel BacklightOff function, clear the checkmark in
the check box.

This setting is valid when [None] or [Notify Bit] is set for [Function].

The Cancel Backlight OFF function is automatically provided for the screen
switching function and the control code input function.

Function

Specify the input terminal function.

S None

S Switch Screen

S Notify Bit

S Input Key -- Control

When Switch Screen is specified

Screen No.

Specify the screen No. of the screen to which the screen should be switched
when the input terminal goes ON.
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When Notify Bit is specified

Notify Bit Address

Specify the PC (PLC) bit where the event of the input terminal going ON is noti-
fied.

Comments

Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

When Input Key -- Control is specified

Control Key

Select the control code to be input when the input terminal goes ON from the list.

: Inputs numeral 0 in a data input field.

: Inputs numeral 1 in a data input field.

: Inputs numeral 2 in a data input field.

: Inputs numeral 3 in a data input field.

: Inputs numeral 4 in a data input field.

: Inputs numeral 5 in a data input field.

: Inputs numeral 6 in a data input field.

: Inputs numeral 7 in a data input field.

: Inputs numeral 8 in a data input field.

: Inputs numeral 9 in a data input field.

: Inputs hexadecimal A in a data input field.

: Inputs hexadecimal B in a data input field.

: Inputs hexadecimal C in a data input field.
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: Inputs hexadecimal D in a data input field.

: Inputs hexadecimal E in a data input field.

: Inputs hexadecimal F in a data input field.

: Deletes numeric value/character string in a data input field.

: Confirms inputs in a data input field (cursor remains in this field.).

: Toggles plus (+) and minus (−) sign in a data input field.

: Inputs a decimal point in a data input field.

: Moves the input cursor to the data input field at the upper left area.

: Moves the cursor to the data input field immediately above the present
data input field.

: Moves the cursor to the data input field immediately below the present
data input field.

: Move the cursor to the left data input field.

: Move the cursor to the right data input field.

: Moves the cursor to the previous data input field in the order.
Changes the continuous screens to the previous screen.

: Moves the cursor to the next data input field in the order.
Changes the continuous screens to the next screen.

: Stops Buzzer.

: Displays the System menu.

After setting the items for the selected function (switch screen, notify bit, control
code input), click on .

The specified contents are displayed in the extended I/O input table entry.

7-6 Extended I/O Output Table
An extended I/O output table controls the output terminal of an extended I/O unit
according the ON/OFF status of a PC (PLC) bit.

Extended I/O units can be used only with NT30 and NT30C.

PC (PLC) address:
0001002

PT

External output

PC (PLC)

Extended I/O output table
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7-6-1 Operation Procedure

An extended I/O output table entry is displayed by following the operation de-
scribed below.

S Select [Tools] (menu bar)→ [Table]→ [Extended I/O Output] tab

Setting

With an extended I/O output table entry, the objective of an operation is specified
by clicking on the line. Setting is performed by using the setting dialog box that is
displayed by clicking on .

For the operation procedure for , , and ,
refer to 7-1 Common Operation.

7-6-2 Description of Extended I/O Output Table Fields

No.

Extended I/O unit output terminal number.

PLC Address

Specify thePC (PLC) bit that controls the output terminal of an extended I/O unit.

I/O Comment

Specify a comment for a PC (PLC) bit.
A comment can comprise up to 16 characters.

7-7 I/O Comment Table
The I/O comment table is an area provided in a PT tomanage the comment data
of all words and bits in a PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by numeral memory
table entries, character string memory table entries (string table), bit memory
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table entries, extended I/O input table entries, extended I/O output table entries,
and elements, in the form of list. The displayed comments can be edited.

Reference: If “--” is displayed for PLC Bit Address when its “Ref” is Yes, object without PLC
address exist.

Clicking on enables to knowwhich objects is created without PLC ad-

dress.

7-7-1 Operation Procedure
An I/O comment table entry is displayed by following the operation described be-
low.

S When allocating PC (PLC) address by the setting of lamps and touch switches

Click on in the I/O comment field of the properties displayed for each ele-

ment→ Specify the edit field→ Click on

Example:

Click

S [Tools] (menu bar)→ [Table]→ [I/O Comments] tab→Specify the edit field→

Reference: S When only editing an I/O comment of a PC (PLC) address allocated to an ele-
ment, call out the I/O comment table entry from the property dialog box of the
element.

S To set an I/O comment for multiple PC (PLC) addresses, select the [Tools]
menu, then select [Table].

Setting

To edit an address or a comment, display the setting dialog box by clicking on
or edit directly on a table entry.

For the operation procedure for , , and , refer to

7-1CommonOperation. (Note that cannot be used if it is displayedby

the operation using an element property.)
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7-7-2 Description of I/O Comment Table Fields

Displaying specified word and bit I/O comment

Editing and adding I/O comment

Displaying I/O comment for specified word and bit

The items displayed on an I/O comment table are shown below.

Address

Displays the PC (PLC) word or bit address that corresponds to the comment.

I/O Comments

Displays the comment for the PC (PLC) word or bit.

Reference

Displays if the word is already used or not.

Yes: Already used in an element or a table.
No: Not used.

If the indication is Yes, you can checkwhere theword in question is used by click-
ing on .

(For details of the button, refer to 7-1-1 Reference Operation.)

For details of the button, refer to 7-1-2 Search Operation.

Editing or adding an I/O comment

S Editing (modifying) an I/O comment

To edit (modify) the I/O comment already set, click on the table entry number,
then click or edit directly on a table entry.
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S Adding an I/O comment

To set (add) an I/O comment, after clicking on the table entry number of the
blank field at the bottom, click .

S Setting items in the set dialog box

Channel (Word)

Specify the type of area (area name in PC (PLC)) for which a comment is to be
displayed.

Address

Specify the address numberwhere the I/O comment to beedited is allocated. If
you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is dis-
played for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a
table entry.

Bit

Specify the PC (PLC) bit number where the I/O comment to be edited is allo-
cated. If you specify a new address or bit, an I/O comment can be added.

If a comment is allocated using an element or a table entry (i.e., Yes is dis-
played for [Reference]), it is not possible to change the comment.

It is possible to change the comment if it is not allocated using an element or a
table entry.

I/O Comments

Specify a comment for a PC (PLC) address or bit.
A comment can comprise up to 16 characters.

7-7-3 Importing I/O Comments from a Ladder Program
With NT-series Support Tool for Windows, it is possible to import I/O comments
from the ladder program that is created using the following PLC Support Soft-
ware. Inputting I/O comments can save time and labor.

This section describes the import method of I/O comment.

S SYSMAC Support Software, SYSMAC CPT

I/O comments can be imported from a C-series ladder program with the exten-
sion .SP1.

Reference: S With SYSMAC Support Soft, when saving ladder program, I/O comments are
automatically saved in a file with an extension .SP1.
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SYSMACCPT saves ladder program in SSS program (*.SP1) and use this file
to import I/O comment.

S I/O comment of CVM1/CV series can not be imported with Support Tool.

S WithSYSMACCPT, it is not possible to save ladder programofPLCwith “-Z” in
a file with an extension .SP1. Therefore, Support Tool can not import I/O com-
ment of ladder program for “-Z” created with SYSMAC CPT.

Priority in I/O comment

When the I/O comment table at Support Tool has an existing I/O comment or
when both word I/O comment and its bit I/O comment exist in ladder program to
be imported (e.g., 0005CH:DDD, 000512:EEE), priority will be as follows
(smaller number takes higher priority):

(1) Existing I/O comment in Support Tool (in I/O comment table)

(2) I/O comment of bit in ladder program to be imported

(3) I/O comment of word in ladder program to be imported

Example: Existing I/O comments in Support Tool (in I/O comment table)

Word / Bit I/O Comment

0005 AAA

000603 BBB

0007 CCC

I/O comments in ladder program to be imported

Word / Bit I/O Comment

0005 DDD

000512 EEE

0006 FFF

000613 GGG

000708 HHH

0008 III

↓

I/O comments in Support Tool (in I/O comment table) after importing

*: Existing I/O comment in Support Tool (in I/O comment table)
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Handling of I/O comments of Timer / Counter

Timer/Counter donot have their ownnumber. Theyshare commonTimer/Count-
er number.

However, with an I/O comment table at Support Tool, it is possible to input Timer
and Counter separately.

So when the Timer/Counter number is imported, I/O comment table stores the
same comment both for timer and counter of the same number.

In case I/O comment table at Support Tool has an existing I/O comment for either
of timer and counter, existing I/O comment inSupport Tool (in I/O comment table)
takes priority and imported I/O comment will be stored only for an empty one.

Example: Existing I/O comment in Support Tool (in I/O comment table)

Word / Bit I/O Comment

TIM002 AAA

CNT002 BBB

CNT003 CCC

I/O comments in ladder program to be imported

Word / Bit I/O Comment

TIM/CNT000 DDD

TIM/CNT002 EEE

TIM/CNT003 FFF

TIM/CNT004 GGG

↓

Existing I/O comments in Support Tool (in I/O comment table) after importing

*: Existing I/O comment in Support Tool (in I/O comment table)

Import Procedure

SYSMAC Support Software, SYSMAC CPT

Follow the procedure below to import I/O comment from ladder program.

(1) Select “Import I/O Comments” from the Tools menu.
Dialog box to specify I/O comment is displayed.

(2) Specify the I/O comment file (.SP1) to be imported and click the
Button.
I/O comment Import is performed. While importing, progress will be dis-
played on status bar.



7-7SectionI/O Comment Table

302

(3) When the operation is finished, the message “Import of I/O Comments, op-
eration completed” is displayed. Then, click the Button.
When an I/O comment import was aborted or could not be done because of
error, the message “Failed to import I/O comment” is displayed, then click
the Button. In this case, the contents of I/O comment table in
Support Tool remain unchanged.
If this message box is displayed, check the following points.

S Is this a program file for OMRON C-series PLC?

S Is the extension .SP1 (SSS program file format)?

In case OMRON SYSMAC CPT is used, store (export) the ladder program in
SSS program (*.SP1) format and then use this file to import I/O comment.

Reference: S For SYSMAC Support Soft, SYSMAC CPT, priority of word types to be im-
ported is given below. CIO has the highest priority.
(With comments of more than 3000 entries, D will be cut first.)

CIO (Bit)
L (Bit)
H (Bit)
TIM/CNT
A (Bit)
CIO (Word)
L (Word)
H (Word)
A (Word)
D (Word)

The I/O comments table displays comments in numerical/alphabetical order.

7-7-4 Importing I/O Comment from Tab-delimited Text File
Import Procedure

(1) Select “Import I/O Comments” from the Tools menu.
The dialog box to specify I/O comments will be displayed.

(2) Specify “CX-P IO Comments (Tab Delimited) (*.txt)” or “All Files” as a file
type and specify the I/O comment file (tab delimited text file) saved and click
the [OK] Button.
The I/O comment will be imported.

(3) When the operation is finished, the message “Import of I/O Comments, op-

eration completed” will be displayed. Next, click the Button.
When an I/O comment import was aborted or could not be performed be-
cause of an error, the message “Failed to import I/O comment” will be dis-

played. Click the Button to clear themessage. In this case, the
contents of the I/O comment table in Support Tool remain unchanged.
If this message box is displayed, check the following points.

S Is the data format of the I/O comment file to be imported (tab delimited text file)
correct? (see the following page)

If an import is aborted in the middle of the import operation, I/O comments in the
Support Tool will remain unchanged.

Text file format to be imported by the Support Tool

The Support Tool can read the tab-delimited text file, which was created by the
user, as an I/O comment file. Here, the rule for the text file format is described.
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Format

S One line must be constructed as follows:

Name [TAB] PLC address [TAB] I/O comment [Enter]

Example

START 0.01 START(ON)

STOP 0.02 STOP(OFF)

N_DataV1082 DM1082 Speed1

N_DataA1083 DM1083 Speed2

For details of the format rule, see the description below and the [Example of im-
port].

Name

The Support Tool imports only the PLC address and the I/O comments to the I/O
comment table. Therefore, the address name can be omitted.

In this case, however, be sure to insert TAB code before “PLC address.”

Example

[TAB]0.01[TAB]START(ON) [Enter]

PLC address

Each word type should be expressed as shown below. To specify a bit number,
input bit number after a decimal point.

Word Prefix
Example

Word Prefix
C series CS1 series

CIO area Address (None) 120 120

Bit 0.12 0.12

HR area Address HR or H HR120 H120

Bit HR0.12 H0.12

AR area Address AR or A AR120 A120

Bit AR0.12 A0.12

LR area Address LR LR120 L120 *

Bit LR0.12 L0.12 *

Timer TIM or T TIM100 T100

Time up flag TU --- TU100

Counter CNT or C CNT100 C100

Count up flag CU --- CU100

Work area Address W --- W120

Bit --- W0.12

Task flag TK --- TK1

Data memory area DM o r D DM20 D20

EM current bank EM or E EM20 E20

EM bank specification
(j: Bank specification, hexade-
cimal, 1 digit)

Ej_ --- EC_20

*: CS1 series does not have an LR area. If an LR area bit (L00000 to L00199) is
set to screen data, it will be automatically converted to CIO 01000 to CIO 01199
inside the PT.
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I/O comment

If an I/O comment longer than 16 characters is set, the remaining characters are
discarded.

Example of import

Strings Import Result
Strings Import

OK/NG PLC address I/O comment

ABC [Enter] NG --- ---

nABC [Enter] NG --- ---

nABCnn [Enter] NG --- ---

ABC [TAB] 100.01 [TAB] comment1 [Enter] OK 0010001 comment1

ABC [TAB]100.02 [TAB] [Enter] OK 0010002

ABC [TAB] [TAB] comment2 [Enter] NG --- ---

ABC [TAB] [Enter ] NG --- ---

ABC [TAB] [TAB] [Enter] NG --- ---

ABC [TAB] nn [TAB] nn [Enter] NG --- ---

nn [TAB] nn [TAB] nn [Enter] NG --- ---

[Enter] Ignored --- ---

[TAB] [TAB] [Enter] NG --- ---

[TAB] [Enter] Ignored --- ---

n [TAB] 100.03 [TAB] comment3 [Enter]r OK 0010003 comment3

n [TAB] 100.04 [TAB] [Enter] OK 0010004

n [TAB] 100.05 [Enter] NG --- ---

[TAB] [TAB] comment4 [Enter] NG --- ---

[TAB] [TAB] [TAB] [EOF] NG --- ---

[TAB] 100.06 [TAB] comment5 [EOF] OK 0010006 comment5

ABC [TAB] 100.07 [TAB] comment6 [EOF] OK 0010007 comment6

n: Blank space [TAB]: TAB code
[Enter]: Enter code [EOF]: End of file

Reference: S It may take time to import I/O comments when there are many I/O comments.

S There are the PLC address, I/OComment, andReference in an I/O comments
table. Addresseswith no comment and no referencewill not be downloaded to
PT. (See below)

Referenced Not Referenced

With Comments f f

Without Comments f ×

f: Can be downloaded ×: Cannot be downloaded

Lines in an I/O comment table with only the PLC address input (for future use
etc.) will not be downloaded toPT, andas a result, when the data is uploaded to
the Support Tool, the line itself will be lost. (This also applies when saving data
in mmi format.)

S Support Tool cannot import more than 3,000 PLC addresses with comments.
Therefore, if there are more than 3,000 PLC addresses with comments, only
the addresses will be imported for PLC addresses from entry 3001 onwards.
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(I/O comment import operation will be finished normally.)
Rejected entries are displayed in theError Log.Check themby selecting [Error
Log] from the [View] menu and print them.

7-8 F-Key Input Notify Table
This table is only available for NT11S. The F-Key Input Notify Table consists of
four entries. Each entry is assigned to a function key in thePTdevice. It specifies
a PC (PLC) memory bit to be related to a corresponding function key.

7-8-1 Operation Procedure
AnF-Key InputNotify Table is displayed by following the operation described be-
low.

S Select [Tools] (menu bar)→ [Table]→ [F-Key Input Notify] tab→ Specify the
edit field→

7-8-2 Description of F-Key Input Notify Table

Table Entry Number

The table entry number field, or the <No.> column is not editable. All table entries
are listed in ascendingorder of their entry numbers, starting fromzero to one less
than the maximum number of entries.

Table Entry No. F-Key Input

0 F1

1 F2

2 F3

3 F4

PLC Bit Address

Specify the PC (PLC) bit that you want to link with the Function Key.

I/O Comment

Specify a comment for a PC (PLC) address or bit.

A comment can comprise up to 16 characters.
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7-9 Mathematical Table
Mathematical table is only available for the NT21, NT31/631-V2 and above. The
tablemay contain 0 to 255 entries and each entry can be assigned amathemati-
cal formula. The result of each calculation can be stored in either a Numeral
Table entry or a PLC address.

7-9-1 Operation Procedure
The mathematical table setting dialog box is displayed by following either of the
operations described below.

S Select [Tools] (menu bar) --> [Mathematical Table].

S Double click on “Mathematical Table” from application manager window

7-9-2 Supported Objects
The following objects are affected or have an effect on the Mathematical Table:
NumeralDisplay,Numeral Input,Thumbwheel switch,BarGraph,Analogueme-
ter, Broken Line Graph, Trend Graph.

7-9-3 Supported PLC Addresses
The supported addresses for the operand and result based on the PLC vendor
type are as follows:

Omron

Word Range

CIO 00000 to 32767 (decimal)

DM 00000 to 32767 (decimal)

HR 00000 to 32767 (decimal)

AR 00000 to 32767 (decimal)

LR 00000 to 32767 (decimal)

EM 00000 to 32767 (decimal)

WR 00000 to 32767 (decimal)

E0 to EA 00000 to 32767 (decimal)

C 00000 to 32767 (decimal)

T 00000 to 32767 (decimal)

Memory Link

Word Range

CIO 00000 to 32767 (decimal)

Mitsubishi A

Word Range

X 0000 to 2700 (hexadecimal)

Y 0000 to 2700 (hexadecimal)

M 0000 to 9984 (decimal)

L 0000 to 9984 (decimal)

B 0000 to 2700 (hexadecimal)
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Word Range

D 0000 to 9999 (decimal)

R 0000 to 9999 (decimal)

W 0000 to 270F (hexadecimal)

C 0000 to 9999 (decimal)

T 0000 to 9999 (decimal)

Mitsubishi Fx

Word Range

X 00000 to 23400 (octal)

Y 00000 to 23400 (octal)

M 0000 to 9984 (decimal)

S 0000 to 9984 (decimal)

D 0000 to 9999 (decimal)

C 0000 to 9999 (decimal)

T 0000 to 9999 (decimal)

7-9-4 Description of Mathematical Table Fields

Description

Themathematical function specified in each table entry will be displayed here in
the form of a simple equation. Left-hand side of the equation will indicate the
location where result calculated from the function will be stored. Right-hand side
will display the actual function.

Set

Invokes ‘SetMathematical DialogBox’. Specifymathematical function using this
dialog box.

Edit

Refer to 7-1 Common Operation.
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Goto Entry

Refer to 7-1 Common Operation.

Move

Invokes ‘Move To’ dialog box. Move a table entry using this dialog box

Close

Closes the dialog box.

Help

Shows help information related to mathematical table.

7-9-5 Description of Set Mathematical Formula Fields
This dialogbox is to beused todefineanew/edit anexistingmathematical formu-
la.

Formula

Shows the list of available formula that can either be arithmetic, boolean or bit-
wise operations. This will list out combinations of available operands and opera-
tors i.e., type of the function.

Selected Formula

Shows the selected mathematical formula for this entry. It is updated whenever
there is any change in operands or operators.

Word Size

This is a common setting for Result andOperand. It is only valid for PLCAddress
and constant. For Numeral Table entry, the word size will follow the setting in the
Numeral Table. This control will be enabled when the selected formula is not
‘None’.

Result

This buttonwill be used to specify the result. This buttonwill be enabledwhen the
selected formula is not ‘None’. The following choices areavailable for result loca-
tion.

S PLC word address

S Numeral table entry

Operand buttons
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This buttons will be used to specify operands. Operand buttons will be enabled
according selection of [Formula]. The following choices are available for oper-
ands.

S Constant value (integer only)

S Numeral table entry (Direct)

S PLC Address

Operators

These combo boxes will provide a list of available operators. Operator combo
boxes will be enabled according selection of [Formula]. Following choices of
types of operators will be available.

S Numerical Operator (Addition, Subtraction, Multiplication, Division (result will
have the quotient only) and Modulo)

S Boolean Operator(AND, OR & XOR)

S Bitwise Operator (&: bitwise AND, |: bitwise OR and ^: bitwise XOR)

S Comparison Operator( <, > and =)

7-9-6 Description of Edit Operand Fields

This dialog box will be obtained by clicking ‘any of the enable Operand’ buttons.
This will be used to specify the operand.

Operand Type

This combo box will specify the type of operand. Default is ‘None’ andOK button
will remain disabled unless some other selection is made. The following choices
are available for the combo box:

PLC Address

This is almost like the address dialog box. There is an extra field: Storage Type.

Storage Type

Specify the type of the storage type (BCD/BIN).
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Numeral Table Entry

Numeral Table Entry

Specifies numeral table entry number. Numeral table entry can be specified in

this edit box using corresponding table button .

Constant

Constant

Specify constant integer for the operand.

7-9-7 Description of Edit Result Fields
This dialog box will be obtained by clicking Result button. This will be used to
specify the result.

Result Type

This is to specify type of the result. Choices for result types are:

(1) Numeral Table Entry

(2) PLC Address

Dialogboxesaresameas thatof corresponding ‘EditOperand’ dialogboxes.Re-
fer to 7-9-6 Description of Edit Operand Fields [Dialog Box] for UI and fields.

7-9-8 Description of Move To Fields
This dialog box will be used to move amathematical table entry to any of the ex-
isting entry.

Entry

Specifies the table entry number of the table where current entry will be moved.
The cursor moves to the specified table entry number. Entries following this will
be moved downwards to adjust for the moved entry.



7-10SectionRecipe Table

311

7-10 Recipe Table
Each application has one recipe table. A recipe table (see Section 7-10-2) con-
sists of a number of entries. Each entry consists of a collection of records, and
each record consists of a number of parameters or attributes. Parameters desig-
nate consecutive memory areas from a starting address defined for each recipe
entry.

Each standard screen is limited to one recipe screen element. A recipe screen
element (see Section 6-11-1) is a compound screen element, consisting of an
alarm-like grid structure and some touch switches. It is like a collection of numer-
al inputs, featuring access and display of data from the recipe table.

Recipe Table is only available in the NT21 and NT31/631-V2 (System Ver. 3.1).

7-10-1Operation Procedure
The recipe table can be activated by selecting [Tools] (menu bar) ! [Recipe
Table].

7-10-2 Description of Recipe Table Fields

Description of Recipe Table Dialog Controls

No.

Displays the entry number. By default, the 1st record is selected. Nothing hap-
penswhenanentry is double-clicked. This numberwill not changewhenanother
entry is deleted.

Name

Displays the name for a recipe. Mark objects can be allowed.

A [Name] can comprise up to 12 characters.

No. of Records

Displays the number of records contained in the recipe.
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No. of Parameters

Displays the number of parameters contained in the recipe.

Bytes/Record

Displays the size in bytes of all records in eachentry. This size is 4 * no. of param-
eters in 1 record. The size of a parameter value is 4bytes regardless ofwhether it
is 1 or 2 words.

Occupied Bytes

Display the size in bytes of all records in each entry. This is the size of memory
occupied by each recipe entry in the recipe memory. Equals [No. of Record] *
[Bytes/Record].

New

Shows the recipe setting dialog to create a new recipe entry. The created entry
becomes the last entry and gets selected.

Delete

Delete the selected entry. Same as [Edit]--[Delete].

Set Recipe

Shows the setting of the selected entry in a recipe setting dialog.

Set Record

Show the records of the selected entry in a record setting table.

Edit

Permits delete, cut, copy and paste operations on a selected recipe. An edit pop-
up menu with these 4 options will appear.

Delete, Cut, Copy, Paste is disabled when no entry exists. Paste is available
when the clipboard contains recipe data.

Goto Entry

Selects an entry by specifying the entry number through a Go to dialog. The be-
havior is the same as numeral table Go to dialog.

Total

Displays the byte-size of all entries. Equals sum of all [Occupied Bytes].

Available

Displays the table’s maximum byte-size less the used byte-size. This is the total
recipe size minus total occupied size.
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Recipe Setting Dialog

This Recipe Setting dialog allows you to specify the settings for an entry in the
recipe table.

Description of Recipe Setting Dialog Controls

Number

Displays the recipe number in the recipe table.
When creating a new entry, the lowest available number is suggested.

The maximum recipe number is 200.

Name

Specifies the name of the recipe entry.

A character string of up to 12 characters can be accepted.

Insert Mark

Insert a mark object in recipe name.

Comment

Specifies a comment for recipe entry.

A character string of up to 24 characters can be accepted.

No. of Records

Inputs the number of records required for this recipe entry. If this entry is being
created, default value is 2.

Allocate up to a maximum of 200 digits.
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No. of Parameters

Inputs the number of parameters required for this recipe entry. If this entry is be-
ing created, default value is 2.

Allocate up to a maximum of 200 digits.

Storage Type

Sets the numeral data type for parameter values in each record of this recipe
entry.

PLC Address

Inputs the starting PLC address for this recipe entry. Bit addresses cannot be
specified.

Set

Sets the starting PLC address via an address composition dialog.

I/O Comments

Inputs comments for the starting PLC address. By default, the current comment
is shown.

A character string of up to 16 characters can accept.

7-10-3 Record Setting Table

This Record Setting Table dialog box permits you to specify the settings for all
records of a recipe entry in the recipe table.

Description of Record Setting Table Controls

Start Address

Displays the starting PLC address.

No.

Displays the record number.
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Record

Specifies the name for the record entry.

A string of up to 12 characters can be used and edited.

Parameter Title

Displays the parameter name, i.e., “Param1” and “Param2.”Default value is “Pa-
ramX,” where X is a number.

Up to 8 characters can be used and edited, with the column width depending on
the parameter values.

Parameter

Displays the numerical data values for each record.

You can edit data values. The Initial value is 0.

Lock

Sets the Record as read only.

Edit Param

Displays the parameter setting table.

Edit

Permits clear, copy and paste operations on a selected range of record entries.
An edit popupmenuwith these 4 options will appear, like themenu in the current
numeral table entry.

Clear, Copy, Paste is only enabled when the clipboard contains record data.

Goto Entry

Allows the selection of an entry by specifying the entry number through a Go to
dialog. The behavior is same as the numeral table Go to dialog.

Insert Mark

Inserts a mark object in a record or a parameter name.

Import

Import parameter data from a CSV formatted file. A file open dialog with a CSV
Formatted Recipe Data (*.csv) filter will prompt for the source file.

Export

Export all data of this recipe entry. A file save dialog with aCSV Formatted Rec-
ipe Data (*.csv) filter will prompt for the target file name. Exporting a selection of
parameter data is not supported.

Reset Width

Resets the width of each column to the default setting.

Note The parameter data cell will always be displayed using the parameter’s number
format. A decimal type parameter will display values in decimal, while a hexade-
cimal type parameter will display values in hexadecimal.
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Parameter Setting Table

This dialog permits users to specify the setting for all parameters of a recipe table
entry.

When the Words field is changed from 2 to 1, you will be prompted with a mes-
sage that some data will be lost with this conversion. If the value is less than
--32,768 or greater than 32,767, the valuewill be set to 0.Otherwise, if the sumof
Integer and Decimal digits exceed the maximum limit, the number of Decimal
digits will be reduced. For example, given a parameter with settings “Dec,” “4 In-
teger” and “4 Decimal” and value 54.3675, when word size is reduced to 1, set-
ting will become “4 Integer” and “1 Decimal” and value will be 54.3.

Whenentering values into the Integer andDecimal fields, the followingvalidation
will occur. When “Dec/Hex” is decimal and “Integer” or “Decimal” is set so that
their sum is greater than the maximum digits allowed, once the cell loses the fo-
cus, the following occurs:
a) If the entered value is less than or equal to the maximum digits allowed, it is
accepted. Any other value is reduced, so that their sum is not greater than the
maximum digits allowed.
b)Otherwise, the entered value is set to themaximumdigits allowed and the oth-
er value is set to 0.
The maximum digits allowed is 5 (1 word) or 10 (2 words).

Description of Parameter Setting Table Controls

No.

Displays the parameter entry number.

Parameter

Displays the parameter name.

A string of up to 8 characters can be used and edited.

Dec/Hex

Displays the numeral display format, either decimal or hexadecimal.

When this is changed Integer and Decimal will be reset to default.
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Sign

Display sign option. Check if you want a sign to be displayed.

Integer/Decimal

Displays the precision of the integer/decimal digit of the numeral data. Limitation
on thesumof integer anddecimal digitswill follow thenumeral display restriction.

Words

Defines the memory size for the parameter. The address column will be reset
when this size is changed.

PLC Address

Displays the starting PLC address used by the parameter.

Goto Entry

This will allow the selection of an entry by specifying the entry number through a
Go to dialog.

Insert Mark

Inserts a mark object in a parameter name.

Import

The Parameter values in the records of a recipe can be edited through a CSV
(CommaSeparatedValues) file. Each line consists of the fields of a record,with a
comma separating two fields.

The first line of a CSV file is the header. The first field is the recipe name. If it con-
tains ASCII characters from 0x00 to 0x1F will be converted to spaces after im-
port. The second field is “Master Record Flag,” which is equivalent to the Lock
check box in the Record Setting dialog. Subsequent fields are the names of all
the parameters in the record.

The second line onwards contain the parameter value of the records in the rec-
ipe. The first field is the record name. The second field is a value indicating
whether the Lock check box should be checked or unchecked. 0 means un-
checked and 1means checked. Any other values are considered invalid. Subse-
quent fields are the actual values of the parameters in that record.

During export of parameters in the Record Setting Table, the decimal points of
the parameters will not be exported. Example: Parameter 1 is set to 3 integer
digits and 2 decimal digits, and the parameter value is 123.45. After exporting to
CSV format the value will become 12345. Hexadecimal values will be converted
to the decimal equivalent after export.

If you try to import aCSV file that has a valuewith a decimal point, it is considered
invalid and an improper line dialog is displayed. Likewise, hexadecimal values
containing A-F are not allowed.
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Improper Line Dialog

The import operation will overwrite all the current parameter values. However, if
any line in the file is incorrect, an improper line dialog will prompt for instructions.
An improper line is any line of text in the source import file whose data does not
comply with the CSV format or whose data is not valid. Any incorrect value in a
CSV line is shown in red in the Original row as shown in the diagram below. The
Import row will display the adjusted values. You can change the values high-
lighted in red to the desired ones.

In theName field, if the string consist ofmore than the allowednumber of charac-
ters, the data will be truncated from the right.

In the Lock field, ’0’ means unchecked and ’1’ means checked. Anything other
than that is considered invalid. This value will be reset to uncheck.

In the Parameter fields, any non-numeric data is considered invalid. The values
will be reset to 0.

Example
Forexample, if the importeddata is “this is only for testing” andonly 11characters
are allowed, then the grid cell will show “this is only” in red. “for testing” will be
truncated.

“**12**” is not valid for the Lock field and is thus highlighted in red.

So are “$%#@” and “$62#!78” for parameter values, which are both reset to 0.

Description of Improper Line Dialog Controls

Improper Line

You cannot edit this [Improper Line] edit box.

Displays the improper line in the CSV file.

Detail

Original -- Shows the original CSV line. It cannot be edited and these invalid val-
ues will be displayed in red.

Import -- Shows the default values and you can modify the default values.

Name

Shows the first value in the CSV file. This is the record name. If the value has
more than 12 characters, only the first 12 characters from the left will be shown.
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Accepts a character string of up to 8 characters.

Lock

Shows the second value in the CSV file. This is the master record flag. Only the
first character from the right of the value is shown.

Can only accept 0 or 1 (0: unchecked, 1: checked).

Parameter data

Show theother values in theCSV file. Theseare theparameter data values. If the
importedvaluehasmore than thenumberof characters allowed, thevaluewill be
set to 0.

Ignore

Ignore this improper line and proceed to import the rest of the lines in the file.

Ignore All

Ignore all improper lines and proceed to import the rest of the lines in the file.
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SECTION 8
Editing Graphic Data

The graphic data edit function creates images in the bit map data format, library data using fixed elements, and marks that
display special characters and symbols.

8-1 Image Editor 322. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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8-1-2 Creating Image Data Using Image Editor 325. . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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8-2-1 Operating the Library Table 334. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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8-1 Image Editor
The procedure for creating images of any required shape in the bit map (BMP)
format is described below.

The bit map format graphic data that has been created using aWindows-based
general purpose application software can be pasted onto the image creation
screen by using the image editor via the clip board.

Created image data can be inserted into a character string in an image/library
lamp display, alarm list display, alarm history display, or character string display.

With the NT21 and NT31/631 without NT20/30/620-compatible mode, it is not
possible to insert image data into a character string.

Reference: Image editor has the following features.
S You can draw any graphics in the bit map format freely.
S It is possible to import Image data from the different screen data file.
S Selected image data can be expanded or shrunk.
S The bit map file can be pasted onto the image editor.
S Copy, cut, paste operation of image data is possible.
S Preview display of selected image data is available on the image table.

8-1-1 Operating the Image Table
Image table dialog is configured as follows:

[Edit] Deletes, cuts, copies or pastes the image data of the selected. . . . . . . .
code (refer to pages 323 to 325). It is possible to select two or
more codes and delete them collectively.

[Goto Code] Code number can be specified and the cursor moves to the.
code. The operation method is same as the “Goto Entry” of a
memory table (refer to7-1-6TableDisplayOperationbySpec-
ifying the Table Entry Number).

[Preview] Switches the preview window ON and OFF (refer to page. . . .
323).

[Open] Displays the editing screen (image editor) of the selected. . . . . .
code (P331). When two or more codes are selected, edit
screens of all the selected codes can be opened collectively.

[New] Registers the new image code to the image table (refer to. . . . . . .
page 325).
Only the registered image codes are listed on the image table.
Press this button when you are going to create new image
data.
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[Delete] Deletes the image data of the selected code. When two or. . . . .
more codes are selected, they can be deleted collectively.

[Close] Closes the image table dialog.. . . . . .

[Help] Displays Help about the image table dialog box.. . . . . . .

S Specifying a code

To specify a code for operations, click on the objective line (image code).
To specify the continuous codes collectively, click on the first code to be se-
lected and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or
deselected alternately each time it is clicked.

S Preview Function

Support Tool provides a preview function that can display the contents of the
selected code.
When twoormorecodesare selected, thepreviewof the codeselected lastwill
be displayed in preview window.
The previewwindow can be switchedON andOFF by clicking the /

button.

S Deleting the image data

To delete an image data, follow the procedure below. Deleted image data will
not be stored to the clipboard and its code itself will be also deleted.When two
or more codes are selected, they will be deleted collectively.

(1) Select [Image Editor] from the [Tools] menu.
The image table is displayed.

(2) Select the code of the image data to be deleted.
When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
S button→ [Delete]
S Right-click the selected code→ [Delete]
S button
Selected code will be deleted after you click the Button in the con-
firmation dialog box.

S Cutting/copying the image data
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To cut or copy an image data, follow the procedure below. The cut/copied
imagedatawill be stored to the clipboard andcanbepasted to the other codes.
In caseof ““cut,” cut codewill be deleted from the image table. In caseof “copy,”
copied code remains in the image table.

Reference: When two Support Tools are started up by [Import Component] from the [File]
menu, the data that is cut or copied on the image table of oneSupport Tool canbe
pasted onto the image table of another Support Tool (PTmodel setting of the two
screen data files should be the same). For details, refer to 3-3-6 Importing Com-
ponents from Different Screen Data File (Starting Up the Second Support Tool).

(1) Select [Image Editor] from the [Tools] menu.

The image table is displayed.

(2) Select the code of the image data to be cut or copied.

Select only one code. When two or more codes are selected, cut/copy op-
eration can not be performed.

(3) Click the Button or right-click on the selected code.

(4) Select [Cut] or [Copy].

Image data of the selected code will be stored to the clipboard. In case of
[cut], confirmation dialog box will be displayed. After clicking the
Button, cut code will be deleted from the image table.

S Pasting the image data

To paste an image data that is stored in the clipboard by cut or copy operation,
follow the procedure below.

Reference: S When two Support Tools are started up by [Import Component] from the [File]
menu, the data that is cut or copied on the image table of one Support Tool can
bepastedonto the image tableof anotherSupport Tool (PTmodel settingof the
two screen data files should be the same). For details, refer to 3-3-6 Importing
Components fromDifferent ScreenData File (Starting Up the SecondSupport
Tool).

S If the paste operation is performed, the image data previously registered to the
code is overwritten and lost. (Confirmation dialog box will be displayed.)

S When an image data is pasted, the property (size, colors, compression, com-
ment) of the image code is changed to that of the new one.

(1) Select [Image Editor] from the [Tools] menu.

The image table is displayed.

(2) Select the code of the image data to be pasted.

Select only one code. When two or more codes are selected, paste opera-
tion can not be performed.



8-1SectionImage Editor

325

(3) Click the Button or right-click on the selected code.

(4) Select [Paste].

[Paste] can not be selected if the image data to be pasted is not stored in the clip-
board. After clicking the Button in confirmation dialog box, image data
will be pasted to the selected code.

S Quitting the image table

You can quit the image table in any of the two ways described below.
S Clicking the Button of the image table dialog.

S Clicking the Button at the upper right corner of the image table dialog.

8-1-2 Creating Image Data Using Image Editor
S Registering new image data

(1) Select [Image Editor] from the [Tools] menu.

The image table is displayed.

(2) Click the Button.

The New Image Entry dialog box is displayed.

(3) Set the code, size, colors, compression, comment of the image data to be
newly created, then click the Button.
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S Setting for New Image Entry dialog box

Code: Specify the code to which the new image data is regis-
tered.
When the dialog box is opened, the smallest unused code
is set.

Colors: Specify whether the image data is created in “2 Colors”
(monochrome) or “8 Colors” (color).

Search Direction: Unregistered code can be searched using the

Button. In the Search Direction, specify Up (to the smaller
code) or Down (to the larger code) to designate the direc-
tion to which search operation is executed.

Width: Specify the width of the image data as a number of dots.

Height: Specify the height of the image data as a number of dots.
The image data size can be set in the range from 8 x 8 dots
(minimum) to the screen size of the PT to be used (maxi-
mum). The image data width and height must be specified
in units of 8 dots.

Compression: Specify the data format for storing the created image data.
Check mark set: Image data is compressed for storage.
Check mark not set: Image data is stored without being
compressed.

Comments: Specify the comment for the image data to be created.

: Searches the unused code. Specify the search direction in

the Search Direction.

Displaying image editor

(1) [Tools] (menu bar)→ [Image Editor]

The image table is displayed.

(2) Select the code in the image table and click the Button or

double-click the mouse on the objective code line.
When two or more codes are selected, edit screens (editors) of all the se-
lected codes can be opened collectively. Image table dialog automatically
closes at the same time the editor is displayed.
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S Changing the property

To change the property of the code that is already registered, open the editor
and then display the property dialog of the image data as follows:

Double click with tool,
or Right click→ [Properties]

Double click,
or Right click→ [Properties]

[Code]: Displays the code of the selected image data.

[Size]: Displays the size of the specified image data.
To change the size, set the desired size.

[Mode]: Displays the specified color mode.
To change the color mode, set the desired color mode.

[Compression]: Specify the data format for storing the created image data.

Check mark set: Image data is compressed for storage.

Check mark not set: Image data is stored without being
compressed.

Although the data size of the created image data will be
reduced if the data is compressed, the speed of display on the
screen will be slowed a little.

[Comments]: Specify the comment for the image data to be created.

Screen Configuration of Image Editor

The screen configuration of the image editor is described below.

Tool box

Font selection

Line width selection

Point type selection

Pattern selection

Color selection

Tool selection

Edit area

Operating the image editor

Using the imageeditor, youcancreateagraphic in thedesired shape in theedit
areaas combinationsof lines, points, rectangles, and circlesafter selecting the
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tool and drawing conditions (color, tiling pattern, point type, line width, and
font).

S Tool selection

Used to specify the range to copy, cut, move, shrink or expand the
created graphic.

The range is specified by dragging the mouse cursor.
To cancel the range specifying frame, select the tools other than ,

.

Range specifying frame

Used to move the graphic that is defined by the range specifying frame.

The range specifying frame can be dragged, or a pop-up menu can be
displayed by right clicking the mouse.

Used to draw a point.

Click the mouse at the position where a point is to be drawn: a point is
drawn in the size specified by point type selection and in the color speci-
fied as foreground color.

Used to draw a line.

By dragging themouse cursor from the start point to the end point of the
line to be drawn, the desired line is drawn in the width specified by line
width selection and in the specified foreground color.

Used to draw a rectangle.

By dragging the mouse cursor, a rectangle is drawn having opposing
corners at the start and the end point of dragging, having the line of the
specifiedwidth (linewidth selection) and in the specified foreground col-
or. The inside of the rectangle is tiled with the colors specified as fore-
ground color and background color in the specified pattern.

Used to draw a circle or an oval.

By dragging one corner or one side of a rectangle that circumscribes the
circle or oval to be drawn, the desired circle or oval is drawnwith a line of
the specified width (line width selection) and in the specified foreground
color. The inside of the circle or oval is tiled with the colors specified as
foreground color and background color in the specified pattern.

Used to draw a character.

Click themouse at the positionwhere a character is to be drawn and the
character cursor is displayed. Input characters: the input characters are
displayed in the color specified as foreground color with the background
displayed in the specified background color.

Select this toolwhen tiling the insideof the closedareaof a drawngraph-
ic.

The area is tiled according to the specified pattern and in the colors spe-
cified as foreground color and background color.
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S Color selection

Displays background color Color selection palette

Displays foreground color

On thecolor selectionpalette,move thecursor to thedesiredcolor andclick the
mouse; a left click selects the foreground color and a right click selects the
background color.

S Pattern selection

Selection box

Move the cursor to the desired pattern and left click the mouse; the selection
box moves to the pattern at the cursor location, indicating that the pattern is
selected.

S Point type selection

Selection box

Move the cursor to the desired point type and left click themouse; the selection
boxmoves to the point type at the cursor location, indicating that the point type
is selected.

S Line width selection

Selection box

Move the cursor to the desired line width type and left click themouse; the line
width type display at the cursor location will be highlighted, indicating that the
line width type is selected.

S Font designation

Displays sample characters

Click the Button and the font selection dialog box is displayed.

After selecting the font, the style, and the size, click the Button.
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S Modifying the size of an image data

Specify the range to bemodified using the Button and drag one of greenJ
marks (handles) that enclose the range specifying frame.
Position the mouse cursor on a green handle, and the shape of mouse cursor
changesasshownbelow. (Thearrow indicates thesamedirectionas thearrow
mark in the handle.)

Drag the mouse cursor in the indicated direction to modify the size of an image
data.

Reference: To shrink the size of an image data, shrink it by one dragging operation without
releasing the button of the mouse. If you try to expand the image data that was
shrunk once, the shape or the color may be modified.

Zooming the edit area

It is possible to display the edit area at an enlarged size to facilitate drawing fine
areas and creating small images.

To change the display size of the edit area, select [View] in the menu bar then
choose [Zoom]; specify the zoom percentage.

Modifying Graphics

Created graphics can be mirrored (flipped) up and down or right and left, or
turned 90° left or right.

The mirroring and 90° turn operations are possible for the graphic in the range
specifying frame.
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Tomodify thegraphic, select [Edit] (menubar)→ [Rotate or Flip], then specify the
desired modification method.

Flip Horizontal Flip Vertical Rotate Left Rotate Right

Cutting/copying/deleting graphics

You can cut, copy, paste, and delete the created graphic.

Cut, copy and delete operations are valid for the graphic in the range specifying
frame.

To call the desired operation, select [Edit] in the menu bar, then specify [Cut],
[Copy], [Paste], or [Delete]. (or right click the mouse, then specify [Cut], [Copy],
or [Paste])

Cuts the graphic in the range specifying
frame and stores it in the clip board.

Copies the graphic in the range specifying
frame onto the clip board.

Pastes the graphic in the clip board to the
specified position.
Deletes the graphic in the range specifying
frame.

Reference: Image data that is cut or copied on one image editor window can be pasted onto
the other image editor window (The data can be pasted until another data is
stored to the clipboard).
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When more than one image editor window is displayed or when two Support
Tools are opened by [Import Component] from the [File] menu (same PT model
setting), cut, copy and paste operations between these image editor windows
are possible. For details, refer to 3-3-6 Importing Components from Different
Screen Data File (Starting Up the Second Support Tool).

Saving to the bit map file

You can save the created graphic to the file in bit map format.
This operation is valid for the graphics in the range specifying frame.

To save the graphic to the bit map file, follow the procedure below.

(1) Specify the area to be saved in a file with a range specifying frame.

(2) Select [Copy To] from the [Edit] menu.
The dialog box to specify the file name is displayed.

(3) Set the folder and file name and click the Button.

Graphics in the range specifying frame is saved in a file.

Pasting from the bit map file

You can read out the graphics saved in a bit map file and paste them onto the
image editor.
The graphics can be pasted onto the image editor that is currently activated.

To paste the graphic from the bit map file, follow the procedure below.

(1) Select [Paste From] from the [Edit] menu.
The dialog box to specify the file to be read is displayed.

(2) Specify the folder and file name and click the Button.

Read out graphic is pasted onto the image editor enclosed with a range
specifying frame.

(3) Select [Clip] from the [Edit] menu.
Image data size is changed to the read out image size.

Instead of the procedure (3), it is also possible to drag the read out image to the
required position.
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Changing the image data size

The image data size can be changed in either of the following two ways.

S Changing the size by property setting

S Changing the size to the range specifying frame size

S Changing the size by property setting

Change thesetting for [Size] in the imageeditor property settings to change the
size of the image data.

The image data size is changed according to the new setting; the reference
point of the size change is at the upper left corner of the present size.

If the size is reduced, part of the created graphic may be cut.

S Changing the size to the range specifying frame size

The size of the image data can be changed to fit the size of the specified range
specifying frame.

Select [Edit] in the menu bar, then select [Clip].

Quitting the image editor

You can quit the image editor in any of the three ways described below.

S Clicking the Button at the upper right corner of the image editor.

S Selecting [Close] from the control menu box of the image editor.

S Double clicking the control menu box of the image editor.

Control menu box
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8-2 Library Editor
Graphics of any required shape can be created by combining fixed elements.
The created graphic can be registered as one element (library data) and any
number of elements can be displayed at any positions in any screen using the
library display function.

Created library data canbeused for image/library lampdisplay, alarm list display,
alarm history display.

Reference: Library editor has the following features.
S You can draw any graphics by combining fixed elements.
S It is possible to import library data from the different screen data file.
S Fixed display elements can be copied, cut, pasted from the editing screen
S Copy, cut, paste operation of library data is possible.
S Preview display of selected library data is available on the library table.

8-2-1 Operating the Library Table
Library table dialog is configured as follows:

[Edit] Deletes, cuts, copies or pastes the library data of the selected. . . . . . . .
code (refer to pages 335 to 336). It is possible to select two or
more codes and delete them collectively.

[Goto Code] Code number can be specified and the cursor moves to the.
code. The operation method is same as the “Goto Entry” of
memory table (refer to7-1-6TableDisplayOperationbySpec-
ifying the Table Entry Number).

[Preview] Switches the preview window ON and OFF (refer to page. . . .
335).

[Open] Displays the editing screen (library editor) of the selected. . . . . .
code (P343). When two or more codes are selected, edit
screens of all the selected codes can be opened collectively.

[New] Registers the new library code to the library table (refer to. . . . . . .
page 337).
Only the registered library codes are listed on the library table.
Press this button when you are going to create new library
data.

[Delete] Deletes the library data of the selected code. When two or. . . . .
more codes are selected, they can be deleted collectively.

[Close] Closes the library table dialog.. . . . . .
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[Help] Displays Help about the library table dialog box.. . . . . . .

S Specifying a code

To specify a code for operations, click on the objective line (library code).
To specify the continuous codes collectively, click on the first code to be se-
lected and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or
deselected alternately each time it is clicked.

S Preview Function

Support Tool provides a preview function that can display the contents of the se-
lected code.
When two or more codes are selected, the preview of the code selected last will
be displayed in preview window.
The preview window can be switched ON and OFF using the /

Buttons.

S Deleting the library data

To delete a library data, follow the procedure below. Deleted library data will not
be stored to the clipboard and its code itself will be also deleted. When two or
more codes are selected, they will be deleted collectively.

(1) Select [Library Editor] from the [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be deleted.
When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
S button→ [Delete]
S Right click on the selected code→ [Delete]
S button
Selected code will be deleted after you click the Button in the con-
firmation dialog box.

S Cutting/copying the library data

To cut or copy a library data, follow the procedure below. The cut/copied library
data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut,” cut code will be deleted from the library table. In case of “copy,”
copied code remains in the library table.
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Reference: When two Support Tools are started up by [Import Component] from the [File]
menu, the data that is cut or copied on the library table of oneSupport Tool canbe
pasted onto the library table of another Support Tool (PTmodel setting of the two
screen data files should be the same). For details, refer to 3-3-6 Importing Com-
ponents from Different Screen Data File (Starting Up the Second Support Tool).

(1) Select [Library Editor] from the [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be cut or copied.
Select only one code. When two or more codes are selected, cut/copy op-
eration can not be performed.

(3) Click the Button or right-click on the selected code.

(4) Select [Cut] or [Copy].
Library data of the selected code will be stored to the clipboard. In case of
[cut], confirmationdialogboxwill be displayed.After clickingon but-
ton, cut code will be deleted from the library table.

S Pasting the library data

To paste a library data that is stored in the clipboard by cut or copy operation,
follow the procedure below.

Reference: S When two Support Tools are started up by [Import Component] from the [File]
menu, the data that is cut or copied on the library table of one Support Tool can
bepastedonto the library tableof anotherSupport Tool (PTmodel settingof the
two screen data files should be the same). For details, refer to 3-3-6 Importing
Components fromDifferent ScreenData File (Starting Up the SecondSupport
Tool).

S If the paste operation is performed, the library data previously registered to the
code is overwritten and lost. (Confirmation dialog box will be displayed.)

S When a library data is pasted, the property (size, colors, compression, com-
ment) of the library code is changed to that of the new one.

(1) Select [Library Editor] from the [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be pasted.
Select only one code. When two or more codes are selected, paste opera-
tion can not be performed.

(3) Click the Button or right-click on the selected code.

(4) Select [Paste].
[Paste] can not be selected if the library data to be pasted is not stored in the
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clipboard. After clicking the Button in confirmation dialog box, li-
brary data will be pasted to the selected code.

S Quitting the library table

You can quit the library table in any of the two ways described below.
S Clicking the Button of the library table dialog.

S Clicking the Button at the upper right corner of the library table dialog.

8-2-2 Creating Library Data Using Library Editor
S Registering new library data

(1) Select [Library Editor] from the [Tools] menu.
The library table is displayed.

(2) Click the Button.

The New Library Entry dialog box is displayed.

(3) Set the code, size, colors, compression, comment of the library data to be
newly created, then click the Button.

S Setting for New Library Entry dialog box

Code: Specify the code to which the new library data is regis-
tered.
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When the dialog box is opened, the smallest unused code
is set.

Search Direction: Unregistered code can be searched using the

Button. In the Search Direction, specify Up (to the smaller
code) or Down (to the larger code) to designate the direc-
tion to which search operation is executed.

Comments: Specify the comment for the library data to be created.

Find Next: Searches the unused code. Specify the search direction in
the Search Direction.

Displaying library editor

(1) [Tools] (menu bar)→ [Library Editor]
The library table is displayed.

(2) Select the code in the library table and click the Button or

double-click the mouse on the objective code line.
When two or more codes are selected, edit screens (editors) of all the se-
lected codes can be opened collectively. The library table dialog automati-
cally closes at the same time the editor is displayed.

S Changing the property

To change the property of the code that is already registered, open the editor and
then display the property dialog of the library data as follows:

Double click, or
Right click→ [Properties]

[Code]: Displays the code of the selected library data.

[Size]: Displays the size of the specified library data.
Size data is not displayed if there are no elements in the library
data specifying frame.

[Comments]: Specify the comment for the library data to be created.
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Screen Configuration of Library Editor

The screen configuration of the library editor is described below.

Edit area

Library data specifying frame

Operating the library editor

Using the library editor, you can create a graphic using fixed elements in the
same manner as creating graphics in a standard screen. The size of the library
data specifying frame is taken as the size of the library data. The position and
size of the library data specifying frame can be changed as needed.

Only the graphic in the range of the library data specifying frame is registered as
the library data.

For details on how to use fixed elements, refer to 6-2 Fixed Display.

Reference: Library data that is cut or copied on the library editor window can be pasted onto
the other library editor window or standard editing screen (The data can be
pasted until another data is stored to the clipboard). Also, fixed-display elements
that were cut or copied from standard editing screens can be pasted onto the li-
brary editor window.
When more than one library editor window is displayed or when two Support
Tools are opened by [Import Component] from the [File] menu (same PT model
setting), cut, copy and paste operations between these library editor windows
are possible. For details, refer to 3-3-6 Importing Components from Different
Screen Data File (Starting Up the Second Support Tool).

Library data Display of library data

A circle extending outside
the specifying frame is not
displayed as library data.

Changing the size and display position of the library data specifying frame

To change the size of the library data specifying frameormove it, follow the steps
described below.



8-2SectionLibrary Editor

340

(1) Click the mouse on the dotted lines of the library data specifying frame.

Green J (handles) are displayed enclosing the library data specifying
frame.

(2) The size can be changed by dragging a handle.

Position themousecursor onagreenhandle: the shapeof themousecursor
changes as shown below. Drag the mouse cursor in the indicated direction
to change the size of the library data specifying frame.

Up-down handleRight-left handle Apex handle

(3) The library data specifying frame can be moved by dragging the frame at
positions other than handles.

Whenhandles are displayed, position themouse cursor on the dotted line at
a position where there is no handle: the shape of mouse cursor changes as
shown below. Drag the mouse. The frame moves as it is dragged.

(4) After changing the size and the position of the library data specifying frame,
click on the screen at a position other than on the frame.

The size and the position of the library data specifying frame is determined
and the handles are cleared.

To change the size and the position of the library data specifying frame, re-
peat the procedure above from step (1).

Setting grids

To set a grid on the library editor screen, select [Screen] (menu bar) and [Grid].

The necessary settings for displaying grids are same as those for a standard
screen. For details, refer to 5-1-2 Grid Setting.

Quitting the library editor

You can quit the library editor in any of the three ways described below.

S Clicking the Button at the upper right area of the library editor.

S Selecting [Close] from the control menu box of the library editor.
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S Double clicking the control menu box of the library editor.

Control menu box
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8-3 Mark Editor
Special symbols andmarks canbe created by tiling selecteddots in a 16×16dot
area. (For NT11S it is 8×16 dot.)

The created mark data can be inserted into mark data displays and character
string displays.

Reference: The NT-series Support Tool cannot handle marks of 32×32 dots and 64×64
dots. If marks created by the DOS version Support Tool are imported, 32×32 or
64×64 dot size marks must be represented by dividing and grouping them as
16×16 dot size mark data.

8-3-1 Screen Configuration
The screen configuration of the mark editor is shown below.

Drawing toolbar

Standard toolbar Image display area

Edit area

8-3-2 Creating Marks Using the Mark Editor
Displaying the mark editor

(1) [Tools] (menu bar)→ [Mark Editor]

The mark data list dialog box is displayed.

In the mark data list dialog box, the mark data registered for the codes are
displayed.

(2) Select the code in the mark data list dialog box and click on , or
double click the area corresponding to the code in the list.
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Acodecanbeselectedeither from thedisplayed list or by specification in the
[Code] field. If a code is selected in the list, the specified part is displayed
enlarged.

Operating the mark editor

Using the mark editor, you can create a mark by tiling dots arranged in a matrix.

To tile a dot, position the cursor on it and left click themouse. To cancel tiling, right
click the mouse on a tiled dot.

Created graphics can be copied or pasted using the standard toolbar, and lines,
rectangles, and circles can be easily created using the drawing toolbar.

Reference: When two Support Tools are started up by [Import Component] from the [File]
menu, the data that is cut or copied on themark editor of oneSupport Tool can be
pasted onto themark editor of another Support Tool (PTmodel setting of the two
screen data files should be the same). For details, refer to 3-3-6 Importing Com-
ponents from Different Screen Data File (Starting Up the Second Support Tool).

* Standard toolbar

Open (mark data list dialog box is opened)

Redo (operation canceled by undo is executed again)

Undo (previous operation is canceled)

Paste (data that has been copied or cut is pasted)

Copy (graphic in the specified range is copied)

Cut (graphic in the specified range is cut)

Register (mark data is registered)

* Drawing toolbar

S Toolbar

Used to move the graphic defined by the range specifying frame By
positioning the cursor on graphic defined by the range specifying
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frame after positioning the cursor on it and dragging, the graphic is
moved.

Used to specify the range of a created graphic to copy, cut, or move.
By dragging the cursor from one corner to the diagonally opposing
corner, the range specifying rectangle frame is defined.
To cancel the range specifying frame, select the tools other than

, .

Range specifying frame

Used to tile dots.
After placing the cursor on a dot to be tiled, left click the mouse.
To cancel tiling, place the cursor on a tiled dot and right click the
mouse.

Used to draw a line.
By dragging the mouse cursor from the start point to the end point,
dots arranged on a line are tiled.

Used to draw a rectangular frame.
By dragging the mouse cursor, the dots on a rectangle that has its
diagonally opposing corners at the start and the end point of the drag-
ging route are tiled.

Used to draw a circular or oval frame
By dragging the mouse cursor between two diagonally opposing
corners of a rectangle that circumscribes the desired circle or oval
frame, the dots on the circle or oval are tiled.

Used to draw a tiled rectangle
By dragging themouse cursor, the dots inside a rectangle that has its
diagonally opposing corners at the start and end point of the dragging
route are tiled.

Used to draw a tiled circle or oval
By dragging themouse cursor between two diagonally opposing cor-
ners of a rectangle that circumscribes thedesired circle or oval frame,
the dots inside the circle or oval are tiled.

Used to move the entire drawn graphic.
Drag the edit area and the graphic drawing position moves.
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Used to turn the entire drawn graphic through 90°.
Left clicking on the edit area turns the graphic clockwise and right
clicking turns the graphic counterclockwise.

Right click

Left click

Referring to graphics

The mark editor allows you to refer to or reuse the existing graphics or sample
characters to draw desired new marks.

Click on button and the reference graphic display area is displayed.

Reference graphic
display area

To close the reference graphic display area, click on button again.

S Referring to the existing mark data

To display the existingmark data as reference for creating a newmark, click on
above the reference graphic display area. The mark data list dialog box is

displayed.
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Select the data you want to use as the reference in the mark data list dialog box
and click on , or double click themouse on the desired reference data.

Referring to characters

The mark editor allows you to use the existing characters as the reference for
creating characters. Click on above the reference graphic display area, and

the reference character setting dialog box is displayed.

Input the characters you want to use as the reference and click on .

For the reference characters, two characters (8 dot size) can be input.

To change the font and/or size of the characters used as the reference, click on
. The character setting dialog box is displayed.

(Presently, the Color setting is not
supported. It will be invalid even
if it was specified.)
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Copying the reference graphics

To reuse the existing graphic displayed in the reference graphic display area,
specify the range to be copied and click on above the reference graphic dis-

play area. After copying the graphic, click on above the edit area.

Paste button Copy button

Specifying
the copy range

Quitting the mark editor

To quit the mark editor, click on the button of the mark editor.

If you click on , the created mark data is discarded before you quit the
mark editor.

[OK] button
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Deleting mark data

To delete the mark data, specify the mark data to be deleted in the mark data list
dialog box and click on .

Reset button
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SECTION 9
Example Screens

This section is intended to familiarize you with the operation of the Support Tool through actual operation.

The operational procedures for creating example screens are explained step by step.

Please follow the steps shown in this section and create example screens in order to understand the functions and the features
of the Support Tool.

Please do not forget to save the screen data frequently. (Refer to 3-3-3 Saving the Screen Data (Application) File.)

The sample screen data to be created in this section is supplied by the CD-ROM version Support Tool.
Use this data to check the setting status etc.
(This data is provided just as a sample screendata. It is not created for the purposeof actual operation onPTafter downloading
it to PT.)

9-1 Example Screen Configuration 350. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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9-1 Example Screen Configuration
The configuration and screen transfer of the example screens you are going to
create are described below.

9-1-1 Screen Configuration

Monitor
button

Menu Screen (Screen No. 1)

Monitor Screen (Screen No. 2) Set Screen (Screen No. 3)

Alarm Screen
(Screen No. 4)

Menu
button

Menu
button

Menu
button

Monitor
button

Set
button

Set
Screen
button

Monitor
Screen
button

Alarm
button

Alarm
Screen
button

Alarm
button

PT power ON

Set
button

Create the Monitor Screen as overlapping screens comprising screen No. 10
and screen No. 11.

Parent screen (screen No. 2) Child screen (screen No. 10) Child screen (screen No. 11)
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9-1-2 Screen Transfer among Example Screens
How the displayed screen switches according to the button operation is shown
below.

Menu Screen

S Monitor Screen button

Switches the screen to the Monitor Screen (screen No. 2).

S Set Screen button

Switches the screen to the Set Screen (screen No. 3).

S Alarm Screen button

Switches the screen to the Alarm Screen (screen No. 4).

Monitor Screen

S Numeral Display 1

Displays the value of DM0000 in the PC (PLC).

S Numeral Display 2

Displays the value of 32-bit data, the sum of DM0001 and DM0002 in the PC
(PLC).

S Trend graph

Displays the value of DM0003 and DM0004 in the PC (PLC) in the form of a
trend graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0003 –800 0 800

DM0004 0 600 1200

S Lamp1 to Lamp 5

Displays the ON/OFF state of L000000 to L000004 in the PC (PLC).
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When L000000 is ON (OFF), Lamp 1 goes ON (OFF).

When L000001 is ON (OFF), Lamp 2 goes ON (OFF).

When L000002 is ON (OFF), Lamp 3 goes ON (OFF).

When L000003 is ON (OFF), Lamp 4 goes ON (OFF).

When L000004 is ON (OFF), Lamp 5 goes ON (OFF).

S Image Lamp

Displays the ON/OFF state of L000005 in the PC (PLC).

Display when L000005 is ON.

Display when L000005 is OFF.

S Bar Graph 1

Displays the value of DM0005 in the PC (PLC) in the form of a bar graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0005 –500 0 500

S Bar Graph 2

Displays the value of DM0006 in the PC (PLC) in the form of a bar graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0006 –300 0 300

S Menu

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen
No. 1).

S Set

This is a screen switching button.

When you touch this button, the screen switches to theSet Screen (screenNo.
3).

S Alarm

This is a screen switching button.

When you touch this button, the screen switches to the Alarm Screen (screen
No. 4).
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Set Screen

S Numeral Input 1

Used to set the data at two words, DM0010 and DM0011, in the PC (PLC).
Whenyou touch thenumeral displayarea, numeric keysaredisplayed (pop-up
window), allowing you to input the data.

S Numeral Input 2

Used to set the data at two words, DM0012 and DM0013, in the PC (PLC).
Whenyou touch thenumeral displayarea, numeric keysaredisplayed (pop-up
window), allowing you to input the data.

S Thumbwheel

Used to set the data at DM0014 in the PC (PLC).

S String Display, Auto./Man./Step/Reset

When you touch any of the [Auto.], [Man.], [Step], and [Reset] buttons, the fol-
lowing character string is displayed in the [String Display] filed.

[Auto.] button: Automatic

[Man.] button: Manual

[Step] button: Step

[Reset] button: Reset

S Start

This is a momentary type button.

When you touch this button, L000100 in the PC (PLC) goes ON.

If L000200 in the PC (PLC) goes ON, the button lights.

S Stop

This is a momentary type button.

When you touch this button, L000101 in the PC (PLC) goes ON.

If L000201 in the PC (PLC) goes ON, the button lights.

S Menu

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen
No. 1).

S Monitor

This a screen switching button.
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Whenyou touch this button, the screen switches to theMonitor Screen (screen
No. 2).

S Alarm

This is a screen switching button.

When you touch this button, the screen switches to the Alarm Screen (screen
No. 4).

Alarm Screen

S Alarm list and contents

Allocate 0002000 to 0002007 in the PC (PLC) as alarm bits.

If any of the allocated bits goes ON, the corresponding alarm message is dis-
played.

When you touch the alarm message, the corrective action and details of the
alarm are displayed in the alarm content display area.

Bits Alarm Message Alarm Content Display

0002000 Line 1 Error Set line 1.

0002001 Line 2 Error Set line 2.

0002002 A-spot Screw Error Check torque screw.

0002003 B-spot Screw Error Check torque screw.

0002004 Low Pressure Check pipe and valve.

0002005 Area 1 Alarm Detection near entry. Confirm safety
before restarting the line.

0002006 Area 2 Alarm Detection near entry. Confirm safety
before restarting the line.

0002007 PC (PLC) Network
Error

Check the PC (PLC) and the net-
work.

S Menu

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen
No. 1).

S Monitor

This is a screen switching button.

Whenyou touch this button, the screen switches to theMonitor Screen (screen
No. 2).
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S Set

This is a screen switching button.

When you touch this button, the screen switches to theSet Screen (screenNo.
3).

Required environment

The required hardware environment for the creation of the example screens is
shown below.

S PT model: NT620C/625C

S Image memory: 512 Kbytes

S Memory table capacity:
Numeral memory table 512 entries
Character string memory table (String table) 256 entries

9-2 Operation Flow
Create the example screens by following the steps shown below.

Start up the Support Tool

↓

[File] -- [New]

↓

Set PT configuration

↓

Set memory tables

↓

Creating the Menu Screen

Create new screen (screen No. 1)

↓

Set properties for screen No. 1

↓

Create screen title

↓

Create [Monitor Screen] button

↓

Create [Set Screen] button

↓

Create [Alarm Screen] button

↓
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Creating Monitor Screen

Create new screen (screen No. 10)

↓

Set properties for screen No. 10

↓

Create screen title

↓

Create numeral display field of [Numeral Display 1]

↓

Create numeral display field of [Numeral Display 2]

↓

Create [Trend graph]

↓

Create new screen (screen No. 11)

↓

Set properties for screen No. 11

↓

Create [Lamp 1] to [Lamp 5]

↓

Create image data for image lamp

↓

Create [Image Lamp]

↓

Create [Bar Graph 1]

↓

Create [Bar Graph 2]

↓

Create [Menu] button

↓

Create [Set] button

↓

Create [Alarm] button

↓

Create parent screen
(screen No. 10, 11 as child screens)

↓
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Creating the Set Screen

Create new screen (screen No. 3)

↓

Set properties for screen No. 3

↓

Create screen title

↓

Create numeral input field of [Numeral Input 1]

↓

Create numeral input field of [Numeral Input 2]

↓

Create [Thumbwheel]

↓

Create [Start] and [Stop] buttons

↓

Create [String Display] display field

↓

Create [Auto] button

↓

Create [Man.] button

↓

Create [Step] button

↓

Create [Reset] button

↓

Create [Menu] button

↓

Create [Monitor] button

↓

Create [Alarm] button
↓
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Creating the Alarm Screen

Create new screen (screen No. 4)

↓

Set properties for screen No. 4

↓

Create screen title

↓

Create alarm list

↓

Create [Menu] button

↓

Create [Set] button

↓

Create [Monitor] button

↓

Create alarm library data

↓

Create numeric keys for pop-up window display

↓

Save the created data

↓

Download the created data

9-3 Creating the Sample Data
This section describes the operational procedure and data creation procedure
step by step according to the operation flow shown in 9-2 Operation Flow.

Reference: The explanation in this section assumes that the default value of each object’s
property is not changed since installation.

9-3-1 Starting up the Support Tool
At the start-up screen ofWindows, double click the Support Tool icon to start the
Support Tool. (Refer to 3-1 Starting-up and Exiting the Support Tool.)

9-3-2 File -- New
Select [File] in the main menu, then select [New] to create a new file.
(Refer to 3-3-1 Creating New Screen Data (Application) File.)

9-3-3 Setting the PT Configuration
At the PT configuration setting dialog box, set the items as shown below.
(Refer to 3-3-1 Creating New Screen Data (Application) File.)
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PT Type PT Model NT620C/625C

PLC Vendor OMRON

Font Type CP437

Comments SAMPLE DATA

System Initial Screen 1

Backlight OFF Check mark set,
60 min

Resume function Check mark not
set

Number of
Table Entries

Numeral Table 512
Table Entries String Table 256

Bit Memory Table 256

Printer for PT Printer ESC/P

Mode Color

History Setting Alarm (Use Ring Buffer) Check mark set

Buzzer Enable Check mark set,
On Error

Key Input Check mark not
set

After setting the PT configuration items as indicated above, click on .

9-3-4 Setting Memory Tables
Set the memory tables (numeral memory table, character string memory table
(string table), and bit memory table). (Refer to Section 7Memory Table Setting.)

Opening a table

(1) Select [Tools] (menu bar)→ [Table].

Setting numeral memory table

(1) Make the numeral memory table settings as shown below.

No. Value Initial Words PC (PLC)
Address

I/O
Comments Ref

0 0 n 1 D00000 Mtr: Num.disp.1 ––

1 0 n 2 D00001 Mtr: Num.disp.2 ––

2 0 n 1 D00003 Mtr: Trd.graph 1 ––

3 0 n 1 D00004 Mtr: Trd.graph 2 ––

4 0 n 1 D00005 Mtr: Bar graph 1 ––

5 0 n 1 D00006 Mtr: Bar graph 2 ––

––

10 0 n 2 D00010 Set: Num.input 1 ––

11 0 n 2 D00012 Set: Num.input 2 ––

12 0 n 1 D00014 Set: Thumbwheel ––

Setting character string memory table

(1) Click on [String].
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(2) Make the character string memory table settings as shown below.

No. Value Initial Words PC (PLC)
Address

I/O
Comments

Ref

0 0 –– ––

10 Automatic n 0 –– ––

11 Manual n 0 –– ––

12 Step n 0 –– ––

13 Reset n 0 –– ––

––

20 Line 1 Error n 20 D00150 Alarm data 1 ––

21 Line 2 Error n 20 D00170 Alarm data 2 ––

22 A-spot Screw Error n 20 D00190 Alarm data 3 ––

23 B-spot Screw Error n 20 D00210 Alarm data 4 ––

24 Low Pressure n 20 D00230 Alarm data 5 ––

25 Area 1 Alarm n 20 D00250 Alarm data 6 ––

26 Area 2 Alarm n 20 D00270 Alarm data 7 ––

27 PC (PLC) Network Error n 20 D00290 Alarm data 8 ––

Setting bit memory table

(1) Click on [Bit Memory].

(2) Make the bit memory table settings as shown below.

Click the Button to set the following items.

S Function

S History

S Switch Screen

S String Table Entry

S Image/Library Code

S Color

Click the Button to set the following items.

(Direct input on a bit memory table is also possible.)

S PLC Address

S I/O Comments
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No. Function Switch
Screen History

String
Table
Entry

Image/
Library
Code*1

Color PC
Address

I/O
Comments

0 Alarm/Switch
Screen

20 FA20 White 0002000 Alarm 1

1 Alarm/Switch
Screen

21 FA21 White 0002001 Alarm 2

2 Alarm/Switch
Screen

22 FA22 White 0002002 Alarm 3

3 Alarm/Switch
Screen

23 FA22 White 0002003 Alarm 4

4 Alarm/Switch
Screen

24 FA23 White 0002004 Alarm 5

5 Alarm/Switch
Screen

25 FA24 White 0002005 Alarm 6

6 Alarm/Switch
Screen

26 FA24 White 0002006 Alarm 7

7 Alarm/Switch
Screen

27 FA25 White 0002007 Alarm 8

*1: WithNT31,NT31C,NT631, NT631C, set theAlarm for function and unmark
the check box for “Switch Screen.”

9-3-5 Creating the Menu Screen
Create the Menu Screen.

Display the data creationwindow for screenNo. 1,which is displayedat the start-
up of the Support Tool, at the front.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 1. (Refer to 5-1-1
Setting the Screen Attributes.)

Attributes Screen No. 1

History n

Title Menu Screen

Comment Menu Screen

Buzzer n, Short

Load Local 1 (Keyboard)

System Keypad

Color Background Black
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Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid n

Snap to Grid n

Creating the screen title (Menu Screen)

S Setting the characters

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text] (Refer to 6-2-7
Text.)

(2) Click the mouse with the mouse cursor set at the position where the
screen title is to be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

Description Menu Screen

Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent

(4) Adjust the position of the “Menu Screen” on the data creation screen by
dragging it.

S Surrounding the title with a frame

(5) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle]. (Refer to
6-2-3 Rectangle.)

(6) On the data creation screen, drag the rectangle so that it encloses the
“Menu Screen” character string.

(7) Use the properties as they are.

(8) Adjust the size and the position of the frame (rectangle).

Creating the [Monitor Screen] button
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S Setting the touch switch outline

(1) Select [Objects] (menu bar) → [Touch Switch]. (Refer to 6-8 Touch
Switches.)

(2) Create the outline of the [Monitor Screen] button by dragging the mouse
on the data creation screen.

(3) Set the properties as shown below.

General Position ––

Size ––

Frame n

Shape 3-Dimension

Show ON State ––

Color Frame White

ON White

OFF Transparent

Settings Function Switch Screen

Screen No. 2

Light
Function

Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute Light

Label*1 Label n

Description Monitor Screen
(Refer to the fol-
lowing)*2

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, multiple lines of label, On Off static label, numeral/
string display label can also be set.

*2: Click the Button to set the label.
After completing the setting, go to the next step by clicking the

Button.

*3: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, it is possible to set an interlock bit that can enable/dis-
able the operations.

S Setting the touch switch label

(4) Press in the general property of a touch switch and set the la-
bel properties as shown below.

Description Monitor Screen

Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent
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Click on , (return to touch switch property) then click on

again.

S Adjusting the size and position of the touch switch

(5) Adjust the size and position of the frame of [Monitor Screen] button.

(6) Specify the [Monitor Screen] button.

(7) Select [Centralize Label] from [Draw] menu.
The label is centralized.

Creating the [Set Screen] button

S Copying and pasting the [Monitor Screen] button

(1) Specify the [Monitor Screen] button.

(2) Select [Edit] (menu bar)→ [Copy]. (Refer to 6-1-5Copying, Cutting, Past-
ing, and Deleting Elements.)

(3) Select [Edit] (menubar)→ [Paste]. (Refer to 6-1-5Copying,Cutting, Past-
ing, and Deleting Elements.)

(4) Drag the [Monitor Screen] button, displayed at the upper left area in the
data creation screen, to the position where you want to create the [Set
Screen] button.

S Modifying to the [Set Screen] button

(5) Double click themoved button andmodify the properties as shown below.
Note that other properties must be left unchanged.

Attribute Label n

Description Set Screen*1

Settings Screen No. 3

*1: Press to set the label.

Creating the [Alarm Screen] button

S Copying and pasting the [Monitor Screen] button

(1) Specify the [Monitor Screen] button.

(2) Select [Edit] (menu bar)→ [Copy].

(3) Select [Edit] (menu bar)→ [Paste].

(4) Drag the [Monitor Screen] button, displayed at the upper left area in the
data creation screen, to the position where you want to create the [Alarm
Screen] button.

S Modifying to the [Alarm Screen] button

(5) Double click themoved button andmodify the properties as shown below.
Note that other properties must be left unchanged.
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General Label n

Description Alarm Screen*1

Settings Screen No. 4

*1: Press to set the label.

9-3-6 Creating the Monitor Screen (Child Screen 1)
Themonitor screen consists of overlapping screens with screen Nos. 10 and 11
as its childscreens.Whencreatingoverlappingscreens, create thechildscreens
first. Here, create screen No. 10 as child screen 1.

(1) Select [Screen] (menu bar) → [New]. (Refer to 4-2-3 Creating a New
Screen.)

(2) At the screen selection dialog box, set “Standard Screen.”

(3) At the new standard screen dialog box, set 10 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 10.

Attributes Screen No. 10

History n

Title Monitor Screen-1

Comment Monitor Screen-1

Buzzer

Load Local 1 (Keyboard)

System Keypad

Color Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid n

Snap to Grid n

Creating the screen title ([Monitor Screen])
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S Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” character string and its frame (rectangle) on
screen No. 1 and paste them to screen No. 10.

(2) Adjust the display position of the pasted character string and frame to the
desired position.

S Modifying to [Monitor Screen]

(3) Double click the “MenuScreen” character string andmodify theproperties
as shown below. Note that other properties must be left unchanged.
If selection of the “Menu Screen” character string is not easy, select [Edit]
(menu bar)→ [Select Object], then click on the fixed display text.

Description Monitor Screen

(4) Adjust the size of the frame (rectangle).

Creating the data display field ([Numeral Display 1])

S Setting the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click the mouse with the mouse cursor set at the position where the nu-
meral display field title is to be displayed (at the intended upper left corner
of text).

(3) Set the properties as shown below.

Description Numeral Display 1

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent

(4) Adjust the position of “Numeral Display 1” on the data creation screen by
dragging it.

S Creating the numeral display field

(5) Select [Objects] (menu bar)→ [Numeral Display]. (Refer to 6-6 Numeral
Display.)
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(6) Click the mouse with the mouse cursor set at the position where the nu-
meral display field is to be displayed (at the intended upper left corner of
numeral display).

(7) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground White

Background Black

Settings Reference Indirect
Reference

Table Entry 0

Display Type Decimal

Format Integer 4

Decimal 0

Zero Suppression n

Display Sign n

(8) Adjust the position of the numeral display field by dragging it.

S Surrounding the numeral display field with a frame

(9) Select [Objects] (menu bar)→ [Fixed Display]→ [Rectangle].

(10) On the data creation screen, drag the rectangle so that it encloses the nu-
meral display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).

Creating the numeral display field ([Numeral Display 2])

S Copying and pasting the numeral display field ([Numeral Display 1])

(1) Copy the “Numeral Display 1” character string, numeral display field, and
its frame (rectangle).

(2) Paste the copied contents andmove them to the desired position (for dis-
playing [Numeral Display 2]).

S Modifying to [Numeral Display 2]

(3) Double click the “NumeralDisplay 1” character string andmodify theprop-
erties as shown below.Note that other propertiesmust be left unchanged.
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Description Numeral Display 2

S Modifying the numeral display field

(4) Double click the numeral display field ([ 0] displayed) and modify the
properties as shown below. Note that other properties must be left un-
changed.

Settings Reference Indirect
Reference

Table Entry 1

Format Integer 8

Decimal 0

(5) Drag the numeral display field ([ 0]) to the desired display position.

S Modifying the frame

(6) Specify the copied frame (rectangle) and adjust the size and the position.

Creating the trend graph

S Setting the graph

(1) Select [Objects] (menu bar)→ [Graph]→ [Trend Graph]. (Refer to 6-9-4
Trend Graph.)

(2) At the trend graph display position, drag the mouse to set the trend graph
display area as desired.

(3) Set the general properties as shown below.
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General Position ––

Size ––

Display Type Standard

Drawing Width 3

Frame n

Display Sign n

Direction Right

Sampling Cycle 1 *1

Color Frame White

+ Range Black

– Range Black

*1: For NT31, NT31C, NT631, NT631C, sampling cycle of trend graphmust be
multiple of 5 (minimum 5).

S Setting the graph line

(4) Double click the [Settings] tab and click on .

Set the line 1 properties as shown below.

Line Value Table Entry 2

Display % n

Line Color Cyan

Style Solid ( )

100% Table Entry

Value n, 800

0% Table Entry

Value n, 0

–100% Table Entry

Value n, –800

(5) Click on to close the line 1 properties.

(6) Click on to add line 2.

Set the line 2 properties as shown below.

Line Value Table Entry 3

Display % n

Line Color White

Style Dot-dash ( )

100% Table Entry

Value n, 1200

0% Table Entry

Value n, 600

–100% Table Entry

Value n, 0
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Click on , (returns to setting property) then click on again.

S Adjusting the size and position of the frame and % display

(7) Specify the trend graph and select [Edit] (menu bar)→ [Select Object].

(8) In the list, specify [0%] (Line 1 display %) at the upper right of the trend
graph and drag it to the % display position for Data 1.

Reference: Even if elementsareoverlapped, youcanselect thedesiredelementeasily using
the [Select Object] function. For elements such as a trend graph that consist of
several elements, use the [Edit Object] function to make element selection easi-
er.

(9) Specify [–100%] (Line 2 display %) at the upper right of the trend graph
and drag it to the % display position for Data 2.

(10) Specify the trend graph frame and adjust the size and the position.

S Displaying an example

Create the example of display using fixed display text and straight lines.

(11) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(12) Click the mouse with the mouse cursor positioned at the “Data 1” display
position.

(13) Set “Data 1” in the character string setting (Fixed Display -- Text) dialog
box.

(14) Adjust the “Data 1” display position.

(15) Select [Objects] (menubar)→ [FixedDisplay]→ [Polyline]. (Refer to6-2-1
Polyline.)

(16) Drag the mouse cursor in the range (from the start point to the end point)
where a line is to be displayed to the left of [Data 1].

Set the line property as shown below.

General Line Style Solid

Line Color Cyan

(17) Specify the drawn line and adjust the length and the position of the line.

(18) Create the example display of “Data 2” in the same manner.

Set the line property as shown below.

General Line Style Dot-dash

Line Color White
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9-3-7 Creating the Monitor Screen (Child Screen 2)
Here, create screen No. 11 as child screen 2.

(1) Select [Screen] (menu bar)→ [New].

(2) At the screen selection dialog box, set “Standard Screen.”

(3) At the new standard screen dialog box, set 11 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 11.

Attributes Screen No. 11

History n

Title Monitor Screen-2

Comment Monitor Screen-2

Buzzer

Load Local 1 (Keyboard)

System Keypad

Color Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid n

Snap to Grid n

Creating the lamps ([Lamp 1] to [Lamp 5])

S Creating the frame of lamp 1

(1) Select [Objects] (menu bar) → [Lamp] → [Standard]. (Refer to 6-5
Lamps.)

(2) At the [Lamp 1] display position in the data creation screen, drag the
mouse to create the lamp frame.
In this step, a rectangular frame is created.
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(3) Set the properties as shown below.

General Position ––

Size ––

Frame n

Shape Circle

Color Frame White

ON White

OFF Transparent

Light
Functions

Address PC (PLC) Bit Address L0000000
Functions I/O Comment Lamp 1

Lamp Attrib-
ute

ON Type Light

Label*1 Label n Lamp 1 (refer
to the follow-
ing)*2

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, multiple lines of label, On Off static label, numeral/
string display label can also be set.

*2: Click the Button to set the label.
If the I/Ocomment is already set for thePLCaddress of light function,

clicking the Button copies the label.

After completing thesetting, go to thenext stepwith clicking the

Button.

S Setting the label for lamp 1

(4) Press in the general property of a lamp and set the label prop-
erties as shown below.

Comment Lamp 1

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent

Click on , (returns to lamp property) then click on again.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, “Color: ON” and “Color:
OFF” can be set independently for a label so that the lamp can be displayed in
different colors in the ON and OFF states.
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S Adjusting the size and position of the lamp

(5) Specify the “Lamp 1.”

(6) Select [Edit Object] from [Edit] menu.
For methods of specifying an element consisting of multiple elements, refer
to 6-1-3 Selecting an Element.

(7) Specify the “Lamp 1” and adjust the size and position of the lamp frame.

(8) Adjust the position of the “Lamp 1” character string by dragging it.

S Creating lamp 2

(9) Copy [Lamp 1] and paste it onto the data creation screen.

(10) Move the pasted [Lamp 1] to the [Lamp 2] position.

(11) Double click the mouse on the pasted [Lamp 1] andmodify the properties
as shown below. Note that the properties not shown here must be left un-
changed.

Light
Functions

Address PC (PLC) Bit Address L0000001
Functions I/O Comment Lamp 2

Label Label n, Lamp 2 *1

*1: Press to set the label.
If the I/Ocomment is already set for thePLCaddress of light function,

clicking on button copies the label.

(12) Create [Lamp 3], [Lamp 4], and [Lamp 5] in the same manner.

(13) Modify the properties as shown below meeting the individual lamps.

Lamp 3 n, Lamp 4 n, Lamp 5

Light
Functions

Address PC (PLC)
Bit Address

L0000002 L0000003 L0000004

I/O
Comment

Lamp 3 Lamp 4 Lamp 5

Label Label n, Lamp
3*1

n, Lamp
4*1

n, Lamp
5*1

*1: Press to set the label.
If the I/Ocomment is already set for thePLCaddress of light function,

clicking on button copies the label.

Creating the image/library lamp image data

Create two kinds of image data for the image/library lamp.

Create the image data for codes FE20 and FE21.

FE20 FE21
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(1) Select [Tools] (menu bar)→ [Image Editor].

(2) Click on .

(3) Set the properties as shown below and click on .

Code FE20

Size Width 64

Height 48

Mode 8 Colors

Compression n

(4) Click on to create the image data. (For the image data creation

procedure, refer to 8-1 Image Editor.)

(5) Close the image editor.

(6) Call the image editor again and create the image data for code FE21.

Reference: It is possible to copy image data FE20onto FE21on the image table so that it can
be reused.
Follow the procedure below.
a. Click on and register the code FE21 (Properties other than code

need not be changed).
b. Specify FE20 and select [Copy] by pressing button.
c. Specify FE21 and select [Paste] by pressing button.

Creating the [Image Lamp]

S Creating the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click the mouse with the mouse cursor set at the position where the label
“Image Lamp” is to be displayed.

(3) Set the properties as shown below.

Description Image Lamp

Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent
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(4) Adjust the position of “Image Lamp” character string on the data creation
screen by dragging it.

S Setting the image/library lamp

(5) Select [Objects] (menu bar)→ [Lamp]→ [Image].

(6) Click the mouse with the mouse cursor set at the position where the
image/library lamp is to be displayed (at the intended upper left corner).

(7) Set a check mark in the check box of the [Code] for OFF, in General, and
click on .

(8) In the image table, specify “FE20” and click on .

(9) Set a check mark in the check box of the [Code] for ON, in General, and
click on .

(10) In the image table, specify “FE21” and click on .

(11) Set the lamp function properties as shown below.

Light
Functions

Address PC (PLC) Bit Address L0000005
Functions I/O Comment Image Lamp

(12) Adjust the display position of the image/library lamp.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, codes assigned to image
data are from 0001 to 0FFF. However, if NT20/30/620-compatible mode is used
with the NT21, NT31, NT31C, NT631, and NT631C, the image code will be the
same as NT30, NT30C, NT620S, NT620C and NT625C.

Creating [Bar Graph 1] and [Bar Graph 2]

S Creating the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click themouse with themouse cursor set at the position where the char-
acter string of [Bar Graph 1] is to be displayed (at the intended upper left
corner of bar graph).

(3) Set the properties as shown below.

Description Bar Graph 1

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black
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(4) Adjust the position of “Bar Graph 1” character string on the data creation
screen by dragging it.

S Creating the bar graph frame

(5) Select [Objects] (menu bar)→ [Graph]→ [Bar Graph]. (Refer to 6-9-1 Bar
Graph.)

(6) Drag the mouse cursor at the position where bar graph 1 is to be displayed
(drag between diagonally opposing corners) to create the frame of [Bar
Graph 1].

(7) Set the properties as shown below.

General Position ––

Size ––

Frame n

Display Sign n

Direction Right

Color Frame White

+ Range White

– Range White

Settings Value Table Entry 4

Display % n

100% Table Entry

Display % n, 500

0% Table Entry

Display % n, 0

–100% Table Entry

Display % n, –500

S Setting the % display

(8) After specifying the bar graph, select [Edit] (menu bar)→ [Edit Object].

(9) Double click on [0%] and set the properties as shown below.

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute ––

Color Foreground White

Background Black

S Adjusting the size and position of bar graph frame and % display
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(10) Specify [0%] at the upper left of the trend graph and drag it to the%display
position.

(11) Specify the bar graph frame and adjust the size and position of bar graph
frame.

S Creating bar graph 2

(12) Specify all of label, bar graph frame, and % display of [Bar Graph 1] and
copy and paste them onto the data creation screen.

(13) Move the pasted bar graph 1 element, which was pasted at the upper left
area in the data creation screen, to the position of [Bar Graph 2].

(14) Double click the label “Bar Graph 1,” which has been moved to the bar
graph 2 position, and modify the properties as shown below.

Label Bar Graph 2

(15) Double click on the frame of bar graph 2 and modify the properties as
shown below. Note that other properties must be left unchanged.

Settings Value Table Entry 5

Display % n

100% Table Entry

Display % n, 300

0% Table Entry

Display % n, 0

–100% Table Entry

Display % n, –300

Creating the [Menu] button, [Set] button, and [Alarm] button

S Creating the [Menu] button frame

(1) Select [Objects] (menu bar)→ [Touch Switch]

(2) Create the [Menu] button frame by dragging the mouse at the button dis-
play position.

(3) Set the properties as shown below.
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General Position ––

Size ––

Frame n

Shape 3-Dimension

Show ON State n

Color Frame White

ON White

OFF Transparent

Settings Function Switch Screen

Screen No. 1

Light
Function

Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute Attribute Light

Label Label n, Menu (refer
to the following)
*1

*1: Press to set the label.
After completing the setting, go to the next step without clicking on

button.

S Setting the label of [Menu] button

(4) Press in the general property of a touch switch and set the la-
bel properties as shown below.

Description Menu

Position ––

Font Type Standard

Scale 1×1 (Equal)
Smoothing ––

Attribute Standard

Color Foreground White

Background Transparent

Reference: With the NT21, NT31, NT31C, NT631 and NT631C, “Color: ON” and “Color:
OFF” can be set independently for a label so that the lamp can be displayed in
different colors in the ON and OFF states.

Click on , (returns to touch switch property) then click on

again.

S Adjusting the size and position of the touch switch

(5) Specify the [Menu] button and select [Edit] (menu bar)→ [Edit Object].

(6) Adjust the size and position of [Menu] button frame.

(7) Adjust the position of label “Menu” by dragging it.
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S Creating the [Set] button

(8) Copy the [Menu] button and paste it on the screen.

(9) Move the [Menu] button pasted at the upper left area of the screen to the
[Set] button position.

(10) Double click themoved button andmodify the properties as shown below.
Note that other properties must be left unchanged.

Settings Screen No. 3

Label Label n, Set *1

*1: Press to set the label.

(11) Create the [Alarm] button in the same manner.
Modify [Alarm] button properties as shown below.

Settings Screen No. 4

Label Label n, Alarm *1

*1: Press to set the label.

S Creating the frame

(12) Select [Objects] (main menu)→ [Fixed Display]→ [Rectangle].

(13) Drag themouse so that the rectangular frame encloses the three buttons.

(14) Use the properties as they are.

(15) Adjust the size and the position of the frame (rectangle).

S Setting the [Switch Screen] character string

(16) Select [Objects] (main menu)→ [Fixed Display]→ [Text]

(17) Click the mouse with the mouse cursor set at the position where the
[Switch Screen] character string is to be displayed (at the intended upper
left corner).

(18) Set the properties as shown below.

Description Switch Screen

Position ––

Font Type Standard

Scale 1×1 (Equal)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

(19) Adjust the position of the “Switch Screen” character string on the data cre-
ation screen by dragging it.
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(20) Specify the “Switch Screen” character string, then select [Draw] (menu
bar)→ [Bring to Front]. (For details of Moving an overlapped element to
the front or back, refer to 6-1-5 Copying, Cutting, Pasting, and Deleting
Elements.)

The “Switch Screen” character string is brought to the front of the frame.

Reference: The positional relationship in the display of the same kind of elements, such as
among fixed display elements, can be controlled by selecting [Draw]→ [Bring to
Front] or [Send to Back].

9-3-8 Creating the Monitor Screen (Parent Screen)
Register screensNo. 10 andN0. 11 as child screens of screenNo. 2. ScreenNo.
2 is regardedasaparent screenof overlappingscreens. (Refer to5-3-2Overlap-
ping Screens.)

(1) Select [Screen] (menu bar)→ [New].

(2) In thescreen typedesignationdialogbox, select theParentScreenandclick
on .

(3) In thesettingdialogboxof aparent screen, set thedisplayed itemsasshown
below.

Parent Screen Screen No. 2

Type Overlapping

(4) Specify 10 in the standard screen box and click on .

(5) Specify 11 in the standard screen box and click on .

(6) Click on .

9-3-9 Creating the Set Screen
Create screen No. 3 (new screen) as the Set Screen.
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(1) Select [Screen] (menu bar)→ [New].

(2) At the screen selection dialog box, set “Standard Screen.”

(3) At the new standard screen dialog box, set 3 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 3.

Attributes Screen No. 3

History n

Title Set Screen

Comment Set Screen

Buzzer

Load Local 1 (Keyboard)

System Keypad

Color Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid n

Snap to Grid n

Creating the screen title ([Set Screen])

S Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” character string and its frame (rectangle) on
screen No. 1 and paste them onto screen No. 3.

(2) Adjust the display position of the pasted character string and frame to the
desired position.

S Modifying to [Set Screen]

(3) Double click the “MenuScreen” character string andmodify theproperties
as shown below. Note that other properties must be left unchanged.

Description Set Screen

(4) Adjust the size of the frame (rectangle).

Creating the data input field ([Numeral Input 1])
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S Setting the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click the mouse with the mouse cursor set at the position where the data
display field title is to be displayed (at the intended upper left corner).

(3) Set the properties as shown below.

Description Numeral Input 1

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Transparent

(4) Adjust the position of “Numeral Input 1” on the data creation screen by
dragging it.

S Creating the data input field

(5) Select [Objects] (menu bar)→ [Data Input]→ [Numeral]. (Refer to 6-4-1
Numeral Input.)

(6) Click the mouse with the mouse cursor set at the position where the data
input field is to be displayed (at the intended upper left corner).

(7) At the cursor moving touch switch use selection dialog box, set the dis-
played items as shown below.

Create Cursor Move Touch Switch n

S Setting the numeral input field

(8) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground White

Background Black
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Settings Table Entry 10

Display Type Decimal

Format Integer 8

Decimal 0

Limit Maximum 99999999

Minimum 0

Zero Suppression n

Display Sign n

Focus Frame n

Focus Attribute Standard

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, it is possible to set an interlock bit that can enable/dis-
able the operations.

S Setting the cursor moving touch switch

(9) Double click on the touch switch area (dotted line frame) created at the
numeral input field position and set the properties as shown below.
If selection of the touch switch is not easy, choose [SelectObject] from the
[Edit] menu and select the touch switch from the list.

General Position ––

Size ––

Frame n

Shape Standard

Show ON State n

Color Frame White

ON White

OFF Transparent

Settings Function Cursor Move

Use Window/Keyboard Screen n

Screen No. 1900

Auto Arrange *1

Light
Function

Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute Light

Label Label

*1: Uncheck the checkmark for “Auto Arrange.” Otherwise, it is not pos-
sible to change the position of each numeral input and touch switch.

*2: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, it is possible to set an interlock bit that can enable/dis-
able the operations.
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S Adjusting the size and position of numeral input 1 input field and the touch
switch

(10) Specify only the touch switch area and adjust the size and the position.

(11) Specify only the numeral input field and adjust the size and the position.

Creating the numeral input field ([Numeral Input 2])

S Copying and pasting the numeral input field ([Numeral Input 1])

(1) Copy “Numeral Input 1” character string, numeral display field, and touch
switch and paste them to the data creation screen.

(2) Move the character string, numeral display field, and touch switch pasted
at the upper left area of the screen to the desired position (for displaying
[Numeral Input 2]).

(3) Double click the “Numeral Input 1” character string andmodify the proper-
ties as shown below. Note that other properties must be left unchanged.

Description Numeral Input 2

(4) Double click the data input field ([ 0] displayed) and modify the proper-
ties as shown below. Note that other properties must be left unchanged.

Settings Table Entry 11

Creating the thumbwheel switch

S Creating the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click themousewith themouse cursor set at the position where the title is
to be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

Description Thumbwheel

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black
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(4) Adjust the position of the Thumbwheel on the data creation screen by
dragging it.

S Creating the thumbwheel switch

(5) Select [Objects] (menu bar)→ [Data Input]→ [Thumbwheel Switch].
(Refer to 6-4-3 Thumbwheel Switch.)

(6) Click the mouse with the mouse cursor set at the position where the
thumbwheel switch is to be displayed (at the intended upper left corner of
thumbwheel).

(7) Set the properties as shown below.

General Position ––

Size Medium

Attribute Standard

End Plate n

Thumbwheel
Color

Frame White
Color Foreground White

Background Black

Character
Color

Foreground White
Color Background Black

Settings Table Entry 12

Display Type Decimal

Format Integer 4

Decimal 0

Limit Maximum 999

Minimum F0009999

Display sign n

*1: For the NT21 and NT31, NT31C, NT631 and NT631C with “-V2” or
later models, it is possible to set an interlock bit that can enable/dis-
able the operations.

(8) Adjust the position of the thumbwheel switch on the data creation screen
by dragging it.

Creating the [Start] button and the [Stop] button
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S Creating the [Start] button frame

(1) Select [Objects] (menu bar)→ [Touch Switch]

(2) Create the [Start] button frame by dragging the mouse at the button dis-
play position.

(3) Set the properties as shown below.

General Position ––

Size ––

Label n, Start (refer to
the following) *1

Frame n

Shape Shadow

Show ON State ––

Color Frame White

ON White

OFF Transparent

Settings Function Notify Bit

Address PC (PLC) Address L0000100

I/O Comments Start Switch

Action Type Momentary

Light
Function

Address PC (PLC) Address L0000200
Function I/O Comments Start lamp

Lamp Attrib-
ute

General Light

*1: Press to set the label.
After completing the setting, go to the next step without clicking on

button.

(4) Press in the general property of a touch switch and set the la-
bel properties as shown below.

Description Start

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

Click on , (returns to touch switch property) then click on

again.

S Adjusting the size and position of [Start] button

(5) Specify the [Start] button and select [Edit] (menu bar)→ [Edit Object].

(6) Adjust the size and position of [Start] button frame.



9-3SectionCreating the Sample Data

387

(7) Adjust the position of the label “Start” by dragging it.

S Creating the [Stop] button

(8) Copy the [Start] button and paste it on the data creation screen.

(9) Move the [Start] button pasted at the upper left area of the screen to the
[Stop] button position.

(10) Double click themoved button andmodify the properties as shown below.
Note that other properties must be left unchanged.

Settings Address PC (PLC) Address L0000101

I/O Comments Stop Switch

Light
Function

Address PC (PLC) Address L0000201
Function I/O Comments Stop lamp

Label Label n, Stop *1

*1: Press to set the label.

Creating the character string display field ([String Display])

S Setting the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click themousewith themousecursor set at thepositionwhere the “String
Display” character string is to be displayed (at the intended upper left cor-
ner of text).

(3) Set the properties as shown below.

Description String Display

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

(4) Adjust the position of the “String Display” on the data creation screen by
dragging it.
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S Creating the character string display field

(5) Select [Objects] (menu bar)→ [String Display].

(6) Click themouse with themouse cursor set at the position where the char-
acter string display field is to be displayed (at the intended upper left cor-
ner of string display field).

(7) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

Settings Reference Indirect
Reference

Table Entry 0

Length 20

(8) Adjust the position of the character string display field by dragging it.

S Creating the character string display field frame

(9) Select [Objects] (menu bar)→ [Fixed Display]→ [Rectangle].

(10) On the data creation screen, drag the rectangle so that it encloses the
character string display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).

Creating the [Auto] button, [Man.] button, [Step] button, and [Reset] button

S Creating the [Auto] button frame

(1) Select [Objects] (menu bar)→ [Touch Switch]

(2) Create the [Auto] button frame by dragging the mouse at the button dis-
play position.

(3) Set the properties as shown below.
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General Position ––

Size ––

Frame n

Shape Shadow

Show ON State n

Color Frame White

ON White

OFF Transparent

Settings Function Copy Setting

Copy From Numeral Table

String Table n

Code

Entry (Text Box) 10

Copy To Numeral Table

String Table n

Cursor Position

Entry (Text Box) 0

Light
Function

Address PC (PLC) Ad-
dress

––

I/O Comments ––

Lamp Attribute On Type Light

Label Label n, Auto (refer to
the following) *1

*1: Press to set the label.
After completing the setting, go to the next step without clicking on

button.

S Setting the label of [Auto] button

(4) Press in the general property of a touch switch and set the la-
bel properties as shown below.

Description Auto

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

Click on , (returns to touch switch property) then click on

again.

S Adjusting the size and position of [Auto] button

(5) Specify the [Auto] button and select [Edit] (menu bar)→ [Edit Object].
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(6) Adjust the size and position of [Start] button frame.

(7) Adjust the position of the label “Auto” by dragging it.

S Creating the [Man.] button

(8) Copy the [Auto] button and paste it onto the data creation screen.

(9) Move the [Auto] button pasted at the upper left area of the screen to the
[Man.] button position.

(10) Double click themoved button andmodify the properties as shown below.
Note that other properties must be left unchanged.

Settings Copy From Numeral Table

String Table n

Code

Entry (Text Box) 11

Label Label n, Man. *1

*1: Press to set the label.

S Creating the [Step] button and the [Reset] button

(11) Create the [Step] button and the [Reset] button in the samemanner as the
[Man.] button.
For the [Step] button and the [Reset] button, change the properties as
shown below.

[Step] but-
ton

[Reset]
button

Settings Copy From Numeral Table

String Table n n

Code

Entry (Text Box) 12 13

General Label n, Step n, Reset

S Creating the button group title bar

(12) Select [Objects] (menu bar)→ [Fixed Display]→ [Polyline].

(13)While pressing the shift key, drag the polyline from start point to the se-
cond vertex, and then from the second vertex to the third vertex. Repeat
this procedure to create thedesired form.Release theShift key just before
reaching at the last point.
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Reference: To draw continuous polyline, press shift key when drag operation is finished.
Dragging this end point creates continuous polyline.

(14) Use the properties as they are.

S Creating the “Select” character string

(15) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(16) Click the mouse with the mouse cursor set at the position where the “Se-
lect” character string is to be displayed (at the intended upper left corner of
text).
In the character string setting (FixedDisplay-text) dialog box, set “Select.”

(17) Set the properties as shown below.

Description Select

Position ––

Font Type Standard

Scale 1×1 (Equal)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

(18) Adjust the position of the “Select” character string on the data creation
screen by dragging it.

(19) Specify the “Select” character string, then select [Draw] (menu bar) →
[Bring to Front].

The “Select” character string is brought to the front of the title bar.

Creating the [Menu] button, [Monitor] button, and [Alarm] button

S Copying and pasting the buttons from screen No. 11

(1) Copy the “Switch Screen” character string, frame (rectangle), [Menu] but-
ton, [Set] button, and [Alarm] button collectively and paste them to screen
No. 3.

(2) Adjust the display position of the pasted character string, frame (rectan-
gle), and buttons.

S Modifying to the [Monitor] button

(3) Double click the [Set] button and change the properties as shown below.
Note that other properties must be left unchanged.

Settings Screen No. 2

Label Label n ,Monitor *1
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*1: Press to set the label.

(4) Resize the [Monitor] button larger than others.

9-3-10 Creating the Alarm Screen
Create screen No. 4 (new screen) as the Alarm Screen.

(1) Select [Screen] (menu bar)→ [New].

(2) At the screen selection dialog box, set “Standard Screen.”

(3) At the new standard screen dialog box, set 4 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 4.

Attributes Screen No. 4

History n

Title Alarm Screen

Comment Alarm Screen

Buzzer

Load Local 1 (Keyboard)

System Keypad

Color Background Black

Grid Grid Size Custom
Horizontal Spacing:
5
Vertical Spacing:
5

Display Grid n

Snap to Grid n

Creating the screen title ([Alarm Screen])

S Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” character string and its frame (rectangle) on
screen No. 1 and paste them onto screen No. 4.
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(2) Adjust the display position of the pasted character string and frame to the
desired position.

S Modifying to [Alarm Screen]

(3) Double click the “MenuScreen” character string andmodify theproperties
as shown below. Note that other properties must be left unchanged.

Description Alarm Screen

(4) Adjust the size of the frame (rectangle).

Creating the alarm list

S Setting the title

(1) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(2) Click themousewith themousecursor set at thepositionwhere the “Alarm
List” character string is to be displayed (at the intended upper left corner of
text).

(3) Set the properties as shown below.

Description Alarm List

Position ––

Font Type Standard

Scale 1×1 (Equal)
Smoothing n

Attribute Standard

Color Foreground White

Background Black

(4) Adjust the position of the “Alarm List” character string on the data creation
screen by dragging it.
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S Creating the alarm list

(5) Select [Objects] (menubar)→ [Alarm]→ [List]. (Refer to6-3-1AlarmList.)

(6) Click themousewith themouse cursor set at the positionwhere the alarm
list is to be displayed (at the intended upper left corner).

(7) Make the following settings in the dialog box for selecting whether or not
the line scroll touch switches and page scroll touch switches are used.

Create Line Scroll Touch Switch n

Create Page Scroll Touch Switch n

Reference: For NT21, NT31, NT31C, NT631, and NT631C, this dialog box is not displayed.
For thesemodels, create the alarm list and then set whether or not the line/page
scroll touch switches are created in the property settings.

(8) Set the properties as shown below.

General Position ––

Size ––

Message Length 32

Display Line Qty 8

Scale 1×2 (High)
Smoothing n

Color Frame White

Back-
ground

ON White
ground OFF Black

Image & Library Display ImageLib n

Color Foreground White

Background Black

Settings List Settings Start Bit Table Entry 0

No. of Bits Referenced 8

(9) Adjust the display position of the alarm list by dragging it.

After that, click onany position in the screenother than thealarm list to cancel the
alarm list selected state (edit state).

S Changing the frame of the line scroll (down) touch switch

(10) Specify the switch at the bottom in the touch switches at the right side of
the alarm list and adjust its size and position (move it to the lowest line in
the alarm list).

(11) Double click the line scroll (down) touch switch and set the properties as
shown below.
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General Position ––

Size ––

Frame n

Shape Standard

Show ON State n

Color Frame White

ON White

OFF Transparent

Settings Function Input Key-Control

Control Key

Light
Function

Address PC (PLC) Ad-
dress

––

I/O Comments ––

Lamp Attribute General Light

Label Label n, <!FFF9> *1

*1: Here, the label is not changed. (If you need to change it, press
button.)

After completing the setting, go to the next step without clicking on

button.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, the touch switches used to
control the alarm list are a part of the list and their properties, such as the label
and the size, cannot be changed. Only the position can be adjusted.

(12) Press in the general property of a touch switch and set the la-
bel properties as shown below.
Note that other properties must be left unchanged.

Foreground Color Cyan

(13) Adjust the position of the label graphic by dragging it.

S Setting the page down, page up, and line scroll (up) touch switches

(14) Modify the page down, page up, and line scroll (up) touch switches in the
same manner as the line scroll (down) touch switch.
Refer to the screen in p 393 to check the position of each touch switch.

Modify the properties of the individual touch switches as shown below.

Page down Page up Scroll up

General Position –– –– ––

Size –– –– ––

Frame n n n

Shape Standard Standard Standard

Show ON State n n n

Color Frame White White White

ON White White White

OFF Transparent Transparent Transparent



9-3SectionCreating the Sample Data

396

Scroll upPage upPage down

Settings Function Input
Key-Control

Input
Key-Control

Input
Key-Control

Control Key

Light
Function

Address PC (PLC)
Address

–– –– ––

I/O
Com-
ments

–– –– ––

Lamp
Attribute

General Light Light Light

Label Label n, <!FFF7> n, <!FFF6> n, <!FFF8>

(15) Modify the foreground color of the label graphic to cyan as with the line
scroll (down) touch switch.

Reference: WithNT21,NT31,NT31C,NT631, andNT631C, the touch switchesused to con-
trol the alarm list can be adjusted only in position.
Size, color, label can not be changed. If you want to move the position, select
[Edit] (menu bar)→ [Edit Object] (or right click→ [Edit Object]) and specify the
touch switch.

S Setting for the image/library data display field

(16) Specify the alarm list and select [Edit] (menu bar)→ [Edit Object].

(17) Specify the image data display field, displayed at the central left part of the
alarm list, and adjust the size and the position.
(Resize the size to 200 × 200 dots.)

Creating the [Menu] button, [Monitor] button, and [Set] button

S Copying and pasting the buttons from screen No. 3

(1) Copy the “Switch Screen” character string, frame (rectangle), [Menu] but-
ton, [Monitor] button, and [Alarm] button collectively and paste them onto
screen No. 4.

(2) Adjust the display position of the pasted character string, frame (rectan-
gle), and buttons.

S Modifying to the [Set] button

(3) Double click the [Alarm] button and change the properties as shown be-
low.

Settings Screen No. 3

Label Label n ,Set *1

*1: Press to set the label.
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9-3-11 Creating the Alarm List Library Data
Create the library data that is displayed at the occurrence of an alarm.

Create the library data for FA20 toFA25. (For the library data creationprocedure,
refer to 8-2 Library Editor.)

FA20 FA21 FA22

FA23 FA24 FA25

Set line 1. Set line 2. Check torque
screw.

Check pipe and
valve.

Detection near
entry. Confirm
safety before re-
starting the line.

Check the PC
(PLC) and the
network.

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, the library data codes are
1000 to 3FFF.However, if NT20/30/620-compatiblemode is usedwith theNT21,
NT31, NT31C, NT631, and NT631C, library code will be the same as NT30,
NT30C, NT620S, NT620C and NT625C.

S Creating the library data of code FA20

(1) Select [Tools] (menu bar)→ [Library Editor].

(2) Specify FA20 in the library table and click on .

(3) Click the library creation area frame (dotted lines) that is displayed at the
upper left area in the library creation screenand drag the point at the lower
right corner. The mouse cursor position is displayed under the screen;
change the frame size to X=200, Y=200 (size: 200×200).

(4) Select [Objects] (menu bar)→ [Fixed Display]→ [Text].

(5) Click the mouse at the position where the character string is to be dis-
played (at the intended upper left corner of text).

(6) Set the properties as shown below.

Description Set Line 1

Position ––

Font Type Standard

Scale 1×2 (High)
Smoothing n

Attribute Inverse Flash

Color Foreground White

Background Black
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(7) Adjust the “Set Line 1” character string display position by dragging it.

(8) After creating the library data of code FA20, click at the upper right

section in the FA20 library editor to close it.

S Creating the library data of code FA21 to FA25.

(9) Create the library data of code FA21 to code FA25 in the same manner.
If character string occupiesmore than one line, create the character string
line by line.

Reference: It is possible to copy library data FA20 to other code so that it can be reused. Fol-
low the procedure below.
a. Specify FA20 and select [Copy] by pressing button.
b. Specify the code to be pasted and select [Paste] by pressing

button.

9-3-12 Creating the Pop-up Display Numeric Keys
Create the numeric keys displayed in the pop-up window at screen No. 1900.

Reference: WithNT30, 30C,NT620S,NT620C, andNT625C, screennumbers of the screen
where a window/keyboard screen can be created are restricted to 1900 to 1979.
With the NT21, NT31, NT31C, NT631, and NT631C, however, a window/key-
board screen can be created for any screennumber aswith a standard screen (1
to 3999).

Creating the window/keyboard screen

For details of window/keyboard screen, refer to 5-4Window/Keyboard Screens.

(1) Select [Screen] (menu bar)→ [New].

(2) At the screen selection dialog box, set “Window/Keyboard Screen.”

(3) At the new standard screen dialog box, set 1900 for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar)→ [Properties].

(2) Set the screen properties as shown below for screen No. 1900.

Attributes Screen No. 1900

History

Title

Comment Pop-up Numeric Keys

Buzzer

Load Local 1 (Keyboard)

System Keypad

Color Background Black
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Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid n

Snap to Grid n

Creating the screen (numeric keys)

S Creating the [0] key frame

(1) Select [Objects] (menu bar)→ [Touch Switch]

(2) Create the outline of the [0] key by dragging the mouse on the data cre-
ation screen.

(3) Set the properties as shown below.

General Position ––

Size ––

Frame n

Shape Standard

Show ON State n

Color Frame White

ON White

OFF Transparent

Settings Function Input Key-Control

Control Key

Light
Function

Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attrib-
ute

General Light

Label Label n, 0 (refer to the
following) *1

*1: Press button to set the label.
After completing the setting, go to the next step without clicking on

button.

S Setting the label of the [0] key
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(4) Press button in the general property of a touch switch and set
the label properties as shown below.
Note that other properties must be left unchanged,

Scale 2×2
Smoothing n

Click on , (returns to touch switch property) then click on

again.

S Adjusting the size and position of the [0] key

(5) Specify the [0] key and select [Edit] (menu bar)→ [Edit Object].

(6) Adjust the size and position of [0] key frame.

(7) Drag [0] to adjust the display position.

Reference: The explanation above described the procedure for creating numeric keys using
the touch switch control code input function. The Support Tool, however, pro-
vides numeric keys as symbol data and you do not have to create numeric keys
by using the pre-registered numeric keys; in the menu bar, select [Window]→
[Symbol Manager] and drag the numeric keys appropriate for your PT model
from the symbol file (Supplmnt.sbl). The selected numeric keys can be regis-
tered on the screen. For details, refer to 6-10 Registering Created Elements
(Symbol Manager Operation).

S Creating other keys

(8) Copy the [0] key, paste it onto the screen and move the pasted [0] key to
the position of the key to be created ([1] to [↵]).
Once the [0] is copied to the clipboard, it remains on the clipboard until the
next cut or copy operation.

(9) Set the properties as shown below for the individual keys.

1 2 3 4 5 6 7

Settings Control Key

Label Label n, 1 *1 n, 2 *1 n, 3 *1 n, 4 *1 n, 5 *1 n, 6 *1 n, 7 *1

8 9 . CLR +/– ↑ ↓

Settings Control Key

Label Label n, 8 *1 n, 9 *1 n, . *1 n, CLR
*1

n, +/– *1 n, *2
<!FFFA>

n, *2
<!FFFB>

↵

Settings Control Key

Label Label n, *2
<!FFFF>

*1: Press button to set the label.

*2: Press button to set the label. It is also possible to select a
mark by pressing button in the label property.

(10) For the [+/–] key and the [CLR] key,modify the label size to 1×2. For other
keys, the label size should not be modified.
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(11) Select all the touch switches above.

(12) Select [Centralize Label] from the [Draw] menu.
The position of all the labels for the selected touch switch is centralized
both vertically and horizontally.

Creating a temporary input field

(1) Select [Objects] (menu bar)→ [Data Input]→ [Numeral].

(2) Click the mouse with the mouse cursor set at the position where the data
input field is to be displayed (at the intended upper left corner of numeral in-
put field).

(3) At the cursor moving touch switch use selection dialog box, set the dis-
played items as shown below.

Create Cursor Move Touch Switch

Reference: With the NT21, NT31, NT31C, NT631, and NT631C, this dialog box is not dis-
played and, accordingly, the cursor moving touch switch cannot be set at the
temporary input field. For a temporary input field, the setting of “Create Cursor
Move Touch Switch” is not so significant. Even with NT20S, NT30, NT30C,
NT600S,NT620S,NT620C, andNT625C, it is not necessary to set this property.

(4) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2×2
Smoothing n

Attribute Standard

Color Foreground Black

Background White

Settings Table Entry 10

Display Type Decimal

Format Integer 8

Decimal 0

Settings Limit *1 Maximum 99999999

Minimum 0

Settings Zero Suppression n

Display Sign n

Settings Focus Frame n

Focus Attribute Standard

*1: The setting is not needed for the NT21, NT31, NT31C, NT631 and
NT631C.

(5) Specify the numeral input field and adjust the position.
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Setting the pop-up display range frame

Set the range for pop-up display.

(1) Move the range specifying frame, displayed at the upper left section in the
screen, to the numeric key area and adjust its size so that the keys and tem-
porary input field are enclosed.

For details of changing the size and the position of pop-up display frame,
refer to 5-4 Window/Keyboard Screens.

9-3-13 Saving the Created Data

(1) Select [File] (menu bar)→ [Save As]. (Refer to 4-2-10 Saving the Screen
Data (Application) to a File.)

(2) Specify the file name of the file where the created data is saved (example:
SAMPLE.ONW) and click on .

9-3-14 Downloading to the PT

Setting the PT status control area and PT status notify area

(1) Select [Tools] (menu bar)→ [PT Configuration].

(2) Click the [Control/Notify Area] tab and set the properties as shown below.
(For details of Control/Notify area, refer to 3-3-1 Creating New Screen Data
(Application) File.)

PT Control Area PC (PLC) Address D00100

Comments Control Area

PT Notify Area PC (PLC) Address D00110

Comments Notify Area

Downloading to the PT

(1) Place the PT in the [transfer mode] by the system menu operation.

(2) At the Support Tool, select [Connect] (menu bar)→ [Download (NT-series
Support Tool→ PT)]→ [Application].
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Downloading of the screen data starts. During screen data download, the
screen as shown below is displayed.

For details of the screen data download, refer to 4-2-12 Sending (Downloading)
the Data to a PT and 11-3 Sending (Downloading) the Data.
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SECTION 10
Quick Reference

This section enables you to access the information you require easily using what you want to do as the key.

10-1 Quick Reference 406. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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10-1 Quick Reference

Item Operation Refer to

Displaying
graphics

To display a polyline or a
broken line

[Objects]→ [Fixed Display]→ [Polyline] 6-2-1

To display a rectangle [Objects]→ [Fixed Display]→ [Rectangle] 6-2-3

To display a triangle, poly-
gon, trapezoid, or dia-
mond

[Objects]→ [Fixed Display]→ [Polygon] 6-2-5

To display a circle [Objects]→ [Fixed Display]→ [Circle] 6-2-4

To display an arc [Objects]→ [Fixed Display]→ [Arc] 6-2-2

To display a sector [Objects]→ [Fixed Display]→ [Sector] 6-2-6

To tile a graphic [Objects]→ [Fixed Display]→ [Tiling] 6-2-8

(1) [Window]→ [Symbol Manager]
Start the symbol manager, and register the created
data from color palette symbol.

6-10-5

To display bit map data (1) [Tools]→ [Image Editor] Create the image data.

(2) [Objects]→ [Fixed Display]→ [Image Display]
Display the created data.

8-1

6-2-9

To display a special sym-
bol/character

(1) [Tools]→ [Mark Editor] Create the mark data.

(2) [Objects]→ [Fixed Display]→ [Mark]

Display the created data.

8-3

6-2-10

To display the same
graphic in different posi-
tions and/or different
screens

(1) [Tools]→ [Library Editor] Create the library data.

(2) [Objects]→ [Fixed Display]→ [Library Display]
Display the created data.

8-2

6-2-11

To switch the graphic dis-
play according to the PC
(PLC) bit status

(1) [Tools]→ [Library Editor] or [Tools]→ [Image Editor]

Create the graphic to be displayed.

(2) [Objects]→ [Lamp]→ [Image]

Display the created data.

8-2

8-1

6-5-2

To move a graphic ac-
cording to shift of the PC
(PLC) bit status.

(1) [Tools]→ [Library Editor] or [Tools]→ [Image Editor]

Create the graphic to be displayed.

(2) [Objects]→ [Lamp]→ [Image]
Arrange the image on the locus of the graphic and dis-
play the same graphic according to bit shift of the PC
(PLC) bits.

8-1

8-2

6-5-2

To switch the graphic dis-
play according to the sta-
tus.

(1) [Tools]→ [Library Editor] or [Tools]→ [Image Editor]

Create the graphic to be displayed.

(2) [Objects]→ [Fixed Display]→ [Image Display] or [Li-
brary Display]

Display the graphic using indirect reference.

(3) Write the image/library code (1) in hexadecimal value
to the numeral table entry (set the storage type to
Binary) referenced at (2) according to the status.

8-1

8-2

6-2-9

6-2-11
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Item Operation Refer to

Displaying
graphics

To use the same graphic
in multiple application
data.

(1) [Window]→ [Symbol Manager]
Start the symbol manager, and register the created
data at the symbol manager.

(2) Open other screen data.

(3) [Window]→ [Symbol Manager]

Read the registered data.

6-10

[File]→ [Import Component]
Start up the second Support Tool.
Perform copy & paste operation of graphic between the
screen data files.
(Between the files of the same PT model setting only)

3-3-6
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Item Operation Refer to

Displaying
character
strings

To display text that will not
change.

(1) [Objects]→ [Fixed Display]→ [Text]

Create a text.

6-2-7

strings
(texts) To switch the character

string according to the
status of a PC (PLC) bit.

(1) [Objects]→ [Lamp] or [Touch Switch]

Create a lamp or a touch switch for which On Off Static
is set as the label type

(2) Turn the PC (PLC) bit to which the lamp is allocated
ON/OFF.

DEF

Screen

PT

ABC

PC
(PLC)

Bit

If OFF

Lamp or touch switch with On Off static label

If ON

(Only for the NT21, NT31/631-V2 and above)

8-2

6-5-2

(1) [Tools]→ [Library Editor]

Create the text to be displayed as the library data.

(2) [Objects]→ [Lamp]→ [Image]

Display the created data.

(3) Turn the PC (PLC) bit to which the image/library lamp
is allocated ON/OFF.

DEF

Screen

PT

ABC

PC
(PLC)

Bit

If OFF

Image display

If ON

8-2

6-5-2

(1) [Objects]→ [String display]

Display the contents of a character string memory table
entry (string table).

(2) Change the contents of the word allocated to the char-
acter string memory table entry (string table) with the
PC (PLC) ladder program.

DEF

PT

ABC

PC (PLC)

Ladder
program

ABC

ABC

DEF

Character string display

DEF

Character string memory
table (String table)

Screen

6-7

7-3
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Item Operation Refer to

Displaying
character
strings
(texts)

To switch the displayed
character string according
to the touch switch input.

(1) [Objects]→ [Touch Switch]→ [Function: Copy Setting]

Copy text to a character string memory table entry
(string table) using a touch switch for which the copy
function is set.

(2) [Objects]→ [String Display]

Display the contents of the copy destination character
string memory table entry (string table).

Character string memory
table (String table)

ABCABC

Constant ABC

Character string display
Touch switch (copy function)

PT

Screen

6-8-6

6-7

To display a character
string in which a special
symbol or character is in-
serted.

[Objects]→ [Fixed Display]→ [Text]

Specify the mark, or image/library code.

Specification: ABC<!FE20>DE
Display: ABCLDE

6-2-7

To insert image data and
library data into a string
with NT21 and
NT31/631-V2 and above

[Tool]→ [PT Configuration]

Set NT20/30/620 Compatible Mode on.

(The range of image/library data is as the same as
NT30/620 series in NT20/30/620 Compatible Mode.)

3-3

Screen
display

To display a blank screen Specify screen No. 0 at the first word in the PT status con-
trol area.

Note With NT20S, NT30, NT30C, NT600S, NT620S,
NT620C, and NT625S, if screen No. 0 is set for the
touch switch assigned the screen switching function,
the previous screen is displayed instead of a blank
screen.

1-3-4

To switch the screen using
a touch switch

[Objects]→ [Touch Switch]→ [Function: Switch Screen]

Create a touch switch for which the screen switching func-
tion is set.

Screen Screen No. n

6-8-2

To switch the displayed
screen according to a PC
(PLC) bit status.

[Tools]→ [Table]→ [Bit Memory]

Set the bit memory table screen switching function.

PC (PLC)
PT

Screen No. 2

Screen No. 1

7-4
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Item Operation Refer to

Screen
display

To switch the displayed
screen using an arrow
symbol key

(1) [Objects]→ [Touch Switch]→ [Function: Input Key --
Control]

Create the [↑] and [↓] touch switches. or [Screen]→
[Properties]→ [System Keypad: Tick]

Display the [↑] and [↓] keys of the system keypad.

(2) [Screen]→ [New]→ [Parent Screen: Continuous]

Specify the screen to be switched to when the or
key is pressed.

Note With the NT21, NT31, NT31C, NT631 and NT631C, it
is not possible to create continuous screens. There-
fore, set the screen switching function for the touch
switches created in step (1).

PT

Screen No. 1
Screen No. 2

Screen No. 3

6-8-5

5-1-1

5-3-1

To switch the displayed
screen using an external
switch

[Tools]→ [Table]→ [Extended I/O input]

Set the extended I/O input table screen switching function.

PT

Screen No. 1

Screen No. 2

7-5

To display a pop-up
screen (help, menu, etc.)
using a touch switch

(1) [Objects]→ [Touch Switch]→ [Input Key-Window/Key-
board]

Create a touch switch for which the window display
function is set.

6-8-4

(2) [Screen]→ [New]

Create the window/keyboard screen to be displayed.

Note For a keyboard, the data registered to the symbol
manager can be used. Creation is also possible using
[Touch Switch] -- [Function: Input Key -- Control]

Screen

Keyboard
screen

Screen

1-3-4

6-10

6-8-5
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Item Operation Refer to

Screen
display

To display multiple
screens in one screen

[Screen]→ [New]→ [Parent]

Set the child screens, then specify the parent screen on
which to overlap them.

Note With theNT21, NT31, NT31C, NT631, and NT631C, if
a parent screen is created, it is automatically set for
overlapping screens since continuous screens are not
supported.

PTScreen No. 10

Screen No. 11

Screen No. 1
ABC

DEF

ABCDEF

5-3-2

To move a window using a
touch switch. (Only for
NT21 and for NT31,
NT31C, NT631, NT631C
with “-V1” and above.)

(1) [Screen]→ [New]
Create a window/keyboard screen.

(2) [Objects]→ [Touch Switch]
Register Window Move touch switch on a screen
created in (1)

Center point of the window/keyboard screen goes to the
position touched next.

Screen

Window

Screen

1-3-4

6-8-8

To open/close/control a
window from the host.

(Only for NT21 and for
NT31, NT31C, NT631,
NT631C with “-V1” and
above.)

(1) [Tools]→ [PT Configuration]→ [Control/Notify Area]
Allocate Window Control Area to a host.

(2) [Screen]→ [New]
Create a window/keyboard screen.

(3) Write window screen No. to be displayed and X, Y co-
ordinate in a word to which window control area is allo-
cated.

Screen Screen

Window

3-3-1

1-3-4

3-3-1

PC (PLC)
Bit Status
Display

To turn a lamp ON/OFF
according to the ON/OFF
status of a PC (PLC) bit

[Objects]→ [Lamp]→ [Standard]

Set the PC (PLC) Bit address.

PT

PC (PLC)Screen

6-5-1
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Item Operation Refer to

PC (PLC)
Bit Status
Display

To turn a lamp ON/OFF
according to the ON/OFF
status of a PC (PLC) bit
that is controlled by the
operation of touch
switches.

(1) [Objects]→ [Touch Switch]→ [Function: Notify Bit]

Reflect the touch switch status in the PC (PLC) bit sta-
tus.

(2) [Objects]→ [Lamp]→ [Standard]

Reflect the PC (PLC) bit status at the lamp.

6-8-1

6-5-1

To switch the graphic to
be displayed according to
the PC (PLC) bit status

(1) [Tools]→ [Image Editor]

[Tools]→ [Library Editor]

Create the image data or the library data.

(2) [Objects]→ [Lamp]→ [Image]

Create an image/library lamp.

Set the light function PC (PLC) address.

Screen
PT

L

PC
(PLC)
Bit

If ON

If OFF

Graphic (image data)

l

8-1

8-2

6-5-2

To switch the text to be
displayed according to the
PC (PLC) bit status.

(1) [Objects]→ [Lamp] or [Touch Switch]

Create a lamp or a touch switch for which On Off Static
is set as the label type

(2) Turn the PC (PLC) bit to which the lamp is allocated
ON/OFF

DEF

Screen
PT

ABC
Bit

If ON

If OFF

Lamp or touch switch with On Off static label

PC
(PLC)

(Only for NT21, NT31/631-V2 and above)

8-2

6-5-2

(1) [Tools] -- [Library Editor]

Register the text as the library data.

(2) [Objects]→ [Lamp]→ [Image]

Create a lamp that displays the registered text.

(3) Turn the PC (PLC) bit allocated to the lamp ON/OFF.

DEF

Screen
PT

ABC
Bit

If ON

If OFF

Image

PC
(PLC)

8-2

6-5-2
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Item Operation Refer to

PC (PLC)
Bit Status
Display

To display an alarm mes-
sage according to the PC
(PLC) bit status

Bit memory
table

(1) [Tools]→ [Table]→ [Bit Memory]

Allocate the PC (PLC) bit and a character string
memory table entry (string table) (storing an alarm
message) to the bit memory table entry.

(2) [Tools]→ [Table]→ [String]

Create the alarm message.

(3) [Objects]→ [Alarm]→ [Alarm List]

Create the alarm list and specify the bit memory table
entry in the alarm area.

Alarm
2

Alarm
1

PT
Screen PC (PLC)

Alarm
2

Alarm
1

Character string
memory table
(String table) Alarm

Alarm list Stores alarm messages

7-4

7-3

6-3-1

To display alarm related
information (details and
corrective action) by
touching an alarm mes-
sage

(1) [Tools]→ [Table]→ [String]

Create the alarm message.

(2) [Tools]→ [Image Editor] or [Library Editor]

Register the alarm related information (details and cor-
rective action).

(3) [Tools]→ [Table]→ [Bit Memory]

Allocate the PC (PLC) bit, a character string memory
table entry (string table) (storing an alarm message),
and image/library code to the bit memory table entry.

(4) [Objects]→ [Alarm]→ [List]

Create the alarm list and specify the bit memory table
entry in the alarm area (set a check mark for image/li-
brary display in the alarm list properties.).

PC (PLC)PT

Screen Screen
Temp.
Alarm

Temp.
AlarmPLEASE
CALLNo.012
0

7-3

8-1

8-2

7-4

6-3-1

To store the ON/OFF sta-
tus of a PC (PLC) bit as a
history and check the his-
tory on the screen

(1) [Tools]→ [Table]→ [Bit Memory]

Click the [function] button and choose alarm function.

Allocate the PC (PLC) bit to the bit memory table entry.

Then, set a check mark in the [History] check box in
the function setting.

After that, select the message and the image/library
code to be displayed from the character string memory
table (string table) and the image/library table.

(2) [Objects]→ [Alarm]→ [History]

Create the alarm history.

Alarm 2
Alarm 1

PT

Screen PC (PLC)
Character string
memory table
(string table)

Bit memory
table

Alarm

Alarm 1

Alarm history

7-4

6-3-2
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Item Operation Refer to

PC (PLC)
Word
Status

To display numeral data [Objects]→ [Numeral Display]

Create a numeral display element.

6-6

Status
Display [Objects]→ [Lamp] or [Touch Switch]

Create a lamp or a touch switch for which Numeral Display
is set as the label type.

(Only for NT21, NT31/631-V2 and above)

6-5, 6-8

To display a bar graph [Objects]→ [Graph]→ [Bar Graph]

Create a bar graph.

6-9-1

To display an analogue
meter

[Objects]→ [Graph]→ [Analogue Meter]

Create an analogue meter.

6-9-2

To display a trend graph [Objects]→ [Graph]→ [Trend Graph]

Create a trend graph.

6-9-4

To display a broken-line
graph

[Objects]→ [Graph]→ [Broken-line Graph]

Create a broken-line graph.

6-9-3

To display character string
data

[Objects]→ [String Display]

Create a character string display element.

6-7

[Objects]→ [Lamp] or [Touch Switch]

Create a lamp or a touch switch for which String Display is
set as the label type.

(Only for NT21, NT31/631-V2 and above)

6-5, 6-8
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Item Operation Refer to

Writing
Data to
the PC
(PLC)

To turn PC (PLC) bits ON/
OFF by operation at the
PT

[Objects] -- [Touch Switch] -- [Notify Bit]

Create the touch switch for which the notify input function is
set.

Screen

Notify

PC (PLC)

Bit address

PT

6-8-1

Writing
Data to
the PC
(PLC)

[To write a numeric value]
To input a numeric value
using numeric keys or a
system keyboard.

(1) [Objects]→ [Data Input]→ [Numeral]

Create the numeral setting input field.

(2) [Objects] -- [Touch Switch] -- [Input Key -- Control]

Create a touch switch.

or [Screen] -- [Properties] -- [System Keypad: Ticked]

Display the system keypad.

Note With the NT21, NT31, NT31C, NT631, and NT631C, reg-
ister the system keypad from the symbol manager since
the system keypad cannot be used for these models.

123

Screen
PC (PLC)

Numeral
memory
table

PT

�

123

1
4
7

.
2
5
8

CL

3
6
9

↵
↓

↑
+--Input 123↵

Numeral setting input field

Touch switch (control code input),
or system keypad

6-4-1

6-8-5

5-1-1

[To write a numeric value]
To write a constant using
a touch switch

(1) [Objects] -- [Touch Switch] -- [Function: Copy Setting]

Create a touch switch for which the copy function is set,
and copy a constant to a numeral memory table entry us-
ing this touch switch.

(2) [Objects] -- [Numeral Display]

Display the contents in the copy destination numeral
memory table entry.

Numeral
memory
table

123123

Constant:
123

Numeral display
Touch switch (copy function)

PT

Screen
PC (PLC)

123

6-8-6

6-6
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Item Operation Refer to

Writing
Data to
the PC
(PLC)

[To write a numeric value]
To write a constant to a
numeral setting input field

(1) [Objects] -- [Data Input] -- [Numeral]

Create a numeral setting input field.

(2) [Objects] -- [Touch Switch] -- [Function: Copy Setting]

Create a touch switch for which the copy function is set,
and copy a constant to a numeral memory table entry us-
ing this touch switch (Copy To = Cursor Position).

Numeral
memory
table

123123

Constant:
123

Numeral setting input field
Touch switch (copy function)

PT

Screen
PC (PLC)

123↵

6-4-1

6-8-6

[To write a numeric value]
To input a numeric value
using thumbwheel switch

[Objects] -- [Data Input] -- [Thumbwheel Switch]

Create a thumbwheel switch.

PT
Numeral
memory
table

Screen

--
1 2 3

-- --

+ + + 123

PC (PLC)

123

6-4-3

[ To write a character
string]
To input a character string

(1) [Objects] -- [Data Input] -- [String]

Create a character string input field.

(2) [Objects]→ [Touch Switch]→ [Function: Input Key -- Con-
trol] or

[Objects]→ [Touch Switch]→ [Function: Input Key --
String]

Create a touch switch for which the control code input
function or the character string input function is set.

Touch switch (control code input)

A

ABC

PC (PLC)

PT

�

ABC

�
B

H
G
F
E

L
K
J
I

↵
↓
↑

SP ABC↵

Touch switch (character string input)

Character string input field

Character string
memory table
(String table)

Input

Screen

6-4-2

6-8-5

6-8-3
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Item Operation Refer to

Writing
Data to
the PC
(PLC)

[To write a character
string]
To copy between charac-
ter string memory table
entries (string table) with
one touch switch

(1) [Objects] -- [Touch Switch] -- [Function: Copy Setting]

Create a touch switch for which the copy function is set,
and copy the content of a character string memory table
entry (string table) to another character string memory
table entry (string table).

(2) [Objects] -- [String Display]

Display the content of the character string memory table
entry (string table).

ABC

ABC

PT

ABC

Character string display

Screen
Character string
memory table
(String table)

Touch switch (copy function)

6-8-6

6-7

Writing
Data to
the PC
(PLC)

To disable the input ac-
cording to the ON/OFF
status of a PC(PLC) bit

(1) [Objects]→ [Data Input]→ [Numeral],[String],[Recipe]
or [Thumbwheel Switch]
Create a data input object and set Interlock on.

(2) Turn OFF the PC (PLC) bit to which the interlock is
allocated to disable from inputting.

123

Screen PC (PLC)
Numeral
memory
table

PT

*

123

�

Q

Input Bit

Numeral setting input field

Touch switch (control code input),
or system keypad

Disable the input

(Only for NT21, NT31/631-V2 and above)

It is possible to disable the input into a data input object by
using Numeral/Character string input flag in PT status con-
trol bits.

(Except NT20S and NT600S)

↵

4
7

.
2
5
8

3
6
9

↵
↓

↑
+--

6-1-12

To store calculated result
in numeral table entry

(1) [Tools]-[Mathematical Table]

Click on Set button to specify the formula for calculation and
set result to specific Numeral table entry.

7-9

To store calculated result
in a specified PLC ad-
dress

(1) [Tool]-[Mathematical Table]

Click on Set button to specify the formula for calculation and
set result to specific plc address.

7-9

To store more than one
value in a specified PLC
address

(1) [Tools] -- [Recipe Table]

Create Recipe entry.

(2) [Objects] -- [Data Input] -- [Recipe]

Create Recipe object referring to the Recipe entry. In Settings
properties, check Show Window/Keyboard Screen and set
screen number to display keypad. Create window screen con-
taining keypad.

6-11-1
7-10
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Item Operation Refer to

Image To modify the size of an
image data

(1) Specify the area of an image data to be shrunk or ex-
panded on the image editor.

(2) Drag one of the green handles (J) displayed on the
range specifying frame to modify the size of an image
data.

8-1

Label To display a label in multi-
ple lines

[Objects]--[Lamp] or [Touch switch]

Create a lamp or a touch switch for which Static or On Off
Static is set as the label type.

(NT21, NT31/631-V2 and above)

6-5, 6-8

To change the contents
and the position of a label
according to the ON/OFF
status of the lamp bit

(1) [Objects]→ [Lamp] or [Touch Switch]

Create a lamp or a touch switch for which On Off
Static is set as the label type

(2) Turn the PC (PLC) bit to which the lamp is allocated
ON/OFF.

DEF

Screen

PT

ABC

PC (PLC)

Bit

If OFF

Lamp or touch switch with On Off static label

If ON

(Only for NT21, NT31/631-V2 and above)

6-5, 6-8

To change the contents of
a label according to the
values in PLC memory

[Objects]--[Lamp] or [Touch switch]

Create a lamp or a touch switch for which Numeral Display
is set as the label type.

(Only for NT21, NT31/631-V2 and above)

6-5, 6-8

[Objects]--[Lamp] or [Touch switch]

Create a lamp or a touch switch for which String Display is
set as the label type.

(Only for NT21, NT31/631-V2 and above)

6-5, 6-8

To insert image data and
library data into a string
with NT21, NT31/631-V2
and above

[Tool]→ [PT Configuration]

Enable NT20/30/620 Compatible Mode.

(The range of image/library data is as the same as
NT30/620 series in NT20/30/620 Compatible Mode.)

3-3,
APPENDIX A

Lamp To centralize the lamp la-
bel

Specify the lamp to be centralized and select [Draw]→
[Centralize Label]

6-1-9
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Touch
Switches

To create numeric keys (1) [Objects] -- [Data Input] -- [Numeral]

Create a numeral setting string input field.

(2) [Objects]→ [Touch Switch]→ [Function: Input Key --
Control]

Create numeric keys using touch switches for which
the control code input function is set

PT

Numeral setting input field

Touch switch
(control code input)

Screen

�

123

CL

Input
4
7

.
2
5
8

3
6
9

↵
↓

↑
+--

1

6-4-1

6-8-5

To display numeric keys
as a pop-up window/key-
board by touching a nu-
meral input field

(1) [Objects]→ [Data Input]→ [Numeral]

Create a numeral input field, where a cursor moving
touch switch is automatically set.

(2) Specify the automatically created touch switch and add
the window/keyboard screen display function by setting
properties.

Pop-up window

PT

123

ScreenScreen

123 123

PT

CL

4
7

.
2
5
8

3
6
9

↵
↓

↑
+--

1
0

6-4-1

6-8-4

To switch the objective in-
put field among multiple
numeral setting input
fields arranged in a
screen in response to the
touching of a numeric set-
ting input field.

[Objects] -- [Data Input] -- [Numeral]

Create the cursor moving touch switches automatically.

Screen

5678

Screen

PTPT

1234

Input objective field

5678

1234

6-4-1
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Touch
Switches

To switch the objective in-
put field among multiple
numeral setting input
fields arranged in a
screen using the arrow
symbol [↑] and [↓] keys.

(1) [Objects]→ [Data Input]→ [Numeral]

Create a numeral setting input field.

(2) [Objects]→ [Touch Switch]→ [Function: Input Key --
Control]

Create the [↑] and [↓] touch switches.

Input objective field

ScreenScreen
PTPT

↓ 5678

1234 1234

5678

↑

↓

↑

6-4-1

6-8-5

To copy between numeral
memory table entries or
character string memory
table entries (string table)
with one touch switch

[Objects] -- [Touch Switch] -- [Function: Copy Setting]

Create a touch switch for which the function to copy char-
acter strings or numeric values between character string
memory table entries (string table) or numeral memory
table entries.

ABC

ABC ABC

PT
Character string display

Screen
Character string
memory table
(String table)

Touch switch (copy func-
tion)

6-8-6

To set a constant (fixed
numeral), including initial-
ization and clear, using a
touch switch

[Objects] -- [Touch Switch] -- [Function: Copy Setting]

Set a constant for Code/No. of “Copy From” and a numeral
memory table entry or a numeral setting input field for
“Copy to.”

PT

123

Screen
Numeral
memory
table

Constant:
123

Touch switch (copy function)

6-8-6

To set a constant or a
content of a numeral
memory table entry for a
numeral setting input field

(1) [Objects] -- [Data Input] -- [Numeral]

Create a numeral setting input field.

(2) [Objects] -- [Touch Switch] -- [Function: Copy Setting]

Set a numeral memory table entry or a constant for
“Copy From” and a numeral setting input field for “Copy
To.”

PT

123

Constant: 123Screen

Numeral setting input field
Touch switch (copy function)

6-4-1

6-8-6
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Item Operation Refer to

Touch
Switches

To print a hard copy of the
screen

(1) [Tools]→ [PT Configuration]

Set the printer to be connected.

(2) [Objects]→ [Touch Switch]→ [Function: Print Screen]

Create a touch switch for which the print screen func-
tion is set.

Screen

PT

Touch switch
(print screen) function

3-3-1

6-8-9

To stop the buzzer sound
using a touch switch

[Objects]→ [Touch Switch]→ [Input Key -- Control]

Create a touch switch for which the “stop buzzer” code of
the PT is set.

PT

Screen

Stopping buzzer
sound

Touch switch (control code input func-
tion)

6-8-5

To display the PT’s sys-
tem menu using a touch
switch

[Objects] -- [Touch Switch] -- [Input Key -- Control]

Create a touch switch for which the menu display is set.

PT PT

Touch switch (control code input func-
tion)

Screen

System
Menu

6-8-5
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Item Operation Refer to

Touch
Switches

To input a different string
from the label

[Objects]--[Touch Switch]--[Input Key--String]

Create a touch switch for which a different string from the
label is set as the Input key string.

NT31C--ST141B--V2

PT
Character string input field

Screen

Touch switch (string input)

NT31C(Black)
input

(Only for NT21, NT31/631)

6-8-3

To centralize the touch
switch label

Specify the touch switch to be centralized and select [Draw]
→ [Centralize Label]

6-1-9

To disable the touch
switch input according to
the ON/OFF status of a
PC (PLC) bit

(1) [Objects]--[Touch Switch]Create a touch switch for
which interlock is set.

(2) Turn OFF the PC (PLC) bit to which the interlock is
allocated to disable the input.

456

Constant:
123

Numeral setting input field
Touch switch (copy function)

PT

Screen
PC (PLC)

Bit

Disable the input

(Only for NT21, NT31/631-V2 and above)

6-1-12

Extended
Input/Out-
put (NT30/
NT30C
only)

To switch the displayed
screen using an external
switch

[Tools]→ [Table]→ [Extended I/O input]

Set the screen switching function for an extended I/O input
table entry.

PT

Screen No. 2

Screen No. 1

7-5
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Extended
Input/Out-
put (NT30/
NT30C
only)

To notify the PC (PLC) of
the ON/OFF status of an
external switch

[Tools]→ [Table]→ [Extended I/O input]

Set the Notify Bit Function for an extended I/O input table
entry.

PC
(PLC)

Extended
I/O table

PT

Extended input

7-5

To input a numeric value
using an external switch
(numeric keys, etc.)

(1) [Objects]→ [Data Input]→ [Numeral]

Create a numeral setting input field.

(2) [Tools]→ [Table]→ [Extended I/O input]

Set the control code input function for an extended I/O
input table entry.

PT
Extended input
(control code input function)

123

Numeral setting input field of
numeral setting element

CL

4
7

.
2
5
8

3
6
9

↵
↓

↑
+--

1
0

6-4-1

7-5

To turn ON/OFF the lamp,
connected to a PT, ac-
cording to the status of a
PC (PLC) bit

[Tools]→ [Table]→ [Extended I/O Output]

Set a PC (PLC) bit for an extended I/O output table entry.

Extended
I/O table

PT

Extended I/O output

PC (PLC)

7-6

To output the status of a
touch switch to an exter-
nal device

(1) [Objects] -- [Touch Switch] -- [Function: Notify Bit]

Create a touch switch and notify the PC (PLC) of the
status of the touch switch.

(2) [Tools]→ [Table]→ [Extended I/O Output]

Set the same PC (PLC) bit as the one set in (1) above
for an extended I/O output table entry.

Extended
output

Extended
I/O table

PT PC (PLC)

Ladder

Touch switch
(notify bit function)

6-8-1

7-6

Operations To change grids [Screen] -- [Grid] 5-1-2

To copy a created graphic (1) Specify the graphic to be copied.

(2) [Edit]→ [Copy]

(3) [Edit]→ [Paste]

6-1-5

If screen data of the same PT model setting is opened by
[Import Component] from the [File] menu, copy & paste
operation above is possible between the Support Tools.

3-3-6
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Item Operation Refer to

Operations To copy the screen data (1) Using the application manager, select the file of the
screen to be copied.

(2) [Edit]→ [Copy]

(3) [Edit]→ [Paste]

(4) Specify the copy destination screen number.

4-2

(1) Display the copy source screen

(2) [Edit]→ [Select All]

(3) [Edit]→ [Copy]

(4) Open the copy destination screen

(5) [Edit]→ [Paste]

6-1-5

If screen data of the same PT model setting is opened by
[Import Component] from the [File] menu, copy & paste
operation above is possible between the Support Tools.

3-3-6

To copy image/library data (1) Selected the code to be copied on the image/library
table entry.

(2) [Edit]→ [Copy]

(3) Select the code to be pasted.

(4) [Edit]→ [Paste]

8-1

8-2

If screen data of the same PT model setting is opened by
[Import Component] from the [File] menu, copy & paste
operation above is possible between the Support Tools.

3-3-6

To group several graphics
into one graphic

(1) Select all graphics to be grouped.

(2) [Draw]→ [Group]

Note Use the following commands to ungroup the grouped
graphics: [Draw]→ [Ungroup]

6-1-7

To specify the graphic that
is behind another ele-
ment/graphic

Click the different position so that the graphic at the back
side is selected.

Note The element with the smallest area enclosing the point
of selection will be selected.

6-1-3

(1) Select the graphic at the front side.

(2) [Draw]→ [Send to Back]

(3) Specify the graphic brought to the front side.

6-1-5

(1) Select the graphic at the front side.

(2) [Edit]→ [Select Object]

(3) Select the graphic to be specified in the list.

6-1-3

Keep pressing the Tab key (or Shift key + Tab key) until the
objective graphic is selected.

6-1-3

Specify the objective type of element on a filter and select
the graphic by the method above.

5-1-4

To display only the se-
lected type of element to
facilitate the screen edit-
ing of complicated screen

Specify the type of element to be displayed using a filter
(on the utility bar). (During the filter function, only the dis-
played element can be edited.)

5-1-4

To align the position of the
graphics correctly

(1) Select all the graphics to be aligned.

(2) [Edit]→ [Align] and select the aligning method.

6-1-6
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Operations To change the PC (PLC)
words/bits in batch

[Tools]→ [Table]→ [Change Address]

Change the word (address) and bit numbers in a batch.

7-1-3

To use the created data in
other applications

(1) [Window]→ [Symbol Manager]

Start the symbol manager and register the created
data.

(2) Open other applications.

(3) [Window]→ [Symbol Manager]

Start the symbol manager and read the registered
data.

6-10

[File]→ [Import Component]
Start up the second Support Tool.
Perform copy & paste operation of graphic between the
screen data files.
(Between the files of the same PT model setting only)

3-3-6

To store large data in a
FD.

[File]→ [Save] or [Save As]

Save data in Memory Map Image File (*mmi) format.

3-3-3

To use I/O comments in
ladder program.

[Tools]→ [Import I/O comments]

Import I/O comments file of ladder program.

7-7-3

To check the flash display on the screen [View]→ [Simulate Flash]
Elements with a flash attribute flashes.

5-1-3

To check the lamp ON status of lamps/
touch switches on the screen

[View]→ [Simulate ON/OFF]
Lamp ON status of lamps/touch switches is displayed.
([Simulate Flash] mentioned above can be used at the
same time.)

5-1-3

To specify whether or not to inverse the
screen color or to print screen grid/
dotted line for Screen Image printing
(without changing the screen property).

In Screen Image Attribute of Screen Image printing, set
“Inverse Print,” Hide Screen Grid” or “Show Dotted Line
Frame” items as required.

12-1-6

To display time [Objects]→ [Numeral Display]

Specify numeral memory table entries No. 247 to No. 253
(time data) to display the time.

6-6

To set the time to be displayed (1) [Objects]→ [Data Input]→ [Numeral]

Set the time to be written to a numeral memory table
entry.

(2) [Objects]→ [Touch Switch]→ [Function: Copy Setting]

Copy the memory table contents where the time is set
to numeral memory table entries No. 254 and No. 255
(time setting).

6-4-1

6-8-6

To display the display history of PT The display history is displayed by calling the following
screen numbers.

NT30, NT30C, NT600S, NT620S, NT620C, and NT625C:
No. 1997, No. 1998

NT21, NT31, NT31C, NT631, and NT631C: No. 9001, No.
9002

The history is displayed in either the order of occurrence or
order of frequency.

5-6

5-7

To sound a buzzer at the occurrence of
an error

[Tools]→ [PT Configuration]

Set “On Error” for the buzzer setting.

3-3-1
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To upload/download the screen data
without modifying the contents

Use the NT Transfer Utility supplied with the Support Tool
on CD-ROM.
(The screen data should be saved in mmi format.)

Appendix C

To display calculated numeric value [Tool]--[Mathematical Table]

Define formulas that are used for calculations on PT.

(Only for NT21, NT31/631-V2 and above)

7-9
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SECTION 11
Data Communications with a PT

This section describes the procedure for sending the created and edited screen data to a PT to register them in the PT and also
the procedure for reading the data registered in the PT.

11-1 Preparation for Data Communications with a PT and Data Communication Procedure 428. .
11-1-1 Connection to PT 428. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-1-2 Available Data Communication Methods by PT Models 428. . . . . . . . . . . . . . . . . . .
11-1-3 Data Communication Procedure 430. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

11-2 Communication Setting at the Support Tool 430. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-3 Sending (Downloading) the Data 431. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-4 Receiving (Uploading) Data 434. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-5 Receiving (Uploading) the History Record 437. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
11-6 Setting and Reading the Date and Time 438. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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11-1 Preparation for Data Communications with a PT and Data
Communication Procedure

11-1-1 Connection to PT
To send/receive data between a PT and the NT-series Support Tool (personal
computer), connect them with a cable.

S Cable

The recommended communication cable supplied by OMRON has a 25-pin
RS-232C connector at the end for connection to a personal computer. To con-
nect to a PC/AT compatible personal computer that has a 9-pin (female) con-
nector, use a 25-pin to 9-pin conversion adapter available on the market.

Recommended cable is in the Appendix J.

S Connection

Connect the RS-232C connector at the personal computer to the Support Tool
connection port at the PT.

For the location of the connection port in the PT, refer to the Appendix of the
User’sManual of thePT.With somemodels of PT, it is necessary to disconnect
from the host before connecting the Support Tool.

An example of connection is shown below assuming NT31/NT31C.

RS-232C, 9 pins

11-1-2 Available Data Communication Methods by PT Models
Data communication is possible by the two methods indicated below.

S Batch transmission of all screen data

S Data transmission in screen and data units (individual transmission)

Whether or not individual data transmission is possibledependson thePTmodel
as shown below.

PT Model Batch Transmission Individual Transmission

NT11S f ¢

NT20S f f

NT21 f f

NT600S f f

NT30 f ¢

NT30C f ¢

NT620S f ¢
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PT Model Individual TransmissionBatch Transmission

NT620C, NT625C f ¢

NT31 f f

NT31C f f

NT631 f f

NT631C f f

f: Possible ¢: Not possible

Reference: The type and content of individual transmission differs between the NT20S/
NT600S and theNT21, NT31, NT31C, NT631, andNT631C. For details, refer to
11-3 Sending (Downloading) the Data and 11-4 Receiving (Uploading) Data.

In case of NT31, NT31C,NT631 andNT631C, screen data file that can be trans-
mitted is as followsdependingon theversionofPThardwareand thesystempro-
gram version installed in a PT.

Use the method below to check the system program version of a PT (For details
of the operation of a PT, refer to the manual of PT).

(1) Display the system menu on a PT.

(2) At the upper right position of the system menu screen, its version is dis-
played, like “Ver.2.10.” If you are using NT31, NT31C, NT631 or NT631C, it
is also possible to check the PLC vendor by selecting [Expansion Mode]→
[Version Display].

Type of PT
Hardware

NT31, NT31C, NT631, NT631C
below “-V1”

NT31, NT31C, NT631, NT631C
“-V1” and above

PT model
selected at
Support Tool

System
program
Ver.1.0

System
program
Ver2.0

System
program
Ver2.1

System
program
Ver3.1

System
program
Ver1.0

System
program
Ver2.0

System
program
Ver2.1

System
program
Ver3.1

NT31, NT31C, NT631,
NT631C without “-V1” f f f f ∆1 ∆1 ∆1 ∆1

NT31, NT31C, NT631,
NT631C “-V1” ¢ ∆2 ∆2 ∆2 ¢ f f f

NT31, NT31C, NT631,
NT631C “-V1 (System
Ver.2.1)”

¢ ¢ ∆2 ∆2 ¢ ¢ f f

NT31, NT31C, NT631,
NT631C “-V2 (System
Ver.3.1)”

¢ ¢ ¢ ∆2 ¢ ¢ ¢ f

f : Downloading/Uploading is possible (Both Batch Transmission and Individ-
ual Transmission are possible).

¢: The message shown below is displayed on transmitting.
Application version mismatched; communication aborted.

∆1: Messagewarningyouabout32dot font and font type ISO-8859 isdisplayed
on transmitting. If this combination is selected, 32 dot font and font type
ISO-8859 are displayed on a PT but they are not available on the Support
Tool.

∆2: Messagewarningyouabout32dot font and font type ISO-8859 isdisplayed
on transmitting. If this combination is selected, 32 dot font and font type
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ISO-8859 are displayed on the Support Tool but they are not available on a
PT (16x16 font and CP437 font type are used on the PT).

Note) If the vendor (manufacturer) of the PLC you are using and the PLC ven-
dor settingof thecreatedscreendata isdifferent, transmission is notpos-
sible. The following message is displayed.
Memory access mismatched: communication aborted

11-1-3 Data Communication Procedure

The procedure for transmitting data between a PT and the Support Tool is indi-
cated below.

Setting for communications at Support Tool

Set theRS-232Cport and baud rate at theSupport Tool (personal computer).

↓

Set PC (PLC) to Transmit mode

Place the PT in the Transmit mode to allow communications of the data be-
tween the PT and the personal computer.

For details of this procedure at PT, refer to the User’s Manual of your PT.

↓

Selecting the data to be sent/received

From the menu at the Support Tool, select the direction of data transmission
(download/upload) and the kind of data to be transmitted. Depending on the
data, more detailed selection may be possible.
After the data has been determined, data transmission will start.

11-2 Communication Setting at the Support Tool
Set the baud rate and communication port at theSupport Tool (personal comput-
er)

Operation procedure

(1) Select [Connect] (menu bar)→ [Comms. Setting].

The communication dialog box is displayed.

(2) Set the data for the displayed items.

The meanings of the items are described below.
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Item Description

COM Port Specify the RS-232C port to be used.
Specify either COM1, COM2, COM3, or COM4.

Baud Rate Set the data communication rate.
If “38.4 Kbps (High)” is set, high-speed data communica-
tion is possible. (Not available for NT11S.)
It is recommended to specify “9.6 Kbps (Standard)” to en-
sure error-free communication if a communication error
occurs due to an inadequate communication environment.
Data communication at the “9.6 Kbps (Standard)” setting
will take about twice the time required in the “38.4 Kbps
(High)” setting.
If the PT is set to the NT21, even faster communications
are possible by selected 115 Kbps.

Verify Select this item by setting a check mark in the check box if
you want to check the communication data at the same
time it is transmitted. Please note that this setting is al-
lowed only for NT11S, NT20S and NT600S.

(3) After completing the setting for all items, click on .

11-3 Sending (Downloading) the Data

To send (download) the data created or edited by the Support Tool to a PT, follow
the steps shown below.

The type of data that can be sent is indicated in the table below.

Data Type Description

Application (in file units) All data is sent in batch.

Screen Data is sent in units of a screen.
It is possible to send the data of several
screens at a time.
When sending the data of a parent screen, you
can specify whether or not the data of the child
screens should be sent with the parent screen
data.

Direct Access Information NT20S and NT600S:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area, numeral/character string memory
table (string table), etc.

NT21:
Information on the PC (PLC) addresses allo-
cated to PT status control area, PT status
notify area, and window control area.

NT31, NT31C, NT631, and NT631C:
Information of the PC (PLC) addresses allo-
cated to PT status control area, PT status
notify area and window control area (models
with “-V1” and above).
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Data Type Description

System Memory*1 The setting contents of “System” of “PT Config-
uration” are sent and set at the PT.

Table*2 NT20S and NT600S:
The following data is sent in a batch.
S Numeral memory table data

S Character string memory table (String table)
data

S Mark data

NT21, NT31, NT31C, NT631, and NT631C:
The following data can be sent individually.
S Numeral memory table

S Character string memory table (String table)

S Bit memory table

S Mark data

S Image data

S Library data

S Recipe table

*1: With theNT21,NT31,NT31C,NT631andNT631C, individual transmission
of system memory is restricted as follows:

The following data stored in a PT cannot be overwritten.

S Number of numeral table entries

S Number of string table entries

S Number of bit memory table entries

S Screen history setting

S Alarm history setting

S Numeral storage type

The following data can be overwritten.

S Initial screen number

S Screen data comment

*2: You cannot transmit the mathematical table separately. The mathematical
table will be transmitted only when application transmission is performed.

Reference: S When data is sent from the Support Tool to a PT, the existing data in the PT is
lost. Therefore, make sure that the existing data in the PT is backed up by the
Support Tool before executing data transmission from the Support Tool to the
PT.

S With the Support Tool on CD-ROM, NT Transfer Utility that is exclusively used
for downloading/uploading the screen data is supplied (For details, refer toAp-
pendix C).

Operation procedure

(1) Select [Connect] (menu bar)→ [Download (NT-series Support Tool→PT)].
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The menu is displayed, allowing you to select the data to be sent.

The items that can be selected vary according to the PT model.

Selection of “Screen” is not possible if screen data is not selected.

(Pressing Ctrl key + Shift key + D executes Application downloading.)

(2) Select the data to be sent.

Data transmission timing is determined according to the type of data se-
lected to be sent.

Data Type Description

Application (in file units) Data transmission starts immediately.

Screen If a parent screen is included in the
screens selected to be sent, a dialog box is
displayed requesting you to specify wheth-
er child screens are sent with the parent
screen.
Set a check mark for the “Include Child
Screen” item if you want to send the child
screens with the parent screen.
Data transmission starts when is
clicked.

Direct Access Information Data transmission starts immediately.

System Memory Data transmission starts immediately.

Table NT20S and NT600S:
Data transmission starts immediately.

NT21, NT31, NT31C, NT631, and
NT631C:
The dialog box where the information to
be sent is specified is displayed.
Only the information for which a check
mark is set is sent.
Data transmission starts when
is clicked.

(3) Place the PT in the Transmit mode so that the data sent from the Support
Tool can be received.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at the Support Tool. In this case, set the PT in the Transmit mode and
click on in the error message dialog box.

(4) While the data is being sent to the PT, the progress of data transmission is
indicated by a bar graph.

To abort the operation, click on .

Reference: If data transmission is aborted, it is necessary to initialize the imagedatamemory
in the Maintenance mode (SystemMenu). Execute the same processing if data
transmission is interrupted due to trouble.

When sending all the screen data (Application), initialization is not necessary
since initialization is automatically executed.
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CAUTION

When transferring the data in units of screens, if there are changes in a

memory table and /or direct access, transfer such data along with the

screen data.

Otherwise the system may operate unpredictably.

11-4 Receiving (Uploading) Data
To receive (upload) data stored in a PT at the Support Tool as the screen data
being edited, follow the steps shown below.

The type of data that can be received is indicated in the table below.

Data Type Description

Application (in file units) All data is sent in batch.

Screen Data is received in units of a screen.
It is possible to receive the data of several
screens at a time.
When receiving the data of a parent screen,
you can specify whether or not the data of the
child screens is to be received with the parent
screen data.

Direct Access Information NT20S and NT600S:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area, numeral/character string memory
table (string table), etc.

NT21:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area, and window control area.

NT31, NT31C, NT631, and NT631C:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area and window control area (models
with “-V1” and above).
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Data Type Description

System Memory*1 The contents of “System” set at the PT are re-
ceived and set for “System” of “PT Configura-
tion.”

Table*2 NT20S and NT600S:
The following data is received in a batch.
S Numeral memory table data

S Character string memory table (String table)
data

S Mark data

NT21, NT31, NT31C, NT631, and NT631C:
The following data can be received individually.
S Numeral memory table data

S Character string memory table (String table)
data

S Bit memory table data

S Mark data

S Image data

S Library data

S Recipe table

*1: With theNT21,NT31,NT31C,NT631andNT631C, individual transmission
of system memory is restricted as follows:

The following data stored in the Support Tool can not be overwritten.

S Number of numeral table entries

S Number of string table entries

S Number of bit memory table entries

S Screen history setting

S Alarm history setting

S Numeral storage type

The following data can be overwritten.

S Initial screen number

S Screen data comment

*2: It is not possible to perform individual transmission of the mathematical
table. The mathematical table will be transmitted only when application
transmission is performed.

Reference: S When the Support Tool receives data from a PT, the data being edited at the
Support Tool is lost. Therefore, make sure that the edit data is saved in a file
before executing data receiving from the PT to the Support Tool.

S With the NT21, NT31, NT31C, NT631, and NT631C, individual uploading of
tables is possible. However, it may take time to upload the bit memory table. In
this case, perform batch transmission of the application (in file units).
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S With the Support Tool on CD-ROM, NT Transfer Utility, which is exclusively
used for downloading/uploading the screen data, is supplied (For details, refer
to Appendix C).

Operation procedure

(1) Select [Connect] (menu bar)→ [Upload (PT→ NT-series Support Tool)].

The menu is displayed, allowing you to select the data to be received.

The items that can be selected vary according to the PT model.

(Pressing Ctrl key + Shift key + U executes Application uploading.)

(2) Select the data to be received.

The data receiving timing is determined according to the type of data se-
lected to be received.

Data Type Description

Application (in file units) Data receiving starts immediately.

Screen If a parent screen is included in the
screens selected to be received, a dialog
box is displayed requesting you to specify
whether child screens are to be received
with the parent screen.
To specify multiple screens in batch, speci-
fy the screen numbers in the manner “1, 3 -
5, 7,” delimiting them with commas “,” and
hyphens “–”.
Set a check mark for the “Include Child
Screen” item if you want to receive the
child screens with the parent screen.
Data receiving starts when is
clicked.

Direct Access Information Data receiving starts immediately.

System Memory Data receiving starts immediately.

Table NT20S and NT600S:
Data receiving starts immediately.

NT21, NT31, NT31C, NT631, and
NT631C:
The dialog box is displayed where the
information to be received is specified.
Only the information for which a check
mark is set is received.
Data receiving starts when is
clicked.

(3) Place the PT in the Transmit mode so that the data can be transmitted to the
Support Tool.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at the Support Tool. In this case, set the PT in the Transmit mode and
click on in the error message dialog box.

(4) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph.

To abort the operation, click on .
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11-5 Receiving (Uploading) the History Record
It is possible to receive (upload) the display history recorddata and the alarmhis-
tory record data, recorded in a PT, at the Support Tool to save them in a file.

The type of history record data that can be received is indicated in the table be-
low.

PT Model Screen Display
History Record Data

Alarm History
Record Data

NT11S, NT20S ¢ ¢

NT30, NT30C, NT600S,
NT620S, NT620C, NT625C f ¢

NT21, NT31, NT31C, NT631,
NT631C f f

The received history record data is saved in a desired folder by assigning a file
name. The extension of the file name is fixed as .LOG.

Since the file is described in a special format, the contents cannot be read using
Windows general application tools.

Reference: Thehistory record data file (.LOG) canbeoutput to a printer, saved in anRTF file,
or output to the screen, using the [Print] function or the [Print Preview] function of
the Support Tool.

To analyze the history record data using other software, convert the file into an
RTF file so that it can be read by other software.

Operation procedure

(1) Select [Connect] (menu bar)→ [Get History Log].

The menu is displayed, allowing you to select the history record to be re-
ceived.

The items that can be selected vary according to the PT model.

(2) Select the history record to be received.

The dialog box for setting the file name for saving the history record is dis-
played.

(3) Set the folder and file namewhere the history record is to be saved and click
on .

Receiving of the history record data starts.

(4) Place thePT in theTransmitmode so that it can send the data to theSupport
Tool.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at the Support Tool. In this case, set the PT in the Transmit mode and
click on in the error message dialog box.

(5) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph.

To abort the operation, click on .
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11-6 Setting and Reading the Date and Time
It is possible to set the date and time to PT from the Support Tool or to read the
date and time from the PT to display them at the Support Tool.

The functions that can be used are indicated below.

PT Model Setting Date/Time Reading Date/Time

NT11S, NT20S, NT600S ¢ ¢

NT21 ¢*1 ¢*1

NT30, NT30C, NT620S,
NT620C, NT625C f f

NT31, NT31C, NT631,
NT631C ¢*2 ¢*2

*1: The NT21 can read clock data from the PLC.

*2: PT has the clock function. For displaying and setting the date/time at a PT,
use the System Menu.

Operation procedure

(1) Select [Connect] (menu bar)→ [Date and Time].

The date and time dialog box is displayed.

Current Date & Time

Displays the date and time at the time the dialog box is displayed.

Date

This area is used for sending/receiving date data to/from a PT.

To set the date at a PT, set “Year, Month, Day, and Day of Week” here and
execute sending (downloading).

Click the button to download it to the PT.

To read the date data of a PT, execute receiving (uploading) and the result is
displayed here.

Click the button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are dis-
played.

Time

This area is used for sending/receiving the time to/from a PT.

To set the time at a PT, set “Hour, Minute, and Second” here and execute
sending (downloading).
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Click the button to download it to the PT.

To read the time data of a PT, execute receiving (uploading) and the result is
displayed here.

Click the button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are dis-
played.

Used to download the date and time data, set at [Date] and [Time], to a PT to
set them.

Used to upload the date and timedata in aPTanddisplay themat [Date] and
[Time].

(2) To set the date and timeat aPT, set the data at [Date] and [Time] and click on
.

To read the date and time of a PT, click on .

Data transmission starts when or is clicked.

(3) Place the PT in the Transmit mode so that communications between the
Support Tool and the PT are enabled.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at the Support Tool. In this case, set the PT in the Transmit mode and
click on in the error message dialog box.

(4) In the case of receiving (uploading), the date and time data that have been
read from the PT are displayed at [Date] and [Time].
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SECTION 12
Making Reports

TheSupport Tool provides a function for displaying various kinds of data, such as screen data andmemory table use status, in
the form of a list, and printing them.

12-1 Report Types 442. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-1 Cross-References 443. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-2 Direct Connection Information 444. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-3 History Report 445. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-4 Image/Library Report 445. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-5 Mark List 446. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-6 Screen Image 446. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-7 Screen List 447. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-8 Table Report 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-9 Validation Report 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-10 Mathematical Report 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-1-11 Recipe Report 449. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

12-2 Printing Reports 449. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-2-1 Printer Setting 449. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-2-2 Output to a Printer 450. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-2-3 Output to a File (RTF) 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

12-3 Displaying the Print Image (Preview) 456. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
12-4 Outputting the Screen Image 457. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .
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12-1 Report Types
The Support Tool outputs the following types of report.

S Cross-Reference

S Direct Connection Information

S History Report

S Image/Library Report

S Mark List

S Screen Image

S Screen list

S Table Report

S Validation Report

Output of these reports can be selected from the following three types (use [Print
Preview] for outputting to the display).

Printer:

Screen image, setting data, etc. are output to a printer.

Rich Text Format (file):

Various setting data, etc. are output to a file in RTF.

Display (print preview):

Screen image, setting data, etc. are displayedon the screenbefore output
to a printer.

The screen image can be output to a file in bit map format using the [Screen]
(menu bar)→ [Copy to Image]. (Refer to 12-4 Outputting the Screen Image.)
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12-1-1 Cross-References
The use statuses ofmemory tables such as the numeralmemory table and char-
acter string memory table (string table) are printed or displayed.

The cross-reference allows you to find the screens where a specific memory
table is used.
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12-1-2 Direct Connection Information
Direct connection information is printed or displayed.

This report is availableonlywhen thedirect connectionsettingdatahasbeenset.
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12-1-3 History Report
By specifying the display history record file or the alarm history record file, sent
from a PT, the history record data can be printed or displayed.

Thehistory record that canbe readby theSupport Tool dependson thePTmodel
as shown below (refer to 11-5 Receiving (Uploading) the History Record).

NT30, NT30C, NT600S, NT620S, NT620C, NT625C

S Screen display history record

NT21, NT31, NT31C, NT631, NT631C

S Screen display history record

S Alarm history record

[Screen History Report] � Filename::�HistoryReport.rtf 98/05/01 12:51 P.445

[Screen History of Occurrence]
Screen No Month Day Hour Minute Comments
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2
1 4 15 19 58 HISTORY TITLE
2 4 15 19 58 HISTORY TITLE 2

[Screen History of Frequence]
Screen No Count Comments
1 10 HISTORY TITLE
2 10 HISTORY TITLE 2

12-1-4 Image/Library Report
A list of the image data and the library data is printed or displayed.

Type Code Compression Color Mode Size Comments
Image 1 Yes 8 Colors 64x48
Image 2 Yes 8 Colors 64x48
Library 1000 -- -- 200x200
Library 1001 -- -- 200x200
Library 1002 -- -- 200x200
Library 1003 -- -- 200x200
Library 1004 -- -- 200x200
Library 1005 -- -- 200x200

[Image/Library List] � Filename: �Filename:Image-Library.rtf 98/04/30 22:01 P.445
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12-1-5Mark List
A list of mark data is printed or displayed.

[Mark List] � Filename: Filename:MarkList.rtf 98/04/30 22:01 P.446

Reference: In the case that the font size for Display Properties of Control Panel is set to large
font, it may be printed while part of mark list is being chipped off. When it occurs,
please select [Start] -- [Settings] -- [Control Panel], then open theDisplayProper-
ties and set the font size in Setting to small font, and perform themark list printing
(displaying).

12-1-6 Screen Image
The screen image and the setting contents of a screen are printed or displayed
(to print the screen image, add [Screen Image] to the simultaneously printed
items. With the default status, check mark is set).

You can select whether or not to inverse screen image for printing.
It is also possible to select whether or not to include screen grid or dotted line
frame for string display etc. for printing (P461).
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Reference: It is possible to save each screen image to a bit map file. In this case, open the
screen to be saved and select [Screen] - [Copy to Image]. The saved screen
image can be edited using the application software such as “Paint.”

Screen No.: 1 Standard Screen
Screen Comment: Menu Screen

[Fixed Display: Rectangle/Square]
Start Pos End Pos FrGnd Color BkGnd Colour Attribute
10, 10 204, 59 White Transparent Standard

[Fixed Display: Text/Mark]
Position Font Scale Smoothing Attribute FrGnd Colour BkGnd Colour Description
20, 15 Standard 2x2 Yes Standard White Transparent Menu Screen

[Touch Switch Display]
Start Pos End Pos Function Frame Disp SPos Disp EPos Attr Pos Lamp Bit
On State Attribute Frame Col Off Col On Col Flash Col Label Pos Font Scale Smoothing
Attribute Label Fg Col Label Bg Col Label On Col Label
181, 141 500, 200 Switch Screen No. 2 3--Dimension 181, 141 500, 200 -- --------------
No Light White Transparent White White 230, 155 Standard 2x2 Yes
tandard White Transparent -- Monitor Screen

181, 221 500, 280 Switch Screen No. 3 3--Dimension 181, 221 500, 280 -- --------------
Yes Light White Transparent White Whit 265, 235 Standard 2x2 Yes
Standard White Transparent -- Set Screen

181, 301 500, 360 Switch Screen No. 4 3--Dimension 181, 301 500, 360 -- --------------
Yes Light White Transparent White White 250, 315 Standard 2x2 Yes
Standard White Transparent -- Alarm Screen

[Fixed Display: Rectangle/Square]
Start Pos End Pos FrGnd Colour BkGnd Colour Attribute
10, 10 204, 59 White Transparent Standard

[Fixed Display: Text/Mark]
Position Font Scale Smoothing Attribute FrGnd Colour BkGnd Colour Description
20, 15 Standard 2x2 Yes Standard White Transparent Menu Screen

[Touch Switch Display]
Start Pos End Pos Function Frame Disp SPos Disp EPos Attr Pos Lamp Bit
On State Attribute Frame Col Off Col On Col Flash Col Label Pos Font Scale Smoothing
Attribute Label Fg Col Label Bg Col Label On Col Label
181, 141 500, 200 Switch Screen No. 2 3--Dimension 181, 141 500, 200 -- --------------
No Light White Transparent White White 230, 155 Standard 2x2 Yes
Standard White Transparent -- Monitor Screen

181, 221 500, 280 Switch Screen No. 3 3--Dimension 181, 221 500, 280 -- --------------
Yes Light White Transparent White White 265, 235 Standard 2x2 Yes
Standard White Transparent -- Set Screen

181, 301 500, 360 Switch Screen No. 4 3--Dimension 181, 301 500, 360 -- --------------
Yes Light White Transparent White White 250, 315 Standard 2x2 Yes
Standard White Transparent -- Alarm Screen

12-1-7 Screen List
Screen numbers and comments are printed or displayed.
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12-1-8 Table Report

The setting contents of memory tables are printed or displayed.

12-1-9 Validation Report

The results of an error check on the setting contents are printed or displayed.

Thecontents tobeprintedor displayedare thesameas in theerror displaydialog
box.

12-1-10Mathematical Report

The setting of mathematical table is printed or displayed.
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12-1-11 Recipe Report
The setting of Recipe table is printed or displayed.

12-2 Printing Reports
This section describes the procedure for printing reports (screen data, memory
table use status, etc.) using a printer.

12-2-1 Printer Setting
To print a report using a printer, it is necessary to set the type of printer and print
mode.

To set the printer information, display the Print Setup property by selecting [File]
(menu bar)→ [Print Setup].

Printer: Set the information of the printer you are going to use.

Name: Specify the printer by selecting the printer name from the list of
registered printer names.

Status: Displays the status of the selected printer, and the number of
files in the queue.

Type: Displays the name of the driver that is set for the selected
printer.

Where: Displays the nameof the port that is set for the selected printer.

Comment: Displays the comment that is set for the selected printer.

Paper: Set the paper size and the paper tray.
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Size: Set the size of paper to be used.

Source: Set the paper tray to be used.

Orientation: Set the direction of printing paper.

Portrait: Specify this item if the data is to be printed parallel to the short-
er dimension of the paper.

Landscape: Specify this item if the data is to be printed parallel to the longer
dimension of the paper.

[Properties]: Used to set the printer properties.

Since the setting differs according to the printer, refer to themanual of the printer
driver.

Reference: If the print setup, print, or print preview has been executed under condition that
no printer driver has been installed, there may be times Support Tool does not
move correctly.

12-2-2 Output to a Printer
To output the report to the printer, follow the procedure shown below.

(1) Select [File] (menu bar)→ [Print].
The Reports dialog box is displayed. (page 451)

(2) Set “Printer” for [Destination].

(3) To specify the printing position of the paper, click on [Set Margins ..] button.
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.

(4) To set the header/footer, click on the [Header/Footer] button.
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.

(5) After completing the setting, click on in the Reports dialog box.

The Print dialog box is displayed. (page 455)
Set the print range and the number of copies.
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(6) After completing the setting, click on in the Print dialog box.

Printing starts.

Print

Reports

Set Margins

Header and Footer

Reports dialog box

In this dialog box, the contents of printing, and printing header/footer, are set.

Report Type: Select the type of report to be printed.

Destination: Specify the destination of report output.

Printer: The report is output to the printer.
Rich Text Format: The report is output to a file.

Header: Specify this item to attach the header.
The contents of header can be specified by pressing .

Footer: Specify this item to attach the footer.
The contents of footer can be specified by pressing .

S Specification of “Screen Image”

If you specify “Screen Image” for [Report Type], a dialog for setting and select-
ing the range and print items is displayed.
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Screen Image Attribute

Inverse Print: Specify this item when you want to inverse
black and white for printing.
When this item is selected, the screen image
will be monochrome even when color-printer
is used. With the color-type PT, the screen
imagewill be turned tograyand thescreenwill
be inverse for printing.

Hide Screen Grid: Specify this item when you do not want to in-
clude screen grid for printing. With the default
status, check mark is set. If it is unchecked,
the grid is printed according to the grid setting
of each screen’s property.

Show Dotted Line Frame: Specify this itemwhen youwant to include the
dotted line frame for the following objects.
S Dotted line frame indicating the position of

string input and string display
S Dotted line frame indicating the touch

sensing area of touch switch
S Dotted line frame indicating the display

position of image/library data of an image
lamp
(The status of an image lamp to be printed
depends on the [Simulate ON/OFF] set-
ting of the [View] menu.With lampON sta-
tus, display position of image/library data
for OFF state is shown with the dotted line
frame and with lamp OFF status, display
position of image/library data for ON state
is shown with the dotted line frame.)

Screen: Specify the screen to be printed.

All: Select this item to print all screens.

Range: Select this item if you want to print only specified screens.
Specify the screen numbers using a comma (,) as a delimiter.
By joining two page numberwith a hyphen (–), you can specify
the range. (“5 - 12,” for example, indicates the range from
screen
No. 5 to screen No. 12.)

Include: Specify the items to be printed.
It is possible to select all items.

Screen Image: Specify this to print the screen image.

Screen Information: Specify this to print the detailed screen setting
information.

Lamp/Touch Switch Number:
Specify this when there is a lamp and/or touch
switch on the screen and youwant to print the allo-
cated bit number of a lamp and/or touch switch.
Usually in the case of a touch switch, the allocated
bit number specified when setting a lamp is
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printed. If the notify
bit function is set, however, the notify bit number is
printed.

Memory Table Entry Number:
Specify thiswhen there is acharacter stringdis-
play, numeral display, bar graph, and/or input
setting element on the screenand if youwant to
print the element with the set memory table
entry number.

Image/Library Number: Specify this when there is image data display
and/or library data display on the screen and
you want to print the displayed data with the
image/library code number.

S Specification of “History Report”

If you specify “History Report” for [Report Type], you are requested to specify
the file name where the display history record data sent from the PT is stored.

S Specification of “Validation Report”

If you specify “ValidationReport” for [Report Type], you are requested to speci-
fywhether an error check is to beexecutedand then the result of the check is to
be printed or the present error log information is to be printed.

If an error check is executed, the existing error log is lost. To keep the record on
the error for which the message is displayed like after the conversion, select
“Print Current Error Log Window.”

To print the result of error check, click on after selecting “Print After

Validation.” A message asking if you want to execute an error check is dis-
played. The time necessary for error check execution varies depending on the
registered screen data.

Reference: S Printing information on errors occurring during data conversion
The procedure for printing information on errors occurring during data conver-
sion is shown below.

(1) Data of NT-series Support Tool

S Open the source file.
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S Select [Tools]→ [PT Configuration] and specify the PT model (conver-
sion destination).

S Execute data conversion.

Data of DOS version

S Specify the file using [File]→ [Import].

S Execute data conversion.

(2) If an error occurs, the message “Application conversion has resulted
some messages in Error Log.” is displayed.
Click on .

(3) Select [View]→ [Error Log] to display the error log.

(4) Select [File]→ [Print] and set the properties as shown below.

S Report Type: Validation Report

S Destination: Printer, or Rich Text Format

S Screen: Print Current Error Log Window

For details of data conversion, refer to Appendix A Data Conversion.

Setting margins

Specify the margins to define the print area.
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The units for dimensions can be selected between cm and inch.

Setting footer and header

Specify contents of header and footer to be printed.

The header/footer print position can be set as Left, Center, or Right.
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Left Center Right

Footer

Header

Left Center Right

Page numbers, date, time, and file name can be printed automatically.
To select the item to be printed as a header or a footer, move the cursor to the
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print location and click on the corresponding button ( , ,
, ).

Print dialog box

Printer: Set the printer to be used.

Range: Specify the pages to be printed.

All: All pages are printed.

Pages: Only the specified pages are printed.
The pages to be printed are specified as a range.

The pages to be specified here are actual print pages and it must be
taken into consideration that one screen data does not always corre-
spond to one print page. If youwant to print the screens partially, use
the “Print Preview” function to check the correspondence between
pages and screens to specify pages.

Print to File: Specify this item to output the contents to be printed to a file. The
file format differs depending on the printer used.
After setting a check mark in the check box, click on :

the file name setting dialog box is displayed.

Copies: Specify the number of copies to be printed.

Number of copies: Set the number of copies.

Collate: Specify if the same page is printed in a group when printing
multiple copies. (The same page is printed in a group if a check
mark is set in the check box.)

12-2-3 Output to a File (RTF)
Reports can be output to a file in the rich text format.

The operation for outputting the reports to a file is basically the same as that for
printing them.

Reference: The rich text format is a file format used for document data; in this file format, in-
formation such as characters and indents is retained. The data saved in this for-
mat is highly interchangeable among Windows 95/98 applications.

Operation procedure to output to a file is shown below:

(1) Select [File] (menu bar)→ [Print].
The Report dialog box is displayed. (page 451)

(2) Set “Rich Text Format” for [Destination].

(3) To specify the print position of the paper, click on [Set Margins ..].
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.

(4) To set the header/footer, click on the [Header/Footer].
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.
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(5) After completing the setting, click on in the Reports dialog box.

Reports

If you click on in theReports dialog box, the dialog box used to specify

the report output file is displayed. Specify the file name and click on ,
then the report is output to a file.

For details on operations at the Reports dialog box, the Set Margins dialog box,
and the Header and Footer dialog box, refer to 12-2-2 Output to a Printer.

12-3 Displaying the Print Image (Preview)
Before printing a report, it is possible to visually check the print image on the
screen.

The procedure for displaying the print image is basically the sameas that for out-
putting the report to a printer.

Operation procedure to display the print preview is shown below:

(1) Select [File] (menu bar)→ [Print Preview].
The Reports dialog box is displayed.

(2) To specify the print position of the paper, click on [Set Margins ..].
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.

(3) To set the header/footer, click on the [Header/Footer].
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on . The Reports

dialog box is displayed again.
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(4) After completing the setting, click on in the Reports dialog box.

For details, Reports dialog box, the Set Margins dialog box, and the Header and
Footer dialog box, refer to 12-2-2 Output to a Printer.

The operation procedure at the preview screen is shown below.

Print: Specify this item to output the data to the printer.

Next Page: Specify this item to display the next page.

Prev Page: Specify this item to display the previous page.

Two Page: Specify this item to display two pages on the screen.

Zoom In: Specify this item to enlarge the displayed image.

Aftermoving the cursor to the desired position, click themouse
and the specified area is enlarged.

Zoom Out: Cancels the enlarged display mode.

Close: Closes the print preview screen.

12-4 Outputting the Screen Image
It is possible to output only the data creation screen in the bit map format.

The output data can be used in other applications to be displayed or printed.

The operation procedure for outputting the screen image is shown below.

(1) Display the screen to be output at the front.

(2) Select [Screen] (menu bar)→ [Copy to Image].
The file name setting dialog box is displayed.

(3) Specify the folder and file name and click on .
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Reference: The screen image of the editing screen is saved in the bit map file without
change.
If youwant to savean inverted image toa file, select [File] - [Print] and set “Screen
Image” for “Report Type” and “Rich Text Format” for “Destination,” set a check
mark for “Inverse Print”and output it. (Refer to 12-2-3 Output to a File (RTF).)
If you use thismethod, the screen imagewill bemonochromeevenwhen the col-
or-printer is used.
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Appendix A
Data Conversion

This section describes the data conversionmethod between different direct access
types and different PT models.

In the following explanation, the NT20S, NT30, NT30C, NT600S, NT620S,
NT620C, and NT625C are referred to as “conventional models” and the NT21,
NT31, NT31C, NT631, and NT631C (including models with “-V1,” “-V1 (System
Ver. 2.1)” and “-V2 (System Ver.3.1)”) are referred to as “new models.”

Direct Access Types
Direct access type can be set at “PLC Vendor” of “PT Type (PT Configuration).”
Changing PLC vendor of existing screen data changes direct access type.
Thedirect access types that canbehandledby theSupport Tool (Ver. 3.j) areas
follows;

OMRON: This is a direct access for OMRON PLCs

Memory Link: This is a simulative direct access with which host and PT
execute sending or receiving of command via RS-232C/422A
communication.

Mitsubishi A: This is a direct access for Mitsubishi A series PLC.

Mitsubishi FX: This is a direct access for Mitsubishi FX series PLC.

Memory Link,Mitsubishi A andMitsubishi FX can be set only with NT31,NT31C,
NT631 and NT631C with “-V1” and above.

Reference: S The direct access version that can be handled by the Support Tool is:

NT20S, NT600S: Ver. 5

Conventional models other than NT20S, NT600S: Ver. 4

New models: No direct access versions

S Depending on the direct access types, exclusive system program may be
needed for the PT hardware.
For details of the system programs and system installer, refer to Appendix B
System Installer Operation.

S To create screen data to be used for direct access (PLC vendor) other than
OMRON,Memory Link,Mitsubishi AandMitsubishi FX, use system installer of
DOS version.

Conversion between different direct accesses (PLC vendor)

With the Support Tool (Ver. 4.1), data conversion between different direct ac-
cesses such as OMRON→Mitsubishi A or Mitsubishi FX→OMRON is possible.

However, data conversion between different direct accesses is limited to data of
the samePTmodel. (e.g., BetweenNT31-V1 data forOMRONandMitsubishi A)

Whenbothdirect accessesandPTmodel are different, convert data to that of the
samePTmodel first (see figures in next page) and then convert the direct access
type.
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Conversion between conventional PT models (Between same direct access)

NT620C/NT625CNT620S NT30CNT30

NT600S NT20S

Conversion from conventional PT model to new PT model (Between same direct access)

NT620C/NT625CNT620S

NT30C

NT31 (-V1)

NT30

NT31C (-V1)

NT631 (-V1) NT631C (-V1)

NT31 (-V2)

NT631 (-V2)

NT31C (-V2)

NT631C (-V2)

NT20S

NT21

Conversion between new PT models (Between same direct access)

NT631

NT31

NT631C

NT31C

NT631-V1

NT31-V1

NT631C-V1

NT31C-V1

NT631-V1

NT31-V1

NT631C-V1

NT31C-V1

System Program Ver.2.0 System Program Ver.2.1

NT631-V2

NT31-V2

NT631C-V2

NT31C-V2

NT21 NT31-V2

System Program Ver.3.1

System Program Ver.3.1

It is possible to convert the screen data for the lower system program version to
that for the higher system program version freely regardless of the PT models.
(e.g., from “-V1” to “-V2” or from “-V2” to “-V2 (System Ver3.1)).
However, conversion towards the opposite direction is not possible (ex. PTmod-
els with V1→PTmodels without -V1 or higher system program version→ lower
system program version).
When the PT models with the large screen size are converted to those with the
smaller screen size (ex. NT631 → NT31), the elements exceeding the screen
size after conversion are deleted.
Note that when the screen data is converted, user group and grid informationwill
be lost.
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Reference: S The data conversions shown above indicate the conversion of entire screen
data files.

If an element registered to the symbol manager is registered for a screen of
another PTmodel, the data is converted. In this case, conversion is performed in
element units. For data conversion in element units, the restrictions shown
above are not applicable and element data can be converted between any com-
bination of PT models.

S You cannot convert both the PT Model and PLC Vendor at the same time (an
errormessagewill be displayed). First, changeeither of themand thenperform
conversion a second time.

Data Conversion Procedure
The data conversion procedure is shown below.

(1) Open the existing screen data file.

Open the existing screen data file that is the source for data conversion.

If the data has been created using the DOS version Support Tool, select
[File] (menu bar)→ [Import] in the Support Tool screen to open the file.

For details of the operation, refer to 3-3-2Reading the Existing ScreenData
(Application) File or 3-3-5 Importing (Reading) the DOS Version Screen
Data (Application) File.

(2) Convert the data.

At theSupport Tool, select [Tools] (menubar)→ [PTConfiguration], then se-
lect the [PT Type] tab. Select the conversion destination PT model or PLC
Vendor (refer to Dialog Box Settings in the PT configuration on page 45).

Click on , and the data conversion confirmation message is dis-

played. Click on again to execute data conversion.

S NT11Scannot convert to othermodel from [PTConfiguration]. If youwant,
please use symbol manager to convert to other model.

Reference: S After converting the screen data, there might be some messages in the error
log. This errormessageswill disappearwhen the screendata has beenedited.
Especially for the converting errors, it is not possible to reproduce these errors
even if the error check (Validation) has been performed. So soon after the con-
verting error occurs, it is recommended to perform “Print Current Error Log
Window.” The operation for this, refer to 12-2 Printing Reports.

S When converting the screen data to the NT21 or the NT31, NT31C, NT631 or
NT631C using “-V2,” the specification of NT20/30/620 Compatible Mode is
possible. (For details of NT20/30/620 compatible mode, refer to Appendix A
NT20/30/620CompatibleMode). For details of themodification of screen data
and program at the host, refer to Correcting the NT21, NT31, NT31C, NT631,
and NT631C screen data after conversion on page 464).

(3) Change the allocated bits and words

If necessary, change the allocated bits and words.

Usually, it is not necessary to change theallocatedbits andwords since their
settings in the conversion source data are reflected in the converted data.
However, if the data is converted from the NT21, NT31, NT31C, NT631, or
NT631C to a conventionalmodel in element units, or if the data is converted
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between different direct access types, modification of the allocated bits and
words may become necessary since the range of usable word addresses
differ. For details, refer toCorrecting the PC (PLC) addresses on page 466.

(4) Correct the screen data

If the data is converted fromaPTmodel to another PTmodel that has small-
er screen than the source PT model, it is necessary to modify the screen
data in accordance with the screen size.
If data is converted between a conventional model and a new model, the
data must be corrected in accordance with the conversion destination be-
cause there aremany differences between a conventionalmodel and a new
model.
Refer to page 464.

(5) Modify the program.

If the screen data is corrected, the programat the hostmay have to bemodi-
fied.Modify theprogramby referring to “Correcting theScreenDataConver-
sion” (page 464).

Correcting the Screen Data Conversion
This section describes how the screen data should be corrected after it has been
converted.

If the screen data cannot be converted correctly, an error message is displayed
onconversionof thedata (whenchangingaPTmodelorPLCVendor, or register-
ing a symbol from the symbol manager). If an error message is displayed, it will
be necessary to correct the screen data or the program.

Correcting the NT21, NT31, NT31C, NT631, NT631C screen data after conversion

If the screen data is converted to the NT21, NT31, NT31C, NT631 or NT631C,
the followingmodification of the screendata andprogram is neededaccording to
the source/destination PT model.

Convert From Convert To Modification needed

NT30, NT30C,
NT620S, NT620C,
NT625C

NT31, NT31C,
NT631, NT631C with
“-V1” *1

S If image/library is inserted into a lamp/touch switch label or a character
string, modification of screen data is needed. For how to perform the
correction, refer toCorrection of image codes (page 471) orCorrection
of library codes (page 472).

S Word configuration of PT control/notify area differs between the source
and destination PT model. Check the program at the host and make
corrections. For details, refer to Appendix A NT20/30/620 compatible
mode.

S If a keyboard screen is used, the size of the keyboard screen frame
needs to be checked/adjusted. For how to perform the correction, refer
to Correction related to keyboard screens (page 467).

NT20S NT21 S Word configuration of PT control/notify area differs between the source
and destination PT model.
Check the program at the host and make corrections. For details, refer
to Appendix A NT20/30/620 Compatible Mode.

S Some changes will occur on the screens, such as in the sizes of touch
switches and the positions of objects, check all converted screens and
correct them as necessary.

NT30, NT30C,
NT620S, NT620C,
NT625C

NT31, NT31C,
NT631, NT631C with
“-V2” *2

If a keyboard screen is used, the size of the keyboard screen frame
needs to be checked/adjusted. For how to perform the correction, refer
to Correction related to keyboard screens (page 467).
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Convert From Modification neededConvert To

NT31, NT31C,
NT631, NT631C with
“-V1”

NT31, NT31C,
NT631, NT631C with
“-V2”

Not needed.

NT31, NT31C,
NT631, NT631C with
“-V2”

NT31, NT31C,
NT631, NT631C with
“-V2”

Not needed.

NT21 NT31 with “V2” Not needed.

*1: When converting the screen data from NT30/620 series to NT31/631 se-
ries, we recommend converting to NT31, NT31C, NT631, NT631C with
“-V2” using NT30/620 compatible mode. This requires less modification of
screen data and is easy to perform. In this case, check if the system pro-
gram installed in the PT is Ver3j. For details of how to install the system
program, refer to Appendix B System Installer Operation.

*2: On conversion, check if “NT20/30/620 Compatible Mode” ([PT Configura-
tion] -- [PT Type] is selected). (In the default status, the check mark will be
ON when trying to convert screen data from the NT20S, NT30, NT30C,
NT620S, NT620C, and NT625C to the NT21, NT31, NT31C, NT631, and
NT631C with “-V2.”)

Correcting colors

S Conversion from monochrome display models to color display models

Colors (black and white) remain as they are after the conversion.

If you want to color the converted data, change or color the data as needed.

S Conversion from color display models to monochrome display models

Colors are converted into black or white as shown below.
Colors for objects other than Image

Black, blue, red, magenta: Black

Green, cyan, yellow, white: White

Colors for Image

Black: Black

Blue, red, magenta, green,
cyan, yellow, white: White

Change the colors as needed.

Correcting the PLC addresses (On data conversion between direct accesses)
When converting the data between different direct accesses, it may be neces-
sary to change PLC addresses since corresponding PLC is changed. In this
manual, conversion between OMRON and MEMLINK is described.
S Difference

OMRON: Various words are available such as CIO area and
data memory area.
Available word addresses differ depending on the
PLC that is used.

MEMLINK: Only memory link area (PT memory) can be used.
Available word addresses: 0000-9999

S Conversion result, error message and corrective action.
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With OMRON data,
an area other than
the CIO area is set.

The PLC address is
reset.

PLC address (XXX)
of YYY is invalid. It
is reset to default.

Reset the area to
memory link area (PT
memory). If this PC
(PLC) address is re-
ferred to from the pro-
gram, it is necessary to
correct the program ac-
cordingly. (Refer to
6-1-10 Setting Proper-
ties.)

Correcting the PC (PLC) addresses (On data conversion between PT models)

When converting the data of the entire screen data file, screen data for use with
newmodels cannot be converted to screen data for use with conventional mod-
els. However, if the data of a newmodel is registered for the screen of a conven-
tional model using the symbol manager, the following points must be taken into
consideration due to differences in the usable PC (PLC) address range between
a conventional and a new model.

S Difference

New models: Word addresses can be handled up to five digits.

Conventional models: Word addresses can be handled up to four digits.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
word addresses are
within four digits.

With a conventional
model, word
addresses remain
as they were.

–– ––

With a new model,
the word address is
five digits.

The word address is
reset.

Invalid PC (PLC)
address. It is reset
to default.

Reset the word address
to a number of four or
less digits. If this PC
(PLC) address is re-
ferred to from the pro-
gram, it is necessary to
correct the program ac-
cordingly. (Refer to
6-1-10 Setting Proper-
ties.)

Correction related to continuous screens

When thedata of a conventionalmodel is converted into data for anewmodel, an
error may occur due to differences in the handling of continuous screens be-
tween conventional models and new models.

S Difference

New models: Continuous screens cannot be used.

Conventional models: Continuous screens can be used.

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With conventional
models, continuous
screens are used.

The parent screen
of the continuous
screens is deleted.

The screen no.
XXXX was a Con-
tinuous Parent
Screen that is not
supported in this
model. It is dis-
carded.

Use a touch switch to
switch screens. If the
program is created to
display the parent
screen of continuous
screens, correct the pro-
gram so that the first
child screen is dis-
played. (Refer to 6-8-2
Switch Screen Touch
Switch.)

Correction related to overlapping screens

When overlapping screens are converted, an errormay occur due to differences
in the handling of overlapping screens between conventional models and new
models.

S Difference

New models: A window/keyboard screen cannot be specified as a
child screen.

Conventional models: A window/keyboard screen can be specified as a
child screen.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a window/
keyboard screen is
specified as a child
screen.

With a new model,
a window/keyboard
screen is removed
from child screens.

The screen no. XXX
of type YYY is not
supported as a
child, so the parent-
child association is
discarded.

Copy the contents of the
window/keyboard
screen to a standard
screen and specify that
standard screen as a
child screen. (Refer to
5-3-2.Overlapping
Screens)

Correction related to number of window/keyboard screens to be opened

Whenawindow/keyboardscreen is converted, conversion isexecutedasshown
below due to differences in number of window/keyboard screens that can be dis-
played at the same time.

S Difference

New models (NT21, NT31/631-V1 and above):

Up to threewindow/keyboard screenscanbeopened
at the same time. (1 GlobalWindow and 2 LocalWin-
dows)
With a screen attribute, up to two local windows can
be specified as pop-up windows to be displayed
when the screen is opened.
With a touch switch (cursor move and input key-win-
dow/keyboard function), specification of local win-
dow 1 or 2 is possible.

Conventional models, New models (NT31/631):

Only one window/keyboard screen can be opened.
(Local window 1 (keyboard) only)
With a screen attribute, only one window can be spe-
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cified as a pop-up window to be displayed when the
screen is opened.
With a touch switch (cursor move and input key-win-
dow/keyboard function), specification of only local
window 1 (keyboard) is possible.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model
with “-V1” and
above, local window
2 is specified for the
attribute of touch
switch. And the
touch switch is reg-
istered to the sym-
bol manager.

Minimum value is
restored for window/
keyboard screen
number.

Input Key-Window/
Keyboard screen
number is not within
the valid range.
Minimum value re-
stored.

Correct the screen data
so that the local window
1 includes all the re-
quired elements.

Correction related to display range of window/keyboard screens

Whenawindow/keyboardscreen is converted, conversion isexecutedasshown
below due to differences in the window/keyboard screen display range between
a conventional and a new model.

S Difference:

New models: A window/keyboard screen can be specified only in
the range that fits the touch switch grids.

Conventional models: A window/keyboard screen can be specified at any
desired position.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a range that
does not fit the
touch switch size is
specified as the dis-
play range.

With a new model,
the range is cor-
rected so that it
agrees with the
touch switch posi-
tions.

Some screen ele-
ments exceed
frame size. The ele-
ments will not be
downloaded to PT
Hardware.

If the position and the
range of the window to
be displayed is inconve-
nient for operation, cor-
rect the position and the
range. (Refer to 5-4
Window/Keyboard
Screens.)

Correction related to the system initializing screen (Host Connect screen)

When the system initializing screen is converted, conversion is executed as
shown below due to differences in screen numbers and elements that can be
registered between conventional and new models.

S Difference

New models: Screen No. 9000
Only fixed display elements (excluding image data
and library data) can be registered.

Conventional models: Screen No. 1999
All kinds of element can be registered.
Some elements that need communications with a
host may not be displayed correctly.

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, elements
that cannot be reg-
istered on a new
model are regis-
tered.

With a new model,
the screen No. is
modified to 9000.
Elements that can-
not be registered for
a new model are re-
moved.

This screen does
not support XXX. It
is discarded.

Correct the screen so
that the same screen as
before the conversion is
created using fixed dis-
play elements excluding
image/library data. (Re-
fer to 5-8. Host Connect
Screen (System Initializ-
ing Screen))

Correction related to extended screens

Whenanextendedscreen is converted, an errormessagemaybedisplayeddue
to differences in the handling of an extended screen between conventional and
new models.

S Difference

New models: Extended screens are not supported.

Conventional models: Extended screens can be used as standard screens.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, the screen
number of an ex-
tended screen is
used for a standard
screen.

With a new model,
the screen is
treated as a stan-
dard screen.

The screen no. XXX
was an Extended
Screen that is not
supported by this
model, so it is con-
verted to a standard
screen.

––

Correction related to history screens

When a history screen is converted, an error message may be displayed due to
differences in thehandlingof the screennumbersof the frequencyhistory screen
and the occurrence history screen between conventional and new models.

S Difference:

New models: Screen No. 9001 and No. 9002
History screens (occurrence order, frequency order)
cannot be edited.

Conventional models: Screen No. 1997 and No. 1998
History screens (occurrence order, frequency order)
can be edited.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a history
screen (occurrence
order, frequency or-
der) is edited.

With a new model,
the history screen is
deleted (displaying
the edited history
screen is possible
by specifying it from
a PT).

The screen no. xxx
was a history occur-
rence (frequency)
screen that is not
supported in this
model. It is dis-
carded.

––

Correction related to the number of memory tables

Since thenumber of entries that canbeused in thememory tables dependon the
PT model, conversion is executed in the manner shown below.
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S Difference

NT11S NT20S NT600S NT30
NT30C

NT620S
NT620C
NT625C

NT21
NT31
NT31C
NT631
NT631C

Numeral
memory table 128 128 512 512, or

1000
512, or
1000

512,
1000, or
2000

Character
string memory
table (String

table)

128 128 256 256, or
1000

256, or
1000

256,
1000, or
2000

Bit memory
table –– –– –– 256 256 256, or

1000

Extended I/O
input table –– –– –– 64 –– ––

Extended I/O
output table –– –– –– 64 –– ––

F-key input
notify table 4 –– –– –– –– ––

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

A memory table
number that is out-
side the allowable
range for the
memory table is
used for display or
input.

The memory table
number is reset to
0.

[Object Name] re-
fers to invalid nu-
meral table entry.
The referenced
table entry is reset
to entry 0.

Correct the memory
table number to the one
that is in the valid range.
If the memory table
number is specified in a
program, correct it also.
(Refer to Dialog Box
Settings in the PT Con-
figuration on page 45.)

Correction related to contents of numeral memory table

When the data of a conventional model is converted to the data for a newmodel,
the converted data requires your attention to the fact that the processing that oc-
curs if incorrect data (existence of A to F other than F at the most significant bit
position) iswritten to anallocatedword in thehost differs betweenaconventional
and a new model.

S Difference

New models: The written data is invalid and the existing content is
retained.

Conventional models: The incorrect data is stored.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

–– –– –– Note that the display dif-
fers between a conven-
tional and a new model
if incorrect data is writ-
ten. (Refer to 7-2. Nu-
meral Memory Table)

Correction related to bit memory table

If a bit memory table is converted from the conventionalmodel to the newmodel,
conversion will be executed in the manner shown below due to the difference of
the bit memory table function.
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S Difference

New models: Alarm function and switch screen function cannot be
set simultaneously.

Conventional models: Alarm function and switch screen function can be set
simultaneously.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion

Error
Message Corrective Action

[Switch screen]: OFF
[Screen No]: 0

Function: None
[Switch screen]: OFF
[Screen No]: 0

–– Change function to
[Alarm], if you want to dis-
play the alarm. (Refer to
7-4 Bit Memory Table.)

[Switch screen]: OFF
[Screen No]: As desired

Function: Alarm
[Switch screen]: ON
[Screen No]: As desired

–– Correction is not neces-
sary.

[Switch screen]: OFF
[Screen No]: 0

Function: Alarm
[Switch screen]: ON
[Screen No]: 9999

–– Correction is not neces-
sary.

[Switch screen]: ON
[Screen No]: As desired

Function: Alarm
[Switch screen]: ON
[Screen No]: As desired

–– Change the function to
[Switch screen]. (Refer to
7-4 Bit Memory Table.)

Correction related to extended I/O input/output table

When an extended I/O input/output table is converted, the data is converted in
the manner shown below due to differences in the handling of an extended I/O
input/output table between NT30/NT30C and other models.

S Difference

NT30/NT30C: Extended I/O input/output table can be used.

Other models: Extended I/O input/output table cannot be used.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With an NT30/
NT30C, an ex-
tended I/O input/
output table is set.

With a PT model
other than NT30/
NT30C, the setting
of an extended I/O
input/output table is
discarded.

–– Correct the screen data
and a host program so
that unusable table
entries can be replaced
with inputs/outputs of a
host, etc. (Refer to 7-5
Extended I/O Input
Table and 7-6 Extended
I/O Output Table.)

Correction of image codes

When an image code is converted between a conventional and a new model,
conversion is executed in the manner shown below due to differences in the
image codes between them.

S Difference

New models: 0001 to 0FFF (hexadecimal)

Conventional models: FE20 to FEFF (hexadecimal)

S Conversion result, error message and corrective action



Appendix AData Conversion

472

Status before
Conversion

Status after
Conversion Error Message Corrective Action

Conventional model
Assume the code is
X.

New model
The code is X –
FE1F.

[E]
Image Table entry
has been con-
verted.
[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYY.

If the code after conver-
sion differs from the
image code to be used,
change the code to the
correct one. (Refer to
8-1 Image Editor.)

New model
Assume the code is
Y.

Conventional model
The code is Y +
FE1F (if the con-
verted code is out-
side the usable
range, the code is
fixed as FE20.)

[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYY.

Correction of library codes

Whena library code is converted between a conventional and a newmodel, con-
version is executed in the manner shown below due to differences in the library
codes between them.

S Difference

New models: 1000 to 3FFF (hexadecimal)

Conventional models: FA20 to FAFF, FB20 to FBFF, FC20 to FCFF, FD20 to
FDFF (hexadecimal)

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

Conventional model
Assume the code is
X.

New model
The code is X –
EA20.

[E]
Library Table Entry
has been con-
verted.
[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYYY.

If the code after conver-
sion differs from the li-
brary code to be used,
change the code to the
correct one. (Refer to
8-2 Library Editor.)

New model
Assume the code is
Y.

Conventional model
The code is Y +
EA20 (if the con-
verted code is out-
side the usable
range, the code is
fixed as FA20.)

[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYYY.

Correction related to image/library in character strings

Whenan image/library in a character string is converted between a conventional
and a newmodel, conversion is executed in themanner shown below due to dif-
ferences in handling of the image/library between them.

S Difference

New models: Insertion of an image/library into a character string is
impossible except for NT21, NT31/631-V2 and later
models in NT20/30/620-compatible mode.

Conventional models: Insertion of an image/library into a character string is
possible.
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S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, the image/li-
brary is used in a
character string.

With a new model,
the code is dis-
played like this:
\<!xxxx>.”
(The code after con-
version conforms to
the image/library
code conversion
method.)

[E]
Image Table entry
has been con-
verted.
[E]
String Table: Table
Entry XXXX has in-
valid component
code. It has been
converted from
XXXX to YYYY.

Delete a code in the
character string and
make corrections so that
the character string and
image/library (fixed dis-
play or image lamp) are
overlapped for display or
grouped, allowing the
image/library to be dis-
played in the same way
as a character string.
(Refer to 6-1-7 Grouping
Elements.)
(In case of lamp/touch
switch label, a fixed dis-
play-image goes behind
the label and the display
will not be as desired. In
this case, use an image
lamp instead.)

Correction of graphic display attributes

When a graphic is converted between a conventional and a newmodel, conver-
sion is executed as shown below due to differences in the display attributes.

S Difference

New models: The inverse attribute is not supported for some kinds
of graphic.

Conventional models: All graphics have inverse attributes.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, the inverse
attribute is specified
for a graphic for
which the inverse at-
tribute is not sup-
ported by a new
model.

With a new model,
the foreground color
and background col-
or are automatically
interchanged.

[Object Name] –
inverse attribute not
supported. Fore-
ground and back-
ground colors inter-
changed.

Since the foreground col-
or and background color
are automatically inter-
changed, no special
correction is required
(display attribute is set to
default (standard)).

Correction of smoothing processing for marks

If a mark is converted between a conventional and a new model, conversion is
executed in the manner shown below due to differences in the handling of mark
smoothing processing between them.

S Difference

New models: Smoothing processing is not possible for marks.

Conventional models: Smoothing processing is possible for marks.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, smoothing
processing is speci-
fied for a mark.

With a new model,
smoothing proces-
sing is invalid for a
mark.

[Fixed Display Mark]
–
smoothing not sup-
ported. It is ignored.

Correction not neces-
sary.
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Correction related to the system keypad

If a system keypad is converted between a conventional and a newmodel, con-
version is executed in themanner shownbelowdue todifferences in thehandling
of the system keypad between them.

S Difference

New models: The system keypad cannot be set.

Conventional models: Numeric keys canbecreatedautomatically by setting
a system keypad.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a system
keypad is automati-
cally created with a
numeral setting in-
put screen.

With a new model,
the system keypad
is invalid and thus
not displayed.

–– Either copy the regis-
tered keyboard from the
symbol manager (refer
to 6-10 Registering
Created Elements (Sym-
bol Manager Opera-
tion)), or create numeric
keys that are equivalent
to a system keypad us-
ing the touch switch
control code input func-
tion (Refer to 6-8-5 Con-
trol Code Input Touch
Switches).

Correction of alarm list/history touch switches

If a touch switch for alarm list/history is converted between a conventional and a
new model, conversion is executed in the manner shown below due to differ-
ences in the handling of this kind of touch switch between them.

S Difference

New models: Control touchswitchesareannexed toalarm lists/his-
tories; correction is possible only with regard to the
position of the touch switches.
When converted to the NT21, NT31/631-V2 or later
models (NT20/30/620-compatible mode ON)
associated touch switches will keep other properties,
as it is, only thing is that it cannot beeditedseparately.

Conventional models: Control touch switches can be handled as indepen-
dent touchswitches (tobeassociatedwithalarm lists/
histories). Their position, size, label, etc. can be
edited as desired.

Switches: When converted to the NT21, NT31/631-V2 models
(20/30/620 mode on) associated touch switches will
keep other properties, as it is, only thing is that it can-
not be edited separately.

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, an alarm list/
history is registered
for a screen and
touch switches are
associated with it.

With a new model,
the associated
touch switches are
deleted and the
control touch
switches (in the ini-
tial state) are auto-
matically created.
When converted to
the NT21,
NT31/631-V2 or lat-
er models
(NT20/30/620-com-
patible mode on)
associated touch
switches will be
converted to control
touch switches, oth-
er properties re-
maining the same.

[E]
Touch Switch func-
tion type is not sup-
ported. It is dis-
carded.
[W]
The associated
touch switches of
the alarm has been
discarded and com-
ponent touch
switches have been
created.
No error message
will be generated.

Adjust the position of
control touch switches if
necessary. (Refer to 6-3
Alarm.)
Adjust the position of
control touch switches if
necessary. (Refer to 6-3
Alarm.)

With a conventional
model, an alarm list/
history is registered
for a screen (with-
out control touch
switches).

With a new model,
control touch
switches (in the ini-
tial state) are auto-
matically created.

[W]
The associated
touch switches of
the alarm has been
discarded and com-
ponent touch
switches have been
created.

If control touch switches
are not necessary, de-
lete them by setting in
the alarm list/history
properties. (Refer to 6-3
Alarm.)

With a new model,
touch switches are
automatically
created by register-
ing alarm list/history
to the symbol man-
ager.

With a conventional
model, all control
touch switches are
deleted.

[W]
The component
Touch Switches of
the Alarm List will
be discarded.

Create the control touch
switches using the touch
switch control code input
function and associate
them with the alarm list/
history. (Refer to 6-8-5
Control Code Input
Touch Switches.)

Correction of touch switch position and size

Touch switch size differs between NT20S, NT600S, NT620S and other PTmod-
els.
Therefore, when the data of NT20S, NT600S, NT620S is converted to the data
for other PT models, touch switch position and size may change.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

Touch switch posi-
tion and size may
change.

–– Correct the touch switch
position and size as
needed. (Refer to 6-8
Touch Switches)

Correction related to a touch switch for which a pop-up window/keyboard function is set

If a touchswitchassigned thepop-upwindow/keyboard function is convertedbe-
tween a conventional and a new model, conversion is executed in the manner
shown below due to differences in the range of screen numbers of the touch
switch window/keyboard screen.

S Difference

New models: Screen numbers of window/keyboard screen:
1 to 3999

Conventional models: Screen numbers of window/keyboard screen:
1900 to 1979



Appendix AData Conversion

476

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
the touch switch for
which a pop-up win-
dow/keyboard func-
tion is set is regis-
tered to the symbol
manager.

With a conventional
model, the window/
keyboard screen
number is corrected
to 1900.

Input Key-Window/
Keyboard screen
number is not within
the valid range.
Minimum value re-
stored.

Create the window/key-
board screen for a
screen number in the
range 1900 to 1979 and
correct the window/key-
board screen number
set for the touch switch
accordingly. (Refer to
5-4 Window/Keyboard
Screens and 6-8-4 Pop-
up Window/Keyboard
Function Touch Switch.)

Correction related to the touch switch for which the copy function is set

If a touch switchassigned the copy function is convertedbetweenaconventional
and a newmodel, conversion is executed in themanner shown below due to dif-
ferences in the range of numeric values that can be input.

S Difference

New models: As a constant for the copy setting function, a numeric
value of up to 10 digits can be input.

Conventional models: As a constant for the copy setting function, a numeric
value of up to 8 digits can be input.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
a touch switch for
which the copy set-
ting function is set
with a numeric val-
ue greater than
100000000 or
smaller than
–10000000 speci-
fied is registered to
the symbol manag-
er.

With a conventional
model, a value
greater than
100000000 is cor-
rected to 99999999
or a value smaller
than –10000000 is
corrected to
F0000000.

[W]
Constant Value is
out of limit. Maxi-
mum value re-
stored.

Correct the screen data
or the program in the
host so that a constant
of up to 8 digits suffices.
(Refer to 6-8-6 Copy
Setting Touch Switch.)

Corrections related to lamp/touch switch label

In the conversion of data between aV2model and a non-V2model/conventional
model, conversion is executed in the manner shown below due to differences in
the new functions of the lamp/touch switch label added to V2 models.

S Difference
V2 models: Multiple lines of label, On Off Static label, Numeral/String Display
label can be set.
Conventional models, non-V2 models: Only fixed display label (one line) can
be set.

Conversion from conventional models to V2 models

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a fixed dis-
play object is used
with a label to dis-
play multiple label
lines.

With a V2 model,
multiple label lines
can be set (no need
to add a fixed dis-
play object.)

*1 Create multiple label
lines using Label proper-
ty (P??) and delete fixed
display objects.

With a conventional
model. A numeral/
string display object
is created on a
lamp/touch switch.

With V2 models. nu-
meral/string display
labels can be set.

*1 Select “Numeral Dis-
play” or “String Display”
as the Label Type in La-
bel Property for the
lamp/touch switch. Make
the setting as required.
Delete the numeral/
string display objects
created on the lamp/
touch switch.

*1: It is also possible to use the screen data after conversion without perform-
ing the above modification.

Conversion from V2 models to conventional models

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a V2 model, a
lamp/touch switch
allocated a newly
added function is
registered in the
symbol manager.

According to the
status before con-
version, the label
will be converted to
a default status (La-
bel) or OFF label
(see below).

See below Create a fixed display
object or a numeral/
string display object on
a lamp/touch switch
(use Group function if
needed) so that it
matches the status be-
fore conversion.

S Label error messages following conversion from V2 models to conversion
model.

Status of label before conversion Error Message

Static One line Label Type -- Static not supported. Label will be set to Off Description.

Two or more lines Label Type -- Static not supported. Label will be set to default.

On Off Static Off label -- one line Label Type -- On Off Static not supported. Label will be set to Off Description.

Off label -- two or
more lines

Label Type -- On Off Static not supported. Label will be set to Default.

Numeral Display Label Type -- Numeral Display not supported. Label will be set to Default.

String Display Label Type -- String Display not supported. Label will be set to Default.

Correction related to the lamp label (ON state)

If a lamp’s label is converted between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to difference of label color set-
ting.

S Difference

New models: ON state and OFF state can be set independently.
Background color is transparent only.

Conventional models: Only foreground color can be set. (OFF, ON/Flash
has same color). Background color can be set as de-
sired.

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model;
Background: Any
Foreground: Any

With a new model;
Background: Trans-
parent
OFF State: Same
as Foreground
ON State: Black

–– This will lead to an invis-
ible label when the lamp
is ON. Select the lamp
and choose [Edit] – [Edit
Object] and double click
at the label. Then
change the label ON
state color to different
color.

Correction related to the maximum and minimum limit check function for numeral input

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences in the range of
numeral that can be input.

S Difference

New models: A numeric value of up to 10 digits can be input for the
maximum/minimum limit.

Conventional models: A numeric value of up to 8 digits can be input for the
maximum/minimum limit.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
a numeral setting
input field for which
a numeric value
greater than
100000000 or
smaller than
–10000000 is speci-
fied as a maximum
or minimum limit is
registered to the
symbol manager.

With a conventional
model, maximum
and minimum value
greater than 8 digits
will be reset.

[W]
Numeral Input Maxi-
mum value is out of
limit. Default values
restored for maxi-
mum and minimum.

Create a new numeral
setting input field. Cor-
rect the screen data or
the program in the host
so that a constant of up
to 8 digits suffices. (Re-
fer to 6-4-1 Numeral In-
put, 6-4-3 Thumbwheel
Switch.)

Correction related the number of digits for numeral input

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences in the range of
numeric values that can be input.

S Difference

New models: A numeric value of up to 10 digits can be input.

Conventional models: A numeric value of up to 8 digits can be input.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
a numeral setting
input field (or a
thumbwheel switch)
for which a numeric
value exceeding 8
digits is input is reg-
istered to the sym-
bol manager.

With a conventional
model, a numeral
setting input field (or
a thumbwheel
switch) of greater
than 8 digits is dis-
carded.

[E]
[Numeral Input] –
Total number of in-
teger and decimal
exceeds limit. It is
discarded.

Create a new numeral
setting input field
(thumbwheel switch).
Correct the screen data
or the program in the
host so that a constant
of up to 8 digits suffices.
(Refer to 6-4-1 Numeral
Input , 6-4-3 Thumb-
wheel Switch.)
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Correction related the reference memory table entires for numeral input

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences in the numeral
memory table entries that can be referred to.

S Difference

New models: For numeral memory table entries No. 247 to No.
253, reference is not possible for numeral input/
thumbwheel switch.

Conventional models: For numeral memory table entries No. 247 to No.
253, reference is possible for numeral input/thumb-
wheel switch. (Display only)

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, a numeral
setting input field (or
a thumbwheel
switch) for which a
numeral memory
table in the range
No. 247 to No. 253
is referred to is reg-
istered to the sym-
bol manager.

With a new model,
the reference nu-
meral memory table
No. is corrected to
0.

Thumbwheel switch
refers to reserved
numeral table entry.
The referenced
table entry is reset
to 0.

Make corrections so that
the contents of a numer-
al memory table in the
range No. 247 to No.
253 are displayed in a
numeral display. (Refer
to 6-6 Numeral Display.)

Correction related to an interlock function of a touch switch, numeral/string input, or thumbwheel

In the conversion of the data between a V2 model and a non-V2 model/conven-
tionalmodel, conversion is executed in themanner shown below due to an inter-
lock function, that has been added to V2 models.

S Difference
V2models:Operations/Inputs canbeenabled/disabledaccording to thestatus
of the host bit (interlock bit).
Conventional models, non-V2 models: Interlock bit can not be set.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With V2 models, an
object allocated an
interlock function is
registered in the
symbol manager.

With non-V2 mod-
els/conventional
models, an interlock
bit setting will be
discarded.

Interlock not sup-
ported. Interlock
setting will be dis-
carded.

Screen switching, nu-
meral/string input at PT
side can be enabled/dis-
abled using the PT con-
trol bit in PT control area
also. Modify the pro-
gram according to the
setting.

Correction related the number of digits for numeral display

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences in the range of
numeric values that can be displayed.

S Difference

New models: A numeric value of up to 10 digits can be displayed.

Conventional models: A numeric value of up to 8 digits can be displayed.
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S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
a numeral display
element for which a
numeric value ex-
ceeding 8 digits is
displayed is regis-
tered to the symbol
manager.

With a conventional
model, a numeral
display element of
greater than 8 digits
is discarded.

Numeral Display:
Total number of in-
teger and decimal
exceeds limit. It is
discarded.

Create a new numeral
display element. Correct
the screen data or the
program at the host so
that a constant of up to
8 digits suffices. (Refer
to 6-6 Numeral Display.)

Correction related to analogue meter

In the conversion of the data between new models (with “-V1” and above) and
other PT models, conversion is executed in the manner shown below due to
presence/absence of analogue meter.

S Difference

New models (with “-V1” and above): Analogue meter can be used.

Conventional models, new models (below “-V1”):
Analogue meter cannot be used.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model
(“-V1” and above),
an analogue meter
is registered to the
symbol manager.

With a conventional
model and a new
model (below
“-V1”), an analogue
meter is not dis-
played.

Cannot paste ana-
logue meter. It is
discarded.

Create a bar graph or
other display element
instead of an analogue
meter to display con-
tents that was displayed
by an analogue meter.

Correction related to control touch switch of trend graph

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in themanner shownbelowdue to differences in the trendgraph
control touch switches.

S Difference

New models: Marks with codes FFEF to FFF5 (hexadecimal) are
used as trend graph control touch switches.

Conventional models: No trend graph control touch switches (codes FFEF
to FFF5 may be used as desired).

S Conversion result, error message and corrective action
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Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, the marks
with codes FFEF to
FFF5 are used as
desired.

With a new model,
marks registered
with a conventional
model are used as
trend graph control
touch switches.

–– (1) Copy marks regis-
tered under codes
FFEF to FFF5 to
other codes with the
mark editor.

(2) Reset the marks
with codes FFEF to
FFF5 with the mark
editor. (By resetting,
the marks are re-
turned to the trend
graph control
marks.)

(3) For the elements
that use the conven-
tional marks of
codes FFEF to
FFF5, correct the
codes to those as-
signed after copying
the marks. (Refer to
8-3 Mark Editor.)

With a conventional
model, the marks
with codes FFEF to
FFF5 are not used.

With a new model,
nothing is registered
for codes FFEF to
FFF5 and trend
graph control touch
switches are not
displayed.

–– Reset the marks with
codes FFEF to FFF5
with the mark editor. The
marks of these codes
are recognized as the
trend graph control
marks. (Refer to 8-3
Mark Editor.)

Correction related to sampling cycles of trend graphs

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences of trend graph
sampling cycles.

S Difference

New models: The sampling cycle canbeset in the range from0.5 to
6553.5s in units of 0.5s.

Conventional models: The sampling cycle canbeset in the range from0.1 to
6553.5s in units of 0.1s.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a conventional
model, the sampling
cycle is set in units
other than 0.5s.

With a new model,
the sampling cycle
is corrected to 0.5s
unit cycle (corrected
to the nearest val-
ue).

[W]
Sampling cycle less
than minimum val-
ue. Minimum value
restored.
[W]
Sampling cycle not
multiple of 5. Value
rounded off to near-
est multiple of 5.

Since there are no prob-
lems in actual operation,
correction is not neces-
sary.

Correction related to the 100% value, 0% value and –100% value of a graph

In the conversion of the data between a conventional and a newmodel, conver-
sion is executed in the manner shown below due to differences in the range of
numeral that can be input.

S Difference

New models: A numeric value of up to 10 digits can be input for a%
value.
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Conventional models: A numeric value of up to 8 digits can be input for a %
value.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a new model,
a graph for which a
value greater than
100000000 or
smaller than
–10000000 is set
for a % value is reg-
istered.

With a conventional
model, if a % value
is outside the allow-
able range, it is re-
placed as shown
below: for a 100%
value, the existing
value is corrected to
100, for a 0% value,
it is corrected to 0,
and for a –100%
value, it is corrected
to –100.

[W]
[Object Name] – %
value is out of limit.
Default values re-
stored for 100%,
0% and –100%.

Correct the screen data
or the program at the
host so that a constant
of up to 8 digits suffices.
(Refer to 6-9 Graph.)

Correction related to the label component of standard lamp and touch switch

In the conversion of the data between a NT31/631-V2 or later model and a
NT31/631-V1 or earlier model, conversion is executed in themanner shown be-
low due to differences in the label data of standard lamp and touch switch.

S Difference

V2 or later models: On label and Off label can be different.

Other models: On label and Off label should be same.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a V2 or later
model, a standard
lamp/touch switch
label type is set to
Static’ and On/Off
label descriptions
are different.

With a V2 or earlier
model, standard
lamp/touch switch
label type is set to
Static’ and On label
description will be
set to that of Off la-
bel.

[W]
Label Type-On Off
Static is not sup-
ported. Label will
set to Off descrip-
tion.

None

With a V2 or later
model, set Standard
Lamp/Touch Switch
label to “Label<\n>
in <\n> multiple
<\n> lines”

With a V2 or earlier
model, standard
lamp/touch switch
label set to “Label”
(Default)

[W]
Label Type-Static
not supported. La-
bel will set to de-
fault.

None

From a 31/631-V2
model application
copy Touch Switch/
Standard Lamp with
Label Type set to
Numeral Display or
String Display and
paste in an applica-
tion for a model ear-
lier than V2.

Label properties are
set to default.

[W] Label Type-Nu-
meral Display not
supported. Label
will set to default.
(Or)
[W] Label Type-
String Display not
supported. Label
will set to default.

None

Correction related to ‘switch screen’ screen numbers

In theconversionof thedata betweenaV2or latermodel andaV1or earliermod-
el, conversion is executed in the manner shown below due to differences in the
new device monitor screens available in V2 or later models.

S Difference

V2 or later models: New device monitor screens available.
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Other models: Device monitor screens are not supported.

S Conversion result, error message and corrective action

Status before
Conversion

Status after
Conversion Error Message Corrective Action

With a V2 or later
model, a touch
switch of switch
screen type is
created with switch
screen number be-
ing 9023 (device
monitor screen)

With a model earlier
than V2, touch
switch will be dis-
carded, because
switch screen num-
ber 9023 is not sup-
ported

[E]
Invalid screen num-
ber in Touch Switch
(Switch Screen).

None

In the case of Bit Memory Table, it will be reset based on the following table.

Default Screen
Number

PT-Models

0 NT30, NT30C, NT620C/625C, NT620S

1 NT20S, NT21, NT31, NT31C, NT31C-V1,
NT31C-V1 (System Ver 2.1), NT31-V1

NT31-V1 (System Ver 2.1), NT600S, NT631, NT631C,
NT631C-V1, NT631C-V1 (System Ver 2.1) NT631-V1,

NT631-V1 (System Ver 2.1)

NT20/30/620-compatible Mode

For the NT21 and the NT31, NT31C, NT631 and NT631C with “-V2,”
NT20/30/620-compatibleModecanbeset.Using thismode requires lessmodifi-
cation of screen data and programs, and is easier following conversion of screen
data between theNT21andNT20S, and betweenV2models andNT30,NT30C,
NT620S, NT620C, and NT625C.

If NT20/30/620-compatible mode is used, the functions of the NT21, NT31,
NT31C, NT631 and NT631C with “-V2” will differ described below. For details of
the each function, refer to the NT21/31/631 Series Reference Manual
(V069-E1-j).

Reference: S Except for the following points, the NT21, NT31, NT31C, NT631, and
NT631C-V2 functions can be used as they are in NT20/30/620-compatible
mode.

S When trying to convert the screen data fromNT30, NT30C, NT620S, NT620C
or NT625C to NT31, NT31C, NT631 or NT631C with “-V2” or from the NT20S
to theNT21,NT20/30/620-compatiblemodewill beautomaticallyON in thede-
fault status. If you do not want to use NT20/30/620-compatible mode, disable
the NT20/30/620-compatible mode ([PT Configuration] -- [PT Type]).

S NT20/30/620-compatible mode can be set only when NT21, NT31, NT31C,
NT631 or NT631C-V2 is selected as a PTModel. In NT20/30/620-compatible
mode, the following points will be the same as for the NT30/620 series.

S Image/library can be inserted into a lamp/touch switch label or a character
string.

S Image/library code

S Word configuration of PT control/notify area
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Appendix B
System Installer Operation

The Support Tool is provided with a system installer, which installs the system
program at a PT.

Version up of the PT system program or installation of new communication pro-
grams in a PT are possible by installing the system program.

Reference: Version up of NT31, NT31C, NT631, NT631C with “-V1” (system program Ver.
2.1)” or below is possible by installing the system program that is supplied with
the Support Tool (Ver. 4.1).
For details of the conversion method, refer to Appendix A Data Conversion.
In this case, however, the following function can not be used.

S 32-dot high-definition font (Refer to Settings for text display in 6-1-10 Setting
Properties.)

S Font type ISO8859-1(Refer to Font Type in 3-3 and Appendix K)

S Memory unit system transmission (Refer to operation manual of NT31,
NT31C, NT631, NT631C with “-V2”)

To reuse the existing NT31, NT31C, NT631, NT631C screen data, the screen
data should be converted to the data for system program Ver.3.1 beforehand.

Applicable PT Models
Thesystem installer is used to install the systemprogram in the followingPTmod-
els.

NT11S, NT21, NT30, NT30C, NT31, NT31C, NT620S, NT620C/NT625C,
NT631, NT631C

Note For the individual PC (PLC) models, always install the system program of the
specific PT model. It is not permissible to install the system program of another
PT model.

Reference: S The Support Tool is provided with the system programs of the following PT
models.

NT31, NT31C, NT631, NT631C with “-V2” (system program Ver.3.1),
NT11S, NT21, NT30, NT30C, NT620S, NT620C/NT625C

The systemprogrammust be installedwith the system installer when installing
the Support Tool at your personal computer. For details of installation at the
personal computer, refer to Section 2 Setting Up the Support Tool.

These system programs can be transmitted to a PT using the system installer
supplied with the Support Tool (Ver.4.1).

Starting and Exiting the System Installer
The system installer is started by pressing the Windows start button, then
selecting [Programs]→ [Omron]→ [Ntst4.1]→ [NT-series System Installer] as
shown below.
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Example: Windows 95

When the system installer starts, the main window, shown below, is displayed.

Existing the system installer

You can exit the system installer by using any of the following operations:

S Select [Download System]→ [Exit].

S Click on the button in the upper right section of the main window.

S Double click on the system installer icon in the upper left section of the main
window.

S Click on the system installer icon in the upper left section of the main window,
then select [Close] in the control menu box.

S Press the [F4] key while holding down the [Alt] key.

When you exit the system installer, the Windows screen is displayed.
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Functions of the Main Window
The functions provided by themainwindow of the system installer are described
below.

Drive:

Specify the drive where the system program is stored. Click on and select

the drive name from the displayed items.

The drive in the network can be selected only when it is allocated to “My Com-
puter.”

PT Model:

Specify the PT model for which the system program is installed. Click on

and select the drive name from the displayed items.

Select NT31, NT31C, NT631 or NT631C to use NT31, NT631C, NT631 or
NT631C.

Com Port:

Specify the port used for communications with the PT. Click on and select

the drive name from the displayed items. Selection is possible from [COM1]
and [COM2].

Look in:

Specify the folder where the system program is stored. The folder can be
opened or closed by double clicking on the folder line.

Among the folders that are open, the folder at the bottom line is selected.

System File(s):

The system programs in the specified folder and those for the specified PT
model are displayed. Specify the system program that is to be installed at the
PT from among the displayed programs. The extension of a system program
file name represents the PT model.
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Extension PT Model

.21 NT21

.31 NT31

.31C NT31C

.631 NT631

.63C NT631C

.11S NT11S

30 NT30

30C NT30C

62S NT620S

62C NT620C/NT625C

:

The system program is installed when this button is clicked.

Installing the System Program
The procedure for installing the system program is shown below.

(1) Specify thePTmodel for which the systemprogram is installed for [PTMod-
el] in the main window.

(2) Specify the system program to be installed by setting the information at
[Drive], [Look in], and [System File(s)] in the main window.

(3) Specify theRS-232Cport used for the communicationswith thePT for [Com
Port].

(4) Make the PT ready for installation of the system program.

The operation required at the PT varies depending on the PT model. Basi-
cally, execute the processing for deleting the system program, then that for
setting the PT in the state in which it waits for the reception of the system
program. For details, refer to the manual for your PT.

(5) Click on in the main window.

The system program is installed.

While the systemprogram is being installed, the progress of the operation is
displayed in graph form.

(6) At the completion of system program installation, the corresponding mes-
sage is displayed.

Read the message and click on .

(7) At the PT, press the touch switch that acknowledges the end of system pro-
gram installation.

The PT re-starts by the installed system program.
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Appendix C
NT Transfer Utility

With the Support Tool on CD-ROM, the NT Transfer Utility, which can transmit
screen data to a PT easily on site, is supplied.
It can download the screen data file in mmi format to a PT and can save the
screen data uploaded from a PT to a file in mmi format.
Screen data file in mmi format is less than 1.44 Mbytes. So it is useful when you
save the file in a floppy disk to transfer the data to and from a PT on site.

Reference: S NT Transfer Utility is a software that is exclusively used for downloading/
uploading the screen data without modifying the contents.

S NT Transfer Utility can handle only the file in mmi format. It is not possible to
read or write the file in onw format, which is a standard format of the Support
Tool. Therefore, please be sure to save the screen data in mmi format when
you use theNTTransfer Utility. For details of the restriction of the file types and
mmi format, refer to 3-3-3 Saving the Screen Data (Application) File.

S NTTransfer utility downloads/uploads the screen data in the application unit. It
is not possible to perform individual transmission such as the transmission in
the screen unit.

Equipment necessary for using the NT Transfer Utility
The following indicates the equipment necessary for using the Support Tool.

Hardware

S Recommended CPU

Pentium 100MHz or faster CPU

S Personal Computer

Use an IBM personal computer or 100% compatible.

S Recommended Memory

32 Mbytes minimum

S Free Area in Hard Disk

At least 3.5 Mbytes

Operating System

Microsoft Windows 95/98 and Windows NT (Windows NT is only available with
NT-series Support Tool Ver.3.3 onward.)

Device necessary for transmitting screen data

S RS-232C cable

The cable used for the Support Tool can be used.
For cable specifications, refer toAppendix J Connecting Cable Specifications.

Installing the NT Transfer Utility
Install theNTTransferUtility in thepersonal computer that is to be connected to a
PT on site. NT Transfer utility operates alone. You do not need to pre-install the
Support Tool in the personal computer.
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Before installing

To install the NT Transfer Utility in the personal computer without a CD-ROM
drive, make the floppy disks for installation beforehand following the procedure
below.

S Equipment to prepare

2 floppy disks (3.5 inch 1.44Mbytes 2HD, formatted)

S Creating installation FD

Copy the contents in the following folder of theSupport Tool (CD-ROM) toFDs.

-- The contents of [disk1] folder in [Transfer Utility] folder

→ To the first installation disk

-- The contents of [disk2] folder in [Transfer Utility] folder

→ To the second installation disk

Reference: If the personal computer has a CD-ROM drive, the install program can be
executed from the CD-ROM of Support Tool directly.

Installation

To install the NT Transfer Utility, execute the install program that is in your soft-
ware package.

Reference: The basic operation of the install program is same as the install program of the
Support Tool. Refer to 2-2-1 Basic Installation Operation.

S Procedure

(1) Start up Windows.

(2) If yourmedia is FD, set the first FDof the systemdisks in driveA (or other 3.5
inch FD drive)
If you are using CD-ROM, set the Support Tool CD-ROM in the CD-ROM
drivewhile holding down theShift key to prevent theSupport Tool setup pro-
gram from starting up. (Release the Shift key after CD-ROM is recognized
and the access to the CD-ROM is stopped.) If the Support Tool setup pro-
gram is automatically started, click on to abort it.

Reference: Youcanexecute the setup programbydouble clickingSetup.exe forNTTransfer
Utility in theSupport Tool systemdisk by displaying theWindowsExplorer. In this
case, steps 3, 4 and 5 bellow can be skipped.

(3) Click on the Start button of Windows and select “Run...”

(4) Input “a:\setup” in the input field in the specified window.
Note that drive designationmust agreewith the nameof the drivewhere you
set the system disk. If you set the disk in drive B, input “b: \ setup.” In case of
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CD-ROM, click on and specify SETUP.EXE in the disk1 folder in
the Transfer Utility folder.

(5) Click on .

The installation started.

(6) When the setup screen of the NT Transfer Utility is displayed, click on
.

The screen for specifying the destination of program installation is dis-
played.

(7) Specify the directory for installation.
In the initial state, thedirectory shownbelow is set as thedestinationdirecto-
ry.
C: \Program Files\Omron\Ntst4.1\Transfer Utility
If you want to change the directory, click on and input the drive and
directory. (If a directory that does not exist in the hard disk is specified, the
directory is automatically made.)

After specifying the destination, click on .
Thescreen for specifying thedestination for registering thestartmenu isdis-
played.

(8) In the start menu of Windows, specify the folder where the short-cut to the
Support Tool is created.
In the initial state, the following folder is selected.
Start\Program\Omron\Ntst4.1
If you want to change the folder, select the desired folder from the Existing
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Folders or directly input the folder name. (If a folder that does not exist in the
hard disk is specified, the specified folder is automatically made.)

After specifying the folder, click on .
Installation of the specified programs is implemented; files are copied.
During program installation, the progress of the processing is indicated as a
percentage.

(9) After the completion of installation, the folder specified in step (8) is dis-
played along with the installation completion message.
Click on , then click on in the setup completion screen.

Installation operation is completed.

Uninstall

An uninstaller (uninstall software) is supplied with the NT Transfer Utility.
If you want to remove the NT Transfer Utility from your personal computer, run
the uninstaller to delete the NT Transfer Utility program files and installation in-
formation. (Note that the data saved by the NT Transfer Utility is not deleted.)

S Starting the uninstaller from the Windows start menu

Select “Uninstall Transfer Utility” in the same folder where the short-cut to the
Support Tool is stored.

Example:Assuming the short-cut to the Support Tool exists in the Start¥Pro-
gram¥Omron¥Ntst4.1¥Uninstall Transfer Utility folder
Select the uninstaller by the following operation.
[Start]→ [Program]→ [Omron]→ [Ntst4.1]→ [Uninstall Transfer Util-
ity]

After the start up of the uninstaller, follow the instructions displayed on the
screen.

How to use the NT Transfer Utility
Reference: For connectionmethodof theNTTransferUtility andPT, refer to11-1-1Connect-

ing to PT.

Start up and exiting the NT Transfer Utility

S Starting up the NT Transfer Utility

To start up the NT Transfer Utility, select [Program] -- [Omron] -- [Ntst4.1] -- [NT
Transfer Utility] starting from the Windows Start button. (Items to select vary
depending on the [Program Folder] setting specified on installation).
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The NT Transfer Utility starts up and displays the main window shown below.

S Exiting the NT Transfer Utility

You can exit the NT Transfer Utility in any of the methods below.
S Select [File] -- [Exit].
S Click on at the upper right area of the main window.

S Double click on the NT Transfer Utility icon at the upper left area of themain
window.
S Click on theNTTransfer Utility icon at the upper left area of themainwindow
and select [Close] from the displayed control menu box.
S Press F4 key while holding down the Alt key.

The screen returns to theWindows screen after the NT Transfer Utility is closed.

Communication Setting at the NT Transfer Utility

Set the baud rate and communication port at the NT Transfer Utility (personal
computer).

(1) Select [Configure] (menu bar)→ [Comms. Setting].
The communication setting dialog box is displayed.

(2) Set the data for the displayed item
The meanings of the items are described below.

Item Description

COM Port Specify the RS-232C port to be used.
Specify either COM1 or COM2.

Baud Rate Set the data communication rate.
If “High” is set, high-speed data communication is pos-
sible.
(Not available for NT11S.)
It is recommended to specify “Standard” to ensure er-
ror-free communication if a communication error oc-
curs due to an inadequate communication environ-
ment.
Data communication at the Standard setting will take
about twice the time required in the High setting.
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(3) After completing the setting for all items, click on .

Sending (Downloading) the Data

The screen data file saved in mmi format is sent (downloaded) to a PT.

Reference: S When data is sent from the NT Transfer Utility to a PT, the existing data in the
PT is lost. Therefore,make sure that the existing data in thePT is backed up by
the Support Tool or by the NT Transfer Utility before executing data transmis-
sion from the NT Transfer Utility to the PT.

S NT Transfer Utility can send only the file in mmi format.

S Operation Procedure

(1) Select [Download] from the [File] menu.
The dialog box to specify the screen data file (mmi format) to be sent is dis-
played (see below). This dialog box can be called also by pressing the Ctrl
key + Shift key + D key.

Click on and the dialog to confirm the screen data to be trans-
mitted is displayed.

(2) Place thePT in theTransmitmodeso that thedata sent from theNTTransfer
Utility can be received.

(3) Click on after confirming the screen data to be transmitted in the

dialog shown below. Downloading of data is started.
If you want to change the screen data to be transmitted, click on at the
right side of the file name and select the file you want to download.

If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at theNTTransfer Utility. In this case, set thePT in theTransmitmode
and click on in the error message dialog box.

(4) While the data is being sent to the PT, the progress of data transmission is
indicated by a bar graph.
To abort the operation, click on .
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(5) After data transmission is completed, click on in the message

box.

Receiving (Uploading) the Data

The NT Transfer Utility receives (uploads) the data stored in a PT and saves it in
mmi file format.

S Operation Procedure

(1) Select [Upload] from the [File] menu.
The dialog box to specify the PTmodel is displayed (see below). This dialog
box can be called also by pressing the Ctrl key + Shift key + U key.

(2) Place the PT in the Transmit mode so that the data can be transmitted to the
NT Transfer Utility.

(3) Click on after selecting the PT model. Uploading of data is

started.
If the PT is not in the Transmit mode, a timeout error occurs in about 10 se-
conds at theNTTransfer Utility. In this case, set thePT in theTransmitmode
and click on in the error message dialog box.

If the type of PT connected and the PTmodel setting at the NT Transfer Util-
ity is different, error message is displayed.

(4) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph.
To abort the operation, click on .

(5) After data transmission is completed, click on in the message

box.

(6) The dialog to confirm the screen data is displayed (see below).
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(7) Click on and the file name setting window is displayed.

Specify the folder and file name where data is to be stored and click on
. Thewarningmessageabout themmi format is displayed.Click on
and the screen data is saved to the specified file inmmi format. If

you specify the existing file, the overwrite confirmation message is dis-
played.
For details of the file name setting dialog, refer to 3-3-3 Saving the Screen
Data (Application) File.

Reference: The screen data file received from a PT can be edited using the Support Tool.
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Appendix D
Translation Support Utility

TheTranslationSupport Utility is utility software that runs onWindows 95/98 and
Windows NT Ver.4. The Translation Support Utility was developed to help in
translating a language to another supported language.

Currently, translation for label contents inNTSTcan only be performedmanually
by opening and editing individual visible string contents in NTST, before down-
loading applications to a different language PT.

Therefore, the purpose of this utility is to provide a translation support utility that
enables you to load the memory map image file (.MMI) for the source language
and be able to translate the new string contents of the application and generate
independent memory map files (.MMI) for the specified target language. The
string data can be exported to Microsoft Excel files and from there you can edit/
change the string data outside the Translation Support Utility. You can also im-
port the string data in Microsoft Excel format to Translation Support Utility.

Installing the NT Translation Support Utility
Thebasic installationmethod is the sameas that for theNTTransferUtility. Refer
to Installing the NT Transfer Utility in Appendix C.

Setup.exe for NT Translation Support Utility is in the \Translation Support Util-
ity\disk1 folder in the Support Tool CD-ROM. By double-clicking the Setup.exe
icon, you can start the installation program. Follow the instructions on the setup
screen to install the NT Translation Support Utility.

Flow of Operations
An NTST application needs to be saved in MMI format before it can be used in
Translation Support Utility.

(1) Load MMI files using [File] -- [Open].

(2) Use [Translation] -- [New] to create a new language column. More than one
target languages may be created.

(3) Strings in target language text are translatedusing the translationeditorwin-
dow.

Select the cell in the target language in which the source text is to be trans-
lated. The source text is displayed in the upper pane of the editor translation
window. You can input the translated text in the lower pane and confirm by

clicking the button.

(4) Repeat the steps for each of the strings to be translated.

(5) Select [Translation] -- [Delete] operation if youwish to remove any of the tar-
get languages.

(6) Use [File] -- [GenerateMMI] to saveall the languages to their respectiveMMI
files.

(7) If you wish to perform the translation using an Excel sheet rather than in the
utility itself, use the Export function in [Translation] -- [Export] to export the
strings to .XLS format.
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(8) To read back the translated text in Excel format to the utility, use the Import
function in [Translation] -- [Import].

Application Window
The name of each part and the available functions are described below.

Main
Translation
Table

Translation
Editor
window

Status Bar

Main Translation Table

The Main Translation Table displays the ID, Source Text and Language in col-
umns for the particular MMI file.

Sorting preference for display of extracted string contents are as follows: Screen
number, and then the object type sorted alphabetically for that particular screen
when there are no header rows identifying the object type.

Select the cell in the target language, into which the source text is to be trans-
lated. You can move around the cells in the translation columns using the arrow
keys or the tab key.

Short Form in the ID Column

The ID of screen objects are displayed in short form.

Below are the short forms with their meanings:

Scr Screen

Txt Fixed Display Text

TSW Touch Switch
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Lmp Lamp

Rec Record in Recipe Entry

Param Parameter in Recipe Entry

Translation Editor Window

You can view the Translation Editor Window in the lower part of the Application
Window. This is where the translated text can be input.

When the source text in the source language column in the translation table is
selected, both panes will be disabled.

Source text of the se-
lected label or string.

Input translated label
or string.

Counter
Displays remaining number of characters that can
be entered for the selected cell from the selection
table. It will display 0 if the current selected cell is
on the Source Language column. In addition, if the
length exceeds the limit, the counter will display a
negative value in the red color.

Navigate to previous item in selectedcolumn.Wraparound
will be performed in case it reaches the top of the row.

Navigate to next item in selected column. Wrap around will be
performed in case it reaches the end of the row.

Copy source text into the editor

Accept changes. Enabled only when contents
are changed.

Status Bar

The status bar, which you can find at the bottom of the translation window, is di-
vided into four panes.

Language of
the current
active
translation.

Current line
and total num-
ber of lines.
(Text Table
window only)

Type/Category of the
screen object to which
the selected label text
item belongs.

The progress is the display op-
eration status for time-consuming
and intensive operations like sav-
ing target language .MMI files,
Importing to Excel etc.

Menu Bar

The menu bar shows the names of each function. The pull-down menu com-
mands provided by the Translation Support Utility and the functions of each
menu item are shown below.
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File
or ALT+F Open or Ctrl+O -- Opens the source MMI file.

Close -- Close current Application

Generate MMI or Ctrl+S -- Save current Ap-
plication in MMI format.

Exit -- Exit Utility

Recent File List -- Displays recently opened file list

File
or ALT+T New orCtrl+N -- Creates a new target translation column

Import-- Import from Excel

Export -- Export to Excel

Settings or Ctrl+T -- Opens the translation setting dialog.

Delete -- Deletes the selected translation column.
This option will only be enabled if there is at least one
target language.

Update Database or Ctrl+U -- Refresh database if time-
stamp of the source MMI file is different from the source
application, thereby indicating that thesourceapplication
has changed

Edit
or ALT+E Find/Replace or Ctrl+F -- Search for and/or replace

specified text
Edit Translation Item or Ins -- Move focus to the lower
pane of Translation Window for user input

Next Item -- Navigate to previous item under selected
column. It will wrap around when it reaches the last row

Previous Item -- Navigate to previous item above se-
lected column. It will wrap aroundwhen it reaches the top
row

View
or ALT+V Toolbar -- Displays or hides toolbar

Status Bar -- Displays or hides status bar

Help
or ALT+H Contents -- Opens the Online Help

About -- Displays the version number

Standard Toolbar

The Standard Tool Bar displays the functions that are used most frequently. In
the Translation Support Utility, the standard toolbar options are Open and Save.
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These functions can be called easily without selecting the function item from the
menu bar.

Open Save

File Open

A File Open dialog box is a window that is displayed in a fixed size.

To Open a .MMI file, select [Open] in the [File] Menu of the Application window.

The File Open Dialog box will be displayed so that the user can select the .MMI
file that will be opened.

Click the after selecting the MMI file. A Translation Dialog Box
will be displayed for the user to enter the language and character set of the file
being opened. However, this translation dialogwill not be shownwhen .MMI files
are opened subsequently as the languages informationwill be stored in thedata-
base the first time it is opened.

Source Project Language

Displays all the available Languages. Youmay input a language that is not in the
list.

Source Project Character Set

Thiswill be disabled if the specifiedSourceProject Language type is the sameas
the pre-defined Source Project language type. However, if you have input your
own language, the Source Project Character Set combo box will be enabled and
the default language will be Latin.

New Translation

Creates a new target language column for translation.

Select [New] in the [Translation] Menu of the Application window.
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TheNewTranslation Dialog box will appear and the user can edit the Language,
Character Set and Output File Name.

Language

Displays all the available Languages. Youmay input a language that is not in the
list.

Character Set

TheCode Pagewill be disabled if the specified language type is the same as the
pre-defined language type. However, if you have input your own language in the
edit box, the character set comboboxwill beenabledand thedefaultwill beLatin.

Output File Name

Modify the path or name of the output file of the translated language.

Translation Setting

This option is used to display translation settings such as language, character
set, database file, source file, output file name of the source file, and the target
file. You can also use this setting to change the output file name of the target lan-
guage.

Select [Settings] in the [Translation] Menu of the Application window.

The Source Translation Setting Dialog box will be displayed.



Appendix DTranslation Support Utility

503

If you change the source language to the target language, the source translation
dialog box will become the target translation dialog. The path and name of the
Output File Name may be modified.

Delete Translation

Deletes the selected Language column.

Select [Delete] in the [Translation] Menu of the Application window.

This optionwill only be enabled if there is at least one target language translation
data present.

The Delete Translation Dialog box will be displayed.

You can delete any language except the source language.

Export

Use Export to export string data to an MS Excel worksheet (*.xls). You can then
translate the strings on MS Excel and subsequently import the data to the
Translation Support Utility to save it to the MMI files of the translated language.

Select [Export] in the [Translation] Menu of the Application window.
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The Export Translation Dialog box will be displayed.

Click the Button after selecting the language to be exported. A
file save dialog box similar to the file open dialog box will prompt you to enter a
filename. Once a valid filename is specified, the export operation begins. The
cursor will change to a wait cursor for the duration of this operation. When the
operation is finished, an export completion message box will be displayed.

Import

Use Import to import string data from an MS Excel worksheet (*.xls).

Select [Import] in the [Translation] Menu of the Application window.

The Open File dialog box will be displayed. Enter the name of the file to the im-
ported.

The Import Translation Dialog box will be displayed.

Language

Displays all the available target languages present in the Translation Table and
that have corresponding valid target language data in Excel. All items are se-
lected as the default, but are disabled once the import operation starts.
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Status

Displays the status of each target language that is being imported.

Current Text -- Source]

Displays the source text present in the Translation Table.

Current Text -- Translation

Displays the translated text for the target language existing in the Translation
Table

Excel Text

Displays the translated text for the target language that can be imported from
Microsoft Excel format.

Import Text

Shows the converted text, i.e., with correct converted key code (if necessary),
length limit, etc. However, if you modify the text and then press Import or Import
All, validation is performed.

Start

Use the Start button to activate the import operation for a language.

Stop

Use the Stop Button to terminate the import operation for that language.

Next

Use the Next Button to move down by one item.

Previous

Use the Previous Button to move up by one item.

Import All

Use the Import All Button to import all items for the selected column.

Import

Use the Import Button to import the selected item.

The sequence of events for the import operation is given below (The term
’Translation Data Itemmay be used interchangeably with a ’Record’ in the notes
below and both mean the same thing):

First of all, the Language Selection list box is enabled so the user can choose
from the list of languages available for Import. By default, all items are selected.

Press theStart button to initiate thewhole import operation.OnceStart is clicked,
the Language list box is disabled and the Import operation starts. The multi-line
edit boxes are populated with relevant data. The status box displays the start of
the import operation by displaying “Importing <Language>...”

At this stage, you have the following options:

Import translation data for all the languages in the Language list box (i.e., accept
all translation data as it exists inExcel format) by clicking the ImportAll button.By
doing this, translation data for all languages is processed and imported. During
this process, when all translation data for a particular language is processed/im-
ported, that language is removed from the Language list box and the status box
displays “Done,” for that language. This process is repeated for all languages in
the Language list box.
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Import translation data one by one by viewing the data (in the Excel Text edit box
in the Import dialog above) to be imported and, if necessary, edit the data (in the
Import Text edit box in the Import Dialog above), and then click the ’Import’ but-
ton. This way, you can inspect and also edit the translation data that is being im-
ported for that language. During this process of importing translation data items
one by one, you can skip any of the translation data items by clicking the ’Next’
button the itemwill be ignored for import and processing will proceed to the next
record. Conversely, you can navigate back to any of the previous records that
youmay havemissed inadvertently by clicking the ’Previous’ Button, so that you
can inspect and import that particular record.

When the last record of a language is processed, the language will be removed
from theLanguage list boxand thenext languagewill become ready for import. In
addition, the status box displays “Done” for the completed language, and the
Start button (which had until now displayed ‘Stop’) caption changes back to
‘Start’. You may start importing the next language by clicking the ‘Start’ Button
again.

Find/Replace

You can search for specific text and replace it, or you can search for and replace
all forms of a word (for example, replace “lamp” with “standard lamp.”

Select [Find/Replace] in the [Edit] Menu of the Application window.

A Find/Replace Dialog box will appear on the screen.

[Language] Display the currently selected language column.

Error/Warning Messages

Situationswhere error/warningsmay be displayed are given below. The list is by
no means exhaustive as more may be added. Also, there may be differences
with the exact messages that are shown.

(1) Fonts with the following character sets are not available on your local ma-
chine. Not all languages can be shown with the required character set.

(2) Only with the NT30/620 series, when saving, once the translation is com-
pleted awarningmessagewill be displayed to prompt you to open the trans-
lated MMI file in NTST and validate the application to ensure proper behav-
ior. This is due to the paging memory constraints for those PT Models.

(3) Database file cannot be found/No access rights for database file/Database
file cannot be opened.

(4) Export/Import successful/unsuccessful (as appropriate).
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(5) When closing the sourceMMI file or exiting the Translation Support Utility, if
you have made some translation changes that have not been committed to
MMI files corresponding to target languages, the Translation Support Utility
will prompt you to generate the correspondingMMI for the target languages
(if any). Refer to the message below.

(6) If the current source MMI file is newer than the one registered in the MDB
database or it has contents that are different from the MDB database file,
then it prompts you whether to update the database with the information of
the current file or not. Refer to the message below.

(7) File save error when saving translated target MMI files. Refer to the follow-
ing image for a sample.

System Function
Translation Scope and Policy

(1) Only the following kinds of label translation are supported, subject to avail-
ability in the target PT model of the source application:
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S Static label of Touch Switch and Standard Lamp (where Touch Switch is a
standalone screen object and not any component such as touch switch in
Alarm/Trend Graph in NT21, NT31/631 models).

S On/Off static label of Touch Switch and Standard Lamp (where Touch
Switch is a standalone screen object and not any component such as
touch switch in Alarm/Trend Graph in NT21, NT31/631 models).

S Fixed Display Text.

S Input Key String label.

S String Table Initial value.

S Screen History Title.

S NamesofRecipeTableEntries, their records (nameonly) andparameters
(name only)

S Static label of Touch Switches internal to Recipe Screen Element.

(2) Multiple language translation is supported by Translation Support Utility.

(3) Automatic generation of translated MMI file. Default target filename with
country/language name as qualifier is used to store the translated MMI file.

(4) Contents not translated are displayed as blank and changes will not be
tracked.

(5) The length limit of label is constrained by the target PT Model.

(6) Code that corresponds to an image/mark/library entrywill be displayed in its
original form (ASCII representation), i.e., it will not be tagged by the NTST
opening token !< and closing token >.

(7) TouchSwitch andStandard Lampwith dynamic labels only, or thosewith no
label at all will not be extracted for translation.

(8) Thevalidationsperformedare thenumberof row/columnand the length limit
of the label according to PT Model.
Additionally, with theNT30/620 series, during saving, once the translation is
completed a warningmessage will be displayed to open the translatedMMI
file in NTST and validate the application to ensure proper behavior.

(9) Translation Support Utility will also take care of key code conversion
(ISO8859--1 -->CP437) resultswherever necessaryandalso restrictedChi-
nese Input for NT20S.

Translation Management

S Languages

The following is a list of commonly used languages available for selection. You
can also specify a language not in the list.

(1) English

(2) Japanese

(3) Simplified Chinese

(4) Traditional Chinese

(5) German

(6) French
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(7) Italian

(8) Spanish

S Character set

A character set is an ordered set of characters in which a numeric index (code-
point value) is associated with each character.

Different languages and locales may be used in different character sets.

Character sets to choose from are provided based on the language selected.
However, for the Translation Support Utility, the following are the character set
shown.

(1) Japanese (Shift JIS)

(2) Simplified Chinese (GB 2312)

(3) Traditional Chinese (BIG 5)

(4) Latin (ISO 8859--1/CP437)

S Filename

An output filename is provided as a default. The filename can be edited.

Database Management

All translation data for each of the source applications with their respective
translation will be stored in aMicrosoft Access relational database, which has to
be retained for later retrieval of translated data for modification etc.,

You can update the database with the latest application information.

When updating the database, Translation Support Utility checks for changes
made at the source file. Items will be added, removed, or updated depending on
the current file. As a result, theremay be new text requiring translation or already
translated text that is obsolete in the database.

File Management

Upon opening a source application MMI file for translation, the user will be
prompted to inform the utility about the language character set pertaining to the
application that is going to be opened for translation.

At any given time, only one application can be opened.

Standard file operations are available for the user to close files, save files, and
exit the utility (which will prompt you to save if any changes have been made).

The following are the file types involved in translationmanagement for this utility:

S .MMI files (Memory Map Image file corresponding to NTST data)

S .mdb files (Microsoft Access database storing translation data for source and
target)

S .xls files (for Export/Import functionality)

Export/Import Management

Export:

(1) All language column headers (excluding the source) will be displayed for
selection of export and the user will be able to select one ormore languages
for export from among them.
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(2) The ID for screen objects containing the label and the source text will be
mandatory export fields and therefore will be exported automatically.

(3) For multi-line text, new lines will remain unchanged and also image, library
and mark codes will remain in binary when exported.

(4) Non-translated text will be exported as blank.

(5) Column widths will take the default for Microsoft Excel after export. The ex-
ported format in Excel will resemble that of the Translation Table.

Import:

(1) Youareallowed toexport translated stringdata for oneormore languagesof
your selectionandalsowill be able to viewandchangeeachdata itemunder
a language before it is imported.

(2) The following will be displayed for selection and navigation by the user:

S Listing and selection of source column headers in Excel to be imported.

S Display of corresponding target column headers into which the column
data from Excel will be imported.

S Read-only Listing of source text for selected items in selected language
and corresponding translation text existing in Translation Support Utility
tables read from the database.

S Display of text that is being exported corresponding to selection made
above with facility for editing.

S Navigational buttons for moving up and down each data item for the se-
lected language.

(3) Import All facility will also be provided.

(4) Import of Excel data into Translation Support Utility will be a controlled
check-in with key code conversion being performed if necessary.

(5) If you attempt to change the item data during import, validation is performed
for length limit, limit for number of rows and columns for multi-line data etc.
before the changed text can be accepted for import.

Launching and Closing
Launching the Translation Support Utility

To Launch the Translation Support Utility, Select [Launch Translation Support
Utility] in the [Tools] Menu in NTST.

This option is not available when no application is loaded in NTST.

When launching the translation Support Utility, the current application in NTST
will close. The user can easily reopen the file by selecting it from recent file list.

Closing the Translation Support Utility

To close the Translation Support Utility, use any of the operations shown below.

S In the menu, select [File]! [Exit].

S Click the Button at the upper right corner in the main window.

S Double click the Translation Support Utility icon displayed in the upper left sec-
tion in the main window [Control Menu].
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S Click the Support Tool icon displayed in the upper left section in the main win-

dow, then select in the control menu box.

S Press the F4 key while holding down the Alt key.

If youaregoing toexit theTranslationSupportUtility, a confirmationmessagewill
be displayed for you to generate .MMI files for the particular languages.

After youexit theTranslationSupportUtility, the screenwill return to theWindows
screen.
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Appendix E
Tables of Functions of PT Models

The functions that canbe set by theSupport Tool are summarizedbelow for each
PTmodel. Some functions can be set at thePT side even if they cannot be set by
the Support Tool.

PLC Vendor (PT Configuration-PT Type)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

OMRON F F F F F F F F F F F F

Mitsubishi_A ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ∆*1 ∆*1 ∆*1

Mitsubishi_Fx ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ∆*1 ∆*1 ∆*1

Memory Link ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

AB ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*2 ∆*2 ∆*2 ∆*2

GE ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*2 ∆*2 ∆*2 ∆*2

Siemens ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*3 ∆*3 ∆*3 ∆*3

Modicon ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*4 ∆*4 ∆*4 ∆*4 ¢

*1: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1” and above.
*2: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V2.”
*3: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1.”
*4: Can be set only with the NT31, NT31C, NT631 and NT631C with “-V1” and “-V2.”

System Setting (PT Configuration)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Initial Screen 1 –
250

1 –
250
256 –
500

1 –
2000

1 –
2000

1 –
1000

1 –
2000

1 –
2000

1 –
3999

1 –
3999

1 –
3999

1 –
3999

1 –
3999

Enable ¢ ¢ F F ¢ F F ¢ *1 ¢ *1 ¢ *1 ¢ *1 ¢ *1

Buzzer Key
Input ¢ ¢ F F ¢ F F ¢ *1 ¢ *1 ¢ *1 ¢ *1 ¢ *1

Resume Function ¢ ¢ F F ¢ *1 F F ¢ *1 ¢ *1 ¢ *1 ¢ *1 ¢ *1

Backlight OFF ¢ F F F F F F ¢ *2 ¢ *2 ¢ *2 ¢ *2 ¢ *2

Number 128 F F ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢Number
of Table
Entries –

512 ¢ ¢ F F F F F F F F F F
Entries –
Numeral
T bl

1000 ¢ ¢ F F ¢ F F F F F F F

Table 2000 ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

Number 128 F F ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢Number
of Table
Entries –

256 ¢ ¢ F F F F F F F F F F
Entries –
String
T bl

1000 ¢ ¢ F F ¢ F F F F F F Fg
Table 2000 ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

Number
of Table
Entries –

256 ¢ ¢ F F ¢ F F F F F F F

Entries
Bit
Memory
Table

1000 ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F
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Items NT631CNT631NT31CNT31NT21
NT620C/
NT625C
Ver. 4

NT620S
Ver. 4

NT600S
Ver. 5

NT30C
Ver. 4

NT30
Ver. 4

NT20S
Ver. 5NT11S

Printer Printer ¢ ¢ F F ¢ F F ¢ ¢ *1 ¢ *1 ¢ *1 ¢ *1
Printer
for PT Mode ¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

History Alarm ¢ ¢ F F ¢ F F F F F F FHistory
Setting Screen ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

Numeral Display
Type ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

*1: Setting is not possible from the Support Tool. Set these items at the PT.
*2: For the NT21, NT31, NT31C, NT631, and NT631C, set the screen saver function at the PT. The Backlight OFF function is only for

turning off the screen or the backlight. If the screen saver function is used, it is possible to display a string at a desired position in
predetermined intervals in addition to turning off the screen/backlight.

Report

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Cross-Reference F F F F F F F F F F F F

Direct Connection In-
formation F F F F F F F F F F F F

History Report ¢ ¢ F F F F F F F F F F

Image/Library Report ¢ ¢ F F ¢ F F F F F F F

Mark List F F F F F F F F F F F F

Screen Image F F F F F F F F F F F F

Screen List F F F F F F F F F F F F

Table Report F F F F F F F F F F F F

Validation Report F F F F F F F F F F F F

Mathematical Report ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*1 F*1 F*1 F*1

Recipe Table ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*2 F*2 F*2 F*2

*1 This option is available only for V2 models and above
*2 This option is available only for V2 (System Ver.3.1) models and above

Data Transmission (Download/Upload)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Applica-
tion F F F F F F F F F F F F

Screen ¢ F ¢ ¢ F ¢ ¢ F F F F F

Download/
Upload

Direct
Access
Informa-
tion

¢ F ¢ ¢ F ¢ ¢ F F F F F

System
Memory ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

Table ¢ F ¢ ¢ F ¢ ¢ F F F F F

Get Histo-

Screen
History ¢ ¢ F F F F F F F F F F

Get Histo
ry Log Alarm

History ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F F F F

Date and Time ¢ ¢ F F ¢ F F ¢ ¢ ¢ ¢ ¢
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Image Data, Library Data, and Marks

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Total No. ¢ ¢ 224 ¢ 224 4095

Code ¢ ¢ FE20 to FEFF ¢ FE20 to FEFF 0001 to 0FFF

Image
Comp. ¢ ¢ F ¢ F F

Image
Mode – 8
Colors ¢ ¢ ¢ F ¢ ¢ F ¢ F ¢ F

Comment ¢ ¢ F ¢ F F

Total No. ¢ ¢ 896 ¢ 896 12288

Library Code ¢ ¢

FA20 to FAFF
FB20 to FBFF
FC20 to FCFF
FD20 to FDFF

¢

FA20 to FAFF
FB20 to FBFF
FC20 to FCFF
FD20 to FDFF

1000 to 3FFF

Comment ¢ ¢ F ¢ F F

Total No. 64 64 224 64 224 224

Mark
Code

FF20
to

FF5F

FF20
to

FF5F
FF20 to FFFF

FF20
to

FF5F
FF20 to FFFF FF20 to FFFF

Memory Tables

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

No. 128 128 512/1000 512 512/1000 512/1000/2000

Value F F F F F F

Initial F F F F F F

Table – Words F F F F F FTable
Numeral PC

(PLC)
Address

F F F F F F

I/O Com-
ment F F F F F F

No. 128 128 256/1000 *1 256 256/1000 *1 256/1000/2000 *2

Value*3 F
(20)

F
(32)

F
(40)

F
(40)

F
(40)

F
(40)

Initial F F F F F F

Table –
String

Words F F F F F F
String

PC
(PLC)
Address

F F F F F F

I/O Com-
ment F F F F F F

*1: String Table entry no. from 256 to 999 are the entries that only the initial value can be stored and can not be changed.
*2: String Table entry no. from 500 to 1999 are the entries that only the initial value can be stored and can not be changed.
*3: Image/library data can be inserted in the following models, NT30/C, NT620/C, NT625C, NT21 (NT20S-compatible mode) NT31/C-V2

or later models (NT30/620-compatible mode) and NT631/C-V2 or later models (NT30/620-compatible mode).



Appendix ETables of Functions of PT Models

516

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

No. ¢ ¢ 256 ¢ 256 256/1000

History ¢ ¢ F ¢ F F

String
Table
Entry

¢ ¢ F ¢ F F

Color ¢ ¢ ¢ F ¢ ¢ F ¢ F ¢ F

Table –
Bit

Image/
Library
Code

¢ ¢ F ¢ F F

Bit
Memory Switch

Screen ¢ ¢ F ¢ F F

Screen
No. ¢ ¢ F ¢ F F

PC
(PLC)
Address

¢ ¢ F ¢ F F

I/O Com-
ment ¢ ¢ F ¢ F F

No. ¢ ¢ 64 ¢ ¢ ¢

Table –
Extended

Cancel
Backlight
Off

¢ ¢ F ¢ ¢ ¢

Extended
I/O Input Function ¢ ¢ F ¢ ¢ ¢

Descrip-
tion ¢ ¢ F ¢ ¢ ¢

No. ¢ ¢ 64 ¢ ¢ ¢

Table –
Extended
I/O Out-
put

PC
(PLC)
Address

¢ ¢ F ¢ ¢ ¢

put I/O Com-
ment ¢ ¢ F ¢ ¢ ¢

T bl
Total No. 3000 3000 3000 3000 3000 3000

Table –
I/O Com-

Address F F F F F F
I/O Com-
ments I/O Com-

ments F F F F F F

Total No. 4 ¢ ¢ ¢ ¢ ¢

F-key
Input
Notify
Table

PC
(PLC)
Address

F ¢ ¢ ¢ ¢ ¢
y

Table I/O Com-
ments F ¢ ¢ ¢ ¢ ¢

Mathe-
matical
Table

Total No. ¢ ¢ ¢ ¢ ¢ 256 256*4

Recipe
Table No. ¢ ¢ ¢ ¢ ¢ 200 200*5

*4: This option is available only for V2 or later models.
*5: This option is available only for V2 (System Ver. 3.1) or later models.
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Screens

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Screen Size
(Dots)

160
¢
64

256
¢
128

320
¢
240

640
¢
400

640
¢
400

640
¢
480

260
¢
140

320
¢
240

640
¢
480

Max. No. of
Screen 250 500 2000 1000 2000 3999

Standard Screen 1 to
250

1 to
250
256 to
500

1 to 1899, 2000 1 to
1000 1 to 1899, 2000 1 to 3999

Parent Screen ¢

1 to
250
256 to
500

1 to 1899, 2000 1 to
1000 1 to 1899, 2000 1 to 3999

Window/Keyboard
Screen ¢ ¢ 1900 to 1979 ¢ 1900 to 1979 1 to 3999

Extended Screen ¢ ¢ 1980 to 1996 ¢ 1980 to 1996 ¢

Occurrence Histo-
ry Screen ¢ ¢ 1997 ¢ 1997 9001 (Not editable)

Frequency History
Screen ¢ ¢ 1998 ¢ 1998 9002 (Not editable)

Host Connect
Screen ¢ ¢ 1999 ¢ 1999 9000

Password Screen F ¢ ¢ ¢ ¢ ¢

Menu Screen F ¢ ¢ ¢ ¢ ¢

Print Format
Screen F ¢ ¢ ¢ ¢ ¢

Device Monitor
Screen ¢ ¢ ¢ ¢ ¢ ¢ 9021-9023*1

Brightness and
Contrast Adjust-
ment Screen

¢ ¢ ¢ ¢ ¢ ¢ 9030*2

*1: Available only for V2 models.
*2: Available only for V2 (System Ver. 3.1) or later models.

Screen Properties

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

None ¢ F F F F F

B

Contin-
uous ¢ F F F F F

Buzzer Beep ¢ F ¢ F ¢ ¢

Long ¢ ¢ F ¢ F F

Short ¢ ¢ F ¢ F F

History F ¢ F F F F

System Keypad ¢ F F F F ¢

Back- Type ¢ F F F ¢ ¢ FBack
light Color ¢ ¢ F ¢ ¢ ¢ ¢

Color – Back-
ground ¢ ¢ F F ¢ ¢ F ¢ F ¢ F
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Elements

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Alarm Alarm List

Start Bit
Table Entry

¢ ¢ F F ¢ F F F F F F F

Alarm List

No. of Bits
Referenced

¢ ¢ F F ¢ F F F F F F F

Alarm
History

order of
frequency/
order of
occurrence

¢ ¢ F F ¢ F F F F F F F

Alarm
History

History Info
¢ ¢ F F ¢ F F F F F F F

Alarm
History

Info Type
¢ ¢ F F ¢ F F F F F F F

Message –
Display
Line Qty

¢ ¢ F(1-12) F(1-12) ¢ F(1-16) F(1-24) F(1-7) F(1-12) F(1-12) F(1-24) F(1-24)

Message –
Length

¢ ¢ F(1-39) F(1-39) ¢ F(1-40) F(1-40) F(1-32) F(1-39) F(1-39) F(1-40) F(1-40)

Message –
Smoothing

¢ ¢ F F ¢ F F F F F F F

Message –
Scale

¢ ¢ F F ¢ F F F F F F F

Display
ImageLib

¢ ¢ F F ¢ F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground –
ON

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground –
OFF

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Image &
Library –
Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F



Appendix ETables of Functions of PT Models

519

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Alarm Image &
Library –
Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Line Scroll
Touch
Switch

¢ ¢ F F ¢ F F F F F F F

Page
Scroll
Touch
Switch

¢ ¢ F F ¢ F F F F F F F

Stan-
dard
Lamp

Shape –
Rectangle

¢ F F F F F F F F F F F

Shape –
Circle

¢ F F F F F F F F F F F

Shape –
Polygon

¢ ¢ F F ¢ F F F F F F F

Shape –
Sector

¢ ¢ F F ¢ F F F F F F F

Frame ¢ F F F F F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Lamp At-
tribute

¢ F F F F F F F F F F F

Color – ON ¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
OFF

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Label –
Max No. of
characters

¢ F(32) F(40) F(40) F(80) F(80) F(80) F(32) F(40) F(40) F(80) F(80)

Label –
Font Type

¢ F F F F F F F F F F F

Label –
Scale

¢ F F F F F F F F F F F

Label –
Smoothing

¢ ¢ F F ¢ F F F F F F F

Label – At-
tribute

¢ ¢ F F ¢ F F F F F F F

Label –
Color – ON

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Label –
Color –
OFF

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ¢ F

Label –
Color –
Back-
ground

¢ ∆*2 F F ∆*2 ∆*2 F ∆*1 ∆*1 ∆*1 ∆*1 ∆*1

Label-Off-
Description

¢ F F F F F F F F F F F
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Label-On-
Description

¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Multiline
Label

¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Static La-
bel Type

¢ F F F F F F F F F F F

Numeral/
String Dis-
play Label
Type

¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

*1: Fix to transparent *2: Fix to black *3: Available only in V2 and later models
With the NT21 and with the NT31, NT31C, NT631 and NT631C with “-V1” and above, smoothing is not performed since 32 dot font is
used.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Stan-
dard
Lamp

Insert Mark ¢ F F F F F F F F F F F

Insert
Image

¢ ¢ F F ¢ F F ¢ ¢ ¢ ¢ ¢

Image
Lamp

ON State –
Code

¢ ¢ F F ¢ F F F F F F F

OFF State
– Code

¢ ¢ F F ¢ F F F F F F F

Numer-
al Dis-
play

Indirect
Reference

¢ F F F F F F F F F F F

Table Entry F F F F F F F F F F F F

Display
Type –
Decimal/
Hexadeci-
mal

F

Decimal
only

F F F F F F F F F F F

Format –
Integer/
Decimal

F F F F F F F F F F F F

Zero Sup-
pression

F F F F F F F F F F F F

Display
Sign

F F F F F F F F F F F F

Font Type
F

Standard
only

F F F F F F F F F F F

Scale
F

2¢1,
1¢1

F F F F F F F F F F F

Smoothing ¢ ¢ F F ¢ F F F F F F F

Attribute F F F F F F F F F F F F

Color –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

String
Display

Indirect
Reference

¢ F F F F F F F F F F F

Table Entry ¢ F F F F F F F F F F F

Length F(20) F(32) F(40) F(40) F(40) F(40) F(40) F(32) F(40) F(40) F(40) F(40)

Font Type
F

Standard
only

F F F F F F F F F F F

Scale
F

1¢1,
2¢1

F F F F F F F F F F F
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

String
Di l

Smoothing ¢ ¢ F F ¢ F F F F F F F

Display Attribute F F F F F F F F F F F F

Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Background

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Data
I t

Table Entry F F F F F F F F F F F F

Input –
Numer-
al

Display Type
– Decimal/
Hexadeci-
mal

F

Decimal
only

F F F F F F F F F F F

Limit – Maxi-
mum

¢ ¢ F F F F F F F F F F

Limit – Mini-
mum

¢ ¢ F F F F F F F F F F

Format – In-
teger/Deci-
mal

F ¢ F F F F F F F F F F

Zero Sup-
pression

F F F F F F F F F F F F

Display Sign F F F F F F F F F F F F

Font Type F

Stan-
dard
only

F F F F F F F F F F F

Scale F

1¢1,
2¢1

F F F F F F F F F F F

Smoothing ¢ ¢ F F ¢ F F F F F F F

Attribute F F F F F F F F F F F F

Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Background

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Focus
Frame

¢ ¢ F F ¢ F F F F F F F

Focus Attrib-
ute

¢ ¢ F F ¢ F F F F F F F

Interlock ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Data
I t

Table Entry ¢ ¢ F F ¢ F F F F F F F

Input –
String

Length ¢
¢ F(40) F(40) ¢ F(40) F(40) F(32) F(40) F(40) F(40) F(40)

Font Type ¢ ¢ F F ¢ F F F F F F F

Scale ¢ ¢ F F ¢ F F F F F F F

Smoothing ¢ ¢ F F ¢ F F F F F F F

*3: Available only in V2 and later models.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Data
Input –
String

Attribute
¢ ¢ F F ¢ F F F F F F F

Color –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Focus
Frame

¢ ¢ F F ¢ F F F F F F F

Focus At-
tribute

¢ ¢ F F ¢ F F F F F F F

Interlock ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Data
Input –
Th b

Table
Entry

¢ F F F F F F F F F F F

Thumb-
wheel
Switch

Display
Type –
Decimal/
Hexade-
cimal

¢ F F F F F F F F F F F

Format –
Integer/
Decimal

F F F F F F F F F F F

Limit –
Maximum

¢ F F F F F F F F F F F

Limit –
Minimum

¢ F F F F F F F F F F F

Display
Sign

¢ F F F F F F F F F F F

Attribute ¢ F F F F F F F F F F F

Size ¢ F *1 F F F *2 F F F F F F F

End Plate ¢ F F F F F F F F F F F

Charac-
ter Color
– Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Charac-
ter Color
– Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Thumb-
wheel
Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

*1: Small & Medium only
*2: Medium only
*3: Available only in V2 and later models.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Data
Input –
Thumb-
wheel
S it h

Thumb-
wheel Col-
or – Fore-
ground *1

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Switch Thumb-
wheel Col-
or – Back-
ground *2

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Interlock ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*4 F*4 F*4 F*4

Graph-
ic
(Fixed

Polyline
¢ F F F F F F F F F F F

(Fixed
Dis-
play)

Rectangle
¢ ¢ F F ¢ F F F F F F F

Polygon ¢ ¢ F F ¢ F F F F F F F

Circle ¢ F F F F F F F F F F F

Arc ¢ ¢ F F ¢ F F F F F F F

Sector ¢ ¢ F F ¢ F F F F F F F

Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Text
(Fixed
Di

Maximum
Character

20 32 40 40 80 80 80 32 40 40 80 80

Dis-
play)

Font Type F

Stan-
dard
only

F F F F F F F F F F F

Scale 1¢1,
2¢1

F F F F F F F F F F F

Smoothing ¢ ¢ F F ¢ F F F F F F F

Attribute F F F F F F F F F F F F

Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Insert Mark F F F F F F F F F F F F

Insert
Image

¢ ¢ F F ¢ F F F*5 *3 *3 *3 *3

Tiling
(Fi d

Pattern ¢ ¢ F F ¢ F F F F F F F

(Fixed
Dis-
play)

Color –
Foreground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

play)
Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Border

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

*1: Foreground color for switch
*2: Background color for switch
*3: This option will be available for corresponding V2 and later models in NT30/620-compatible mode.
*4: Available only in V2 and later models.
*5: This option is available in NT20S-compatible mode.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Mark
(Fi d

Code ¢ ¢ F F ¢ F F F F F F F

(Fixed
Display)

Scale ¢ ¢ F F ¢ F F F F F F F
Display)

Attribute ¢ ¢ F F ¢ F F F F F F F

Smooth-
ing

¢ ¢ *1 F F ¢ *1 F F ¢ ¢ ¢ ¢ ¢

Color –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Image Display (Fixed
Display)

¢ ¢ F F ¢ F F F F F F F

Indirect
Refer-
ence

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*2 ∆*2 ∆*2 ∆*2

Color –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Library Display
(Fixed Display)

¢ ¢ F F ¢ F F F F F F F

Indirect
Refer-
ence

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*2 ∆*2 ∆*2 ∆*2

Touch
Switch

Function
– Notify
Bit

¢ F F F F F F F F F F F

Function
– Switch
Screen

¢ F F F F F F F F F F F

Function
– Input
Key –
Control

¢ F F F F F F F F F F F

Function
– Input
Key –
Window/
Keyboard

¢ ¢ F F ¢ F F F F F F F

Function
– Input
Key –
String

¢ ¢ F F ¢ F F F F F F F

Function
– Copy
Setting

¢ ¢ F F ¢ F F F F F F F

*1: For NT20S, NT600S, smoothing is always ON.

*2: Can be used only NT31, NT31C, NT631, NT631C with system Ver. 2.1 and above.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Touch
Switch

Function
– Cursor
Move

¢ ¢ F F ¢ F F F F F F F

Function
– Screen
Print

¢ ¢ F F ¢ F F F F F F F

Function-

Window
Move

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

PC (PLC)
Bit Ad-
dress

¢ F F F F F F F F F F F

Shape –
Standard

¢ F F F F F F F F F F F

Shape –
Shadow

¢ F F F F F F F F F F F

Shape –
3-Dimen-
sion

¢ ¢ F F ¢ ¢ F F F F F F

Shape –
Rectan-
gle

¢ ¢ F F ¢ F F F F F F F

Shape –
Circle

¢ ¢ F F ¢ F F F F F F F

Shape –
Polygon

¢ ¢ F F ¢ F F F F F F F

Shape –
Sector

¢ ¢ F F ¢ F F F F F F F

Frame ¢ F F F F F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Show ON
State

¢ F F F F F F F F F F F

Lamp At-
tribute

¢ F F F F F F F F F F F

Color –
ON

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color –
OFF

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Max No.
of Char-
acters

¢ 32 40 40 80 80 80 32 40 40 80 80

Label –
Font
Type

¢ F F F F F F F F F F F

Label –
Scale

¢ F F F F F F F F F F F

Label –
Smooth-
ing

¢ ¢ F F ¢ F F F F F F F

*1: Can be used only for NT31, NT31C, NT631 and NT631C with “-V1” and above.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Touch
Switch

Label –
Attribute

¢ ¢ F F ¢ F F F F F F F

Label –
Color –
ON

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ¢ F

Label –
Color –
OFF

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Label –
Color –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Label –
Insert
Mark

¢ F F F F F F F F F F F

Label –
Insert
Image

¢ ¢ F F ¢ F F ¢ ¢ ¢ ¢ ¢

Interlock ¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Multiline
Label

¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Static La-
bel Type

¢ F F F F F F F F F F F

Numeral/
String
Display
Label
Type

¢ ¢ ¢ ¢ ¢ ¢ ¢ F F*3 F*3 F*3 F*3

Trend
Graph

Standard/
Pen
Reco

¢ ¢ F F ¢ F F F F F F F

Drawing
Width

¢ ¢ 1-320 1-320 ¢ 1-640 1-640 2-260 2-320 2-320 2-640 2-640

Sampling
Cycle

¢ ¢ F F ¢ F F F F F F F

Table
Entry

¢ ¢ F F ¢ F F F F F F F

100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

100% –
Value

¢ ¢ F F ¢ F F F F F F F

0% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

0% – Val-
ue

¢ ¢ F F ¢ F F F F F F F

–100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

–100% –
Value

¢ ¢ F F ¢ F F F F F F F

*3: Available only in V2 and later models.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Trend
Graph

Line –
Style

¢ ¢ F F ¢ F F F F F F F

Line –
Color

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Direction ¢ ¢ F F ¢ F F F F F F F

Display
Sign

¢ ¢ F F ¢ F F F F F F F

Frame ¢ ¢ F F ¢ F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – +
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – –
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Display
%

¢ ¢ F F ¢ F F F F F F F

Display
% – Font
Type

¢ ¢ F F ¢ F F F F F F F

Display
% –Scale

¢ ¢ F F ¢ F F F F F F F

Display
% –
Smooth-
ing

¢ ¢ F F ¢ F F F F F F F

Display
% – Col-
or –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Display
% – Col-
or –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Broken-
line
Graph

Start
Table
Entry

¢ ¢ F F ¢ F F F F F F F

No. of
Points

¢ ¢ 2-320 2-320 ¢ 2-512 2-512 2-260 2-320 2-320 2-512 2-512

100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

100% –
Value

¢ ¢ F F ¢ F F F F F F F

0% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

0% – Val-
ue

¢ ¢ F F ¢ F F F F F F F

–100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

–100% –
Value

¢ ¢ F F ¢ F F F F F F F

Line –
Style

¢ ¢ F F ¢ F F F F F F F

Line –
Color

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Direction ¢ ¢ F F ¢ F F F F F F F

Display
Sign

¢ ¢ F F ¢ F F F F F F F

Frame ¢ ¢ F F ¢ F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – +
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – –
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Bar
Graph

Table
Entry

F F F F F F F F F F F F

100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

100% –
Value

F F F F F F F F F F F F

0% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

0% – Val-
ue

¢ ¢ F F ¢ F F F F F F F

–100% –
Table
Entry

¢ ¢ F F ¢ F F F F F F F

–100% –
Value

¢ ¢ F F ¢ F F F F F F F

Direction F

Right
only

F F F F F F F F F F F

Display
Sign

¢ F F F F F F F F F F F

Frame F F F F F F F F F F F F

Color –
Frame

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – +
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Color – –
Range

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Display
%

F F F F F F F F F F F F

Display
% – Font
Type

F

Stan-
dard
only

F F F F F F F F F F F

Display
% –
Scale

F

1¢1,
2¢1

F F F F F F F F F F F

Display
% –
Smooth-
ing

¢ ¢ F F ¢ F F F F F F F

Display
% – Col-
or –
Fore-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F

Display
% – Col-
or –
Back-
ground

¢ ¢ ¢ F ¢ ¢ F ¢ ¢ F ¢ F
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Ana-
l

Frame ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

logue
Meter

Color --
Frame

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Display
Sign

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Direction ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Meter --
Shape

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Meter --
Direction

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Meter --
Type

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Meter --
Width
Rate

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Scale ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Distance ¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Scale
Length

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

No. of Di-
vision

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Scale
Color

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Color --
Fore-
ground

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Color --
Back-
ground

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Color --
+Range

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Color --
--Range

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ ∆*1 ¢ ∆*1

Value --
Table
Entry

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

*1: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1” and above.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C
Ver. 4

NT21 NT31 NT31C NT631 NT631C

Ana-
logue
M t

Display
Label

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Meter 100% --
Table
Entry

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

100% --
Value

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

0% --
Table
Entry

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

0% --
Value

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

--100% --
Table
Entry

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

--100% --
Value

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Display
% -- Font
Type

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Display
% --
Scale

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Display
% --
Smooth-
ing

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Display
% --
Fore-
ground

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Display
% --
Back-
ground

¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*1 ∆*1 ∆*1 ∆*1

Rec-
ipe

Object
¢ ¢ ¢ ¢ ¢ ¢ ¢ F ∆*2 ∆*2 ∆*2 ∆*2

*1: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1” and above.
*2: Can be used only with NT31/631C(System Ver.3.1) and above.



533

Appendix F
Limits on Numbers of Elements

Limits with Conventional Models
For NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C, the limits
on the use of elements are indicated below for each PT model.

Item Limit

Numeral Display 50 entries/screen

String Display NT20S: 32 entries/screen

Other models: 50 entries/screen

Bar Graph 50 entries/screen

Broken-line graph NT20S, NT600S: Not supported

Other models: 1 frame/screen, 256 lines/frame

Trend Graph NT20S, NT600S: Not supported

Other models: 1 frame/screen, 50 lines/screen data file

Lamp NT20S: 128 entries/screen

NT600S: 255 entries/screen

Other models: 256 entries/screen

Touch Switch NT20S: 72 entries/screen

NT600S: 128 entries/screen

Other models: 256 entries/screen

Data Input – Numeral 50 entries/screen
(overlapping screens: Registration is possible only on one child

Data Input – String
(overlapping screens: Registration is possible only on one child
screen.)

Alarm List NT20S, NT600S: Not supported

Other models: 4 groups/screenAlarm History Other models: 4 groups/screen
(max. 32 groups in overlapping screens)
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New Models

Item Limit

Fixed Display 65,535 entries/screen (overlapping screens*1: max. 524,280 entries)

Numeral Display 256 entries/screen (overlapping screens*1: max. 1,024 entries)

String Display 256 entries/screen (overlapping screens*1: max. 1,024 entries)

Image Data 256 entries/screen, including library data
(overlapping screens*1: max. 1,024 entries)

Library Data 256 entries/screen, including image data
(overlapping screens*1: max. 1,024 entries)

Mark Display (fixed dis-
play)

65,535 entries/screen (overlapping screens*1: max. 52,480 entries)

Bar Graph 50 entries/screen (overlapping screens*1: max. 400 entries)

Analogue Meter*2 50 entries/screen (overlapping screens*1: max. 400 entries)

Broken-line Graph 1 frame/screen (overlapping screens*1: max. 8 frames) 256 lines/frame

Trend Graph 1 frame/screen (overlapping screens*1: max. 8 frames)

Data logging function not used: 50 lines/screen data

Data logging function used: 8 lines/screen data

Lamp 256 entries/screen (overlapping screens*1: max. 1,024 entries)

Touch Switch 256 entries/screen (overlapping screens*1: max. 1,024 entries)

Numeral
Input

Numeric
Key Type

256 entries/screen (overlapping screens*3: Registration is possible only
on one child screen)

Thumb-
wheel SW
Type

NT21: 26 entries/screen (overlapping screens*4: Registration is pos-
sible only on one child screen.)

NT31/NT31C: 64 entries/screen (overlapping screens*4: Registration is
possible only on one child screen.)

NT631/NT631C: 256 entries/screen (overlapping screens*4: Registra-
tion is possible only on one child screen.)

Data Input – String 256 entries/screen
(overlapping screens*3: Registration is possible only on one child
screen.)

Alarm List 4 groups/screen (max. 32 groups in overlapping screens*1)
(Alarm history: One group each for occurrence order and frequency

Alarm History
(Alarm history: One group each for occurrence order and frequency
order in standard/child screen)

Recipe 1 frame/screen (overlapping screens*1: max. 8 frames)

*1: Limits on numbers of elements on awindow/keyboard screen is sameas on
a standard screen. Limit check is not performed for overlapping screens at
the Support Tool.

*2: Analoguemeter can be used onlywith theNT21andwith theNT31,NT31C,
NT631 and NT631C with “-V1” and above.

*3: Either of numeral input (numeric key type) or string input can be registered
on a window/keyboard screen.

*4: Thumbwheel type numeral input can not be registered on a window/key-
board screen.
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Limits on display

For elements, limits are also applied to display in addition to the limits on the
numbers shown above.

S Limits on reading the data

For the NT21, NT31, NT31C, NT631, and NT631C, the allowable number of
dataentries that canbe readat thesame time is set and readelementsexceed-
ing this limit are not displayed. If the same data is read fromdifferent elements,
reading of the data is counted separately.

Refer to the appendix in the NT21/31/631 ReferenceManual for the allowable
maximum number of data entries that can be read.
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Appendix G
New Functions of Support Tool Ver.4.1

Here, differences between the Support Tool Ver.3.3 and Ver.4.1 and the new
functions added to Ver.4.1 are shown in the table. Various functions are added to
Ver.4.1 to improve operational efficiency.

Items Ver.3.3 Ver.4.1 Section

NT31/631 V2 Models
support

Not supported The following PT Models are sup-
ported:

NT31-V2
NT31C-V2
NT631-V2
NT631C-V2

3-3

Different On/off de-
scription for standard
lamp/touch switch.

Not supported The following functions are sup-
ported.

S On description and Off description
of standard lamp/touch switch can
be different in V2 models.

6-5-1
6-8

Insertion of image/li-
brary in character
string

Not available in new
models

This option will be available for
NT31/C-V2 and NT631/C-V2 mod-
els in NT30/620 compatible mode.

6-2-7
6-7
7-3-5

Retaining of alarm his-
tory/list associated
touch switch attributes,
when converted from
NT30/620 model to
new V2 models.

Not supported. Alarm history/list associated touch
switches will keep its attributes un-
changed when converted from
NT30/620 to V2 models in
NT30/620-compatible mode.

Appen-
dix-A
Correc-
tion of
alarm
list/histo-
ry touch
switches

Centralizing the Label
of Lamp and Touch
switch in both horizon-
tal and vertical direc-
tion.

Label is centralized
only in horizontal
direction

Label is centralized both horizontal
and vertical direction.

6-1-9
9-3-12

Mathematical Table Not supported A different memory table is sup-
plied to input mathematical func-
tions.

7-9
9-3

Interlock Not supported This facility is provided to activate
or deactivate the associated object.
Only when interlock is ON the ob-
ject will response to the user
touches, deactivated otherwise.

6-1-12

New Words Added to
OMRON

Not supported Words for EM Bank 0..F, Time Up
Flag, Counter Up Flag, Task Flag
and Work Area are added

6-1-10

Device monitor screen Not supported New Device monitor screens
(9021-23) are available switch
screen functionality of touch switch/
bit memory table.

5-12
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Items Ver.3.3 Ver.4.1 Section

I/O Comments Import Not supported I/O Comments in TAB delimited text
file can be imported to NTST.

7-7-4

Multiline Label Not supported Labels (ON/OFF Descriptions) can
be entered in multiple lines.

6-5-1
6-8

NT30/620 Compatible
Mode

Not supported With this option it can be chosen
between the existing 31/631 mod-
el’s 5-2 control/Notify structure or
the 30/620 model’s 4-3 control/
notify structure.

3-3-1
App-A
Correct-
ing the
Control/
Notify
Area
Conver-
sion

Numeral/String Display
Label Type

Not supported Enables dynamic labeling as Label
can be taken from Numeral or
String table

6-5-1
6-8

Input Key -- String
function Touch Switch
of NT31, NT31C,
NT631, NT631C

Description of label is
always used as a char-
acter string to be input.
(When a touch switch
is pressed, a label will
be input.)

Character strings can be specified
individually. Addition of Copy From
Label button. When a touch switch
is pressed, set character string will
be input regardless of the label.

6-8-3

Start-up of system in-
staller from the Sup-
port Tool

Not supported

Can be started using
Windows Start button
only

System installer can be started di-
rectly by selecting [Connect] --
[Launch System Installer]. (It can
also be started up from Windows.)

1-1

System programs to
be attached

NT31/631 series sys-
tem programs

System programs of conventional
models such as NT30/620 series
are also included in a CD-ROM.

1-1

Recipe Not supported This is available only for
NT31/631-V2 (System Ver.3.1).

6-11-1

7-10

Brightness and Con-
trast Adjustment
Screen

Not supported This is available only for
NT31/631-V2 (System Ver.3.1).

5-14

Multi-Edit Mode Not supported Available only for recipe object. 6-1
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Appendix H
New Functions of Support Tool Ver.4.6

Some User Interface functionality was added to Ver.4.6 to improve operation efficiency.

Item Ver. 4.1 Ver. 4.6

NT21 Model support Not supported. NT21 is supported.

Pick I/O comment from
CX-Server database

Only CSV file import is available. When defining PLC address for each object,
the I/O name in CX-Server point data is
picked up as the PT I/O comment.

When editing the I/O comment table multiple
I/O names in CX-Server point data are
imported as PT I/O comments.

Property Dialog for
Grouped Object

Grouped object attributes cannot be edited
unless ungrouped.

Grouped object attributes can be edited to
select each property for grouped object.

Preview in Symbol
manager

Each symbol cannot be previewed on the
Symbol Manager.

Symbol Manager shows preview and object
tree view. Symbols created before V4.6 can
be read on V4.6 screen edit to add preview
data, then can be previewed after copying
then back to the Symbol Manager.

Copying
Image/Library/Mark with
contents

Only code of image/Library/Mark in the
object is copied when the object is copied
from other application with Import
Components Command. Contents must be
copied separately.

Contents of Image/Library/Mark in the object
is copied when the object is copied form
other application with Import Components
command. Separate copying of contents is
also available.
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Appendix I
Error Messages

The error message that may be displayed while using the Support Tool, and the
action to take in response to them, are shown below.

The indications [W] and [E], given at the beginning of an error message, classify
the level of errors as indicated below.

[W]: Minor error (permits transmission and execution of screen data)

[E]: Major error (disables transmission of screen data)

Error Message Corrective Action

Sign % display or other element(s) cannot
overlap with the Trend Graph.

A “% display” or other element is overlap-
ping the trend graph. Move the element
outside the trend graph frame.

A Application version mismatched; Com-
munication aborted.

System program version installed in a PT
maybe a lower one. For details of the com-
bination of system program version that
can be transmitted and the PT model set-
ting at the Support Tool, refer to 11-1-2
Available Data Communication Methods
by PT Models.
For details of updating the system pro-
gram, refer to Appendix B.

C Cannot have more than XXX child
screens.

When creating a new screen, insert a
number of child screens that does not ex-
ceed the maximum limit.

Clock Monitoring Address has not been
set.

With an NT21 PT, set the Clock Address to
define a clock Data Area so the clock data
can be read from the PLC.

Constant Value is out of limit. Maximum
value restored.

Correct the screen data or the program in
the host so that a constant of up to 8 digits
set for the copy setting touch switch will
suffice.

Continuous screen does not allow child
screen to have Thumbwheel/Numeral/
String Input elements.

Delete thumbwheel switches, numeral in-
put elements, and/or character string input
elements.

Control/Notify/Window Control area can-
not overlap each other.

Make sure that the PT status control area,
the PT status notify area and the window
control area are not overlapping each oth-
er.

Cursor Move Touch Switch does not
have any association link.

Select the cursor moving touch switch on
the screen, choose [Draw] -- [Associate],
then specify the element with which the
selected touch switch is to be associated.
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Corrective ActionError Message

D Due to length limitation, Input Key --
String Touch Switch is only displaying
part of the label message.

With NT620S, NT620C and NT625C, if a
character string input is selected as the
touch switch function, up to 80 characters
can be set for an input character string.

With NT21, NT31, NT31C, NT631 and
NT631C, however, although up to 80 char-
acters can be set for a label, the limit is 40
characters for an input character string (a
character string that is input using a touch
switch).

F [Fixed Display Mark] -- smoothing not
supported. It is ignored.

The mark is automatically displayed with-
out smoothing processing.

I Image Table entry has been converted. If the converted image code differs from
the code of the image data that is to be
displayed, correct the code.

Incompatible PT hardware connected;
communication aborted.

The PT model between the screen data
and the target PT is mismatching on down-
loading/uploading. Check the contents of
PT Configuration.

Input key-window/keyboard screen num-
ber is not within the valid range. Mini-
mum value restored.

Create the window/keyboard screen for a
screen number in the range 1900 to 1979
and convert the window/keyboard screen
number set for the touch switch according-
ly.

L Library Table Entry has been converted. If the converted library code differs from
the code of the library data that is to be
displayed, correct the code.

M Memory access mismatched; commu-
nication aborted.

Target PLC vendor type or PT type is mis-
matching between the Support Tool and
PT hardware. Confirm the Support Tool
and PT side PLC vendor and PT type is
mismatching.

Memory utilization has exceeded the
XXX bytes limit by YYY bytes.

Delete several elements.

Memory utilization has exceeded the
XXX bytes limit by YYY bytes.

Delete several elements and screens.

More than one Numeral Input/Thumb-
wheel are referring to Numeral Table
entry 0.

Set different numeral memory table entry
numbers at the numeral input and thumb-
wheel switch properties.

N Notify Area not specified.

Control Area not specified.

Set the PC (PLC) address for the PT sta-
tus control area/PT status notify area after
selecting [Tools] -- [PT Configuration].

Number of [Object name] has exceeded
the XXX limit by YYY.

Delete several elements.

[Numeral Input] -- Total number of integer
and decimal exceeds limit. It is dis-
carded.

Create the numeral input field again. Cor-
rect the screen data and the program in
the host so that numeric values such as
maximum/minimum check values and an
input value of up to 8 digits will suffice.
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Corrective ActionError Message

O [Object Name] -- % value is out of limit.
Default values restored for 100%, 0%,
and –100%.

Correct the screen data or the program at
the host so that a value of up to 8 digits
will be sufficient for the 100% value, 0%
value and –100% value in the bar graph.

[Object Name] has exceeded the maxi-
mum number of characters.

Set the character string within the limit.

[Object name] refers to invalid numeral
table entry. The referenced table entry is
reset to entry 0.

Correct the table entry number to a num-
ber within the valid range. If the table entry
number is specified in a program, correct
the program also.

[Object Name] -- Invalid PLC address. It
is reset to default.

Reset the word number to a number of up
to 4 digits. If this PC (PLC) address is re-
ferred to from the program, it is necessary
to correct the program accordingly.

[Object Name] -- inverse attribute not
supported. Foreground and Background
colors interchanged.

Since foreground color and background
color are automatically interchanged, no
special correction is required (display at-
tribute is set to default (standard).).

Overlapping screen has more than 1
child screen containing Thumbwheel/Nu-
meral/String Input elements.

Overlapping screens do not allow the set-
ting of multiple input functions. Correct the
child screens.

P Please make sure this parent screen
have at least 2 children.

Select the parent screen, then right click
the mouse and select [Modify]. Insert at
least 2 child screens for the parent screen.

S Sampling cycle less than the minimum
value. Minimum value is restored.

Since there are no problems in actual op-
eration, correction is not necessary.

Sampling cycle not multiple of 5. Value
rounded off to nearest multiple of 5.

Since there are no problems in actual op-
eration, correction is not necessary.

Screen is empty, downloading may not
be possible.

Create the data in the empty screen or de-
lete the empty screen.

Some objects exceed library size in code
FA20. The objects will not be down-
loaded to PT hardware.

Reduce the size of elements exceeding
the library size using the library editor, or
set a larger library size.

String Table: Table Entry XXX has invalid
component code. It has been converted
from XXXX to YYYY.

Delete the code from the character string
and make corrections so that an equiva-
lent display can be obtained by displaying
and grouping the character string and the
fixed display image/library data.

T The associated touch switches of the
alarm has been discarded and compo-
nent touch switches have been created.

Correct the position of the control touch
switches as needed. If a control touch
switch is not necessary, cancel the check
for the control touch switch in the alarm
list/history properties. (With alarm touch
switches for NT31, NT31C, NT631, and
NT631, it is not possible to change the
size and label.)

The child screen XXX containing Numer-
al/String Input element(s) does not have
the same key attribute as the overlapping
screen.

In the screen properties, set the same
[Keypad] attribute both for the parent and
child screens.
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Corrective ActionError Message

T The code for screen element [Object
Name] has been converted from XXXX to
YYYY.

If the converted code differs from the code
of the image element that is to be dis-
played, correct the code.

The code for screen element [Object
Name] has been converted from XXXX to
YYYY.

If the converted code differs from the code
of the library data that is to be displayed,
correct the code.

The component Touch Switches of the
Alarm List will be discarded.

Create the control touch switches using
the control code input function as required,
and associate them with the alarm list/his-
tory.

The screen no. XXX of type YYY is not
supported as a child, so the parent-child
association is discarded.

With a new model, it is not permissible to
specify a window/keyboard screen as a
child screen of overlapping screens. Copy
the contents of the window/keyboard
screen to a standard screen and specify
this screen as the child screen of the over-
lapping screens.

The screen no. XXX was a Continuous
Parent Screen which is not supported in
this model. It is discarded.

Use a touch switch to switch screens. If
the program is created to display the par-
ent screen of the continuous screens, cor-
rect the program so that the first child
screen is displayed.

The screen no. XXX was an Extended
Screen which is not supported in this
model, so it is converted to standard
screen.

Correction not necessary.

The screen number referenced in Touch
Switch, is not a Window/Keyboard
screen.

Create the window/keyboard screen after
selecting [New], then use it as the refer-
ence screen.

The total number of Alarm List and Histo-
ry exceeds the overlapping screen’s limit
of XXX by YYY.

Create the alarm list/history within the limit.

The total number of Bar Graph exceeds
the overlapping screen’s limit of 400 by
YYY.

Create the bar graphs within the limit.

The total number of Broken Line Graphs
exceeds the overlapping screen’s limit of
XXX by YYY.

Create the broken line graphs within the
limit.

The total number of lines in Broken Line
Graphs exceeds the overlapping
screen’s limit of XXX by YYY.

Create the broken line graphs within the
limit.

The total number of XXX exceeds the
overlapping screen’s limit of 256 by ZZZ.

Create the elements within the limit.

The total number of Image Display and
Library Display exceeds the overlapping
screen’s limit of 256 by XXX.

Create the image/library data within the
limit.

The total number of Numeral Display ex-
ceeds the overlapping screen’s limit of
1024 by XXX.

Create the numeral display fields within
the limit.
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Corrective ActionError Message

T The total number of Numeral Table refer-
ences exceeds the overlapping screen’s
limit of XXX by YYY.

Reduce the number of reference elements.

The total number of String Table refer-
ences exceeds the overlapping screen’s
limit of XXX by YYY.

Create the elements within the maximum
limit.

The total number of touch switches ex-
ceeds the overlapping screen’s limit of
XXX by YYY.

Create the touch switches within the limit.

The total number of Trend graph frame
exceeds the overlapping screen’s limit of
8 by XXX.

Create the trend graphs within the limit.

The total number of Trend Graph line
with Data Logging is ON exceeds the ap-
plication limit of 8 by YYY.

Create the trend graphs within the limit.

The total number of vertices in Broken
Line Graphs exceeds the overlapping
screen’s limit of XXX by YYY.

Create the broken line graphs within the
limit.

This screen does not support XXX. It is
discarded.

Correct the system initialization screen so
that the same screen as before the con-
version is created using fixed display ele-
ments excluding image/library data.

Touch Switch function type is not sup-
ported. It is discarded.

Correct the position of the control touch
switch as needed.

Touch switch does not have associated
alarm object.

Select the alarm touch switch on the
screen, choose [Draw] -- [Associate], then
specify the element with which the se-
lected touch switch is to be associated.

Y You have already started NT-series Sup-
port Tool.

To import screen data by starting up two
Support Tools, select [Import Component]
from the [File] menu.
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Appendix J
Shortcut Keys

The following shortcut keys can be used with the Support Tool. Pressing these
shortcut keys can perform the functions easily without selecting the items from
the menu.

Menu Function Shortcut key

File New Ctrl + N

Open Ctrl + O

Save Ctrl + S

Print Ctrl + P

Edit Undo Ctrl + Z

Redo Ctrl + Y

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Align Top Ctrl + Up Arrow

Align Bottom Ctrl + Down Arrow

Align Left Ctrl + Left Arrow

Align Right Ctrl +Right Arrow

Center in a Column Ctrl + F9

Center in a Row Ctrl + Shift + F9

Delete Del

Select All Ctrl + A

View Refresh F9

Draw Group Ctrl + G

Ungroup Ctrl + U

Bring to Front Ctrl + F

Send to Back Ctrl + B

Centralize Label Ctrl + L

Screen New Ctrl + W

Delete Ctrl + E

Tools Table Ctrl + T

Validate F12

Connect Download (Application) Ctrl + Shift + D

Upload (Application) Ctrl + Shift + U

Others Properties Alt + Enter

Objects Selection Higher Display Order Tab

Lower Display Order Shift + Tab

Edit Object Mode ON/OFF Insert

Edit Object Mode ON + Object Selection Ctrl + Shift + Click

The “+” mark in the list indicates that you should press the key after the “+” mark while you press the Ctrl key etc.
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Appendix K
Connecting Cable Specifications

Tool Interface Connector Specifications
The followingspecificationsapply to theconnectionbetween thePTand thesup-
port tool (personal computer).

Pin No. Signal Name Meaning

1 FG Frame ground

2 SD Send data

3 RD Receive data

4 RS Request to send

5 CS Clear to send

9 SG Signal ground

Assembly of Connecting Cables
Wiring should be carried out in one of the following ways, depending on the type
of RS-232C connector.

25-pin Connector

Connector for peripheral
devices on PT body

Personal computer

Shield

Use the following recommended products when making the connecting cable.

Name Model Remarks

Connector XM2D-2501 25-pin Made by OMRON

XM2A-0901 9-pin Made by OMRON

Connector hood XM2S-2511 25-pin Made by OMRON

XM2S-0911 9-pin Made by OMRON

Cable AWG28×5P
IFVV-SB

Multi-core shielded cable Made by
Fujikura, Ltd.

CO-MA-VV-SB
5P×28AWG

Multi-core shielded cable Made by
Hitachi, Ltd.
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9-pin Connector

Personal computer

Shield

Connector for peripheral
devices on PT body

Use the following recommended products when making the connecting cable.

Name Model Remarks

Connector XM2D-0901 9-pin Made by OMRON

XM2A-0901 9-pin Made by OMRON

Connector hood* XM2S-0911 9-pin, mm-pitch screw Made by
OMRON

XM2S-0913 9-pin, inch-pitch screw Made by
OMRON

Cable AWG28×5P
IFVV-SB

Multi-core shielded cable Made by
Fujikura, Ltd.

CO-MA-VV-SB
5P×28AWG

Multi-core shielded cable Made by
Hitachi, Ltd.

*: At personal computer, use the connector hood which conforms to the
standard of the screw at connector part.
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Appendix L
Keycode Tables and Conversion Rule

ISO 8859/1
Example:Hex code is represented by 30, decimal code by 48, and character by 0.

0
48

30

0

20 30 40 50 60 70 80 90 A0 B0 C0 D0 E0 F0

0
32

0
48

@
64

P
80

’
96

p
112

Space

128

Space

144

NBSP

160

°
176

À
192

Ð
208

à
224

ð
240

1 !
33

1
49

A
65

Q
81

a
97

q
113

Space

129

Space

145

¡
161

±
177

Á
193

Ñ
209

á
225

ñ
241

2 ”
34

2
50

B
66

R
82

b
98

r
114

Space

130

Space

146

¢
162

2

178

Â
194

Ò
210

â
226

ò
242

3 #
35

3
51

C
67

S
83

c
99

s
115

Space

131

Space

147

£
163

3

179

Ã
195

Ó
211

ã
227

ó
243

4 $
36

4
52

D
68

T
84

d
100

t
116

Space

132

Space

148

¤
164

,
180

Ä
196

Ô
212

ä
228

ô
244

5 %
37

5
53

E
69

U
85

e
101

u
117

Space

133

Space

149

¥
165

µ
181

Å
197

Õ
213

å
229

õ
245

6 &
38

6
54

F
70

V
86

f
102

v
118

Space

134

Space

150

¦
166

¶
182

Æ
198

Ö
214

æ
230

ö
246

7 ’
39

7
55

G
71

W
87

g
103

w
119

Space

135

Space

151

§
167

·
183

Ç
199

×
215

ç
231

÷
247

8 (
40

8
56

H
72

X
88

h
104

x
120

Space

136

Space

152

¨
168

’
184

È
200

Ø
216

è
232

ø
248

9 )
41

9
57

I
73

Y
89

i
105

y
121

Space

137

Space

153

©
169

1

185

É
201

Ù
217

é
233

ù
249

A *
42

:
58

J
74

Z
90

j
106

z
122

Space

138

Space

154

ª
170

º
186

Ê
202

Ú
218

ê
234

ú
250

B +
43

;
59

K
75

[
91

k
107

{
123

Space

139

Space

155

«
171

»
187

Ë
203

Û
219

ë
235

û
251

C ,
44

<
60

L
76

\
92

l
108

|
124

Space

140

Space

156

¬
172

¼
188

Ì
204

Ü
220

ì
236

ü
252

D --
45

=
61

M
77

]
93

m
109

}
125

Space

141

Space

157

SHY

173

½
189

Í
205

Ý
221

í
237

ý
253

E .
46

>
62

N
78

^
94

n
110

~
126

Space

142

Space

158

®
174

¾
190

Î
206

Þ
222

î
238

þ
254

F /
47

?
63

O
79

_
95

o
111 127

Space

143

Space

159

¯
175

¿
191

Ï
207

ß
223

ï
239
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MS-DOS CP437

20 30 40 50 60 70 80 90 A0 B0 C0 D0 E0 F0

0
32

0
48

@
64

P
80

’
96

p
112

Ç
128

É
144

á
160 176 192 208

α
224

≡
240

1 !
33

1
49

A
65

Q
81

a
97

q
113

ü
129

æ
145

Í
161 177 193 209

β
225

±
241

2 ”
34

2
50

B
66

R
82

b
98

r
114

é
130

Æ
146

ó
162 178 194 210

Γ
226

≥
242

3 #
35

3
51

C
67

S
83

c
99

s
115

â
131

ô
147

ú
163 179 195 211

π
227

≤
243

4 $
36

4
52

D
68

T
84

d
100

t
116

ä
132

ö
148

ñ
164 180 196 212

Σ
228

⌠
244

5 %
37

5
53

E
69

U
85

e
101

u
117

à
133

ò
149

Ñ
165 181 197 213

σ
229

⌡
245

6 &
38

6
54

F
70

V
86

f
102

v
118

å
134

û
150

ª
166 182 198 214

∝
230 ÷246

7 ’
39

7
55

G
71

W
87

g
103

w
119

ç
135

ù
151

º
167 183 199 215

τ
231

≈
247

8 (
40

8
56

H
72

X
88

h
104

x
120

ê
136

ÿ
152

¿
168 184 200 216

Φ
232

°
248

9 )
41

9
57

I
73

Y
89

i
105

y
121

ë
137

Ö
153

⌐
169 185 201 217

Θ
233

•
249

A *
42

:
58

J
74

Z
90

j
106

z
122

è
138

Ü
154

¬
170 186 202 218

Ω
234

.
250

B +
43

;
59

K
75

[
91

k
107

{
123

ï
139

¢
155

½
171 187 203 219

δ
235

√
251

C ,
44

<
60

L
76

\
92

l
108

|
124

î
140

£
156

¼
172 188 204 220

∞
236

n
252

D --
45

=
61

M
77

]
93

m
109

}
125

ì
141

¥
157

¡
173 189 205 221

φ
237

2

253

E .
46

>
62

N
78

^
94

n
110

~
126

Ä
142

Pts
158

«
174 190 206 222

ε
238

J

254

F /
47

?
63

O
79

_
95

o
111 127

Å
143

ƒ
159

»
175 191 207 223

∩
239

NOT
USED
255
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Keycode Conversion Rules
When you are using the European keyboard, please read the following keycode
conversion rules.
Also, PT Hardware NT21 and NT31-V1/NT31C-V1/NT631-V1/NT631C-V1 and
above are supporting both Keycodes ISO8859/1 and CP437. This section will
describe the rule for Keycode conversion between ISO8859-1 & Latin-
US(CP437) and vice versa.
Above mentioned will be explained in following order.

(1) When the conversion will be performed.

(2) Basic Policy of the Conversion.

(3) How to Convert.

(4) Conversion Rule from ISO8859/1 to CP437.

(5) Conversion Rule from CP437 to ISO8859/1.

(1) When the conversion will be performed.

The conversion will take place during the following cases.

1. By changing to a different keycode from an existing application.
(From <Tools>--<PT Configuration>)
This is only for the NT21 and the NT31-V1/31C-V1/631-V1/631C-V1 and

above.

2. Drag/Drop of Symbols with different keycode.

3. Key input (Old & new models from ISO8859/1-CP437).

(2) Basic Policy

Basic Policy : If the Character is not found in the Target keycode, “?” (063) is
chosen.

(3) How to convert. (Only for the NT21 and the NT31/631 series with “-V1” and
above.)

The way to convert the Keycode will be as follows.

1. Go <Tools> -- <PT Configuration>

2. Change the “Font Type.”

3. Press [OK] Button.

(4) Conversion Rule from ISO8859/1 to CP437.

Mapping tables for the conversion.
This conversion will be performed when you try to make the former model
screen data such as,

NT11S, NT20S, N30/30C, NT600S, NT620S/620C, NT31/NT631 se-
ries
(System program ver.1.0) by using European Keyboard.
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Also this conversionwill take place if you are selecting “CP437” inNT31/631
series with “-V1” and above.

Note If you have Hardware NT31/631(below V1) and version up the system program
of NT31/631 series to “-V2” system program which is version 3, treat it as
NT31/631 series hardware with “-V2.”

No.
Source Destination

Windows ISO8859/1 MS-DOS CP437

01

02

03

04

05

06

07

08

09

10

11

12

”Space”
128

”Space”
129

[?]
063

[?]
063

”Space”
130

”Space”
131

”Space”
132

”Space”
133

”Space”
134

”Space”
135

[,]
044

[ƒ]
159

[”]
034

[?]
063

[?]
063

[?]
063

”Space”
136

”Space”
137

”Space”
138

”Space”
139

[^]
094

[?]
063

[S]
083

[<]
060

Windows ISO8859/1 MS-DOS CP437
No.

Source Destination

13

14

15

16

17

18

”Space”
140

”Space”
141

”Space”
142

”Space”
143

[?]
063

[?]
063

[?]
063

[?]
063

”Space”
144

”Space”
145

[?]
063

[’]
039

19

20

21

22

23

24

25

”Space”
146

”Space”
147

”Space”
148

”Space”
149

”Space”
150

”Space”
151

”Space”
152

[’]
039

[”]
034

[”]
034

[•]
249

[–]
045

[—]
196

[~]
126

26

27

28

29

30

31

32

33

34

”Space”
153

”Space”
154

[?]
063

[s]
115

”Space”
155

”Space”
156

”Space”
157

”Space”
158

”Space”
159

”Space”
160

[>]
062

[?]
063

[?]
063

[?]
063

[Ϋ]
089

”Space”
032

[¡]
161

[¡]
173

35

36

[¢]
162

[£]
163

[¢]
155

[£]
156
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No.
Source Destination

Windows ISO8859/1 MS-DOS CP437

37

38

39

40

41

42

43

44

45

46

47

48

49

50

[V]
164

[¥]
165

[¦]
166

[§]
167

[¨]
168

[?]
063

[¥]
157

[?]
063

[?]
063

[?]
063

[]
169

[a]
170

[«]
171

[¬]
172

[--]
173

[]
174

[¯]
175

[°]
176

[±]
177

[?]
063

[a]
166

[«]
174

[¬]
170

[?]
063

[?]
063

[?]
063

[°]
248

[±]
241

Windows ISO8859/1 MS-DOS CP437
No.

Source Destination

[2]
178

[3]
179

[·]
180

[µ]
181

[¶]
182

[⋅]
183

[,]
184

[1]
185

[2]
253

[?]
063

[”]
034

[µ]
230

[?]
063

[⋅]
250

[,]
044

[?]
063

[º]
186

[»]
187

[¼]
188

[º]
167

[»]
175

[¼]
172

51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

71

72

73

74

75

[½]
189

[¾]
190

[¿]
191

[À]
192

[Á]
193

[Â]
194

[½]
171

[?]
063

[¿]
168

[A]
065

[A]
065

[A]
065

[Ã]
195

[Ä]
196

[Å]
197

[Æ]
198

[Ç]
199

[È]
200

[É]
201

[Ê]
202

[A]
065

[Ä]
142

[Å]
143

[Æ]
146

[Ç]
128

[E]
069

[E]
144

[E]
069

76

77

78

79

80

81

82

83

84

85

86

[Ë]
203

[Ì]
204

[Í]
205

[Î]
206

[Ï]
207

[Ð]
208

[Ñ]
209

[Ò]
210

[E]
069

[I]
073

[I]
073

[I]
073

[I]
073

[D]
068

[Ñ]
165

[O]
079

[Ó]
211

[Ô]
212

[Õ]
213

[O]
079

[O]
079

[O]
079
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No.
Source Destination

Windows ISO8859/1 MS-DOS CP437 Windows ISO8859/1 MS-DOS CP437
No.

Source Destination

87

88

89

90

91

92

93

94

95

96

97

98

99

100

[Ö]
214

[×]
215

[Ø]
216

[Ù]
217

[Ú]
218

[Û]
219

[Ö]
153

[×]
120

[O]
079

[S]
083

[S]
083

[S]
083

[Ü]
220

[Ý]
221

[Þ]
222

[ß]
223

[à]
224

[á]
225

[â]
226

[ã]
227

[Ü]
154

[Y]
089

[T]
084

[ß]
225

[à]
133

[á]
160

[â]
131

[a]
097

101

102

103

104

105

106

107

108

[ä]
228

[å]
229

[ä]
132

[å]
134

[æ]
230

[ç]
231

[è]
232

[é]
233

[ê]
234

[ë]
235

[a]
145

[ç]
135

[è]
138

[é]
130

[ê]
136

[ë]
137

110

111

112

113

114

115

116

117

118

119

120

121

122

123

124

125

109 [¡]
236

[í]
237

[î]
238

[Ï]
239

[ô]
240

[ñ]
241

[Ò]
242

[Ó]
243

[¡]
141

[í]
161

[î]
140

[Ï]
139

[d]
100

[ñ]
164

[Ò]
149

[Ó]
162

[Ô]
244

[õ]
245

[Ö]
246

[÷]
247

[Ø]
248

[ù]
249

[ú]
250

[û]
251

[ü]
252

[Ô]
147

[O]
111

[Ö]
148

[÷]
246

[Ø]
237

[ù]
151

[ú]
163

[û]
150

[ü]
129

126

127

128

[ÿ]
253

[P]
254

[y]
121

[t]
116

Not Used
255

[ÿ]
152
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(5) Conversion Rule from CP437 to ISO8859/1
This conversionwill be performed at the timewhen you try to change the PT
Type to the NT21 and NT31-V1/31C-V1/631-V1/631C-V1 and above with
Font Type ISO8859/1.

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

21

22

26

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

[Ç]
128

[ü]
129

[Ç]
199

[ü]
252

[é]
130

[â]
131

[ä]
132

[à]
133

[å]
134

[ç]
135

[é]
233

[â]
226

[ä]
228

[à]
224

[å]
229

[ç]
231

[ê]
136

[ë]
137

[è]
138

[Ï]
139

[Î]
140

[Ì]
141

[Ä]
142

[Å]
143

[ê]
234

[ë]
235

[è]
232

[Ï]
239

[Î]
238

[Ì]
236

[Ä]
196

[Å]
197

[É]
144

[æ]
145

[Æ]
146

[ô]
147

[ö]
148

[ò]
149

[É]
201

[æ]
230

[Æ]
198

[ô]
244

[ö]
246

[ò]
242

[Ö]
153

[Ü]
154

[Ö]
214

[Ü]
220

[¢]
155

[£]
156

[¥]
157

[Pts]
158

[ƒ]
159

[á]
160

[¢]
162

[£]
163

[¥]
165

[?]
063

[?]
063

[á]
225

[í]
161

[ó]
162

[ú]
163

[ñ]
164

[N]
165

[ª]
166

[º]
167

[¿]
168

[¡]
237

[ó]
243

[ú]
250

[ñ]
241

[N]
209

[ª]
170

[º]
186

[¿]
191

[
169

[¬]
170

[½]
171

[¼]
172

[¡]
173

[«]
174

[?]
063

[¬]
172

[½]
189

[¼]
188

[¡]
161

[«]
171

No.
Source Destination

Windows ISO8859/1MS-DOS CP437 Windows ISO8859/1MS-DOS CP437

Source Destination

No.

45

46

47
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No.
Source Destination

Windows ISO8859/1MS-DOS CP437 Windows ISO8859/1MS-DOS CP437

Source Destination

No.

48

49

50

[»]
175

176

177

[»]
187

[?]
063

[?]
063

51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

71

72

178

179

180

181

182

183

184

185

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

186

187

188

189

190

191

192

193

194

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

195

196

197

198

199

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

73

74

75

200

201

]
202

[?]
063

[?]
063

[?]
063

76

77

78

79

80

81

82

83

84

85

86

87

88

89

90

203

204

205

206

207

208

209

210

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

211

212

213

214

215

216

217

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

91

92

93

94

95

96

97

218

219

[?]
063

[?]
063

220

221

222

223

[α]
224

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063
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No.
Source Destination

Windows ISO8859/1MS-DOS CP437 Windows ISO8859/1MS-DOS CP437

Source Destination

No.

98

99

100

[β]
225

[Γ]
226

[π]
227

[B]
223

[?]
063

[?]
063

101

102

103

104

105

106

107

108

109

110

111

112

[Σ]
228

[σ]
229

[?]
063

[?]
063

[µ]
230

[τ]
231

[Φ]
232

[Θ]
233

[Ω]
234

[δ]
235

[µ]
181

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[∞]
236

[φ]
237

[ε]
238

[∩]
239

[≡]
240

[?]
063

[φ]
248

[?]
063

[?]
063

[?]
063113

114

115

116

117

118

119

120

121

122

123

124

125

126

127

128

[2]
253

[J]
254

[2]
178

[?]
063

Not Used
255

”Space”
160

[±]
241

[≥]
242

[≤]
243

[±]
177

[?]
063

[?]
063

[⌠]
244

[⌡]
245

[÷]
246

[≈]
247

[°]
248

[•]
249

[⋅]
250

[3]
251
[n]
252

[?]
063

[?]
063

[÷]
247

[?]
063

[°]
176

[Space]
149

[⋅]
183

[?]
063

[?]
063
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Index

Symbols
[Help] Menu, 74

[Show Window/Keyboard], 85

Numbers
32 dot font, 123

A
[About NT--series Support Tool], 75

[Add Node], 137

Alarm History, 165

alarm history, 437

Alarm list, 159

Applicable PT, 25

Application (in file units), 433, 436

Application Manager, 64

[Arc], 138

Arrange Icons, 74

[Associate With...], 117

[Attribute], 123

Available Data Communication Methods, 428

B
[Background function], 247

[Backlight], 79

[Bar Graph], 224

base screen, 92

Batch selection of multiple elements, 107

[Bring to Front], 114

[Broken--line Graph], 228, 235

Buzzer, 79

C
Cable, 428

Cascade, 74

Channel setting, 127

(Character) String Input, 179

(Character) String Input Touch Switch, 215

child screen, 90, 91

[Circle], 140

[Clip], 333

Closing a Creation Screen, 65

Color Palette Symbol, 258

Colour, 80

Comment, 79

[Comms. Setting], 71

Comms. Setting, 430

communication method, 26

Communication method for each PT type, 26

Connection to PT, 428

[Contents], 74

Continuous Screen, 89

Control Code Input Touch Switches, 217

[Copy], 112

Copy Setting Touch Switch, 220

[Copy to Image], 88

Copying a Screen, 66

Copying and pasting elements, 111

Creating a New Screen, 65

Creating an Element, 105

Cross--Reference, 443

Cursor Moving Touch Switch, 221

Cutting and pasting elements, 112

D
Data Communication Procedure, 430

Data logging function, 247

[Date and Time], 438

Decimal, 126

[Delete], 113

Delete, 67

Deleting a Screen, 67

Deleting an element, 113

Direct Access Information, 433

Direct Connection Information, 444

[Disassociate], 117

display history, 437

display history (Screen History) function, 98

[Display Sign], 126

Display Type, 126
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Displaying and Setting Screen Properties, 67

Displaying and Setting the PT configuration, 67

Displaying the Print Image (Preview), 456

Distance, 230

Download (NT--Series Support Tool ” PT), 432

Download (NT--series Support Tool ” PT), 72

E
[Edit Object], 108

Editing a Table, 67

Error Log, 71

Extended I/O Input table, 14

Extended I/O input table, 15

Extended I/O Output table, 14, 16

Extended Screen, 97

F
[Fixed Display], 136

[Format], 126

Full Screen, 85

Full Tiling, 81

G
Get History Log, 437

Global window, 95

[Graph], 224

[Group], 116

Grouping Elements, 116

H
Hardware, 5

Hexadecimal, 126

History, 79

History Report, 445

Host Connect Screen (System Initializing Screen), 99

I
[Image], 197

Image data, 7

[Image Display], 150

Image/Library Report, 445

Input Notify Touch Switch, 214

K--L
Keyboard Screens, 92

[Lamp], 192

Library data, 7

[Library Display], 155

[Load Keyboard Screen], 79, 80

Local window, 95

M
[Mark Editor], 342

Mark List, 446

Marks, 7

MEMLINK, 129

Menu Chart, 21

Meter Shape, 229

Mitsubishi_A, 129

Mitsubishi_Fx, 130

[Modify Parent], 92

Modifying an Element, 110

[More windows...], 74

Moving an overlapped element to the front or back, 113

N
[New], 65

[New Window], 73

No. of Division, 230

[Numeral Display], 200

Numeral Input, 171

O
Objects which can be used, 8

Occurrence History Screen, 98

OMRON, 128

Opening a Data Creation Screen, 65

Opening/Closing and moving a window, 96

Output to a File (RTF), 455

Output to a Printer, 450

Outputting the Screen Image, 457

Overlapping Screens, 91
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P
parent screen, 90, 91

[Paste], 112

PC (PLC) address, 127

[Polygon], 142

[Polyline], 136

pop--up window function, 92

Pop--up Window/Keyboard Touch Switch, 216

[Print], 450

[Print Preview], 456

Print Screen Touch Switch, 223

[Print Setup], 449

Printing information on errors occurring during data conver-
sion, 453

[Properties], 67, 78, 119

[PT Configuration], 67

R
Receiving (Uploading) Data, 434

Receiving (Uploading) the History Record, 437

[Rectangle], 139

Refresh, 84

Relationships between Elements and Memory Tables, 134

[Remove Node], 138

rich text format, 455

Right click the mouse, 106

Rotate or Flip, 331

S
Save, 69

Save As, 69

Saving the Screen Image, 88

[Scale], 123, 124

Scale, 230

Scale Length, 230

Screen, 433, 436

Screen Image, 446

Screen List, 447

Screen No., 79

Search for Help on, 75

[Sector], 144

[Select Object], 107

Selecting an Element, 106

[Selector], 105

Sending (Downloading) the Data, 71, 431

Setting footer and header, 454

setting for screen switching, 87

Setting margins, 454

Setting the color for graphics, 120

Setting the color for lamps and touch switches, 121

Setting the color for text and numerals, 120

Setting the display color, 119

Setting the line type, 119

Setting the Screen Attributes, 78

Setting the tiling color, 120

Settings for numeral display, 124

Settings for text display, 122

setup, 31

[Show Tag], 83

Size and display position of window, 97

[Smoothing], 146

Smoothing, 123

Specifying an element consisting of multiple elements, 108

Standard Lamps, 192

Standard Screen, 88

[String Display], 204

String table, 15

Style Fun, Style Name, Page# Sep
[Window Control Area], 52
Alarm list/history function, 287
Application manager screen, 39
[Backlight OFF], 48
Bit Memory Tables, 286
[Buzzer], 49
Canceling backlight OFF, 292
character string memory table (string table), 281
Check box, 43
[Close], 56
Code setting in the image/library code field, 290
Combo box, 44
[Comment], 47
Connecting Cable Specifications, 549, 550
Control code input, 292
Control Menu Box, 39
[Control/Notify Area], 50
Copy Increment, 274
Copy Increment Setting Operation, 274
Correcting colors, 465
Correcting the PC (PLC) addresses (On data conversion be-

tween PT models), 466
Correction of alarm list/history touch switches, 474
Correction of graphic display attributes, 473
Correction of image codes, 471
Correction of library codes, 472
Correction of smoothing processing for marks, 473
Correction of touch switch position and size, 475
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Correction related the number of digits for numeral display,
479

Correction related the number of digits for numeral input,
478

Correction related the reference memory tables for numeral
input, 479

Correction related to a touch switch for which a pop--up key-
board function is set, 475

Correction related to analogue meter, 480
Correction related to bit memory table, 470
Correction related to contents of numeral memory table, 470
Correction related to continuous screens, 466
Correction related to control touch switch of trend graph,

480
Correction related to display range of window/keyboard

screens, 468
Correction related to extended I/O input/output table, 471
Correction related to extended screens, 469
Correction related to history screens, 469
Correction related to image/library codes in (character)

strings, 472
Correction related to keyboard screens, 468
Correction related to number of window/keyboard screens to

be opened, 467
Correction related to overlapping screens, 467
Correction related to sampling cycles of trend graphs, 481
Correction related to the 100% value, 0% value and --100%

value of a graph, 481
Correction related to the lamp label (ON state), 477
Correction related to the maximum and minimum limit

check function for numeral input, 478
Correction related to the number of memory tables, 469
Correction related to the system initial screen (Host Connect

screen), 468
Correction related to the system keypad, 474
Correction related to the touch switch for which the copy

function is set, 476
Cursor Position, 40
data conversion, 463
Data creation screen, 39
device monitor, 482
dialog box, 43
Dialog Box Settings in the PT Configuration, 45
Direct access (PLC vendor, 461
direct connection type, 47
Edit Operation, 272
[Enable], 49
Error Messages, 541, 542, 543
[Exit], 39
Extended I/O Input Tables, 291
File types, 55
floating palette, 42
[History Setting], 48
I/O Comment Tables, 296
[I/O Comments], 53
[Import], 463
Import I/O Comments, 301
Importing I/O Comment from Ladder Program, 299
[Initial], 278
[Initial Screen], 48
Inserting Image Data, 285
Inserting Library Data, 286
Inserting Mark Data, 284
Installing the System Program, 488
interlock function, 479

[Key Input], 49
Limits on display, 535
Limits on Numbers of Elements, 533, 534, 535
Limits on reading the data, 535
limits on the use of elements, 533
List box, 44
Main Window, 39
Mathematical table, 306
MEMLINK, 47
Menu bar, 40
message box, 44
Mitsubishi--A, 47
Mitsubishi--FX, 47
mmi format, 55
[New], 45
New Models, 534
Notify bit, 291
[NT--series Support Tool], 38
[Number of Table Entries], 49
Numeral Memory Tables, 275
[Numeral Storage Type], 50
object position, 40
OMRON, 47
onw format, 55
[Open], 53
Option button, 43
PC (PLC) Address dialog box, 52
PLC Vender, 40
[Printer for PT], 49
[PT Control Area], 51
[PT Notify Area], 51
PT Type page, 46
Reference Operation, 266
Remaining memory, 40
replacement, 267
[Resume Function], 48
[Save], 54
[Save As], 54
Screen switching, 291
Screen switching function, 287
Search Operation, 267
Selected PT model, 40
Siemens, 47
Start--up Procedure, 38
Status bar, 40
[Storage Type], 278
System Installer Operation, 485, 486, 487
System page, 48
system program, 485
Table Display Operation by Specifying the Table Number,

275
Table of Functions, 489, 490, 491, 513, 514, 515
Text box, 44
the import method of I/O comment, 299
Title bar, 40
[Tools], 463
Total memory, 40
[Value], 277
[Vendor], 47
[Words], 279

Switch Screen Touch Switch, 215

Switching Screen by Extended I/O Input, 87

Switching Screens by Extended I/O Input at Each Screen, 87

[Symbol Manager], 252
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System installer, 30

System Keypad, 80

System Memory, 433, 436

T
Table, 14, 68, 87, 433

Table Report, 448

[Text], 145

The relationships between elements and memory tables, 134

[Thumbwheel Switch], 188

Thumbwheel switch, 171

Tile, 74

[Tiling], 147

Title, 79

[Touch Switch], 209

[Trend Graph], 240

Type, 229

Types of Screens, 17

Types of windows, 95

U--Z
[Ungroup], 116

Uninstall, 35

[unInstallShield], 35

Upload (PT ” NT--series Support Tool), 436

Validate, 70

Validation Report, 448

[What’s This?], 75

Width Rate, 229

[Window], 72

Window Moving Touch Switch, 223

Window/Keyboard Screens, 92

[Zero Suppression], 126

[Zoom], 85
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Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual.

Cat. No. V061-E1-02

Revision code

The following table outlines the changes made to the manual during each revision. Page numbers refer to the
previous version.

Revision code Date Revised content
01 July 2000 Original production

02 October 2001 Revisions to add information on the NT21 and clarify terminology.
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